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1Getting Started
Welcome to mySewnet™ Stitch Editor. Use mySewnet™ Stitch Editor to adjust your 
embroideries to create new ones. Work with sections (subdesigns) of embroideries or 
whole embroideries, and with multipart embroideries or many embroideries at once. 
mySewnet™ Stitch Editor contains all the editing facilities of mySewnet™ Embroidery, with 
many additional powerful features.

Edit stitches directly in 3D or 2D, as desired. Use the Stitch Player in the Control Strip to 
play through the currently selected embroidery subdesign as if it is stitching out, or use 
the Design Player  to play through all sections of an embroidery. Use Life View  to 
view the embroidery in real-world perspective with the desired export options.

Emboss helps you to add beautiful patterns to your embroideries. Choose from over 100 
stamps, or use text or your own design, to make a single stamp, to stamp along a line or to 
fill a large area.

Use point morphing to magnetize, polarize, twirl or ripple stitches in small areas, or the 
eight global morphing effects to change the whole shape of an embroidery. With the 
Cutwork Line  tools Freehand Cutwork Line and Point Cutwork Line you may 
automatically remove fabric for cutwork and reverse appliqué, or simply to cut out a shape 
or design.

Use the Border Line  tools Freehand Border and Point Border, Draw Border Shape  or 
Border Embroidery  to make a new embroidery with a satin, running, triple or motif 
border, optionally with appliqué stitches and fabric. Keep the section of embroidery from 
inside or outside the border, or simply overlay the border. As in mySewnet™ Embroidery, 
the Appliqué Piece functions Express Appliqué , Appliqué Outline  and Appliqué 
Hole  enable you to add appliqué fabric to an existing design with appliqué areas, and 
to adjust appliqué areas within a design.

Apply the Monochrome  effect to create silhouette and cameo designs from 
multicolored embroideries. Use the Density Advisor  to see dense stitch areas and, if 
desired, automatically reduce the density. The Stitch Optimizer  improves the stitchout 
of the embroidery, both in speed and quality. Use Automatically Add Trim Commands  
to trim movement stitches while stitching out, and Basting Line  to secure your fabric 
and stabilizer before stitching. Mark any group of stitches as special Alignment  
stitches, and add Tie On  or Tie Off  stitches as desired.

Add and remove Color Change , Stop  and Trim  Commands. Add customized 
text to Stop commands to streamline the stitching process. Center Designs , 
Compensate Stitches , Break Up  stitches to your preferred maximum length, and so 
much more.

Design Separator  allows you to creatively cut any embroidery into two subdesigns. 
Split Design  allows you to split a large design automatically for stitching out in multiple 
hoopings, adjusting points for the best possible split.
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Use Object Editing to reshape and restyle your embroidery. Change the properties for a 
stitch type in a line, fill or satin area in your embroidery, and even convert an object from 
one stitch type to another. Remove underlay and packing with Remove Underlying 
Stitches .

Finding Information

Reference Guide
The Reference Guide shows how to start the module and provides a quick tour of the main 
screen. This is followed by information on key features, with short ’How-To’ examples, 
which will help you learn how to use the module. The Reference Guide additionally 
contains full reference information. The Reference Guide is supplied in PDF format , 
ready for printing.

Tooltips and Online Help
To learn about a function, position the arrow pointer over its icon. A tooltip with the 
function name and some information will appear.

The online help contains the ’How-To’ examples and full reference information. Use the 
Help icon , press F1 or click the Help button. Where available, a help topic will appear 
that is relevant to the item where help was requested.

Sample Guides
The Sample Guides show examples of the Fonts, Motifs and Stitch Types that are available 
in the mySewnet™ Embroidery Software. The Sample Guides are supplied in PDF 
format , ready for printing.

Viewing and Printing PDF Guides
To find all the Reference and Sample Guides for your mySewnet™ Embroidery Software, in 
Windows® 10 and 11 select the Desktop tile on the start screen. Then double-click the 
mySewnet™ Embroidery Software shortcut on your desktop, and double-click Reference 
Guides or Sample Guides. Select the desired PDF guide.

To view and print the PDF Guides, you will need a PDF reader such as Windows® Reader (included in 
Windows® 10 & 11) or Adobe® Reader (available from adobe.com).

Readme
The most up-to-date details about the mySewnet™ Embroidery Software are in the 
Readme.rtf file . (Double-click on a Readme file to open it in WordPad or Microsoft® 
Word.)

Sample Files
Samples are provided for your use. Download the sample files from the Downloads page: 
download.mysewnet.com. Copy the samples folder to the folder of your choice. 

For the exercises in this manual, the mySewnet folder is used.
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Where to Start
Starting mySewnet™ Stitch Editor

Windows® 10 & 11 Start Screen
1 At the bottom left of your computer screen, open the Windows® 10 or 11 Start Screen.
2 In the Windows Start menu, scroll down to the mySewnet folder.
3 Click the mySewnet™ Stitch Editor icon  to launch it.

Shortcuts
An alternative to the Start screen/menu method described previously is to use a Shortcut 
to mySewnet™ Stitch Editor.

Within mySewnet™ Embroidery
1 Launch mySewnet™ Embroidery .
2 With an embroidery selected, in the Home tab click Edit . mySewnet™ Stitch Editor will start.

Windows® 10 & 11 (Desktop)
1 Close or minimize any programs you have running.
2 Double-click on the Shortcut to the mySewnet™ Embroidery Software folder. A list of the programs 

appears.
3 Double-click on mySewnet™ Stitch Editor  to launch it.

Closing mySewnet™ Stitch Editor

Exit
Ends the mySewnet™ Stitch Editor session. You can also use the Close command on the 
mySewnet™ Stitch Editor Control menu.

Shortcuts
■ Mouse: Click the Close icon  on the title bar or double-click the Control menu box.
■ Keys: Alt + F4

About mySewnet™ Stitch Editor
Access via the Help tab. The version number of your mySewnet™ Stitch Editor module is 
given here. You will need this if you contact technical support at any time.

Shortcut
■ Keys: Alt, P, A
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Parts of the Software Window 

Title Bar
The Title Bar at the top of the window is highlighted if 
mySewnet™ Stitch Editor is active. Each open embroidery 
file also has its own tab showing the name of the embroidery file. The Quick Access 
toolbar gives icons for the following frequently used features: Insert, Save, Save As, Export, 
Print, Change Hoop, Undo, Redo, Life View and Design Player. 

Ribbon Bar
There are nine tabs on the ribbon: File, Home, Modify, Border, Appliqué, Emboss, Object, 
View and Help.

An alternative way to access the ribbon options is to press the Alt key, then the highlighted letter for the 
tab, followed by the highlighted letters for the item, e.g. Alt, V, 3 to view a file in 3D View. Some functions 
are available by pressing the Ctrl key and another key at the same time. These shortcuts are shown in the 
tooltip for the relevant function.
Use the Home tab to select subdesigns or stitches, copy, resize, move and rotate, change 
threads with Color Tone, and display embroideries with Life View and Design Player.

Design Select
The Design Select area of the Home tab shows the different subdesigns or sections of a 
multipart design. Select the Next  or Previous  section, change the order by moving 
subdesigns forwards  or backwards , or combine  sections of a multipart 
embroidery.

Use the Modify tab to make changes that affect the whole embroidery, to add and edit 
stitch commands, and to use the morphing and cutwork features.

Quick Access Toolbar Ribbon Bar Tabs

Status BarControl Strip Stitch AreaEmbroidery Tabs

Design PanelTitle Bar Ribbon Bar
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Use the Border tab to add a satin or stitch border to an embroidery, optionally with 
appliqué stitches and fabric.

Use the Appliqué tab to add appliqué fabric to an existing design with appliqué areas, and 
to adjust appliqué areas within a design.

Use the Emboss tab to add lines or curves of stitch points and to apply stitch points in 
shapes (called stamps) one at a time, in lines or as a fill pattern.

Use the Object tab to change the properties for the fill and line objects in your 
embroidery, or to convert these stitch types to other fill and line types.

Use the View tab to adjust the Grid, change the view mode, view Commands and stitch 
coordinates, change the hoop, and arrange multiple windows.

Work Area
The work area is the area where embroideries are loaded. Tabs along the bottom edge will 
show the names of any open embroideries. Click a tab to make it the active embroidery. 
Press Ctrl + Tab to cycle through the windows. When the embroidery file windows are 
maximized then the work area is filled by the active embroidery file. If the windows are not 
maximized, then arrange the windows in various ways using the Cascade and Tile options 
on the View tab, drag the title bars to arrange them as desired, or press Ctrl + Tab to cycle 
through the windows.

Use Cascade to arrange 
multiple windows in the 
work area in a step-like 
cascade so that you can see 
the embroidery name on 
each title bar. The currently 
active window is placed last 
so that it is on top of all the 
other windows.

Use Tile Windows to 
arrange the embroidery 
windows in the work area. 
The windows are not 
overlapped and you can see 
part or all of each embroidery 
in each window.

Stitch Area
This is the area on which the 
stitches are drawn and where you make changes to an embroidery. Stitches are drawn in 
the appropriate colors, but most thread effects are not shown in the active subdesign. The 
embroideries are shown in either 3D or 2D, with or without stitch points. The background 
color and texture can be changed using mySewnet™ Configure .
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Garment, quilt block or fabric backgrounds may be stored in .vp4 files. They are not shown in mySewnet™ 
Stitch Editor, except for any fabric backgrounds used in appliqué. Decorations are shown, but may not be 
edited, except to move or delete the whole subdesign.
In 3D view , the real hoop is shown, with blue corners 
showing the stitch area within the hoop. Movement stitches 
are hidden. The background texture is shown, if it is selected 
in mySewnet™ Configure.

In 2D view  with and without stitch points, the hoop size is 
shown by a blue outline with bold corners. Stitches are 
drawn in plain colors only, and stitches using multicolor 
threads are drawn using only the first color in the thread 
definition. Movement stitches are shown as dotted lines. The 
background does not use texture in 2D view.

In 2D view with Stitch Points , black dots or small black squares show the stitch points (needle 
insertions) in the fabric. The display of the stitch points, whether they are dots or squares, depends on the 
zoom level. Showing the stitch points may be helpful for inserting new stitches or moving individual 
stitches. The view mode can be set separately in each embroidery. 
Use Ghost Mode  to display pale 'ghost' stitches where there are hidden stitches.

Use Commands  to show or hide the command markers for Color Change , Stop  
Appliqué , and Trim .

Background Grid
Each embroidery has a grid, which may be turned on or off or shown with numbered grid 
lines using the grid options . Zooming in or out makes the grid squares look bigger or 
smaller, but the grid numbers stay the same size. The grid size can be changed from 2mm 
to 50mm using the View tab. The grid and numbering can be turned on and off separately 
in each embroidery window, but changing the grid size affects all windows.

Control Strip
Use the Control Strip to view the colors in the selected section of the embroidery, and to 
select stitches by number, by color block, or with the handles on the slider bar. Stitches 
can be hidden for ease of editing or to protect them from being changed by other 
functions. Also step through the Stop commands in the embroidery.

View how the selected subdesign will be stitched out with the Stitch Player, pausing for 
Color , Stop  and Trim  commands.

Design Panel
To the right of the work area is the Design Panel. Use the Design Panel to change colors, 
and to adjust the Notes and Settings.

Design Information
The Design Information shows the dimensions (Height  and Width ), Stitch Count , 
and number of colors  for the active embroidery.

Hoop Corner
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Color Select
The Color Select area shows the order of the color blocks in the color worksheet and any 
notes that are included in the embroidery. Click on a color block to change thread colors 
and to add thread effects. Also use the color worksheet to show or hide stitches by color 
block, to move color blocks up  or down  and merge  color blocks. Edit or add 
information to the Notes and Settings as desired.

Clipboard Block
The Clipboard Block shows the embroidery that can be pasted into the work area.

Click in the Clipboard to remove the current Clipboard Block.

Overview Window
The overview window gives a small overview of the whole work area for the current 
embroidery.

See “Overview Window” on page 31.

Status Bar
The status bar is found at the bottom of the window. Starting from the left, the status bar 
shows:

■ The selection tools.
■ The horizontal and vertical distance of the mouse pointer from the center of the 

embroidery.
■ The hoop size.
■ An indicator of the current function, which is blank when no function is active.
■ The zoom tools and Zoom Bar.

mySewnet™ Stitch Editor Terms and Conventions
On-screen pointers
The mouse pointer is most commonly shown as an arrow  on the screen.

If it is positioned over a text box it changes to an I-bar  and you can type, such as the Edit 
Notes dialog box. 

If Zoom To Rectangle  or Zoom In  in a dialog box is chosen, the Zoom In pointer  
appears. If Zoom Out  is chosen in a dialog box, the Zoom Out pointer  appears. 
When zoomed in, if the Pan feature is used to move around the screen, the Pan cursor  
appears.

The Box Select pointer , Freehand Select pointer  or Point Select pointer  appear 
when the associated Select function is chosen. Add to a selection with the Add to 
Selection  pointer, and remove items from a selection with the Remove from Selection 

 pointer.

There are several pointers indicating functions in the selection box. The Rotate pointer  
appears when the mouse pointer is over the Rotate handle . The cross-hair pointer  
appears when the mouse is over the center of rotation .
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The diagonal double-headed arrow  pointer appears when the mouse pointer is over a 
square corner handle . The horizontal double-headed arrow  pointer appears when 
the mouse pointer is over the Flip Horizontal handle . The vertical double-headed 
arrow  pointer appears when the mouse pointer is over the Flip Vertical handle . The 
pointer becomes a four-headed arrow  (the move pointer) when it is over a selection 
box.

The Insert Color Command pointer  which places a Color Change , the Insert Stop 
Command pointer  which places a Stop Command , the Insert Trim Command 
pointer  which places a Trim Command , and Insert Stitches pointer  appear 
when the associated Modify Stitch function is chosen. When Tie On or Tie Off are used, the 
tie pointer  appears.

If the Freehand functions are used, the pointer becomes a pen . If the Point functions 
are chosen, the pointer becomes a circle . When nodes placed by either of the drawing 
functions are adjusted, the pointer becomes a small cross  (a move pointer). The Point 
pointers are also used when drawing a split line for Design Separator .

In the Object tab, the Object Select  pointer is shown. Insert points in an object with 
the Insert Point  pointer, and Delete Points with the delete points pointer .

When using stamps, the pointer is the currently selected stamp.

The Measure pointer  appears when the Get Length  function is selected.

The pointer becomes the pink Fabric handle  when adjusting appliqué fabric pieces.

Touch Gestures
Touch gestures are used when viewing and moving embroideries in the mySewnet™ 
Embroidery Software. They are available when using a touch-sensitive screen. 

General

Select and move
One finger touch and one finger slide are equivalent to click and drag with a mouse. Use 
to move embroideries, select, draw or create stitches with freehand features, and so on.

Autoscroll
When you drag within a document, the autoscroll feature moves the pointer 
automatically, changing the view of the work area. 

This is useful when zoomed in. Use autoscroll while moving or resizing a selected 
embroidery.

■ Use a two finger swipe on the work area.

Pinch to zoom
Pinch two fingers to zoom in, and spread two fingers to zoom out.
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Context menu
Press and hold and a context-sensitive menu will appear if available (similar to a right-
click). 

mySewnet™ Embroidery and mySewnet™ Stitch Editor only

Multiple select
Two finger touch will add or remove an embroidery in the current selection (similar to 
Ctrl+click).

Pinch to resize or scale
Pinch two fingers inside the selection box to reduce, and spread two fingers to enlarge the 
selected embroidery, lettering or SuperDesign. 

Pinch outside the selection box to zoom.

Rotate
Twist your thumb and forefinger to rotate the selected embroidery, lettering or 
SuperDesign.

Embroidery File Formats
mySewnet™ Stitch Editor can load any of the following embroidery file formats: Bernina 
(.art version 1, 2, 3), Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby Lock/Bernina PES 
(.pes version 2 - 11), Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff (.vp4, .vp3 and 
.vip), Husqvarna (.hus, .shv and .dhv), Janome (.jef and .sew), Melco (.exp), Pfaff (.pcs), 
Tajima (.dst) and Toyota (.10*).

mySewnet™ Stitch Editor saves embroidery files in Husqvarna Viking / Pfaff (.vp4) format.

Embroideries may only be saved in .vp4 format as this will preserve the separate parts of multipart designs. 
It also preserves hoop, background, decorations and appliqué information, thread colors, and notes.
mySewnet™ Stitch Editor exports any of the following embroidery file formats: Husqvarna 
Viking / Pfaff (.vp4 and .vp3), Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby Lock/
Bernina PES (.pes version 2 - 11), Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff 
(.vp4, .vp3 and .vip), Husqvarna (.hus ,.shv), Janome (.jef, .sew), Melco (.exp), Pfaff (.pcs), 
Tajima (.dst) and Toyota (.10*).

Picture Files
mySewnet™ Stitch Editor can load any of the following picture file formats in the 
Background wizard for appliqué fabrics: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), Tagged Image File Format 
uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced Meta File (.emf ) 
and Windows Icon (.ico).

mySewnet™ Stitch Editor can create pictures and videos of embroidery designs from 
Design Player and Life View.
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Hoop Selection
Use Hoop Selection  to choose the hoop size you wish to use.

Set the hoop size according to the size of your embroidery or the hoop you wish to use for 
stitching out, or enter any other desired size. The hoop information is stored in your .vp4 
embroidery file, and used for your initial Export settings.

Shortcuts
■ Quick Access Toolbar; Home Tab; View Tab: 
■ Keys: Ctrl + H; Alt, 6; Alt, H, H; Alt, V, H

Hoop Group
The drop-down list of Hoop Groups shows all the machine Hoop Groups, and the My 
Hoops group, if used.

Hoop Size
The drop-down Hoop Size list shows the hoops in the chosen Hoop Group. Select the 
desired hoop size and a picture of the hoop will be shown in the Preview.

Included in My Hoops
Select (check) Included in My Hoops to add the selected hoop to the My Hoops list. Use 
the My Hoops list to create a list of your favorite hoops.

The selected hoops will be displayed in the My Hoops group in the order that they were selected.

Select the hoop size Choose a machine or hoop group

Enter a size for a custom hoop Select the hoop orientation

Add the hoop
to My Hoops
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Orientation
Select Natural or Rotated orientation according to the shape of the embroidery that is to 
fit in the hoop. Natural orientation is similar to the way the hoop would appear when you 
sit in front of your machine; note the position of the bracket.

It is recomended to use natural hoop orientation for designs with Twin Needle colors.

Enter Size
To enter a hoop size that is not listed in any of the Hoop Groups, click the Enter Hoop Size 
box so that it is selected (checked). The Width and Height boxes will become available. 
You can enter any size from 10mm to 4000mm. The preview shows the shape of the hoop 
you enter.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.

Changing Hoop Size
All new embroideries and embroideries that are opened after the change will use the new 
hoop size.

However, if you have more than one embroidery open when you change hoop size, you 
will be asked if you want to change the hoop size for all open embroideries.

Click Yes to change the hoop size for all open embroideries, or click No to change the 
hoop size for only the currently active embroidery.
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2Managing Embroideries
Use New  to create a blank embroidery work area, Open  to load an existing 
embroidery in a new window, and Insert  to open an embroidery into the current 
window.

When an embroidery is loaded in mySewnet™ Stitch Editor, you will see the embroidery, 
appliqué areas and decorations. Most thread effects are not shown in the active 
subdesign. You will not see garment, quilt block or fabric backgrounds.

If you Open or Insert an embroidery containing design information such as Lettering or SuperDesigns, a 
warning message will appear saying that these items will be fixed as embroidery stitches. This warning 
message can be turned off in Preferences. See “Preferences” on page 284.

New
Use New  to create a blank embroidery work area in mySewnet™ Stitch Editor. To open 
an existing embroidery, use Open  or Insert .

Use a new embroidery to:

■ Create a blank canvas on which to assemble parts from other embroideries.
■ Paste an embroidery from another mySewnet™ Embroidery Software module.
■ Hold temporary copies of blocks that you are working with.

You may create as many new embroideries as desired.

Use the tabs at the bottom of the work area to switch between multiple open embroideries.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + N

Open Embroideries
Use Open  to load individual files by thumbnail image, name or number into a new 
window. Use Insert  to insert an existing embroidery into your current project. Use 
Windows® Explorer to Load Embroideries with Drag and Drop. Open recently used 
embroideries with File, Recent. Use Paste , Paste into New Window, or Paste as Design 
to insert a file from the clipboard.

The following embroidery file formats may be loaded: Bernina (.art version 1, 2, 3), 
Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby Lock/Bernina PES (.pes version 2 - 11), 
Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff (.vp4, .vp3 and .vip), Husqvarna 
(.hus, .shv and .dhv), Janome (.jef and .sew), Melco (.exp), Pfaff (.pcs), Tajima (.dst) and 
Toyota (.10*).

Only Husqvarna Viking / Pfaff (.vp4, .vp3 and .vip) embroidery files contain full thread 
color information that will be shown in the original thread colors. Other files that hold 
some color information, such as .hus, .shv, .dhv, .pcs, .pes, .sew and .xxx, are shown in the 
nearest match to the colors in which they were created. The shades are converted to the 
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Import Thread Range, as selected in mySewnet™ Configure. For files that do not store 
colors, such as .dst, .exp and .10*, the design will be shown in a default color sequence, 
using thread colors from the Import Thread Range.

Only one copy of each embroidery can be opened. If you attempt to open an embroidery again when it is 
already loaded then it will become the currently active embroidery.

Open
Use Open  to load an existing embroidery in a new window. mySewnet™ Stitch Editor 
displays the Open dialog box so you can choose an embroidery to open. Alignment 
stitches will be retained.

Use Insert  to add an existing embroidery to a project.

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open. This box lists files with the extension you 
select in the Files Of Type box. 

Files of Type
Select the type of file you want to open from the drop-down menu.

Look In
Select the drive or folder containing the file that you want to open.

More Options
Switch from list  or details  view to icons with thumbnail images of the embroideries. 
For example, Extra Large icons .

Preview Pane
Preview the embroidery before opening .

Click Open to load the selected design

Browse to a different folder

Click on a design to preview it

Hover to view the selected design’s details

Previewed design

Search for a design

Change the view or icon size
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Shortcuts
■ File Menu: 
■ Keys: Ctrl + O

Insert
Use Insert  to add existing embroideries to the project in the current window. The Open 
dialog is displayed so that you can choose an embroidery to insert. Alignment stitches will 
be removed.

Shortcuts
■ Quick Access Toolbar; File Menu: 
■ Keys: Ctrl + I; Alt, 1

Load a Dragonfly Embroidery
1 Click New .
2 Click the Hoop icon , and ensure that the hoop is set to 100mm x 100mm - Universal Square 

Hoop 1. Click OK.
If you are changing the hoop size and other embroideries are already open, a message will appear.

3 Click Insert .
4 In the Open dialog box, browse to the folder Documents\mySewnet\Samples\Stitch Editor\Stitch.
5 Click OK and the embroideries in the folder will be shown.

If desired, click Change Your View  to view icons of the embroideries.
6 Scroll down to show the thumbnail of 'Perky Dragonfly'.

Click Open to load the selected design

Browse to a different folder

Click on a design to preview it

Hover to view the selected design’s details

Previewed design

Search for a design

Change the view or icon size
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If you position the arrow pointer over a thumbnail without clicking, the details about the embroidery will 
be shown.

7 Click the 'Perky Dragonfly' picture and the embroidery will be selected.
8 Click Open to load the embroidery onto the screen.

Load Embroideries with Drag and Drop
To drag and drop as many embroideries as desired onto the screen, use Windows® 
Explorer. Hold down the Shift key to select a consecutive group of embroideries. Hold 
down the Ctrl key to select individual embroideries.

Drag an Embroidery to the Work Area
1 Open an Explorer window in Windows®. If required, resize the Explorer window so you can see both 

Explorer and mySewnet™ Stitch Editor.
In Windows® 10 and 11, click File Explorer on the Status Bar.

2 Browse through the drives and folders of your computer to find the 
Documents\mySewnet\Samples\Stitch Editor\Stitch folder.

3 Click on an embroidery icon to highlight it. Hold down the Shift key to select consecutive files or Ctrl 
key to select multiple individual files.

4 Use the mouse to drag and drop the embroideries on the mySewnet™ Stitch Editor screen. All the 
embroideries will be opened in separate windows in mySewnet™ Stitch Editor. The last embroidery 
loaded will be displayed on the screen.

5 Close Windows® Explorer.

Recent
Use File, Recent to open previously used embroideries via the filenames listed in the 
Recent section of the File menu. Select the name of the desired embroidery.
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Switch Between Open Embroideries
To switch between designs in the work area, see “Select, Move and Merge Designs” on page 150.
Switch between open embroideries using any of the following methods:

■ Click the tab showing the embroidery name at the bottom of the work area.
■ If the windows are not maximized, click anywhere on a window to switch to it.
■ Press Ctrl + Tab or Ctrl + F6 to cycle through the windows in the order in which they were 

most recently viewed.
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Save Embroideries
There are four methods of saving embroideries, Save, Save As, Export and Save On Exit.

Use Save or Save As to retain a multipart project file.
Use Export to save an embroidery for stitching out, or to save in a format other than .vp4.

Save
Use Save  to save the contents of the open window as a multipart embroidery in .vp4 
format. If the embroidery has already been saved, this will save any changes using the 
existing name and folder.

Use Save for projects that you cannot Export, such as multipart embroidery projects with designs that do 
not fit in the selected hoop.
When first saving a new embroidery, this saves the embroidery with the name you give it 
in the Save As dialog.

Save will overwrite the existing embroidery. If you want to change the name and folder of an existing 
embroidery file before you save it, choose the Save As or Export functions.

Shortcuts
■ Quick Access Toolbar; File Menu: 
■ Keys: Ctrl + S; Alt, 2

Save As
Use Save As  to save the embroidery as a multipart embroidery in .vp4 format under a 
new name. For instance, you might remove part of an embroidery and want to save the 
changed embroidery with a new name. 

This displays the Save As dialog box so that you can save the embroidery with a new file 
name.

To save an existing embroidery file without changing its name, use Save . 

Shortcuts
■ Quick Access Toolbar; File Menu: 
■ Keys: Ctrl + Shift + S; Alt, 3

Save On Exit
If you make changes to an embroidery, then try to close the embroidery before saving the 
changes, a message will appear, asking if you want to save the changed embroidery.
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If you exit mySewnet™ Stitch Editor then you will be asked about each embroidery that 
you have changed without saving. Choose between:

Close Embroideries
When you have finished working on embroideries, you may close them without closing 
mySewnet™ Stitch Editor. Close embroideries individually, or close all  embroideries in 
a single operation.

Close
Use Close  to the right of the Embroidery tabs below the work area to close the currently 
active embroidery. If there are unsaved changes in the embroidery, you will be prompted 
to save changes.

Alternatively, if the embroidery window is maximized, click the file Close icon  in the top 
left corner of the window, which is below the Close icon for mySewnet™ Stitch Editor. If 
the embroidery window is not maximized within the work area, click the Close icon  on 
the title bar for the embroidery window.

Shortcut
■ Keys: Ctrl + F4

Yes Save the changes to the embroidery. If it is a new embroidery, 
the Save As dialog box appears.

No Do not save the embroidery and continue. Any changes to 
the embroidery are lost. If it was a new embroidery then it is 
discarded without being saved.

Cancel Do not save the embroidery, but keep the embroidery open 
and do not close mySewnet™ Stitch Editor.
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Export
Use Export  to save the embroidery in the current window as a flattened .vp4 file, or in 
an alternative embroidery format. The embroidery must fit in the currently selected hoop. 
Use the Design Player to see how the embroidery will be exported according to the 
current options.

You can customize the initial Export options in mySewnet™ Configure.

To export appliqué pieces, see “Export Appliqué Pieces” on page 24.
The preferred file format for exporting embroideries is Husqvarna Viking / Pfaff .vp4, as 
this will preserve background and appliqué information, thread color information and 
notes.

You can also export embroideries as Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby 
Lock/Bernina PES (.pes), Compucon/Singer PSW (.xxx), Husqvarna (.hus ,.shv), Husqvarna 
Viking /Pfaff (.vp3, .vip), Janome (.jef and .sew), Melco Expanded (.exp), Pfaff (.pcs), Tajima 
(.dst) or Toyota (.10o).

The initial name will be the current file name with "Exported" added. The text "Exported" may be changed 
in mySewnet™ Configure.

Shortcuts
■ Quick Access Toolbar; File Menu: 
■ Keys: Ctrl + E; Alt, 4

Optimize for Sewing Options
All of these options are initially selected when saving as a .vp4 file, or in any other format.

Combine: Merge the embroideries into a single embroidery during Export.
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Combine is not enabled if there is only one design, and for embroidery formats that are automatically 
combined.
Remove Overlap: Prevent areas of stitches building up where embroideries overlap. 
Remove Overlap is not used if any of the designs contain appliqué.

Remove Overlap is not available when Combine is not enabled.
Only deselect this option if, for example, your embroideries are low density and you wish to have a blend 
effect where they overlap.
ColorSort: Reduce the number of thread colors during Export. See “ColorSort” on 
page 42.

Optimize Stitch Length: Automatically remove small and insignificant stitches. See 
“Stitch Length Optimizer Options” on page 23.

Cutwork Needle lines in the Inspira Cutwork Needle "thread range" and Felting Needle Colors in the Inspira 
Felting Needle "thread range" are unaffected by Optimize Stitch Length.

Decoration
Create Center or Line placement stitches for Decorations added in mySewnet™ 
Embroidery, or remove all decorations and their associated placement stitches.

Center placement stitches are recommended when most decorations are individual and 
symmetrical. Line placement stitches are recommended when most decorations are 
individual and asymmetrical (such as bugle beads) or lines of closely spaced beads or 
sequins.

Create Center placement stitches: Create a small cross shape in stitches to show where 
the decoration is to be placed.

Create Line placement stitches: Create a single stitch that runs along the length of the 
decoration.

Remove all decorations and placement stitches: Remove all decorations and placement 
stitches from the exported version. This may be desired to create an embroidery with a 
complementary crystal transfer template (made using the Export Decoration Template 
dialog box in mySewnet™ Embroidery).

Hoop Orientation
Set the hoop orientation.

Rotate to fit natural hoop position: Rotate the embroidery if needed to fit with the 
default hoop orientation for the machine. This option is only available if the hoop on the 
main screen is in the rotated orientation. It is useful if you prefer to create a "landscape" 
shaped project in the rotated orientation.

Flip design for felting or reverse embroidery: Flip the embroidery for being stitched in 
reverse. If an embroidery contains a Felting Needle color effect this option is selected 
initially. See “Felting Needle” on page 40.

Splitting options
Click the button to open the splitting options dialog box. See “Splitting for Multipart 
Hoops” on page 21.
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Splitting for Multipart Hoops is available if .vp4, .vp3, .pes or .jef is chosen.

Additional Sections
Additional dialog options are available, depending on the chosen file format.

■ If .pes is chosen, you can select your machine type, file version, hoop size and rotation.
■ If .jef is chosen, you can select your machine type, hoop size and rotation.

OK
View the Save, or Saving As dialog, depending on the selected file format.

Export an Embroidery
1 Create an embroidery project.
2 Save the embroidery. See “Save” on page 17.
3 Click Export . The Export dialog box appears.
4 Select an embroidery format from the drop-down list.
5 Select your optimization options.
6 If you are using a multipart hoop, click Splitting Options and set Intelligent or Straight Line split.
7 Click OK.
8 The Save As dialog will appear. Save the embroidery as desired. 

Splitting for Multipart Hoops
Note: This dialog is available if .vp4, .vp3, .pes or .jef is selected as the file format.

Embroideries for Multipart hoops are split automatically, according to your Export 
settings. Use an Intelligent or Straight Line Split.

Note: There is no need to ensure embroideries are in one stitch area of the hoop; just place 
your embroideries in the most pleasing arrangement. 

Split Method
You can use one of two split methods:

■ Intelligent Split automatically calculates a split line that is routed through gaps or across 
movement stitches, cuts the minimum number of stitches, and minimizes cuts through 
solid sections of embroidery. Where possible, use Intelligent Split.

■ Straight Line Split cuts the embroidery straight across the center line of the overlap zone.

Intelligent with Tolerance
Intelligent Split calculates a split line that cuts the minimum number of stitches, and 
minimizes cuts through solid sections of embroidery. For example, a large embroidery is 
split at a narrow section, and an embroidery that fits in one stitch area of the hoop is left in 
one piece even if it is part of a larger design.
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Tolerance ensures that the Intelligent Split line stays a short distance from the edges of 
the overlap. This allows for play in the hoop when going from one hoop area to another, 
such as when aligning a hoop that has been turned to stitch out the other side of an 
embroidery.

You can set Tolerance from 0 to 3mm, in steps of 1mm. The initial setting is 1mm.

To use Intelligent Split with Tolerance, select the "Intelligent with Tolerance" checkbox, then enter a number 
in the Tolerance number box, or use the arrows to increase or decrease the Tolerance.

Straight with Compensation
Straight Line Split cuts straight across the center of the overlap zone. Straight Line Split 
will only split an individual embroidery if, before it is combined with everything else, it 
does not fit entirely into one stitch area of the hoop.

Lettering is split straight down the middle, as with any other type of embroidery. This may cut through 
characters rather than gaps and spaces. In such cases, it is recommended to use Intelligent Split instead.
Compensation adds overlapping stitches along the edges where the embroidery is split. 
This compensates for pull on the fabric.

Alignment Stitch for Turnable Hoops
Select this option to add an alignment cross at the end of each embroidery section when 
using the HUSQVARNA VIKING® Designer Majestic™, PFAFF® creative Grand Dream™, 
Universal Multipart hoop, or Brother Jumbo Frame. A hoop movement to the alignment 
cross is added at the beginning of the next section. The next embroidery section can then 
be correctly aligned, or alignment can be confirmed.

None Use None if you can split an embroidery without cutting through any of the design 
elements. Compensation is initially set to None.

Low Use Low when cutting through a lightly stitched embroidery or when the split lines go 
through only a few stitch areas.

High Use High when the embroidery is dense, when the split lines make long splits through 
stitch areas, or when stitching onto materials such as knitted or stretchy fabric.
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Stitch Length Optimizer Options
Use the Stitch Length Optimizer Options dialog box to automatically remove small and 
insignificant stitches. You can adjust the stitch removal sensitivity, or the minimum 
significant stitch length.

Stitch Length Sensitivity
Adjust the sensitivity of the optimization. Low is set as the default.

■ Choose from Low, Medium or High.

Minimum Significant Stitch Length
Select the shortest stitch length that you consider to be significant. Stitches below this 
length are removed during the optimization process. The default stitch length is 0.8 mm.

Cutwork Needle lines and color blocks with the Felting Needle thread effect are unaffected by the 
Minimum Significant Stitch Length.

■ Choose from 0.6 mm, 0.8 mm or 1.0 mm.
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Export Appliqué Pieces
Use Export Appliqué Pieces  to save or print appliqué outlines ready for cutting. Select 
the desired method and options, then click the Export or Print button at the bottom of the 
dialog box.

There are five appliqué piece export methods:

■ Export for Cutter: Save as SVG, DXF or FCM files for use in fabric cutters
■ Export for Cutwork Needles: Save as VP4 or VP3 stitch files that can be used with 

INSPIRA™ Cutwork Needles
■ Print Templates: Print as an outline template to stick or pin to fabric and then cut out
■ Print Appliqué Pictures: Print directly onto printable fabric or an iron-on transfer; this 

also prints the image of the appliqué piece
■ Export for Custom Layout: Save as SVG files with the fabric image placed as the fill for 

each shape. This is designed for use with fully customized layouts.

Export for Cutter
Export the appliqué piece as an SVG, DXF or FCM image file for use in a fabric cutter.

Set the units of measurement (millimeters or inches), and select a file type. Click Export to 
save the file.

The maximum size for the Brother ScanNCut FCM format is 12" x 12" (305mm x 305mm).

Export an SVG, DXF or FCM file 

Use 2 or 4 cutwork needles

Add secure points for fabric stability

Export a .vp3 or .vp4 stitch file

Print as an outline template for cutting out

Print onto printable fabric or an iron-on transfer

Save as a SVG custom layout with fabric images

for use in a fabric cutter
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Recommended file formats for cutters:

Export for Cutwork Needles
Export the appliqué piece for cutting with INSPIRA™ Cutwork Needles. Select 2 or 4 
needles, choose whether to use secure points for fabric stability and their length, and use 
a .vp3 or .vp4 stitch file.

Print Templates
Print the appliqué piece as an outline template to stick or pin to fabric and then cut out. 

Select a printer and paper size in the Print Setup dialog box. See “Print Setup” on 
page 281.

Print Appliqué Pictures
Print directly onto printable fabric or an iron-on transfer; this also prints the image of the 
appliqué piece.

Flip the picture for an iron-on transfer, and select a printer and paper size in the Print 
Setup dialog box. See “Print Setup” on page 281.

Export for Custom Layout
Save as SVG files with the fabric image placed as the fill for each appliqué piece shape. This 
is designed for use with fully customized layouts, for example if you wish to arrange the 
shapes in your cutter software or in another graphics package.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + Shift + E

Sending Embroideries 
Send designs to your mySewnet™ enabled embroidery machine via mySewnet™ from 
within the mySewnet™ Embroidery Software, or directly from your mySewnet™ account.

Use mySewnet™ Connect to change your mySewnet™ settings, and to send embroideries 
directly to some HUSQVARNA VIKING® or PFAFF® machines using Direct USB Connection.

Send
Use the Send dialog to send the selected embroidery to the mySewnet™ Cloud, or to your 
machine.

Cutter Software Export Format

Cricut Explore® Cricut Design Space 1.091 DXF (inches)

KNK Zing Air® Make the Cut! 4.6.1 (Zing Plugin 2.1.0) SVG (inches)

Silhouette Cameo® Silhouette Studio 3.6.39 ss DXF (millimeters)

Brother ScanNCut® ScanNCutCanvas 2.1.0 FCM
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Send to mySewnet™ Cloud
Send the selected embroidery design to the mySewnet™ Cloud.

Send Express to mySewnet™ Device
Send the selected embroidery design direct to the mySewnet™ enabled machine or 
computer.

Select the computer or machine from the list below.

Direct USB Cable
Send or Send Express to a machine with a direct USB connection.

Filename
You can change the name of the design before sending it.

Sending via mySewnet™

Sending from a Machine to mySewnet™ Embroidery
You can send an embroidery from a mySewnet™ enabled embroidery machine to 
mySewnet™ Embroidery on your computer. Adjust the embroidery, then return it to your 
machine for stitching.

To be able to send from your machine to mySewnet™ Embroidery, and to send to your 
machine with Send Express to mySewnet™ Device:

■ mySewnet™ Connect must be running on the computer
■ You must use a mySewnet™ enabled embroidery machine with the most recent updates 

installed
■ The computer and embroidery machine must be signed in to the same mySewnet™ 

account.

Send the design to the mySewnet™ Cloud 
Send directly to a mySewnet™ device 

Select the machine or computer for sending to

Send to a machine using a Direct USB cable

Start the mySewnet™ Connect utility 

Change the design name before sending
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An embroidery moved from a machine to mySewnet™ Embroidery will include no special features from the 
embroidery machine, for example changing the words for lettering. This is also true of designs sent in the 
other direction.

Send from an Embroidery Machine
1 Go to the embroidery machine.
2 Tap the Cloud button at the top and ensure that you are signed in to mySewnet™.
3 Select embroidery mode, and then load an embroidery.
4 In the machine screen, choose the send to software option. 
5 Select the computer to send to, then send the embroidery. 

The embroidery will open in a new mySewnet™ Embroidery window.
6 When you have adjusted the embroidery, save the changes to your computer.

You can name your computer in the mySewnet tab of mySewnet™ Configure.
You can then use Send Express to mySewnet™ Device to return the edited embroidery to 
your machine for stitching out.

When you send from your embroidery machine to mySewnet™ Embroidery, the embroidery may be sent to 
a window beneath the active maximized window. The mySewnet™ button in the taskbar flashes to 
indicate that a design has been sent.

Using Send Express to mySewnet™ Device
1 In the File menu, select Send.
2 In the Send dialog box, select your machine name from the list. 

A message tells you that the design was sent.
3 On the machine, tap to accept the design from your computer.
4 Stitch out the design.

You can use Send to mySewnet™ in the Explorer Plugin to send embroideries to mySewnet™. See the 
mySewnet™ Configure Reference Guide and Help.

Sending to a Machine via Direct USB Connection
Use mySewnet™ Connect to send embroideries directly to your embroidery machine 
screen, or to the embroideries folder on your embroidery machine with Direct USB 
Connection.

■ mySewnet™ Connect must be open to transfer files directly to and from the embroidery 
machine when it is connected to your computer. 

■ Use the file manager on your embroidery machine to browse your computer and copy 
embroideries to any folder on your machine.

When Direct USB Connection is established, the machine name will be shown in the Machine menu.

Using mySewnet™ Connect with Direct USB Connection
Before using Direct USB Connection, ensure that your drivers are up to date at 
mysewnet.com

1 First, check your Direct USB connection.
Switch off your embroidery machine.

2 Open mySewnet™ Configure , and if the mySewnet™ Connect icon cannot be seen in the system 
tray, click Start mySewnet™ Connect  on the Utilities tab. 
The mySewnet™ Connect icon can be seen in the system tray, however it is flagged as inactive .

3 Switch on your embroidery machine, and wait for it to initialize. The mySewnet™ Connect icon is now 
flagged as active . 
You can now send embroideries to your embroidery machine’s screen or designs folder.
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Communication will also be shown as established if  a connection exists with mySewnet™.
4 Open mySewnet™ Embroidery, then use Insert  to load an embroidery design.
5 In the File menu click Send.
6 In the Send dialog box, select Send Express to USB connected machine, then click Send. The 

embroidery appears on the embroidery machine screen.
You can now stitch it on your embroidery machine.

7 In the Send dialog box, select Send to USB connected machine. Then click Send to send the 
embroidery to the MyFiles or Personal Files folder on your embroidery machine.
You can also send embroideries to your directly connected machine via the mySewnet™ Embroidery 
Software Explorer Plugin. See the mySewnet™ Configure Reference Guide and Help.

8 Right-click the mySewnet™ Connect system tray icon. A context menu appears.
9 Ensure that Start Automatically is selected, to start mySewnet™ Connect whenever your computer is 

started.
10 Click About mySewnet™ Connect to view the version number.

You will need this version number if you contact technical support at any time.

mySewnet™ Connect
Use the mySewnet™ Connect module in the mySewnet™ Embroidery Software to access 
your mySewnet™ settings in mySewnet™ Configure, and to send embroideries directly to 
some HUSQVARNA VIKING® or PFAFF® machines using Direct USB Connection.

To change your mySewnet™ settings, see the mySewnet™ Configure Reference Guide and Help.
Use the mySewnet™ Connect menu to check the status of your mySewnet™ or Direct USB 
Connection.

The System Tray Icon
When mySewnet™ Connect is running, it appears as an icon in the system tray  at the 
bottom right of your computer screen. The icon will show whether or not communication 
is established with your machine as follows:

■ Click or right-click the icon to see the mySewnet™ Connect Menu.

Communication is shown as established when a connection exists with either mySewnet™ or with your 
embroidery machine via Direct USB Connection.

Starting mySewnet™ Connect
mySewnet™ Connect is set to start automatically when you restart your computer. If it is 
not open, use the following steps.

1 Open mySewnet™ Configure .
2 On the Utilities tab, click Start mySewnet™ Connect . The mySewnet™ Connect icon  can now 

be seen in the system tray.
3 To close mySewnet™ Connect, click the icon in the system tray and in the mySewnet™ Connect menu 

click Exit.

mySewnet™ Connect Menu
Click the mySewnet™ Connect icon in the system tray to see a menu of options.

Communication established No communication
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The menu tells you whether you are signed in to mySewnet™, and if Direct USB 
connection is active.

For mySewnet™ the current status in mySewnet™ Configure is listed, for Direct USB your machine name or 
Not Connected are present. If you have more than one machine, the first found is used.

■ Select About mySewnet™ Connect to see the version number and copyright.
■ Select Start Automatically to select or deselect the automatic start when Windows® starts.
■ Select mySewnet™ Options to view the mySewnet tab in mySewnet™ Configure.
■ Select Direct USB Settings to view the shared drives list.
■ Select Help to display help pages about mySewnet™ Connect.
■ Select Exit to close mySewnet™ Connect and remove it from the system tray.

Shared Drive Selection
Click the icon in the system tray, and select Direct USB Settings in the popup menu that 
appears.

The Shared drives list shows all the drives on the computer. Drives that are selected with 
check marks can be browsed from your embroidery machine. All available drives are 
selected when mySewnet™ Connect is installed. If you add new drives after installing 
mySewnet™ Connect, such as a USB stick, you will need to click the drive so it is checked. 
Click the check boxes to uncheck drives that you do not want to browse from your 
embroidery machine.

The mySewnet™ Cloud Sync Tool
Use the mySewnet™ Cloud Sync Tool to manage the content of your mySewnet™ 
compatible embroidery machine from your PC.

The mySewnet™ Cloud Sync Tool is available from: www.mysewnet.com
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Select your machine brand, Register or Sign In, and in the Home page select mySewnet™ 
Cloud to download and install the Sync Tool.

The System Tray Icon
When the mySewnet™ Cloud Sync Tool is running, there is an icon on the bottom right of 
your computer screen. The icon will show whether or not the Sync Tool is running:

■ Left-click the icon to view your mySewnet™ folder and the mySewnet™ website.

■ Right-click the icon to see the mySewnet™ Cloud Sync Tool menu.

For more information, click Getting Started in the mySewnet™ Cloud Sync Tool menu.

Sync Tool Active Sync Tool Inactive
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3Viewing Embroideries & Threads

Design Select
Use the Design Select area of the Home tab to 
view the different sections or subdesigns of a 
multipart design. The selected section is 
displayed in the work area. To move 
subdesigns within the multipart design, see 
“Select, Move and Merge Designs” on page 150.

Standard embroidery subdesigns are numbered. Decoration subdesigns are labeled with 
the letter "D", and Alignment subdesigns are labeled with the letter "A".

Automatic Ghost Mode is used to show the position of the other parts of the design in the work area.
To select sections of a multipart design:

■ Click Next Design  or press the Tab key to see the next subdesign.

■ Click Previous Design  or press the Tab key to see the previous subdesign.
■ Click the desired section of the design in the Design Select area.

To see all subdesigns, click the arrow at the bottom right of the Design Select area.

Overview Window
The overview window at the bottom of the Design Panel gives a small overview of the 
whole work area for the current embroidery window.

When you zoom in, a box is shown around the area that is currently visible in the main 
window. Click and drag the box to move to another part of the window.

If there are stitches hidden for the current embroidery, these will also be hidden in the Overview Window.

Show and adjust the grid View command markers

Change the view mode Select a different hoop

View the Design Panel

Set grid size
Measure the design View the coordinates of stitch points View multiple designs

View Tab
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View Mode
Use View Mode in the View tab to toggle between 3D View , 2D View with Stitch 
Points , and 2D View without Stitch Points  for the current window. Stitches and 
blocks can be edited in both 3D and 2D stitch display.  

Use 3D View to see how the embroidery will be stitched, use 2D View with Stitch Points to 
see stitch points clearly, and use 2D View without Stitch Points to see the stitch lines.

3D View
Use 3D View  to see embroideries and grid in standard 3D mode. The stitches of the 
embroideries have three-dimensional shading.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, 3

2D View with Stitch Points
Use 2D View with Stitch Points  to see the individual stitches in your embroideries as 
lines with no shading, and to display the black dots that show the stitch points (needle 
insertions) into the fabric.

When you zoom in, the stitch points are displayed as small squares. Showing the stitch 
points may be helpful for inserting new stitches, moving stitches and pasting stitch blocks.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, 2V

2D View without Stitch Points
Use 2D View without Stitch Points  to see the individual stitches in your embroideries as 
lines with no shading or stitch points.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, 2W

3D View 2D View with Stitch Points 2D View without Stitch Points 
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Commands
Use Commands  to show or hide the command markers for Color Change , Stop , 
Appliqué  and Trim .

The markers are no longer visible, but the commands will still be present in a selection or 
stitch count.

If Delete Commands  is used, all commands will be visible while it is selected.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, CO

Ghost Mode
Use Ghost Mode  to display pale 'ghost' stitches where there are hidden stitches within 
the active subdesign. This allows you to see the overall embroidery and the placement of 
the visible stitches within the embroidery while working only with the visible stitches.

Click the Ghost Mode icon to turn the pale ghost stitches on and off. Ghost Mode may be 
turned on and off individually for the active subdesign in each of the open embroidery 
projects. (Other subdesigns within a multipart design are always shown in Ghost Mode.)

If the background is white or very pale it may be difficult to see the ’ghost’ stitches.

Shortcut
■ Control Strip: 

Background Grid
Use the grid options to turn the background grid on and off, optionally with numbered 
grid lines. The grid may be used to help align stitches, adjust selected blocks, draw border 
shapes precisely and so on. The grid options are:

■ Grid On : show the grid

■ Grid Numbered Half : show the grid with numbers on the even grid lines at the top and 
left of the grid

■ Grid Numbered Full : show the grid with numbers on the even grid lines on all sides of 
the grid

Ghost Mode Off Ghost Mode On
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■ Grid Off : hide the grid

Each time the grid icon is clicked, the next grid option is selected. The grid is initially set to 
Grid Numbered Half. All open embroideries use the same grid option, and the setting is 
remembered for the next mySewnet™ Stitch Editor session.

The grid is initially set at 5mm intervals, so the apparent size will vary depending on the 
size of the currently active embroidery and the zoom level. Adjust its size between 2mm 
and 50mm in the View tab.

If Inches are chosen for Show Measurements in mySewnet™ Configure, the nearest equivalent Grid Size is 
shown in inches in the View tab.

Grid On Grid Numbered Half

Use Grid On  to show the grid.

Shortcuts:

View Tab: 
Keys: Alt, V, GO

Use Grid Numbered Half  to show the grid with 
the even grid lines numbered on the top and left.
Shortcuts:

View Tab: 
Keys: Alt, V, GN

Grid Numbered Full Grid Off

Use Grid Numbered Full  to show the grid 
with the even grid lines numbered on all sides.
Shortcuts:

View Tab: 
Keys: Alt, V, GF

Use Grid Off  to hide the grid.

Shortcuts:

View Tab: 
Keys: Alt, V, GR
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Grid Size
Set the grid size between 2mm and 50mm, depending on what setting is most suitable for 
your screen resolution and embroideries. Type in a figure or use the up and down arrows 
to change the number.

The initial setting is 5mm.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.

Design Panel
Use the Design Panel to change colors, to view and change the Notes and Settings, and to 
view the Clipboard and Overview window.

Show Design Panel
To open or hide the Design Panel, click Show Design Panel in the View tab.

■ Design Information: See “Design Information” on page 58.
■ Thread Colors: See “Change an Existing Thread Color” on page 37.
■ Edit, move and merge colors: See “Move and Merge Color Blocks” on page 40.
■ Notes and Settings: See “Notes and Settings” on page 58.
■ Overview Window: See “Overview Window” on page 31.
■ Clipboard: See “Clipboard Block” on page 81.

Check the design information

Change a thread color

Edit, move and merge the colors

View the contents of the Clipboard

Edit the Notes or Settings information
Select the Notes or Settings information

View the position in the work area when zoomed in

Dual Thread effect

Puffy Foam effect
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Thread Colors
The thread colors are shown in the color worksheet on the Design Panel, in the order in 
which they are used. Any thread effects or special needles used with a color are also 
indicated.

Colors can be added or changed using any color available in the standard thread ranges 
and MyThreads. MyThreads can contain threads copied from the standard thread ranges, 
plus custom threads based on existing threads or added as completely new threads.

A Color Change command  is shown in the embroidery by a small blue circle with a C.

To add a color change, use Insert Color Command . See “Insert Color Command” on page 75.

View Selected Colors
There are several methods for changing which stitches are displayed. Displaying the 
stitches according to their color is an easy method of showing parts of an embroidery.

Hide stitches according to color, leaving the visible stitches available for functions such as 
stamping without affecting the hidden stitches. If desired, use Ghost Mode  to show 
the overall shape of an embroidery while working only on visible stitches. Selecting colors 
for display can be combined with the Draw Range to display a particular set of stitches 
that would be difficult to isolate with other functions.

Color Worksheet
The color worksheet on the Design Panel shows the order in 
which the thread colors are used. A group of stitches using a 
particular thread color is called a color block. Each new color 
corresponds to a Color Change  command in the embroidery. 
There can be unlimited color changes in an embroidery saved 
in .vp4.

The color worksheet can be used to change thread colors, to 
hide and show the stitches in any of the color blocks, and to add thread effects. The 
numbers show the order in which the colors are used. See “Change the Colors in a 
Bumblebee Embroidery” on page 44.

When you pause the arrow pointer over a thread color in the worksheet, the corresponding threads in the 
embroidery are highlighted. Also, a popup description of the thread color appears.
To show only the selected color, right-click the color block and select Show only this Color from the context 
menu.

Pause over a thread color
to see its name

Merge with color above

Click a color to select it

Move color up the stitch order

Display or hide a color

Change the selected color
Move color down the stitch order

Thread effect symbol
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The color worksheet can also be used to change the order of the color blocks, and to 
merge color blocks. See “Move and Merge Color Blocks” on page 40.

The first color in the embroidery is at the top of the list. The check boxes show which color 
blocks are hidden. The numbers show the order in which the colors are used, and the 
samples show solid blocks of each thread color in 3D.

Double-click a thread sample, or select the thread and click the change color icon  to 
access the Color Selection dialog box and select a different thread color, or add thread 
effects. Click a check box to show or hide a color block, as shown here:

The number of color blocks shown in the color worksheet varies with the size of the 
window. If there are many colors, use the scroll bar to see the desired section of the list.

Change an Existing Thread Color
The Color Selection dialog box will appear when you double-click a thread color in the 
color worksheet, or select a thread and click the Change Color icon . You may choose 
any thread shade from the available thread manufacturers' palettes (for instance, Sulky 
Rayon 40 or Robison-Anton Cotton 50) or a thread you have added to MyThreads. Select 
colors by visual selection or by typing in a shade number. Alternatively, click one of the 
Quick Colors to select the nearest matching thread color. Once the desired color is 
selected, click OK. (See “Quick Color Themes” on page 120.) Optionally, add a thread or 
needle effect to the selected color block.

When you select a new thread color, the color worksheet will show the change and the 
work area will show the block of stitches in the new color (assuming the stitches are not 
hidden).

Hidden Visible

Select a thread range

Show chosen thread ranges

Search for a thread number

Click a thread color
to select a thread

View the thread information

Click a QuickColor to select
a matching thread color

Choose a QuickColor Theme

Puffy Foam height

Twin needle gap
& second color

Second thread
color

Wing needle

Felting needle

Cutwork needle
angle

Open Thread Cache



38          mySewnet™ Stitch Editor   Viewing Embroideries & Threads 

Change a Thread Color
1 Click a color that you want to change in the color worksheet. The color block will be highlighted.
2 Click the Change Color icon  below the color worksheet. The Color Selection dialog box will 

appear.
Alternatively, double-click the color block, or right-click the color block and choose Change Color from the 
context menu.

3 If required, change the thread range. Select the desired thread range from all thread ranges or only 
MyThreadRanges. The available shades for the thread range will be shown in the list.
The Abbreviation shows the reference used for the thread range when threads from that range are added 
to MyThreads.
You can use the Manage button to add new threads and Thread Ranges in mySewnet™ Thread Cache. The 
Color Selection dialog box will close. See the mySewnet™ Thread Cache Reference Guide for more 
information.

4 Click a color in the list to select a thread shade visually. You can use the scroll bar to browse through 
the list of threads.

5 If you know the shade number, click in the Find Thread box then type the required shade number.
6 Alternatively, choose a Quick Color Theme then click the desired Quick Color. The nearest shade that 

is available from the current thread range will be selected. 
This is also a quick way to jump to threads of that color (for example, click light yellow in the Standard 
Theme to jump to light yellow thread shades).

7 If desired, add a thread or needle effect. Then click OK to confirm the color selection. The dialog box 
closes, and your changes are displayed in the work area.

Effects
Use the thread effects area on the right side of the Color Selection dialog box to show the 
results of using thread effects or special needles.

Only one thread effect can be used on any thread. In mySewnet™ Stitch Editor, most thread effects are not 
shown in the active subdesign, as it would be difficult to edit the stitches. They are shown in Design 

Player  and Life View , as well as in the subdesigns of the active embroidery that are not selected.
Choose a thread effect. If you choose Puffy Foam, set the foam height. If you choose Twin 
Needle, set the Twin Needle size. Click the color icon for the Second Color if you wish to 
use a different thread color. For Dual Thread, it is recommended to change the Second 
Color. For Twin Needle, this choice depends on the desired result. For Felting Needle select 
a color for the roving fiber for felting. For Cutwork Needle, choose the angle for your 
needles.

Puffy Foam Show the effect of stitching over embroidery foam

Twin Needle Show the effect of using a twin needle

Dual Thread Show the effect of using two threads in one needle

Wing Needle Show the effect of using a wing needle for hemstitch or 
heirloom designs

Felting Needle Show the effect of using a felting needle with a roving fiber

Cutwork Needle Select a cutwork needle in one of four angles
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Puffy Foam
Use Puffy Foam  to show the three-dimensional effect of stitching over embroidery 
foam.

Click the drop-down arrow and select the height of the puffy foam, between 2.0mm and 
6.0mm. The height is initially set to 3.0mm.

Twin Needle
Use Twin Needle  to show the effect of stitching out the color 
block with a twin needle. This creates a horizontal offset between 
the original thread color in the left-hand needle, and a second 
thread color in the right-hand needle.

There are several ways that the Twin Needle effect can be used, 
including:

• Use with running stitch to create a ribbon effect, typically 
using the same thread color in both needles

• Use with a low density fill area to blend two different thread 
colors and also have a lightly shadowed effect

• Use with a dense fill area to create a shadow effect

It is recommended to use natural hoop orientation for designs with Twin 
Needle colors.

Twin Needle Size
This is only available if the Twin Needle effect is selected for the 
current color block. Click the drop-down arrow and select the 
size of the gap between the twin needles. This is initially set to 3.0mm.

Preview the effect of changing the twin needle size to help decide which needles to buy. 
Ensure that the desired size is recommended for embroidery on your machine.

Dual Thread
Use Dual Thread  to show the effects of stitching out two 
threads through the same needle. This is particularly suited to 
blending threads for special effects, such as mixing a rayon thread 
with a metallic thread, as in the center of the star.

Second Color
The second color is initially set to the same color as the original color block. Click the 
change color button  to choose a different thread for the second color. The Color 
Selection dialog box appears. Select the desired thread and click OK. The thread sample 
will change, and the thread range and thread number are shown.
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Wing Needle
Use Wing Needle  to show the effect of stitching out the 
color block with a wing needle and the chosen thread. 

The wing needle creates holes in the fabric, for hemstitch and 
other heirloom techniques. 

To see the holes more than the stitch, use a fine thread such as Poly 60 
weight. To see the actual stitching, Rayon 40 weight is ideal.

Felting Needle
Use Felting Needle  to show the effect of embellishing 
the selected color block using a felting needle and a 
contrasting roving fiber.

Choose a color for the roving fiber for the felting in the Color 
Selection dialog box. In projects without a roving fiber, 
choose a felting needle color similar to the back of the 
fabric.

If a system Font or SuperDesign with Felting Needles is chosen in 
mySewnet™ Embroidery, or if you select Felting Needle in mySewnet™ 
Digitizing the stitching will be adjusted. In other modules the effect is purely visual; for example, to see how 
felting will look in a pre-made design.
When Exporting an embroidery with a Felting Needle effect, the option "Flip design for felting or reverse 
embroidery" is initially selected in the Export dialog box. See “Export” on page 19.

Cutwork Needle
Use Cutwork Needle  to show the line that would be used by cutwork needles to 
automatically cut holes in your fabric areas, or create appliqué areas. Use cutwork needle 
lines for reverse appliqué embroideries and free-standing lace, or simply to cut out a 
shape or design.

Choose the cutting angle for the cutwork needle.

(When creating cutwork needle lines in mySewnet™ Stitch 
Editor or mySewnet™ Digitizing, or converting running 
lines to cutwork needle lines in any mySewnet™ module, 
you may use two needles, or for more precise work use four needles.)

Move and Merge Color Blocks
Use the arrows below the color worksheet, or the right-click context menu, to change the 
order of the color blocks, and to choose color blocks to merge together selectively. 

For example, you can keep two adjacent identical color blocks in case you wish to vary them later. If you 
use ColorSort, all identical colors will be merged unless there are overlapping stitches, or one block has a 
thread effect.
The changes you make are applied immediately.
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This may be useful if you want to merge two blocks of an identical thread color without affecting the color 
order of the rest of the embroidery. Alternatively, the Move and Merge color blocks functions may be useful 
if ColorSort does not merge colors owing to a few overlapping stitches that do not affect the design 
stitchout.
You can also use Merge when optimizing designs with multiple areas of cutwork and stabilizing lines. 
ColorSort may occasionally merge stabilizing lines in these circumstances. See “Use a Cutwork Line for 
Dragonfly Wings” on page 146.

Move and Merge Colors in the Worksheet
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Pink' embroidery.
4 In the work area, select the embroidery using one of the select options in the status bar, then 

Duplicate  it. Move the two copies apart.
The colors in the worksheet are repeated for the second embroidery.

5 Click to select the third color in the color worksheet, a pink.
When you move the pointer over the color block the petals of the second copy of the flower are highlighted 
in the work area.

6 Click Move Color Up  below the worksheet to move the block up the stitching order.
Alternatively, right-click the color block and select Move Color Up from the context menu.

You can use the down arrow  to move a block down the stitching order.
7 With the color still selected, click Merge into Previous Color  to merge the selected color block 

with the block above it.
This will remove the Color Change command.
Use Merge to delete color changes easily. Also use it to merge color blocks with the same thread color, after 
first moving one of the color blocks so that they are adjacent.

Move Colors
The Move Color Up  and Move Color Down  buttons move the selected color block 
so that the colors are stitched in a different order. Click the required color in the list and it 
will be highlighted, then click the Move Color Up or Move Color Down button to move the 
color to the required position.

Alternatively, right-click the block and select Move Color Up or Move Color Down from the context menu.

Merge Colors
The Merge into Previous Color button  will merge the selected color block with the 
color block above it, removing the Color Change command.
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Alternatively, right-click the block and select Merge into Previous Color  or Merge into Next Color from 
the context menu.
Use Merge to delete color changes. Also use it to merge color blocks with the same thread 
color, after first moving one of the color blocks so that they are adjacent.

ColorSort
Use ColorSort  to reduce the embroidery to the minimum number of color blocks. The 
final number of color blocks produced in the ColorSort process can vary, depending on 
any overlap between areas, or whether thread effects are used. If possible, it leaves only 
one color block for each thread color used. If necessary, trims are added to connect the 
areas that use the same thread color. Unnecessary Color Change commands are removed.

Alternatively, you can use the ColorSort option in Export  to merge your color blocks when creating an 
embroidery file for stitching out. 
ColorSort affects the whole of the embroidery, even if only part of it is visible. All stitches 
in the embroidery will be shown when the ColorSort is complete.

If desired, click Undo to return to the original colors.

Shortcuts
■ Tools, Home Tab: 
■ Keys: Alt, H, CL

Color Tone
Use Color Tone  to change the thread colors in an embroidery. The Color Tone dialog 
box includes the Brightness, Contrast and Gamma sliders, and the Thread Range box.

Try different settings to enhance different designs. You may also combine more than one Color Tone tool.
Use the Thread Range box to convert all the threads in the embroidery to a new thread 
range, with or without adjusting the Color Tone options. Thread and needle effects will 
not be removed.

View the original
colors

Preview the changed
colors

Zoom in on the design

Adjust light & dark

Change the color
contrast

Optimize the light/color
balance

Change the thread range
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Shortcuts
■ Tools, Home Tab: 
■ Keys: Alt, H, CT

Use Color Tone to Change the Colors in a Floral Embroidery
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Floral Motif' embroidery.
4 Click Color Tone  in the Home tab. The Color Tone page is displayed.
5 Move the slider to the right to change the Brightness to 2. 

Alternatively, click to select the slider and use the right arrow key, or enter a positive number in the 
box.
You can adjust the Brightness between -10 and +10 relative to the starting point by typing in a number, 
using the left and right arrow keys, or by clicking and dragging the slider bar. To darken the embroidery, 
move the slider to the left, use the left arrow key, or enter a negative number in the box.

6 Enter 2.0 in the number box to change the Contrast.
You can adjust the Contrast between -10 and +10 relative to the starting point by typing in a number, 
using the left and right arrow keys, or by clicking and dragging the slider bar.

7 Click the Gamma slider bar to select it, then use the right arrow key to change the Gamma to 20.
You can adjust the Gamma between 2 and 40 by typing in a number, using the left and right arrow keys, or 
by clicking and dragging the slider bar. 

8 To adjust the threads used, select a new range from the Thread Range drop-down list. 
The threads in the design will be mapped to the nearest color in the range, and the result shown in the 
preview pane.
You can return to the original thread range(s) used in the design by selecting ’Original Threads’.

9 When the picture of the embroidery in the preview window at the right appears as desired, click OK.

Brightness
The Brightness effect makes the selected part or all of an embroidery lighter or darker 
than the original. Use it to lighten embroideries.

Adjust Brightness from -10 to +10 in steps of 0.1. The default setting is 0.

Contrast
The Contrast effect changes the amount of shading between areas for the embroidery. 
Use it to make specific areas stand out. Adjust Contrast up to +10 or -10 more or less than 
the original. Increasing the setting will increase the darkness of dark areas and the 
lightness of light areas.

Adjust Contrast from -10 to +10 in steps of 0.1. The default setting is 0.

Gamma
Use Gamma to adjust the brightness and contrast together so that dark areas are made 
brighter, but bright areas are not overexposed.

Adjust Gamma from 2 to 40 in steps of 1. The default setting is 10. Lower values will make 
the embroidery appear lighter.

Thread Range
Use the Thread Range box to select the thread range used for the embroidery from the 
drop-down list.
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Choose from any of the manufacturer’s thread ranges or the MyThreads ranges you create 
using mySewnet™ Thread Cache.

If the embroidery originally used more than one thread range, only one thread range will now be used.
To return to the original thread range(s) used in the design select ’Original Threads’ from 
the top of the list.

Reset
Reset the embroidery back to the original settings.

Zoom
Use the Zoom functions to change the view of the embroidery.

Use Zoom In  to magnify the view. Move the pointer over the embroidery and the 
pointer changes to the zoom in pointer . Then either click a point you want to zoom in 
towards, or click and drag a rectangle around the area you want to zoom in to and release 
the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the embroidery and the 
pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the embroidery to the preview area.

Click Real Size  to view the embroidery at a magnification as close as possible to the 
Real Size setting you chose in mySewnet™ Configure .

Change the Colors in a Bumblebee Embroidery
The bumblebee uses a very pale blue pattern fill for the wings. If a less dense fill is used, a 
darker thread will be easier to see.

1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Bumblebee 2' embroidery.
4 In the Design Panel move the arrow pointer over the very pale blue at the top of the color worksheet 

(color 1) and pause for a moment. The upper wing in the embroidery is highlighted, and a popup 
description of the thread is displayed.

5 Right-click the color block and select change color from the context menu. The Color Selection dialog 
box will appear.
Alternatively, double-click the color block to open the dialog box.
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6 In Thread Range, ensure that Show MyThreadRanges is 
selected.

7 Select Robison-Anton Rayon 40 from the drop-down 
list.

8 Click in the Find Thread box and enter '2733'. Thread 
color 2733 (Pro Cool Gray) will be found in the list. 

9 Click OK to change the color, and close the dialog box.
10 Move the arrow pointer over the other block of pale 

blue (color 4), and click to select it.
11 Click the Color Change icon  at the bottom of the 

color worksheet to open the Color Selection dialog box.
12 In Thread Range, select Robison-Anton Rayon 40 from 

the drop-down list.
13 Click in the Find Thread box and enter '2733'. Thread 

color 2733 (Pro Cool Gray) will be found in the list. Click 
OK to change the color.
Both of the bumblebee’s wings are now the same gray.
You can use Color Tone to change all of the colors in an embroidery to a different thread range.

14 Click Color Tone  in the Home tab. The Color Tone page is displayed.
15 In the Thread Range drop-down list, select Robison-Anton Rayon 40. The thread shades change a 

little.
16 Click OK to close the Color Tone dialog box.

Monochrome
Use Monochrome  to change all visible stitches to one color. The 
Monochrome effect creates silhouette and cameo designs from 
multicolored embroideries.

Select the stitches that you want to set to the same color, then click 
Monochrome . The Color Selection dialog appears so you can 
choose a color and/or thread effect.

Shortcuts
■ Modify Design, Modify Tab: 
■ Keys: Alt, M, MO

Create a Monochrome Embroidery from a Multicolor Design
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Deco 

Flower Corner' embroidery.
4 In the Modify tab, click Monochrome . The Color Selection dialog box opens.
5 In the Quick Colors click the orange in row 4, column 6.
6 Click OK to select the color. The complete embroidery is now orange.

Monochrome only changes visible stitches. If you use the sliders or other functions to 
hide some of the stitches, the color of those stitches will not be changed.

Control Strip
Use the Control Strip to view the colors in the selected subdesign, and to select stitches 
using the handles on the slider bar.



46          mySewnet™ Stitch Editor   Viewing Embroideries & Threads 

For precise positioning, enter numbers in the start and end boxes, select stitches within 
the next  or previous  color block, or move to the next  or previous  Stop  
command. View the whole embroidery with Draw All Stitches , or see an outline of the 
hidden stitches with Ghost Mode .

Use the Stitch Player to view how the selected subdesign will be stitched out, using Pause 
for Commands  to view where Color , Stop  and Trim  commands will be 
placed.

Use Design Player  to view how the complete project will be stitched out, using the Optimize for Sewing 
settings from mySewnet™ Configure. See “Design Player” on page 50.

Draw Next Color Block
Use Draw Next Color Block  to step through the color blocks one at a time in the order 
shown in the worksheet. Only one color is visible at a time. All the other colors are 
automatically hidden (unchecked). The work area displays only the stitches in the visible 
color block.

The Draw Range shows the Start and End stitches of the color block and the sliders move 
as each color is selected.

Alternatively, you can right-click a color block in the worksheet and select Show only this Color from the 
context menu. See “Color Worksheet” on page 36.

Shortcut
■ Control Strip: 

Draw Previous Color Block
Use Draw Previous Color Block  to step through the color blocks in reverse order. Only 
one color is visible at a time. All the other colors are automatically hidden (unchecked). 
The work area displays only the stitches in the visible color block.

The Draw Range shows the Start and End stitches of the color block and the sliders move as each color is 
selected.
Alternatively, you can right-click a color block in the worksheet and select Show only this Color from the 
context menu. See “Color Worksheet” on page 36.

Shortcut
■ Control Strip: 

Draw all stitches 

Ghost Mode: see an outline of hidden stitches

Switch the visibility of color blocks
Show only the previous/next color

Draw stitches to here

Play through the visible stitches

View where commands are placedDraw stitches from here

Set numbers for the
start and end stitches Show the previous/next Stop command
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Invert Visible Color Blocks
Use Invert Visible Color Blocks  to switch the visibility of the color blocks so that those 
that were visible become hidden, and those that were hidden are displayed.

This is a useful method to quickly turn off all color blocks, and then use Draw Next Color, 
Draw Previous Color, or choose colors in the color worksheet.

Shortcut
■ Control Strip: 

Previous Stop
Use Previous Stop  to step through the Stop  commands one at a time.

Shortcut
■ Control Strip: 

Next Stop
Use Next Stop  to step through the Stop  commands in reverse order.

Shortcut
■ Control Strip: 

Draw All Stitches
Use Draw All Stitches  to display all stitches in the currently active subdesign. This is 
automatically used when a new embroidery is opened or mySewnet™ Stitch Editor is 
started. When stitches have been hidden by changing the color selection or the Draw 
Range, click the icon to view all stitches again. All the color blocks will become visible and 
the Draw Range will be reset to all stitches.

Shortcut
■ Control Strip: 

Effect of Draw Range on Color Blocks
Using Draw Next Color Block or Draw Previous Color Block will set the Start and End slider 
bars to the beginning and end of the currently visible color block. If you then change the 
Start or End stitch in the Draw Range, all the color blocks in the color worksheet will be set 
back to visible, although only the stitches selected with the slider bars will be shown in the 
work area. Alternatively, if you make another color block visible again after using Draw 
Next Color Block or Draw Previous Color Block then the Draw Range will be reset to all 
stitches, but only the stitches in the visible color blocks will be shown in the work area.

If you have set a Draw Range, then only the stitches in the color blocks that are visible within the range will 
be displayed. If you then display a color block that is outside the Draw Range, the Draw Range will change 
to include the newly visible color block and all stitches for all visible color blocks in the new Draw Range 
will be displayed.
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View a Range of Stitches
The draw Start and End slider bars in the Control Strip provide a very powerful way of 
viewing an embroidery and understanding exactly how it is formed. They allow you to 
progress forwards and/or backwards through an embroidery stitch by stitch and isolate a 
specific sequence of stitches. If desired, select the visible stitches as a block to work on 
(Select All Visible ) or use a feature such as stamping or global morphing without 
affecting the hidden stitches. If desired, use Ghost Mode  to show the overall shape of 
the embroidery while only working on visible stitches. Changing the range of stitches can 
be combined with selecting colors to display a particular set of stitches that would be 
difficult to isolate with other functions.

Draw Range (Slider Bar)
The left handle and left stitch number box set the Draw From Start stitch number. The 
right handle and right stitch number box set the Draw To End stitch number.

Use the Draw Range to set the Start or End stitch number in any of the following ways, as 
shown here for Draw From Start:

1 Click and drag the handle along the slider bar. The stitch 
number will change as you move the handle.

2 Click the arrows at the end of the number boxes to change 
the stitch number by one at a time. Click and hold on an 
arrow to progress more rapidly.

3 Click in the space on the slider bar on either side of the 
handle to move it in that direction and change the stitch 
number by 50 at a time. You can also click and hold to 
change the number more rapidly, but the handle will stop 
when it reaches the arrow pointer, or the other handle.

4 Enter a stitch number directly in the stitch number box. A 
number that is outside the range will be ignored.

In all cases, the work area will show the range of stitches as the Start or End number 
changes.

Effect of Color Block Selection on Draw Range
Using the Draw Next Color Block or Draw Previous Color Block icons will set the Start and 
End slider handles to the beginning and end of the currently visible color block. If you next 
make another color block visible again immediately after using Draw Next/Previous Color 
Block then the Start and End slider handles will move to the first and last stitches, but only 
the stitches in the visible color blocks will be shown in the work area. Alternatively, if you 
next move the Start or End slider handle then all the color blocks in the color worksheet 
will be set back to visible, although only the stitches selected with the slider handles will 
be shown in the work area.
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When you set a Draw Range, only the stitches in the color blocks that are visible within the range will be 
displayed. If you then display a color block that is outside the Draw Range, the Draw Range will change to 
include the newly visible color block and all stitches for all visible color blocks in the new Draw Range will 
be displayed.
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Stitch Player
Use the Stitch Player to play through the stitches in the selected subdesign as if they were 
being stitched. The Stitch Player is in the Control Strip.

Use the Design Player  to view the whole embroidery as it will be stitched.

Use the controls to play forward and rewind through the embroidery at three speeds, 
jump to the start or end of the stitches and stop at any time. See “Use a Cutwork Line for 
Dragonfly Wings” on page 146.

If you stop the Stitch Player part way through drawing the design, the rest of the stitches will be hidden. 

Use Draw All Stitches  to show the whole embroidery.

Stitch Player Controls

Pause for Commands
When Pause for Commands  is enabled, the Stitch Player will pause at every Color 
Change, Stop or Trim command.

Any messages, for example instructions for appliqué placement, are displayed following their Stop 
commands.

Shortcut
■ Control Strip: 

Design Player
Use Design Player  to play through the stitches in the embroidery as if they were being 
stitched from an exported embroidery. All parts of the embroidery that are within the 
hoop area are shown, whether or not they are selected.

The current Optimize for Sewing settings from mySewnet™ Configure are used.

Start Jump to the first stitch in the embroidery and stop.

Fast Rewind Play in reverse at triple speed.

Medium Rewind Play in reverse at double speed.

Rewind Play in reverse.

Stop Stop play.

Play Play at normal speed.

Medium Play Play at double speed.

Fast Play Play at triple speed.

End Jump to the last stitch in the embroidery and stop.
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All the designs in a multipart embroidery are shown in the Design Player. This is therefore a good way to 
see the whole project after adjusting stitches in one of the designs.

■ Any messages, for example instructions for appliqué placement, are displayed following 
their Stop commands.

■ Appliqué fabric is displayed if present, but any background garment, quilt block or fabric 
is not shown.

■ Decorations are shown following their placement stitches.

Embroideries that are outside the hoop are not shown in the Design Player. If an 
embroidery contains a felting needle, the project will be shown "flipped", as it would 
actually be stitched.

Share
Use Share  to save a picture or video of your design. See “Share Picture” on page 54 
and “Share Video” on page 55.

Shortcuts
■ Quick Access Toolbar; Home Tab: 
■ Keys: Ctrl + J; Alt, 0; Alt, H, J

Using the Design Player
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert . See “Insert” on page 14.
3 Browse to Documents\mySewnet\Samples\Stitch Editor\Stitch\.
4 Scroll down to "Bumblebee 2 New".
5 Click to load the embroidery into the work area.
6 Click Design Player .

The Design Player dialog opens.
7 Use the Play button  at the bottom left to start playing through the stitches in the embroidery.

Start or pause play

Control play with
the slider

Design Information

Jump to the first stitch

Jump to the last stitch

Rewind

Play at double the
current speed
Share a picture or video 
online
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8 Use the controls to play forwards or backwards through the embroidery at different speeds, jump to 
the start or end of the stitches, and stop at any time.
Press Ctrl and use the mouse wheel to zoom in and out.

Life View
Use Life View  to show how an embroidery exported from the project will look in 3D 
with real-world perspective. Zoom in to see detail, and move and rotate the embroidery in 
a three-dimensional view. All parts of the embroidery that are within the hoop area are 
shown, whether or not they are selected. 

Use Life View  at any time when you want to see the design with no grid, stitches 
selected, or markers displayed, and when you want to see the effects of glow in the dark 
and solar reactive threads.

■ Any background garment, quilt block or fabric is shown, together with appliqué fabric, if 
present.

■ Decorations are shown, but not their placement stitches.

Shortcuts
■ Quick Access Toolbar; Home Tab: 
■ Keys: Ctrl + L; Alt, 9; Alt, H, L

Position
Use the position  slider to move to another part of the Life View window.

Click and drag the cross marker in the center of the box to view the desired part of the 
embroidery, using the zoom slider to control the magnification.

Design Information

Move around the window

Change the 3D viewing angle

Zoom in and out

Light and dark effects
Reset
Animate the preview
Share a picture or video online
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Rotation
Use the rotation  slider to view the stitching in the embroidery in 3D.

Click and drag the cross marker in the center of the box to change the angle at which the 
embroidery is viewed, and allow you to visualize the project in varying real-world views.

Alternatively, click and drag directly in the embroidery preview area to change the angle of view.
Use the zoom and position sliders to select the part of the embroidery to view.

Zoom
Use the zoom slider to change the magnification of the embroidery. 

Drag the slider bar to the right to magnify the view of the embroidery, and to the left to 
shrink the view of the embroidery. The box below the zoom bar displays the current 
magnification. 

Click the marker in the center of the zoom bar (100%) to view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in mySewnet™ 
Configure.

When zoomed in, use the position slider to move around the embroidery.

Design Information
Life View shows the dimensions (Width  and Height ), the number of stitches  and 
the number of colors  in the embroidery.

Glow in the Dark
Use Glow in the Dark  to view the effect of using glow in the 
dark threads. The preview will darken to simulate the lights 
dimming, and the glow in the dark threads will be shown in their 
luminescent colors.

Glow in the Dark  is only available if glow in the dark thread colors are 
used in the design.

Solar Reactive
Use Solar Reactive  to view the effect of using photochromic threads. The preview 
simulates the sun shining on the design, and the photochromic threads change shade to 
show the colors they become in sunlight.

Photochromic threads change color in sunlight.
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Solar Reactive  is only available if photochromic thread colors are used in the design.

Play Demo
Use Play Demo  to animate the preview and show the embroidery at different angles 
automatically. Click to start and stop the animation.

Play My Demo
Use Play My Demo  to animate the preview using your own demo. 
Use the menu options to add the current position as a point in the 
demo, or reset to create a new demo.

The My Demo animation will be used for Life View in all modules. It is stored in the 
AnimationPath.txt file in the \User\AppData\Local\VSMSoftware\mySewnet\LifeView 
folder.

Copy this file to another location as a backup before creating additional My Demo animation paths for 
Life View.

Reset
Use Reset  to set Rotation, Position and Zoom back to the default settings.

Share
Use Share  to save a picture or video of your design. See “Share Picture” on page 54 
and “Share Video” on page 55.

Share Picture
Save a picture of your design. Select a size for the picture, 
then save the picture to your computer.

Size
Select a size for your picture. Choose from Standard, 2x, 3x, 
and 4x. Standard size is the size of the picture in Design 
Player or Life View.

Save
Click Save  to save the picture to your computer. The Save As dialog appears for you to 
save the picture, with the default file name being the same as the design. Change the 
name as desired.
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The following file formats may be saved: JPEG Low Quality (.jpg), JPEG High Quality (.jpg), 
Tagged Image File Format uncompressed (.tif ) and Portable Network Graphics (.png).

Share Video
Save a video of your design.

Name the video and select its size, quality and speed. Then save it to your computer. A 
progress bar is displayed while the video is created.

The higher the image quality, the slower the speed of upload and download.

Video Title and Created By
The video title and the name of the creator are used on the opening frames of the video. 
Enter the name of the video, and the name of the creator.

Size
The size of the moving image in pixels. The higher numbers create a higher quality video. 
Choose from 1080p (HD), 720p (HD), 480p and 360p. The initial setting is 480p.
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Quality
The bit rate, or speed of data transfer. Choose between Low, Medium and High. The initial 
setting is Medium.

Speed
Set the speed of the Design Player for the video. Choose from Standard, 2x, 4x, 8x, 16x, 
32x, 64x, and 128x. The initial speed is 16x.

This option is only available for videos created from Design Player.

Video Information
The Total Duration of the video in minutes and seconds, and the estimated file size in MB 
are displayed. The duration and size vary according to the Size, Quality and Speed of the 
video.

File Name
Select a folder and name for the video file. Click Select to browse to a different folder on 
your computer.

Start and Cancel
Click Start to create your video, using the settings that you chose above. A progress bar 
shows during the creation of the video, with an estimate of the creation time. Click Cancel 
to stop the video creation.

All other functions in the dialog box are unavailable (grayed out) during video creation.

Zoom Commands
A number of functions are available to make it easier to navigate around embroideries. 
These include the Zoom functions at the bottom right of the screen and the Overview 
Window. By default, each embroidery is shown at a size so that the hoop fills the window, 
the same as if you click Zoom To Fit  after zooming in or out.

You can also navigate around an embroidery by selecting the colors to see and changing the range of 
stitches that are displayed.

Zoom To Rectangle
Use Zoom To Rectangle  to enlarge the view of an area of the embroidery.

Click the Zoom To Rectangle icon  to the right of the status bar, 
and the mouse pointer changes to the zoom in pointer . Then 
either click a point on the embroidery you want to zoom in towards, 
or click and drag a rectangle around the area you want to enlarge 
and release the mouse button to zoom.

Drag to zoom in on an area

Zoom to Fit
Click and drag to zoom in and out

Click to zoom in instantlyClick to zoom out instantly

Select or input percentage zoom
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Zoom To Rectangle is automatically deselected after you have used it.

Shortcuts
■ Status Bar: 
■ Keys: Ctrl + 0

If you have a wheel mouse, hold the Ctrl key and move the wheel to zoom.

Pan Mode
Use the Pan feature to move around the screen easily. The Pan feature works when you are 
Zoomed In on part of the screen, making the scroll bars visible at the right and bottom of 
the work area.

Hold the Space key down until the pan cursor  appears, then click and drag.

The pan occurs in real time, that is you see the work area move as you drag across the 
screen.

Alternatively, use the Overview Window to move around the screen when Zoomed In.

Pan Around the Work Area
1 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
2 Click and drag to draw a box, then release to zoom in. Scroll bars appear to allow you to move around 

the screen at this higher zoom level.
3 Hold the Space key down, then start to click and drag. The pan cursor  appears.
4 Click and drag until the pointer is in the desired part of the screen. (If you have a wheel mouse, you 

can click the wheel to pan around the screen.)
5 Lift the pen or release the mouse button.

Zoom To Fit
Use Zoom To Fit  to view the whole hoop area. Click the Zoom To Fit icon and the view 
will zoom in or out to show the hoop area in the window.

Shortcuts
■ Status Bar: 
■ Keys: Ctrl + 9

Zoom By Percentage
Use the drop-down list in the Status Bar to set percentage levels to zoom in for the active 
embroidery. Alternatively, enter a number in the percentage text box, from 10% up to 
1600%.

Select 100% to display the embroidery at a magnification as close as possible to the Real Size setting you 
chose in mySewnet™ Configure.

Shortcuts
Keys: 100%: Ctrl + 1

200%: Ctrl + 2
400%: Ctrl + 3
800%: Ctrl + 4
75%: Ctrl + 5
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50%: Ctrl + 6
25%: Ctrl + 7

Zoom Bar
Use the Zoom Bar to zoom in or out from the center of the currently selected picture or 
embroidery.

The Zoom Bar is on the right side of the Status Bar.

Use the slider to zoom in or out of the picture or embroidery, or click on the Zoom Out  
or Zoom In  icons.

Shortcuts

Design Information
The dimensions (Height  and Width ), Stitch Count , and number of colors  for 
the active embroidery are shown on the Design Panel.

The Design Panel also shows the order of the color blocks in the color worksheet and any 
notes that are included in the embroidery. Click on a color block to change thread colors. 
Also use the color worksheet to show or hide stitches by color block, and move and merge 
color blocks. Edit or add information to the Notes and Settings as desired.

Hoop Size
The current Hoop Size is shown on the status bar. Use Change Hoop  to change the 
Hoop Size.

Notes and Settings
Store up to 2000 characters of notes about an embroidery, such as a description, keywords 
or category of embroidery. This information is shown in the Notes and Settings section of 
the Design Panel. Select Notes  or Settings , then click Edit  to open the Notes or 
Settings dialogs.

Notes from your .vp4, .vp3, .vip, .hus, .pcs and .pes embroideries are automatically placed 
in the Notes box when the embroideries are loaded in mySewnet™ Embroidery. Use the 
mySewnet™ Windows® Explorer plugin to search all your .vp4, .vp3 and .vip format 
embroideries for key words in the Filename or Notes to decide which embroideries to 
view, open or send to certain connected embroidery machines.

To keep the Notes information, save or export your changed embroideries as file type Husqvarna Viking / 
Pfaff (.vp4, .vp3 or .vip).

Zoom Out Keys: Ctrl + -

Zoom To Rectangle Keys: Ctrl + 0

Zoom In Keys: Ctrl + =

Zoom To Fit Keys: Ctrl + 9
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Notes
Click Notes  to display the Notes, then click Edit  to 
change the Notes for the embroidery. The Notes dialog 
will appear.

The Notes dialog allows free text and keywords to be 
added to the Notes for the selected embroidery. Type 
additional Notes in the Notes box.

Use Ctrl+Enter to start a new line of text.

Up to 2000 characters can be entered in the Notes.

Keywords
Select Keywords for the embroidery from the list, then 
click Add to add them to the Notes for the embroidery.

Change the Notes for an Embroidery
1 Select the window and the embroidery for which you want to amend the notes.
2 Click Notes .
3 Click Edit .
4 In the Notes text box make your desired changes to the Notes.

Use Ctrl+Enter to start a new line of text.
5 To add Keywords, select the keyword from the category heading or subcategory in the scrolling list. 

Then click Add.
Double-click to expand the folders until the desired keyword is highlighted. (Alternatively click on the + 
sign.)

6 Click OK to save your amended Notes and added keywords.

Settings
Click Settings  to display the Settings, then click 
Edit  to change the Settings for the embroidery. The 
Settings dialog will appear.

Use Ctrl+Enter to start a new line of text.

Up to 2000 characters can be entered in the Settings.

Change the Settings for an Embroidery
1 Select the window and the embroidery for which you want to amend the settings.
2 Click Settings .
3 Click Edit .
4 In the Settings text box make your desired changes to the Settings.

Use Ctrl+Enter to start a new line of text.
5 Click OK to save your amended Settings.
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Get Length
Use Get Length  to measure the distance between any two points on an embroidery. 
Click the Get Length icon  and the mouse pointer changes to the Measure pointer . 
Then click and drag a line across an embroidery. The length of the line is displayed. Right-
click to deselect.

For example, use this to obtain the width of a column of stitches or the length of a 
movement stitch.

The length is shown in millimeters or inches, according to the setting for Show Measurements in 
mySewnet™ Configure. The alternative units are shown in parentheses.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, L

Measure the Height of a Bumblebee Embroidery
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch, open the Bumblebee 2 New 

embroidery to load it.
4 In the View tab, click the Get Length icon . The mouse pointer changes to the Measure pointer .
5 Click and drag to draw a line across the bumblebee embroidery from top to bottom 
6 Read, and if desired, make a note of the number.

7 Repeat the click and drag to measure any other distances, as required.
8 Right-click to deselect the function.

Coordinates
Use Coordinates  to show and hide the Stitch Coordinates dialog box, which shows the 
coordinates of stitch points. This can also be used to change stitch point positions by 
editing x and y coordinates.

The Stitch Coordinates dialog box shows the technical details of the Start and End stitches 
in the current Draw Range. Five stitches are shown at each end of the Draw Range, with 
the first and last visible stitch indicated by an asterisk. Either absolute (related to the start 
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point of the embroidery) or relative coordinates (related to the previous stitch) may be 
displayed.

While the Stitch Coordinates dialog box is open, you can change the Draw Range as 
required and the Coordinates dialog box will show the relevant stitches and commands.

The X, Y and Length columns are shown in millimeters or inches, according to the Show 
Measurements setting in mySewnet™ Configure.

This is an advanced function that can be used to help find individual stitches or commands.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, CR

Stitch No.
The number of each stitch. The asterisk indicates the first or last visible stitch, depending 
on whether Cursor is set to Start or End respectively.

X and Y
The horizontal and vertical coordinates of the stitches. If Type is set to Relative then this is 
the distance from the previous stitch. If Type is set to Absolute then this is the distance of 
each stitch from the center of the hoop.

Length
The length of each stitch from the previous point to the current stitch point.

Command
This indicates if the stitch or stitch point is a special type of stitch, or if there is a Command 
associated with the stitch point.

Command Description

End The last stitch point in the embroidery.

Color Color Change Command. The thread range and thread number is also 
shown.

Stop Stop Command.

Trim Trim Command.
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Type
This indicates whether the X and Y coordinates are Relative to the previous stitch point or 
Absolute distances from the center of the hoop.

Cursor
Click Start or End to see the first or last stitches in the Draw Range. End is selected when 
the Stitch Coordinates dialog box is displayed.

Coordinates
When a stitch in the list is selected by clicking it, the Coordinates boxes show the position 
(Relative or Absolute) of the stitch point. This does not apply to any item that has an entry 
in the Command column. If desired, edit the X and Y coordinates and click the Apply 
button to change the position of the stitch point.
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Organizing Windows
Use Cascade , Tile Windows  and Switch Windows  to arrange the embroidery 
windows on the work area. To restore an embroidery to the whole work area, click the 
Maximize button  in the top left of its window, or double-click its title bar.

Cascade
Use Cascade  to arrange 
multiple windows in the 
work area in an overlapped 
fashion. All the title bars of 
the open windows will be 
shown in a step-like 
cascade so that you can see 
the embroidery name on 
each title bar. The currently 
active window is placed last 
so that it is on top of all the other windows.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, CA

Tile Windows
Use Tile Windows  to 
arrange the embroidery 
windows in the work area. 
The windows are not 
overlapped and you can see 
part or all of each 
embroidery in each 
window.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, T

Switch Windows
Use Switch Windows  to move to another window. You can switch windows when the 
windows are cascaded, full size, or tiled.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, SW, [...]
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4Select Stitches and Blocks

When viewing stitches, it is often helpful to select 2D. To see the stitch points, select 2D View with Stitch 

Points  (View tab) so the stitch points are visible for selecting and moving them. Zoom in close enough 
to see the separate stitch points. 
Color Change , Stop  and Trim  command markers and their associated stitch 
points can be moved, but they can only be deleted using Delete Commands . 

The command markers are enlarged when one of the Modify Stitch functions in the Modify tab is selected. 
See “Modify Stitch” on page 75 and “Showing Commands” on page 79.

Select Stitches
Use Select Stitches  to select and edit single stitches. Click 
Select Stitches, then click a stitch point and a box appears around 
the point to show that it is selected. 

Click and drag the box to move the stitch point. If desired, use 
Delete  to delete the stitch point.

Use the left arrow or right arrow key to move to the previous or next stitch.

Shortcuts
■ Select, Home Tab; Status Bar: 
■ Keys: Alt, H, SS

Select a Series of Stitches
Click the first required stitch point, then hold down Shift (on the keyboard) and click the 
last required stitch point. The two stitches you click and all stitches between them will be 
selected. Click outside the block to make a new selection using this method. 

To select several individual stitches, hold down Ctrl and click the desired stitches.

Alternatively, hold down Shift and use the left and right arrow keys to select a series of stitches.

Select a Block of Stitches
The block Select functions in the Select area of the Home tab and on the Status Bar allow 
you to select part of an embroidery. A selected part of an embroidery is called a block. A 
block can be resized/scaled, rotated, mirrored, skewed, moved, nudged, duplicated, 
copied, cut and deleted.

Select a design

Move and merge the designs
View the embroidery as it will be stitched out

Step through open designsCut, copy, paste or delete a selected block
Select stitches or a block

Resize or scale a block
Adjust the selection

Arrange and resize a blockChange color and stitch order View all designs
Select a hoop

Home Tab
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When a block has been selected, it has a selection box around it on the work area. The 
selection box has handles which are used to resize, rotate, skew and flip the block. Also, 
the block is outlined within the selection box, to assist with accurate positioning when it is 
moved or rotated.

You may find it easier to select a block when you have selected colors to display and/or changed the ranges 
of stitches that are visible.
Click and drag inside the block to move it, or use the arrow keys on the keyboard to nudge 
it in small amounts for accurate positioning. Click and drag the square corner handles to 
scale the block with constant stitch count (white handles) or resize with constant density 
(blue handles). Click and drag the round rotate handle to rotate the block freely. Click and 
drag the center of rotation  to rotate around a different point. Click the triangular 
handles to flip the block horizontally or vertically. Click and drag the trapezoidal bottom 
right corner handles  to skew the block.

A block can also be resized/scaled and rotated precisely using the Modify Block  dialog on the Home 
tab.
The resize handles will be round instead of square if any part of the selection is outside the 
hoop boundary.

Pasting a Block
When a block is pasted into an embroidery it is automatically selected as the current 
block, and Box Select is activated. The block is attached to the last visible stitch.

See Paste, Paste as Design and Paste into New Window on page 82.

Blue handles for resize White handles for scale

Square handles show that the whole 
embroidery is inside the hoop

Round handles show that at least part of the 
embroidery is outside the hoop
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Deselecting a Block
Click the work area outside a block to deselect it. The selection box around the block will 
disappear. 

Right-click to turn off the current select function without deselecting the block.

Block Select Functions

Box Select
Use Box Select  to select stitches in a rectangular area. Click Box 
Select and the pointer changes to the box select pointer . Click 
and drag around the area you want to select. When you release the 
mouse button, the block will show you the extent of the selection. 
Click outside the block to make a new selection using this method. 
Right-click to deselect.

Use Add to Selection  with any select function to increase the area of selected 

stitches, or use Remove from Selection  to make the currently selected area smaller.

Box Select is also activated automatically when a block is pasted into an embroidery.

If the wrong area is selected, click in the active window, but outside the box, to deselect.

Shortcuts
■ Select, Home Tab; Status Bar: 
■ Keys: Alt, H, B

Select a Heart with Box Select
1 Click the Hoop icon  and set the hoop size to 240mm x 150mm - Universal Large Hoop 2, Rotated 

orientation. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 Browse to the folder Documents\mySewnet\Samples\Stitch Editor\Stitch.
5 Scroll down and load the 'Hearts and Lace’ embroidery.
6 Zoom in  to the area to the right with the small hearts.
7 Click Box Select . The pointer changes to the box select pointer .
8 Click and drag around one of the small hearts to the right, then release the mouse button.

The heart is now surrounded by a selection box.
9 Click outside the block to make a new selection using this method. 
10 Right-click to deselect.

Color Block Select
Use Color Block Select  to select a block of stitches by thread color. Click the icon, then 
click a visible color on the embroidery. The block will be selected according to the visible 
stitches of the color you clicked. Click outside the block to make a new selection using this 
method. Right-click to deselect.

Multiple color blocks using the same thread color are not selected. If you require this then 
either change the color order and merge the required color blocks (see “Move and Merge 
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Colors in the Worksheet” on page 41), or perform a ColorSort which will combine identical 
thread colors into single color blocks where possible (see “ColorSort” on page 42).

If the wrong area is selected, click in the active window, but outside the box, to deselect.

Shortcuts
■ Select, Home Tab; Status Bar: 
■ Keys: Alt, H, CB

Freehand Select
Use Freehand Select  to select a block of stitches within an area 
of any shape. Click Freehand Select and the pointer changes to the 
freehand select pointer , then click and drag to draw an 
irregular outline around the desired area. When you release the 
mouse the area is closed automatically with a straight line between 
the last mouse position and the start position.

Use Add to Selection  with any select function to increase the area of 

selected stitches, or use Remove from Selection  to make the currently selected area smaller.

Freehand Select is useful when an area cannot be easily selected by using the simpler Box 
Select function. It is particularly useful to highlight part of a color area which could not 
otherwise be easily selected.

If the wrong area is selected, click in the active window, but outside the box, to deselect.

Select a Heart with Freehand Select
1 Click the Hoop icon  and set the hoop size to 240mm x 150mm - Universal Large Hoop 2, Rotated 

orientation. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 Browse to the folder Documents\mySewnet\Samples\Stitch Editor\Stitch.
5 Scroll down and load the 'Hearts and Lace’ embroidery.
6 Zoom in  to the area to the right with the small hearts.
7 Click Freehand Select . The pointer changes to the Freehand select pointer .
8 Click and drag to draw an irregular outline most of the way around one of the small hearts to the 

right, then release the mouse button.
When you release the mouse the area is closed automatically with a straight line between the last mouse 
position and the start position, and the heart is surrounded by a selection box.

9 Click outside the block to make a new selection using this method. 
10 Right-click to deselect.

Shortcuts
■ Select, Home Tab; Status Bar: 
■ Keys: Alt, H, FS
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Point Select
Use Point Select  to select a block of stitches within an area of 
any shape, defined by a series of points. Click Point Select and the 
pointer changes to the Point select pointer . Click a series of 
points to create an irregular outline of straight or curved lines 
around the desired area, using Shift+click to place a square 
(straight line) point. Click and drag  to reposition an existing 
point. Click Delete to remove the last–placed point. Right-click 
when the area is complete. The selection box will show you the extent of the block. Point 
Select may be easier to use than Freehand Select for precise selections. Click to deselect.

Use Add to Selection  with any select function to increase the area of selected stitches, or use Remove 

from Selection  to make the currently selected area smaller.

If the wrong area is selected, click in the active window, but outside the box, to deselect.

Shortcuts
■ Select, Home Tab; Status Bar: 
■ Keys: Alt, H, FP

Select a Heart with Point Select
1 Click the Hoop icon  and set the hoop size to 240mm x 150mm - Universal Large Hoop 2, Rotated 

orientation. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 Browse to the folder Documents\mySewnet\Samples\Stitch Editor\Stitch.
5 Scroll down and load the 'Hearts and Lace’ embroidery.
6 Zoom in  to the area to the right with the small hearts.
7 Click Point Select . The pointer changes to the Point pointer .
8 Click to place the first point for the selection. A yellow square node appears.
9 Click to place a series of points around the desired area.

As you click the third point on the line, the line becomes closed (it becomes a loop). As you place more 
points the line adjusts itself.
The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.

10 Use Shift+click to place square nodes for straight lines.
11 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 

pointer . Adjust the node as desired.
When the Move Node pointer is active you can adjust existing nodes.

If you click while the Point pointer  is active, another point will be added to the line.
12 When your line is as desired, right-click to surround the area with a selection box.
13 Right-click to deselect Point Select.

Select All Visible
Select All Visible  is a one-click function that selects all visible stitches in the current 
embroidery. Click outside the block to deselect.

Use the color worksheet and the Draw Range to select which stitches are visible in the 
current embroidery. This is useful to isolate an area of stitches, especially if it includes 
more than one color, or you only wish to apply a function to part of an area.
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Shortcuts
■ Select, Home Tab; Status Bar: 
■ Keys: Ctrl + A; Alt, H, SA, SA

Select None
Use Select None  to deselect all embroideries and blocks in the work area, including any 
outside the hoop.

Shortcuts
■ Select, Home Tab; Status Bar: 
■ Keys: Ctrl + Shift + A; Alt, H, SA, SN

Replace Selection
Use Replace Selection  to replace the currently selected stitches with the new selection. 

Replace a Selection
1 Place an embroidery on the work area.
2 Use Box Select  (or another selection tool) to select some stitches.
3 Ensure that Replace Selection  is selected.
4 Click Box Select  and select some different stitches.

The new selection replaces your old selection.

Shortcuts
■ Select, Home Tab: 
■ Keys: Alt, H, RS

Add To Selection
Use Add to Selection  with any select function to add the new selection to the currently 
selected stitches. 

Add to a Selection
1 Place an embroidery on the work area.
2 Use Box Select  (or another selection tool) to select some stitches.
3 Click Add to Selection .
4 Click Box Select  and select some different stitches.

The new selection is added to your old selection.

Shortcuts
■ Select, Home Tab: 
■ Keys: Alt, H, A

Remove From Selection
Use Remove from Selection  with any select function to remove the new selection from 
the currently selected stitches.
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Remove from a Selection
1 Place an embroidery on the work area.
2 Use Box Select  (or another selection tool) to select some stitches.
3 Click Remove From Selection .
4 Click Box Select  and select some of the stitches within your selection.

The new selection is removed from your original selection.

Shortcuts
■ Select, Home Tab: 
■ Keys: Alt, H, RF

Move Block
Move a block using click and drag. Click inside the block and drag it to the required 
position. Any stitches which lead to or from the block will be stretched to accommodate 
the new position of the stitches moved in the block.

When you drag the selection, an outline within the selection box shows the shape of the block. If you 

accidentally move the center of rotation , simply click and drag inside the selection box again. For more 
information on the Center of Rotation, see “Free Rotation” on page 71.

Nudge
A block of stitches can be moved in small amounts to nudge it accurately into the desired 
position. Use the arrow keys on the keyboard to nudge a block.

Resize Block and Scale Block
Use Resize  to switch between resize and scale. Use resize to change the size of the 
block and retain constant density. Use scale to change the size of the block and retain 
constant stitch count. The handles on the block selection show when resize or scale is 
selected.

Click and drag one of the square corner handles to resize or scale. Hold down Ctrl as you 
click and drag to resize or scale proportionally. Hold down Shift to resize or scale from the 
center.

Alternatively, click Modify Block  and enter the desired percentage values in the 
Height % and Width % boxes in the Modify Block dialog box, then click Apply. Click in the 

Blue handles for resize White handles for scale
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Height % or Width % box and enter a percentage directly, or click the small up and down 
arrow buttons next to each box to change the percentage by 1 point at a time. After 
changing the percentage, you can see what the actual height and width will be in 
millimeters.

Resize should be a single step operation. If necessary, use Undo and try again if the desired effect is not 
achieved at the first attempt. Repeated use of Resize on the same area of stitches will lower the quality of 
stitching.

If desired, use Resize in Preferences  (File menu) to adjust the resize settings. This may be useful when 
making large changes to the size of a block. The Stitch Optimizer is also used automatically after each 
resize, as selected by default in Resize.

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, Re

Rotate Block
Rotate the selected block of stitches to any degree using free rotation with the mouse, 
entering a specific angle or rotating in 45 degree steps.

Free Rotation
Click and drag the rotation handle to rotate the 
block freely to any angle. If desired, move the 
center of rotation  before rotating the block.

The selection box around the block and the 
block outline are rotated around the center of 
rotation. When you release the mouse button, 
the block will be redrawn in its new position.

Move the Center of Rotation
The center of rotation  is initially shown in 
the middle of the block. Click on or within the center of rotation, then drag it to any 
position in the embroidery. This changes the pivot point around which the block rotates 
for any of the rotation methods.

When the block is moved, scaled or resized, the center of rotation is returned to the center of the block.

Rotate 45
Use Rotate 45  to rotate the block or selected area of stitches in 45 degree steps. If 
desired, move the center of rotation  before rotating the block.

Shortcuts
■ Tools, Home Tab: 
■ Keys: Alt, H, R4

Rotate

Center of
Rotation

Handle
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Modify Block
Use Modify Block  to open the Modify Block dialog, where you can show and change 
the size, rotation and skew of the currently selected block.

Shortcuts
■ Tools, Home Tab: 
■ Keys: Alt, H, MB

Modify Block
Use the Modify Block  dialog box to show and change the 
size and rotation of the currently selected block, and to skew 
the selected block.

Modify the currently selected block as desired, then click 
Apply to show your changes in the work area.

Click Undo  to reverse your changes.

Size

Height and Width %
Show and change the height  and width  percentage of 
the currently selected block. The height and width are scaled 
or resized according to the Resize mode.

The size in millimeters to which the block will be changed is shown to the right.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Rotate

Angle
In the Angle  box enter an angle, from 0 to 359 degrees, then click the Apply button. 
The preview shows the selected angle.

If desired, move the center of rotation  before rotating.

Skew %
Skew the currently selected block horizontally and vertically. Enter values in the 
horizontal  and vertical  percentage boxes, then click Apply. The block is scaled or 
resized according to the Resize mode.

For Horizontal Skew , positive numbers will skew the lower part of the block to the left 
and negative numbers will skew it to the right. For Vertical Skew , positive numbers will 
skew the right part of the block upwards, and negative numbers will skew it downwards.



mySewnet™ Stitch Editor   Select Stitches and Blocks              73

Resize a Dragonfly Embroidery
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch, scroll down to the thumbnail of 

Perky Dragonfly. 
4 Click to load the embroidery.

A larger size would be more suitable when creating cutwork, for example.
5 Ensure the Home tab is selected, and click Box Select .
6 Click and drag to draw a rectangle around the dragonfly. 
7 Release the mouse button and the dragonfly is surrounded by a 

selection box with white handles.
8 Click Resize . The handles on the selection box become blue.

The blue handles indicate that when the size of the embroidery is 
changed it will be resized. The stitches are recalculated to maintain the 
original density.

9 Note the number of stitches in the embroidery. You can see this in the 
Information area on the Design Panel, or in the Control Strip.

10 Click Modify Block . The Modify Block dialog box appears.
11 In the Size section, ensure Proportional is checked, then change 

Height percentage  to 125%. 
The Width percentage will increase by the same amount.

12 Click Apply. The dragonfly increases in size, and the number of 
stitches is increased from 4337 to approximately 4387.

13 Close the Modify Block dialog box.
14 Left-click outside the select box to deselect the stitches.

Flip or Skew Block
Mirror a block of stitches vertically or 
horizontally using the flip handles on the 
block selection box.

If long stitches go across the block after it is mirrored, 
use Reverse Order to prevent this. Alternatively, reselect 
the block and try again.

Horizontally Flip Block
Click the Flip Horizontal handle to mirror a 
block horizontally. 

Vertically Flip Block
Click the Flip Vertical handle to mirror a block vertically.

Skew a Block
Skew a block vertically or horizontally using the trapezoidal Skew handles  in the 
bottom right corner of the block selection box.

Skew will change the density of stitching. It is recommended to use Stitch Optimizer  in the Modify tab 
afterwards.

Flip Vertical Handle

Flip
Horizontal

Handle
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Center in Hoop
Use Center in Hoop  (Home tab) to move the embroidery to the center of the hoop and, 
if necessary, add a hoop movement so that the embroidery starts from the center of the 
hoop.

When an embroidery is not centered, it may be difficult to repeatedly stitch out the embroidery so that the 
stitchouts line up. This may happen with certain embroideries that have a start point at the side. Use 
Center in Hoop to correct this.

Shortcuts
■ Tools, Home Tab: 
■ Keys: Alt, H, CI

Reverse Order
Reverse Order  is used to reverse the stitch order of a selected block. For example, if a 
block of stitches making a shape from left to right is selected and mirrored horizontally, 
using Reverse Order will prevent long movement stitches going across the shape after it 
has been mirrored.

When Reverse Order is used, only continuous sets of stitches have their order reversed. 
This ensures that the order of color blocks is preserved, as well as the sequence of stops 
and trims.

Stitches are a continuous set if they are immediately in sequence one after the other, with no commands 
(color changes, stops and trims). 

Shortcuts
■ Tools, Home Tab: 
■ Keys: Alt, H, RO

Reverse the Stitch Order of a Leaf
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 

'FlowersDreamJacketOriginal’ embroidery.
4 In the Control Strip, click Draw Next Color Block . Only the leaves are now visible.
5 In the Home tab, click Box Select . The pointer changes to the box select pointer .
6 Click and drag around the leaf at the bottom left, then release the mouse button.

The leaf is now surrounded by a selection box.
7 Zoom in on the selected leaf.
8 In the View tab, click 2D View with Stitch Points  to view the structure of the embroidery.

There is a diagonal underlay beneath the straight fill stitches.
9 Click 3D View .
10 In the Home tab, click Reverse Order . The stitch order has been reversed, and the underlay 

stitching is now on top.
You could use a contrasting color for the exposed underlay thread to create a multicolored effect.

11 Close without saving.
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5Modifying Stitches and Blocks

Modify Stitch
When using the Modify Stitch functions, after selecting the function click on the stitch that 
you want to modify.

When any of the Modify Stitch functions in the Modify tab except Edit Stop Command are selected, the 
command markers are enlarged to make them easier to identify. (When Edit Stop Command is selected 
only the Stop markers are enlarged.)
To find a marker, click one of the Modify Stitch functions so that the markers are shown at a larger size, 
then right-click to cancel the function.

Insert Color Command
Use Insert Color Command  to add a new color change at the point where you click.

Click the icon and the pointer changes to the insert color pointer . Then click on the 
stitch where you want the color change. The Color Selection dialog box is displayed for 
you to select the thread color for the new color change. 

After you have selected a thread color, the new Color Change command  is shown by a 
blue circle with a C.

The Color Change command marker will become smaller when Insert Color Command is deselected.
The stitches in the embroidery are displayed in the new color after the new color change 
and up to the next color change. When you select the Design Panel you will see the new 
color block in sequence in the color worksheet according to where you inserted the Color 
Change command.

To cancel the function, right-click on the work area, or click Cancel in the Color Selection box.

Shortcuts
■ Modify Stitch, Modify Tab: 
■ Keys: Alt, M, IC

Change Alternate Petal Colors in a Flower
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Pink’ embroidery.

Adjust stitches Break the design in two

Automatic basting line

Optimize stitchout
Automatically add trims

Change to a single color
Create cutwork needle lines

Morph all visible stitches

Morph stitches where you click

Insert a Tie On or Tie Off stitch

Alignment subdesign

Insert stitches where you click
Insert color & trim commands

Delete commands

Insert & Edit Stop Commands

Modify Tab

Split for multiple hoops
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4 Ensure that the Design Panel is available.
5 Double-click the first color in the worksheet and the Color Selection box appears.
6 Click Show All Thread Ranges, then click the drop-down arrow on the Thread 

Range box and scroll up to select Robison-Anton Rayon Twist 35.
7 Browse for thread number 79020 (Baby Pink) in the list and select it.

Alternatively, enter 79020 in the Find Thread box.
8 Click OK to close the Color Selection box, and the thread color of the petals will 

change.
9 Change the second color in the worksheet to Robison-Anton Metallic J 40, thread 

number 1001 (Gov’t. Gold), then click OK. The center color changes.
10 Click Draw Next Color Block  to show only the first color in the worksheet.
11 Click Zoom To Rectangle . The mouse pointer will change to the zoom 

pointer .
12 Click and drag to draw a rectangle inside the flower, a little way inside the tips of 

the petals, then release the mouse button to zoom in.
13 In the View tab, click 2D View with Stitch Points, so that the flower is shown in 2D, 

and you can see the black dots that represent the stitch points in the embroidery.

It may be easier to visualize the design if you enable Ghost Mode .
14 Move the Draw From Start slider bar so that the first petal is hidden, 

leaving only the Trim command  at the end. There should be a 
stitch point at the center of the Trim command marker. The start 
stitch is shown as 280.
Stitch numbers are given as guides only. It is more important to ensure that the correct stitches are hidden 
or left showing than to follow the exact stitch numbers.
To get to the desired stitch number quickly, drag the slider to a nearby stitch number, then click the arrows 
in the stitch number boxes to adjust the number in single steps. Alternatively, type in the stitch number in 
the box below the slider bar.

15 Click the Modify tab.
16 Click Insert Color Command . The Trim command markers become much larger, and the mouse 

pointer changes to the insert color command pointer .
17 Click on the pale pink line showing the stitch to the right of the Trim 

command at the end of the hidden petal. The Color Selection box will 
appear.

18 Choose Show All Thread Ranges, then set the Thread Range to Robison-
Anton Rayon Swirl 35.

19 Select thread number 017 (Soap Stone), then click OK to close the Color 
Selection box. The thread color of the visible petals will change.
The Trim command is replaced, as it is not necessary to have a Trim and 
Color Change adjacent to each other.

20 Move the left Draw Range slider bar so that the start stitch is shown as 
537. This will hide the next petal, leaving only the Trim Command and 
its stitch point at the end.

21 Ensure that Insert Color Command  is still selected, and click on the stitch below the Trim 
Command at the end of the hidden petal.

22 In the Color Selection box select thread number 79020 (Baby Pink) from Robison-Anton Rayon Twist 
35 and click OK. The thread color of the visible petals will change.

23 Move the left Draw Range slider bar so that the start stitch is shown as 794.
24 Ensure that Insert Color Command  is still selected, and click on the stitch below the Trim 

Command at the end of the hidden petal.
25 In the Color Selection box select thread number 017 (Soap Stone) from Robison-Anton Rayon Swirl 35 

and click OK.
26 Look at the Design Panel.

Notice that the new color blocks are shown in the color worksheet and Control Strip as they are added, 
alternating between the Swirl and Twist colors.
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27 Move the left Draw Range slider bar so that the start stitch is shown as 1062.
28 Ensure that Insert Color Command  is still selected, and click on the stitch to the left of the Trim 

Command at the end of the hidden petal.
29 In the Color Selection box select thread number 79020 (Baby Pink) from 

Robison-Anton Rayon Twist 35 and click OK.
30 Move the left Draw Range slider bar so that the start stitch is shown as 1330.
31 Ensure that Insert Color Command  is still selected, and click on the stitch 

above the Trim Command at the end of the hidden petal.
32 In the Color Selection box select thread number 017 (Soap Stone) from 

Robison-Anton Rayon Swirl 35 and click OK.
33 Right-click to deselect Insert Color Command.
34 Click Draw All Stitches  on the Control Strip.
35 In the View tab, click 3D View  and then click Zoom to Fit .
36 Look at the Design Panel.

Notice the number of colors in the design Information is seven.
37 Click the Home tab, and in the Tools area click ColorSort . The colors are sorted, and then the 

design information and slider bar shows how the number of color changes has been reduced.
Notice on the color worksheet that there are now only three colors in the embroidery.

38 Click File, Save As and the Save As dialog box will appear.
39 In the Save As Type box, ensure .vp4 is selected. Browse to the folder Documents\mySewnet\My 

Designs and in the File Name box change the name to 'Flower Pink Twist'. Then click Save.

Insert Stop Command
Use Insert Stop Command  to add a command which instructs the embroidery 
machine to stop at the point where you click, displaying a message. A Stop command  
is shown by a red circle containing the letter S.

Use stop commands to transform an existing satin stitched 'outline' embroidery into an 
appliqué. Insert the stop commands so the appliqué fabric may be placed on the hoop, 
tacked down and trimmed. Stop commands may also be useful where a movement stitch 
might become trapped under the stitches that follow it.

To view Stop commands with their messages, use Draw Next Stop and Draw Previous Stop on the Control 
Strip, the Stitch Player or the Design Player. Alternatively, view Stop Commands and their messages in the 
printed worksheet.

Insert a Stop Command
1 Open an embroidery, then click the Modify tab.
2 Click Insert Stop Command  and the pointer changes to the 

insert stop pointer . 
3 Click on a stitch. The Stop dialog box opens.
4 Use the Quick Text drop-down menu to insert a stitchout hint, or 

enter a message. See “Stop Properties” on page 78.
5 Click OK to place the Stop Command.

A large Stop command marker  shows the place where the 
command was inserted.
The Stop command marker will become smaller when Insert Stop Command is deselected.

6 To cancel the function, right-click on the work area.

Shortcuts
■ Modify Stitch, Modify Tab: 
■ Keys: Alt, M, IS
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Edit Stop Command
Use Edit Stop Command  to add or change the message or stitchout hint for any 
existing Stop Command. (Alternatively, use Draw Next Stop and Draw Previous Stop in the 
Control Strip to locate the desired Stop command.)

Edit a Stop Command
1 Open an embroidery containing a Stop Command.
2 In the Modify tab, click Edit Stop Command . 

All visible Stop Commands are highlighted as a red circle containing the letter S . 
3 Click on a Stop marker. The Stop dialog box opens. See “Stop Properties” on page 78.
4 Edit the message for the Stop command, or select another stitchout hint from the drop-down menu.
5 Click OK to close the Stop dialog box, and save the new message.

Shortcuts
■ Modify Stitch, Modify Tab: 
■ Keys: Alt, M, E

Stop Properties
Add a stitchout hint to a Stop Command in the Stop dialog 
box.

Select a Quick Text comment from the drop-down menu, or 
enter text in the Comment text field. Click OK to save the 
text. Up to 200 characters may be entered.

Quick Text
Select one of the following texts:

■ Place the appliqué fabric now
■ Cut around the appliqué
■ Place the appliqué shape onto the placement line
■ Cut the hole in your fabric
■ Place the puffy foam on the fabric now
■ Remove any excess puffy foam
■ Check alignment now

Insert Trim Command
Use Insert Trim Command  to add a command which instructs some embroidery 
machines to cut the thread. A Trim command  is shown by a green circle containing the 
letter T.

When adding trims to an embroidery, first use Automatically Add Trim Commands , then add any 
additional trims with Insert Trim Command. See “Automatically Add Trim Commands” on page 159.
To add trims automatically to an embroidery with no trims when it is opened, set "Add trims automatically 
when opening a file" in the General section of Preferences. See “General” on page 284.
Click Insert Trim Command and the pointer changes to the insert trim pointer . Then 
click on a stitch. When a trim is inserted, the stitch disappears.
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The Trim command marker becomes smaller  when Insert Trim Command is deselected.

This is useful when converting embroideries made for non-trimming machines for use on 
machines that support Trim commands. Trim commands can be added between areas of 
the same color. For instance, insert Trim commands to trim out the joining stitches 
between lettering when the thread color contrasts with the fabric.

To cancel the function, right-click on the work area.

Shortcuts
■ Modify Stitch, Modify Tab: 
■ Keys: Alt, M, IT

Delete Commands
Use Delete Commands  to delete an unwanted Color Change, Stop or Trim command. 

Select Delete Commands , then click on a command marker to delete it.

To cancel the function, right-click on the work area.

To remove all of the trims in an embroidery, use Remove All Trim Commands . See “Remove All Trim 
Commands” on page 160.

Shortcuts
■ Modify Stitch, Modify Tab: 
■ Keys: Alt, M, DC

Showing Commands
Use Commands  to show or hide the command markers for Color Change , Stop , 
Appliqué  and Trim . See “Commands” on page 33.

Commands are also shown when one of the Modify Stitch functions is selected, even if Commands is not 
enabled.
When the command markers are not visible, the commands will still be present in a 
selection or stitch count.

If Delete Commands  is used, all commands will be visible while it is selected.

Edit and Add Stitches
Editing Stitches
When editing stitches, it may be helpful to select 2D View with Stitch Points  and zoom 
in close enough to see the separate stitch points. 

To select a stitch, click Single Stitch , then click a stitch point. A 
box appears around the point to show that it is selected. 

Click and drag the box to move the stitch point. If desired, use 
Delete  to delete the stitch point. Color Change , Stop  and 
Trim  command markers and their associated stitch points can 
be moved, but they can only be deleted using Delete 
Commands .
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Insert Stitches
Use Insert Stitches  to add new stitches to an embroidery. Click Insert Stitches and the 
pointer changes to the Insert Stitches pointer . The stitches will be added using the 
thread color where you insert the stitches. If you need to use a different color for the 
stitches, insert color changes before and after the new stitches have been added. Right-
click twice to deselect.

Click Insert Stitches , then click the stitch where you want to add stitches. The next click 
will place a new stitch point after the stitch you started from. Each following click will 
place a new stitch point after the previous one. Click Delete to delete the last point placed. 
Right-click to finish adding stitches.

You may not start from a stitch point where there is a command (Color Change, Stop or Trim).
Use Insert Stitches for many reasons. For example, you may add more underlay to an 
embroidery or make a new section of an embroidery. You can even change an embroidery 
into an appliqué embroidery by adding placement stitches and Stops to secure the 
appliqué fabric.

Shortcuts
■ Modify Stitch, Modify Tab: 
■ Keys: Alt, M, IN

Inserting Tie Stitches
Create a tie stitch automatically, to hold down the stitching at the point you click. 
Typically, tie stitches are used at the beginning and end of areas of satin or fill. 

You can add tie stitches to an embroidery where sections are coming loose after stitching out.

Insert Tie On
Use Insert Tie On  to add a tie stitch at the beginning of the stitch area to be secured. 
The stitches making up the tie stitch are inserted in the embroidery before the first stitch 
point of the selected stitch.

Shortcuts

■ Modify Stitch, Modify Tab: 
■ Keys: Alt, M, IO

Insert Tie Off
Use Insert Tie Off  to add a tie stitch at the end of the stitch area to be secured. The 
stitches making up the tie stitch are inserted in the embroidery after the last stitch point of 
the selected stitch.

Shortcuts

■ Modify Stitch, Modify Tab: 
■ Keys: Alt, M, IE
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Add Tie Stitches to Secure a Fill Area
1 Open an embroidery with a fill area.
2 In the Modify tab, click Insert Tie On .
3 Find the beginning of the fill area to be secured.
4 Click the stitch where you wish to insert the tie stitch. A tie stitch is placed to secure the beginning of 

the fill area.
5 In the Modify tab, click Insert Tie Off .

There is no need to deselect the previous tool if another Modify tool is selected.
6 Find the end of the fill area to be secured.
7 Click the stitch where you wish to insert the tie stitch. A tie stitch is placed to secure the end of the fill 

area.
8 Right-click to deselect Insert Tie Off.

To delete a tie stitch, delete the stitch points making up the tie stitch.

Cut, Copy and Paste
Clipboard Block
The Clipboard Block shows the current block that can be pasted 
into your embroideries. It shows the most recent block of 
stitches or embroidery that has been cut or copied from 
mySewnet™ Stitch Editor or another mySewnet™ Embroidery 
Software module. It can be used as many times as desired, until 
a new block is cut or copied.

Click in the clipboard to remove the current Clipboard Block.

Cut
Use Cut  to remove the whole embroidery or the currently selected block of stitches 
from the embroidery and make it the Clipboard Block.

Use one of the block selection methods (Box Select, Color Block Select, Freehand Select, 
Point Select or Select All Visible) to select the desired block to be cut. It can then be pasted 
into the same or another embroidery, or pasted into another mySewnet™ Embroidery 
Software module.

Shortcuts
■ Clipboard, Home Tab: 
■ Keys: Ctrl + X; Alt, H, CU

Copy
Use Copy  to make a copy of the whole embroidery or the currently selected block of 
stitches. The copy becomes the Clipboard Block, where it can be pasted into any open 
embroidery as many times as required, or pasted into another mySewnet™ Embroidery 
Software module. 

Shortcuts
■ Clipboard, Home Tab: 
■ Keys: Ctrl + C; Alt, H, CO, CO
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Copy All
Use Edit, Copy All  to make a copy of all visible stitches in all designs. The copy is placed 
on the Clipboard. It can then be pasted into any open embroidery window as many times 
as required, including into another mySewnet™ Embroidery Software module.

Shortcuts
■ Keys: Ctrl + Shift + C; Alt, H, CO, CA

Paste
Use Paste  to insert the Clipboard Block into the embroidery by attaching it to the last 
currently visible stitch. The Clipboard Block shows the current stitches that will be pasted.

The copied block will be inserted at the same position in the hoop as the original block.
To insert a block at any stitch, use any of the controls on the control strip that change the 
End stitch in the Draw Range. Alternatively, use Paste into New Window.

A pasted block is automatically selected with Box Select so that it is ready to be moved 
and manipulated as required.

Shortcuts
■ Clipboard, Home Tab: 
■ Keys: Ctrl + V; Alt, H, PA, PA

Paste into New Window
Use Paste into New Window to paste the embroidery in the Clipboard into a new window. 

The copied block will be inserted at the same position in the hoop as the original block.

Shortcuts
■ Keys: Ctrl + Shift + N; Alt, H, PA, PI

Paste as Design
Use Paste as Design to paste the embroidery in the Clipboard into the current window as a 
new subdesign within the multipart design.

The copied block will be inserted at the same position in the hoop as the original block.

Shortcuts
■ Keys: Ctrl + Shift + V; Alt, H, PA, PD

Duplicate
Use Duplicate  to make a copy of the whole embroidery or the currently selected block, 
which is automatically pasted on the work area below and to the right of the original and 
after the selected block in the stitch sequence. The copied stitches are shown in the 
Clipboard Block on the control panel.

Shortcuts
■ Clipboard, Home Tab: 
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■ Keys: Ctrl + D; Alt, H, DU

Delete
Use Delete  to delete all visible stitches, or a block of stitches after it has been selected 
using one of the block selection methods (Box Select , Color Block Select , Freehand 
Select , Point Select  or Select All Visible ). 

When all visible stitches are deleted because no block is selected, all remaining stitches 
are shown.

This function differs from Cut because it does not place the stitches on the Clipboard. Therefore stitches 
that have been Deleted cannot be pasted into another embroidery (although Undo can be used if the 
wrong stitches are deleted).

Delete Single Stitches
When you have a single stitch selected, Delete  will remove the stitch point.

Delete Points
When using one of the Point or Freehand features such as Point Select , Point Border  
or Freehand Border , Cutwork lines, and so on, Delete  will remove the last-placed 
point.

Shortcuts
■ Clipboard, Home Tab: 
■ Keys: Del; Alt, H, DE

Undo and Redo
Undo
Use Undo  to reverse the last action. If you are not satisfied with the result, click 
Redo . The Undo steps are recorded separately for each open embroidery.

When you use Undo on the Object tab, the previously selected area(s) will be deselected.
Each time you use Undo the undone action becomes a Redo.

For instance, you might move a stitch point and then Undo the move. You could now Redo 
the move or do something else. If you delete the stitch point instead of using Redo then 
the Redo is lost, along with any other Redos that may have followed.

There are unlimited Undo steps for each open embroidery. Undo steps are only lost when 
you close an embroidery.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Z; Alt, 7

Redo
Use Redo  to reverse the last action that was undone by Undo. If you are not satisfied 
with the result, click Undo .
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Redo only works if nothing has happened after the last Undo. For instance, if you insert a 
Color Change command, then Undo and insert a Trim Command then it is not possible to 
Redo the Color Change because something different has happened instead.

When you use Redo on the Object tab, the selected block is deselected.
There are unlimited Undo and Redo steps for each open embroidery.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Y; Alt, 8
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6Borders and Appliqué

Create Borders and Appliqué Areas

Use the Border tab to make a new embroidery by adding a satin, running, triple or motif 
border, optionally with placement stitches and fabric for appliqué. Use a preset shape for 
the border, draw your own freehand shape, or create a border automatically around an 
embroidery or selected stitches. There are three types of border:

■ Create External Border 
Remove the stitches outside the shape that has been drawn and add a border around the 
stitches

■ Create Internal Border 
Remove the stitches inside the shape that has been drawn and add a border inside the 
stitches

■ Create Overlay Border 
Add the border on top of or with the existing embroidery

The border is always added at the end of the embroidery. If an appliqué option is used, the 
stitches for placing the appliqué fabric are added at the beginning of the embroidery.

All stitches, including stitches you may have hidden, are used when the new embroidery is created. If you 

wish to use only the visible stitches, use Select All Visible  to select all the visible stitches, Copy  the 
stitches, and use Paste into New Window. Then draw a border shape and use the desired border and 
appliqué functions.

Border Line
Draw your own border shape with one of the Border Line  functions, Freehand Border 
Line , or Point Border Line .

Freehand Border Line
Use the Border Line  function Freehand Border Line  to draw a line to create a 
border, optionally with appliqué. 

Draw a line, then release the mouse button to finish the line. The line is closed 
automatically to form a shape. Move the nodes to adjust the shape. Click Delete to remove 
the last–placed point. Then select a border option.

Draw a freehand line
Draw a preset shape

Select a shape for drawing Choose a border stitch type

Add appliqué to the border
Choose an appliqué fabric

Choose the border line settings

Choose appliqué settings

Create an internal, external 
or overlay border

Create a border automatically
Set the automatic border margin

Border Tab



86          mySewnet™ Stitch Editor   Borders and Appliqué 

If the desired line is not achieved when created initially, either redo the line or select and move the nodes as 
desired.

Shortcuts
■ Draw Border Line, Border Tab: 
■ Keys: Alt, B, BL, FT

Draw a Freehand Border Line
1 If desired, select Add Appliqué  to use appliqué with your border.
2 In Stitch Type, choose the desired line type for the border and use Options  to select its settings.
3 In the Border Line  drop-down menu, click Freehand Border . The pointer changes to the draw 

pointer .
4 Draw a line on the work area, then release the mouse button. 

When you release the mouse button the line is drawn as a closed line (a loop) with nodes.
5 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 

pointer . Adjust the node as desired.
Use Shift+click to change a round node to a square node, to make the line straight.
Click Delete to remove the last–placed point.

6 When your line is as desired, in the Create Border area select a Border option. The border is placed on 
the work area.
Right-click to deselect Freehand Border without placing a border.

Point Border Line
Use the Border Line  function Point Border Line  
to create a border of any shape by placing points. 
Click Point Border Line and the pointer changes to 
the add point pointer . Click a series of points to 
create an irregular outline of curved and straight lines 
around the desired area. Use Shift and click to place a 
square (straight line) node. Click Delete to remove 
the last–placed point. Select a border type when the 
border is complete.

Right-click to cancel without creating a border.

When the border is sized and positioned as desired, use one of the Create Border 
functions. 

Shortcuts
■ Draw Border Line, Border Tab: 
■ Keys: Alt, B, BL, FP

Create a Point Border Line
1 If desired, select Add Appliqué  to use appliqué with your border.
2 In Stitch Type, choose the desired line type for the border and use Options  to select its settings.
3 In the Border Line  drop-down list, click Point Border Line . The pointer changes to the Point 

pointer .
4 Click to place a series of points for the border.

As you click the third point on the line, the line becomes closed (it becomes a loop). As you place more 
points the line adjusts itself.
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The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.
5 Use Shift+click to place square nodes for straight lines.

Click Delete to remove the last–placed point.
6 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 

pointer . Adjust the node as desired.
When the Move Node pointer is active you can adjust existing nodes.
If you click while the Point pointer  is active, another point will be added to the line.

7 When your line is as desired, select a Border option. The border is placed on the work area.
Right-click to deselect Point Border without placing a border.

Border Shape
Use Border Shape  to draw an outline with the border 
shape currently selected in the gallery of preset shapes. 
Click the drop-down arrow to the right of the border 
shapes gallery, and scroll to select the desired shape in 
the list. Click Draw Border Shape , then click and drag 
over the embroidery to draw a rectangle that sets the 
size of the shape. Hold down Ctrl to draw in proportion.

When the mouse button is released, the shape will be shown 
as a red line, with handles to resize, flip and rotate the shape.

For best results when drawing shapes with sharp points, it is 
recommended to hold down Ctrl so that the shape is perfectly in 
proportion.
To move the border, click and drag inside the border shape. 
Resize the border with the resize handles on the corners. If the 
border shape was initially drawn in proportion, it will stay in 
proportion when it is resized. You may also hold Ctrl when 
resizing non-proportional shapes to retain the current proportions of the shape. Rotate 
the border with the circular rotate handle on the right. Mirror the border horizontally or 
vertically with the triangular flip handles on the left and top. The border can extend 
beyond the edge of the hoop. Right-click to cancel without creating a border.

When the border is sized and positioned as desired, use one of the Create Border 
functions.

Shortcuts
■ Draw Border Line, Border Tab: 
■ Keys: Alt, B, BS

Cut a Heart Border Shape from Lace
1 Click Change Hoop . From the Universal Hoop Group, set the Hoop Size to 240mm x 150mm - 

Universal Large Hoop 2. Set the Orientation to Rotated. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Curly Lace' embroidery.
5 Click the View tab. 
6 In Grid, ensure that the grid size is is set to 5mm.
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7 Click Grid Numbered Full .
This is so there are grid numbers along the right and lower sides of the stitch area.

8 In the Control Strip, click Invert Visible Color Blocks  to hide the stitches of the lace.
9 Ensure Ghost Mode  is on, so that a pale version of the stitches is shown. 

Hiding the stitches and using Ghost Mode will make it easier to see where to draw the box for the Border 
Shape.

10 Click the Border tab.
11 In Stitch Type, select Satin Line , then click Options .
12 In the Satin Line dialog box, set the Width for the satin border to 3.5mm and the Density to 4.
13 Click OK to close the Satin Line dialog box.
14 Click the drop-down arrow to the right of the border shapes 

gallery and select shape 71, the first heart shape, from the list. If 
necessary, use the scroll bar at the side of the list to find the 
shape.

15 Click Border Shape .
16 Hold down the Ctrl key on the keyboard. This will force the 

shape to be proportional. Click and drag diagonally across the 
hoop to draw a box from upper grid line 13 to lower grid line 
13, then release the mouse button. The heart shape will be 
shown on the work area in a selection box.

17 If the heart shape is out of the hoop on one side, click and drag 
inside the shape to ensure it is entirely within the hoop.

Although the stitches are hidden, the Border functions will still affect all stitches in the embroidery. If 
desired, to see stitches more easily, use the Draw Range slider bar on the Control Strip to change the 
stitches displayed while adjusting the border shape.

18 Click Create External Border . A heart-shaped border is created.
19 Click the Home tab.
20 In the Design Select area there are two subdesigns: the heart shape, and a lace background with a 

heart-shaped hole. Select the lace area and click Delete .
Now only the filled border can be seen.



mySewnet™ Stitch Editor   Borders and Appliqué              89

21 In the Design Panel, select the blue thread color for the border, and then click the Thread Color 
button . The Color Selection box will appear. 

22 Set the Thread Range to Sulky Rayon 40 and browse for thread number 1246 (Orange Flame) in the 
list and select it, or type 1246 in the Find Thread box. 

23 Click OK to close the Color Selection box, and the thread sample will change. The border around the 
heart is now red.
To morph the border of the heart embroidery with Twirl, see “Twirl the Border of a Heart Embroidery” on 
page 126.

Border Embroidery
Use Border Embroidery  to create a border automatically around the selected 
embroidery or stitches, using an internal, external or overlay border, optionally with 
appliqué. Use Margin to set the distance between the selected stitches and the border.

Use a Running Stitch border line for a basting or cutwork line around an embroidery.

Shortcuts
■ Draw Border Line, Border Tab: 
■ Keys: Alt, B, BE

Draw a Border Around an Embroidery Automatically
1 Select the Border tab in the ribbon bar.
2 Load an embroidery design.
3 In Stitch Type, choose the desired line type for the 

border and use Options  to select its settings.
4 If desired, select Add Appliqué  to use appliqué 

with your border, select an appliqué fabric  and 
click Options  to set the appliqué type.

5 Select the part of the design that you want to 
surround by a border.
If no part of the design is selected, the border will be 
placed around the whole embroidery.

6 Set the Margin to the desired distance from the 
stitches in the embroidery.
The initial setting is 10mm.
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7 Click Border Embroidery . The position for the border is shown by 
a red and cyan dashed line.

8 If desired, adjust the Margin setting. The position of the preview line 
will change.
Holes within the embroidery, and some appliqué areas, will also have a 
border, each with its own color block. To remove one of these internal 
borders, after creation select its color block and delete those stitches.

9 Click to select an External, Internal or Overlay Border. The border is 
placed around the embroidery.
Right-click to deselect Border Embroidery without placing a border.
If there are holes or appliqué areas within the embroidery, only the 
Create Overlay Border option may be available.

Margin
Set the distance between the selected stitches or embroidery and the automatic border. 
You can set Margin from 0 to 50 mm, in steps of 1mm. The initial setting is 10 mm.

Border Stitch Type
Select a border stitch type, and use Options  to choose its settings in the dialog box for 
that stitch type - for example, choose width, pattern, density or stitch length. 

Choose from:

■ Satin Line 

■ Motif Line 

■ Running Stitch 

■ Triple Stitch 

For more information on these stitch types, see “Line Types” on page 266.

Create Border
Use the Create Border options to create a new embroidery with a border in the shape you 
have drawn and placed. There are three Create Border functions:

■ Create External Border 

■ Create Internal Border 

■ Create Overlay Border 

Draw the desired border shape. Use either a preset shape with Border Shape  or draw 
your own shape with the Border Line  functions, Freehand Border Line , or Point 
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Border Line . Move, scale, rotate and mirror the border shape as desired. Then use the 
desired Create Border function to create the new embroidery. 

Add a Satin Border to the Sweet Rose Embroidery
1 Change the background color to pink. See “Add a Basting Line to Sweet Rose Border” on page 161.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Sweet Rose with Buttons' 

embroidery.
Alternatively, you could use the embroidery you created in “Make Diamond Stamp Buttons for the Sweet 
Rose Embroidery” on page 198.

5 Click the Border tab.
6 In Stitch Type, ensure that Satin Line  is selected, then click Options .
7 In Satin Line, set the Width to 3.5mm, set Density to 4, and ensure Underlay is selected. 
8 Click OK to close the Satin Line dialog box.
9 Click Border Shape .
10 In the Shapes drop-down list, select Shape 3 (a rectangle).
11 Click and drag to draw a rectangle that surrounds the embroidery, 

leaving a very small gap below.
The gap ensures that the border will not cover the embossed lettering.
If desired, click and drag one of the square corner handles to 
resize the border shape, or click and drag inside it to adjust the 
position.

12 Click Create Overlay Border . A border is placed around the 
embroidery.
Alternatively, to create a quick border with more rounded corners, use 
Border Embroidery  with the Margin set to 2mm.

13 In the color worksheet, select the color at the bottom (the color 
for the border).

14 Click Thread Color . The Color Selection dialog box appears.
15 Ensure that Robison-Anton Rayon 40 is selected in the list of thread ranges.

Create External Border Create Internal Border Create Overlay Border

Create External Border  will 
remove the stitches outside the 
shape that has been drawn and 
add a border around the stitches.
Shortcuts:

Create Border, Border Tab:
Keys: Alt, B, CE

Create Internal Border  will 
remove the stitches inside the 
shape that has been drawn and 
add a border inside the stitches.
Shortcuts

Create Border, Border Tab: 
Keys: Alt, B, CI

Create Overlay Border  will 
add the border on top of the 
embroidery.

Shortcuts

Create Border, Border Tab: 
Keys: Alt, B, CO
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16 Browse for thread number 2500 (New Berry) in the list and select it, or type 2500 in the Find Thread 
box. 

17 Click OK. The thread color is now a plum color.
To add a basting line around the embroidery, see “Add a Basting 
Line to Sweet Rose Border” on page 161.

Add Appliqué
Use Add Appliqué  to add appliqué to the border that you create. Appliqué placement 
stitches are automatically added to the border that you draw.

Select Add Appliqué , and create the desired shape with Border Embroidery , Draw 
Border Shape , Freehand  or Point  Border. Move, scale, rotate and mirror the 
shape as desired. Use the desired Create Border function: External , Internal  or 
Overlay  to create the embroidery. 

A new color block, using the same color as the border is placed at the beginning of the 
embroidery for the appliqué placement stitches. The appliqué placement stitches use the 
method, appliqué piece margin, running stitch length and double stitch length set in 
Appliqué Options. A Color Change is also placed at the beginning of the border line, using 
the default border color. The border uses stitch type settings set in the Line Options for the 
selected stitch type.

External Appliqué Internal Appliqué Overlay Appliqué

Create External Border  with 
appliqué removes the stitches 
outside the shape that has 
been drawn. It then adds 
appliqué placement stitches at 
the beginning of the 
embroidery and a border 
around the stitches.

Create Internal Border  with 
appliqué removes the stitches 
inside the shape that has been 
drawn. It then adds appliqué 
placement stitches at the 
beginning of the embroidery 
and a border inside the 
stitches.

Create Overlay Border  with 
appliqué keeps all the stitches 
in the embroidery. It then adds 
appliqué placement stitches at 
the beginning of the 
embroidery and a border on 
top of the embroidery.
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Draw Internal Heart Appliqué
1 Click the Hoop icon . From the Universal Hoop Group, set the Hoop Size to 240mm x 150mm - 

Universal Large Hoop 2. Set the Orientation to Rotated. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Scalloped Heart' 

embroidery.
5 Click the View tab. 
6 In Grid, ensure that the grid size is set to 5mm. 
7 Click Grid Numbered Full .

This is so there are grid numbers along the right and lower sides of the stitch area.
8 Click the Border tab.
9 Set the Stitch Type to Satin Line .
10 In the Stitch Type area, click Options, and in the Satin Line dialog box, ensure that the Width for Satin 

Line is set to 3.5mm and the Density is set to 4. Click OK.
11 In the Appliqué section, click Add Appliqué , then click Options . 
12 In the Appliqué Options dialog, in Appliqué Method ensure that the first method (Standard Appliqué) 

is selected. 
13 Ensure Running Stitch Length is set to 2.0mm and Double Stitch Length is set to 2.0mm.

14 Click OK to close the Appliqué Options dialog box.
15 Click Select Fabric . 
16 In the Appliqué Selection dialog box, ensure that Quick is selected for Appliqué Type.
17 In Quick Colors, select the orange in row 4, column 6.
18 Ensure that the Texture is set to Woven, then click OK.
19 Click the drop-down arrow next to the currently selected preset border 

shape and select shape 71, the first heart shape, from the list.
20 In the color worksheet on the Design Panel, click the check box for the 

first thread color to hide the stitches of the lace.
21 Click Border Shape .
22 Hold down Ctrl to draw a proportional shape, and draw from left grid 

line 6 to right grid line 6, so that the box is 12 grid squares wide.
23 Release the mouse button and the heart shape appears as a red line.
24 Click and drag inside the small heart shape and move it to the center of 

the hoop. The shape is centered when the points of the flip handles are 
on the center grid lines.
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25 Click Create Internal Border . The lace stitches in the 
central part of the embroidery are replaced by an appliqué 
area.

26 Click the Home tab.
27 In the Design Select area there are two subdesigns: a heart 

with an internal and external border, and a lace heart with 
no border. Select the lace heart and click Delete .

28 The first and last colors in the embroidery should match the 
red for the external border. Select the first color.
These are the appliqué placement stitches.

29 Click the Thread Color button  and change the thread 
color to Sulky Rayon 40 thread number 1246 (Orange 
Flame).

30 Select the final color (the internal border) and change the 
thread color to Sulky Rayon 40 thread number 1246 (Orange Flame).

Select Fabric
Use Select Fabric  to audition a fabric for your appliqué in the Appliqué Selection 
dialog box. 

Click Select Fabric  and the Appliqué Selection dialog box appears. See “Appliqué 
Selection” on page 95.

Shortcuts
■ Appliqué, Border Tab: 
■ Keys: Alt, B, SF
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Appliqué Selection
Use the Appliqué Selection dialog box to select a fabric or picture to use for appliqué. Click 
OK to use the selected appliqué fabric.

Appliqué Type
Choose an appliqué type (or simply select one of the recently used swatches). Select from:

■ Quick
Select a color and texture for your fabric. See “Quick Appliqué Options” on page 95.

■ Fabric
Select a background fabric, or add a new background fabric from a picture. Set the angle 
for the fabric. See “Fabric Options” on page 96.

■ Picture
Create in individual non-tiling appliqué from a picture. For instance, use a photo for a 
printed appliqué memory piece. See “Picture Options” on page 96.

■ Cut-out
Create an appliqué placement line as a guide to where the fabric should be cut to form a 
hole; for example, for reverse appliqué.

Quick Appliqué Options
The Quick Appliqué Options are available when Quick is selected in Appliqué 
Type. 
Select a color and texture for your fabric.

Color
Click the color sample to change the color in the Colors dialog 
box. See “Colors Dialog Box” on page 123. 

Select a Quick Color & texture

Choose an appliqué type

Choose a system fabric

Load an individual picture 

Preview the appliqué fabric

Reuse a recent fabric

or add a new one

for printed appliqué

Print a sheet of appliqué fabric

Set the appliqué border margin
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Quick Colors
Click one of the Quick Colors to select a color for the fabric. Use the drop-down menu to 
choose a different Quick Colors theme, or to create your own theme. See “Quick Color 
Themes” on page 120. 

Texture
Select the texture to use for the fabric. Click on the down arrow and choose the desired 
fabric type.

Fabric Options
The Fabric Options are available when Fabric is selected in 
Appliqué Type. 

Load Previously Saved Fabric
Use Load Previously Saved Fabric  to load a sample fabric, or a fabric from My Fabrics, 
in the Picture Viewer. See “Background Picture Viewer” on page 98.

Add New Background Fabric
Use Add New Background Fabric  to create a new fabric background in the 
Background Wizard. See “Background Wizard” on page 98.

Angle
Use Angle to change the angle at which the pattern will be displayed.

You may also change the angle and position of the fabric pattern directly by selecting the appliqué piece in 
the work area.
Enter an Angle from 0 to 359 degrees. The initial setting is 0. Alter the Angle by entering a 
number in the box, or use the up and down arrows to change the number. Changes in 
Angle are visible in the preview pane.

Print Sheet
Print a sheet of appliqué fabric from the selected Quick Appliqué or Fabric pattern. Flip the 
picture for an iron-on transfer, and select a printer and paper size in the Print Setup dialog 
box. See “Print Setup” on page 281.

Picture Options
The Picture Options are available when Picture is selected in Appliqué Type. 
Click Select Picture to create a picture background in the Load Picture Wizard. See “Load 
Picture Wizard” on page 104.

Fabric Preview
The chosen fabric is previewed on the right.

Recent Swatches
Select a recently used fabric to use again.
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Appliqué Piece Margin
Set the margin for appliqué placement relative to the border shape from -10mm to 10mm. 
The initial value is 1.0mm.

■ Use a positive value when trimming the appliqué fabric before the border is stitched, for 
example with Standard Appliqué and Pre-placed Appliqué. 

■ A negative value is recommended for cut-out and reverse appliqué. 

Appliqué Piece Margin is only available when adjusting Express Appliqué.
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Background Picture Viewer
Use the Background Picture Viewer to select a fabric from the system fabrics, or from the 
My Fabrics folder with fabric backgrounds you have added.

To open the Picture Viewer, in the Appliqué Selection dialog box select Fabric, then click Load Previously 

Saved Fabric .
Open a folder, and scroll down and click a fabric to select it. Click OK to load the fabric in 
the Appliqué Selection dialog box.

To create a new fabric in the Background Wizard, in the Appliqué Selection dialog box select Fabric, then 

click Add New Background Fabric . See “Background Wizard” on page 98.

Background Wizard
Use the Background Wizard to create a new appliqué fabric from a picture.

Choose Picture
Use the Choose Picture page of the Background Wizard to select a picture for the new 
appliqué fabric.

Choose a fabric folder

Scroll to view more fabrics

Click to select a fabric

Scroll to view more folders

Change the icon size

Load the selected fabric

Select a picture file on
your computer

Paste a copied picture

Import a file from a scanner
or camera

The picture is previewed

  
Edit a picture in Draw & Paint
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From Scanner or Camera will not be available if you do not have a Windows Image Acquisition (WIA) 
compliant scanner or digital camera attached to your computer.

Load a Picture
Click Load a Picture  to open a picture from clipart, or one you have previously saved, 
scanned or created in an image editor. After selecting a picture, the preview box will show 
the selected picture with its name underneath. Click OK to continue.

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), Tagged Image File Format 
uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced Meta File (.emf ) 
and Windows Icon (.ico).

Load a Picture for a Background
1 Click Load a Picture  and the Picture Viewer dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted, for example: 

Documents\mySewnet\Samples\Stitch Editor\Pics
3 Click on a picture to select it.
4 Click OK to open the picture in the Choose Picture page.
5 Click Cancel to exit without selecting a picture.

Paste Picture
Use Paste Picture  to load the picture in the Clipboard Block.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from a scanner, a digital camera or another suitable device. Only devices that use WIA can 
be used to obtain pictures.

WIA is a standard method for transferring pictures from the device’s scanning or downloading program to 
another program. If the manufacturer provides the appropriate software components needed for WIA 
compliance, these should have been installed when the device was installed. Each scanner or digital 
camera has its own program that is used to scan or download pictures. Refer to the manual or online help 
provided with the program for instructions, if required. When the device and its software finish processing 
the picture, it will be shown in the Choose Picture page.
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 

Choose a picture folder

Click to select a picture

Scroll to view more folders

Change the icon size

Load the selected picture



100          mySewnet™ Stitch Editor   Borders and Appliqué 

required. When the device and its software finish processing the Picture, it will be shown 
in the Choose Picture page.

Create New Picture and Edit Picture
Create a new picture or edit an existing picture in mySewnet™ Draw & Paint.

Preview and Name

Under the preview pane is a box for the name of the chosen file. If the picture is a scanned 
image then the box will contain the words Scanned Picture.

Rotate and Crop Picture
Use the Rotate and Crop Picture page of the Background Wizard to prepare a picture for a 
fabric.

■ To adjust the crop area, position the mouse over the crop boundary until a double-headed 
arrow  appears, then click and drag to move the boundary line.

■ To move the crop area, position the mouse inside the crop boundary until a four-headed 
arrow  appears, then click and drag to move the whole rectangle.

■ To redraw the crop area, click and drag outside the crop boundary to draw a new 
rectangle, which can then be adjusted as required.

Initially, about half the area of the picture is selected from the middle of the picture, as 
shown by the dashed box in the picture on the left. The preview on the right shows four 
copies of the selected fabric area tiled together.

The tiled preview will change dynamically as you change the crop area.

Drag crop lines to select area

Drag inside area to move it

Click outside area to redraw it

Show divider lines for tiled area
Zoom in and out

Change the angle of the picture
Use the default crop settings

Select the whole picture

Correct the perspective in the picture Save the picture
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To see where the four sections of the background are joined, 
select the Show Divider option. Dashed lines show where 
the tiled sections will be joined. This is useful for patterned 
fabric, to ensure the pattern repeats as desired.

When the desired area is selected, click Next.

Rotate
Rotate  the picture from 0 to 359 degrees. Adjust the 
picture angle as desired. This is often necessary with 
scanned pictures.

Enter the desired Rotation angle  or use the up/down arrows to change the angle. The 
preview will show the effect.

When the picture is rotated between the 90 degree steps, the picture is made larger and 
white background is added.

Select All and Automatic
Use Select All to select the whole of the picture. Use Automatic to set the crop lines back 
to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly. Drag the Stretch Picture  slider to make the 
picture in the Preview wider or narrower. Use Save Picture  to save your edited picture.

Zoom
Use the Zoom functions to change the view of the picture.

Enable perspective correction

Drag the red handles 
to select an area

Adjust the proportions of the picture Save the edited picture
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The fabric preview on the right is not affected by zoom.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Set Size
Use Set Size to enter a real measurement of the fabric so that it will be displayed at real 
size when it is used as the appliqué fabric.

The cropped section of fabric is shown in the preview. Click and drag the arrows at either 
end of the yellow line to place a line across the picture. This should match a measurement 
you have made across the same area of the real fabric.

Then enter the length of the line in the ’Length of displayed line’ text box, or use the up/
down arrows.

The length can be from 1mm to 300mm. The fabric tile must not be larger than 300mm x 
300mm, so a line that does not span the whole picture must be shorter than 300mm.

If the length would make the fabric tile larger than 300mm in either dimension, a message will appear. 
Repeat the process so that the tile is smaller.
Click OK and the measurement you entered will be shown next to the picture. Check that 
the line and the length matches the measurement you made of the real fabric. If desired, 
click and drag the arrows to place a new line and re-enter the line length.

When the line is measured correctly, click Next.

Drag the arrows to place the line

Input the length of the line



mySewnet™ Stitch Editor   Borders and Appliqué              103

Set Background Name
Use Set Background Name to save the finished appliqué fabric in a category and give it a 
name. The categories are the folder names you will see when browsing for existing 
backgrounds.

Background Name
If you started with an existing picture, the picture name will be shown by default as the 
name for the new background. If you scanned a new picture, it will not have a name so 
you will need to enter a name.

Fabric Category
The default category is My Fabrics. To choose a different category, browse among the 
folders in Fabrics.

Select from existing categories, or click Make New Category to provide the name of a new 
category.

Make New Category
To make a new category, click Make New Category, and enter a new folder name. Click OK 
to create the category.

The new category will be created as a subfolder for the currently selected type.
When make a new category, it will be available as a Fabric Category next time you use the 
Background Wizard.

Finish
Click Finish to save the new background with the specified name in the specified Fabric 
Category and close the Background Wizard. The selected or new background will be 
displayed in the Appliqué Selection dialog.

Select an existing category

Create a new category

Enter a background name
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Load Picture Wizard
Use the Load Picture Wizard to use a picture as an individual non-tiled appliqué 
background, for example for a printed appliqué memory piece.

To create a new picture in the Load Picture Wizard, in the Appliqué Selection dialog box select Picture, then 
click Select Picture.

Choose Picture

Use the Choose Picture page to select the picture you wish to use as a background.

Load Picture
Click Load Picture  to open a picture from your My Pictures folder. Alternatively, 
browse to a folder elsewhere on your computer. After selecting a picture, the preview box 
will show the selected picture with its name underneath.
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The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), PatternCAD (.4dq), Portable Network Graphics (.png), Tagged 
Image File Format uncompressed (.tiff., tif ), Windows Meta File (.wmf), Windows Enhanced 
Meta File (.emf ) and Windows Icon (.ico).

Load a Picture with the Viewer
1 Click Load a Picture  and the Picture Viewer dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted.
3 If desired, change the icon size to see more or fewer pictures.
4 Click on a picture to select it.
5 Click OK to open the picture with its name underneath.
6 Click Cancel to exit without selecting a picture.

Paste Picture
Click Paste Picture  to load the picture in the Clipboard Block. The picture is shown in 
the preview area.

Paste Picture is not available if the Clipboard Block is empty.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from a scanner, a digital camera or another suitable device. Only devices that use Windows 
Image Acquisition (WIA) can be used to obtain pictures.

WIA is a standard method for transferring pictures from the device’s scanning or downloading program to 
another program. If the manufacturer provides the appropriate software components needed for WIA 
compliance, these should have been installed when the device was installed. 
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the picture, it will be shown 
in the Choose Picture page.

Create New Picture and Edit Picture
Create a new picture  or edit an existing picture  in mySewnet™ Draw & Paint.

Preview and Name
Under the preview pane is a box for the name of the chosen file. If the picture is a scanned 
image then the box will contain the words Scanned Picture.

Next
Go to the Crop Picture page.



106          mySewnet™ Stitch Editor   Borders and Appliqué 

Rotate and Crop Picture

Use the Rotate and Crop Picture page to select the section of the picture that is to be used 
to create the appliqué background. If required, rotate the picture, and click and drag the 
boundary line of the crop area to select the desired part of the picture.

Click and drag anywhere inside the crop box to move the crop box.

If you need to expand a crop box again, make sure it is not touching the edge of the frame, as this will stop 
it expanding.
When the desired area is selected, click Finish.

Rotate
Rotate  the picture from 0 to 359 degrees. Adjust the picture angle as desired. This is 
often necessary with scanned pictures.

Enter the desired Rotation angle  or use the up/down arrows to change the angle. The 
preview will show the effect.

When the picture is rotated between the 90 degree steps, the picture is made larger and 
white background is added.

Select All and Automatic
Use Select All to select the whole of the picture. Use Automatic to set the crop lines back 
to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly. Drag the Stretch Picture  slider to make the 
picture in the Preview wider or narrower. Use Save Picture  to save your edited picture.
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Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Back
Return to the Choose Picture page.

Finish
Use the selected image for the appliqué

Appliqué Options
Use the Appliqué Options dialog box to select an 
Appliqué Method for appliqué placement, and set 
the Appliqué Piece Margin, the Running Stitch 
Length, and the Double Stitch Length.

Use the Appliqué Options when adding a border to an 
embroidery.

Appliqué Placement
When appliqué is created from a border shape, 
additional stitches are added at the beginning of 
the embroidery for placing appliqué fabric. Use 
these options to determine how these stitches are added. The border used to finish the 
appliqué uses line options for the selected border stitch type.

Appliqué Method
Choose the method for placing and securing the appliqué fabric.

■ Standard Appliqué
Stitch a running line to show where appliqué fabric should be placed, then stop to 
position the fabric. Stitch down the appliqué fabric with double stitch, then stop so the 
fabric may be trimmed. Finish the edges with the selected border stitching.

■ Pre-cut Piece
Use a pre-cut appliqué piece created, for example, using an automatic cutter or cutwork 
needles.
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Stitch a running line to show where the pre-cut appliqué piece should be placed, then 
stop to position the appliqué piece. Stitch down the appliqué piece with double stitch, 
then finish the edges with the selected border stitching.

■ Pre-placed Piece
Place the appliqué fabric before stitching.

Place the appliqué layer in position, then stitch down the appliqué fabric with double 
stitch. Stop so the fabric may be trimmed. Finish the edges with the selected border 
stitching.

■ Cut-out
Use the appliqué placement line as a guide to where the fabric should be cut; for example 
for reverse appliqué.

Stitch a double stitch line. Stop so the fabric may be cut to form a hole defined by the 
stitched outline. Finish the edges with the selected border stitching.

Appliqué Piece Margin
Set the margin for appliqué placement relative to the drawn border shape from -10mm to 
10mm. The initial value is 1.0mm.

Use a positive value when trimming the appliqué fabric before the border is stitched, for example with 
Standard Appliqué and Pre-placed Appliqué . A negative value is recommended for cut-out and reverse 
appliqué.

Match Placement Line
Adjust the position of the first running stitch line for either Standard Appliqué or Pre-cut 
Piece so that it matches the outline of the appliqué piece after the Appliqué Piece Margin 
has been applied.

This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated 
cutter, to ensure the placement line is visible.

Running Stitch Length
Set the length of running stitch used for the placement outline in the first and second 
appliqué methods, from 1 to 12mm in 0.1mm steps. The initial setting is 2.0mm.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.

Double Stitch Length
Set the length of double stitch used to stitch down the appliqué fabric, from 1 to 12mm in 
0.1mm steps. The initial setting is 2.0mm.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.
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View and Adjust Appliqué Pieces

Appliqué Piece
Use the Appliqué Piece functions to add appliqué fabric to an existing design with 
appliqué areas, and to adjust appliqué areas within a design.

Use Express Appliqué  to automatically find appliqué areas in some existing embroideries.

Change the Fabric in an Appliqué Embroidery
1 Open mySewnet™ Embroidery, and click the SuperDesign tab.
2 Select the Appliqué Category.
3 In the Children 1 SuperDesign set, select the 8th design, Happy Sun.

Use Style 1, with a satin line border.
4 Click Apply to place the sun embroidery in the work area. 

It has green handles, indicating that it is a SuperDesign.
5 In the Home tab, click Copy . The design is placed in the Clipboard block.
6 Open mySewnet™ Stitch Editor.
7 If there is an embroidery in the work area, click New .
8 In the Home tab, click Paste , and click Yes to continue. The sun design is placed in the work area.

If you click Select All Visible  you will see white or blue handles, indicating that it is now an embroidery. 
When a SuperDesign is copied and pasted between modules it is converted into an embroidery.

9 Click the Appliqué tab.
10 Click Next Piece . 

All of the appliqué functions are now available.
11 The points for the outer appliqué area should be highlighted. If 

not, click Next Piece  until they are.
12 Click and drag the square zigzag fabric handle . The fabric for 

the sun’s rays moves.
Use the Fabric Handle to move the origin point (center of design) of a 
tiled fabric. This handle  is only available for fabric tiles; you 
cannot rotate quick Appliqué or Pictures.

13 Click and drag the round handle. The fabric for the sun’s rays 
rotates.
The fabric rotates around the fabric handle (the origin point of the 
fabric tile).

14 Click Select Fabric . The Appliqué Selection dialog box opens.
15 To change the fabric, click Fabric in Appliqué Type, then click Load Previously Saved Fabric  and 

choose another fabric.
16 Click OK to close the Appliqué Selection dialog box.
17 Click Next Piece . The points for the inner appliqué area are highlighted. You can now change, 

move or rotate the central appliqué fabric.

Audition a fabric for the 

Delete an appliqué piece
Insert and Delete points in an appliqué area outline

Select an appliqué area, or move to another areaDefine the outline of an appliqué area
Cut a hole in an appliqué area

appliqué

Add fabric to an appliqué area automaticallyAppliqué Tab
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Appliqué Outline
Use the Appliqué Outline  functions to draw or place points to define a line of any 
shape to create an appliqué outline.

Freehand Appliqué Outline
Use Freehand Appliqué Outline  to draw a line of any shape to create an appliqué 
outline. 

Select a Color Command or Stop Command to start the appliqué piece from, then draw 
the outline. When hovering over a Color Command you will see the stitching that follows 
it. Release the mouse button to complete the line. Right-click, and the Appliqué Selection 
dialog box opens. Select a fabric, then click OK to place the Appliqué Piece.

Hold down Shift to place a corner point when creating or editing a line. Click Delete  on the Home tab to 
remove the last-placed point.

Shortcuts
■ Create, Appliqué Tab: 
■ Keys: Alt, A, AO, FT

Point Appliqué Outline
Use Point Appliqué Outline  to place points to define a line of any shape to create an 
appliqué outline. 

Select a Color Command or Stop Command to start the appliqué piece from, then place 
points to draw the outline. When hovering over a Color Command you will see the 
stitching that follows it. Right-click to finish, and the Appliqué Selection dialog box opens. 
Select a fabric, then click OK to place the Appliqué Piece.

Hold down Shift to place a corner point when creating or editing a line. Click Delete  on the Home tab to 
remove the last-placed point.

Shortcuts
■ Create, Appliqué Tab: 
■ Keys: Alt, A, AO, FP

Add an Appliqué Fabric to a Flower Bouquet Embroidery
1 Click Change Hoop . From the Universal Hoop Group, set the Hoop Size to 100mm x 100mm - 

Universal Square Hoop 1. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Appliqué Bouquet' .vp3 

format embroidery.
5 Click the View tab.
6 Ensure that Commands  is selected.
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7 In the Design Panel there are three green color blocks at the 
top of the worksheet. Use the pointer to highlight the names; 
they are all the same thread.
The appliqué stitch lines in this embroidery are marked by Color 
Commands rather than Stop Commands.

8 Below the Control Strip, click Draw Next Color Block . The 
running stitch line outlining the embroidery is shown, with a 
Color command  marker at the top.
Hover over the Color Command and you will see the stitching that 
follows it, which is the outline of the appliqué area.

9 In the bottom left corner of the window, click the up arrow 
next to the numbers box to the right. At the top of the 
embroidery a second Color command marker  appears.
This is the start of the stitch line that secures the appliqué fabric.

10 Click the Appliqué tab.
11 In the Appliqué Outline  drop-down menu, click Point Appliqué Outline .
12 Click the second Color command marker  (the upper one).
13 Click to place points just outside the outline of the appliqué 

area.
Hold down Shift to place a corner point, and click Delete  on the 
Home tab if you need to remove the last-placed point.
The second line of stitching lies just outside the first line, so add a 
slight margin for the fabric to be secured by this line.

14 Place the last point at the Color command where you started.
Don’t worry if your line is uneven; you can change it afterwards.

15 Move the points on the line to reshape it as desired.
16 Right-click. The Appliqué Selection dialog box opens.
17 In Appliqué Type, ensure that Quick is selected.
18 Click the arrow to the right of the Quick Colors, and select Fall 

from the drop-down menu.
19 Click the color in row 3, column 1 (a pale green).

20 Ensure that the Texture is set to Woven, then click OK. The appliqué piece can be seen in the work 
area, and the other appliqué options are available in the ribbon bar.

21 Below the Control Strip, click Draw All Stitches .
22 Click and drag any points in your appliqué line that lie outside the edge of the embroidery, so that 

none of the fabric overlaps.

You can use Insert Points  to add points to this line, and Delete Points  to remove any unwanted 
points.
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23 Click outside the embroidery. You can no longer see the outline of the 
appliqué piece.
Select Piece  is available. This indicates that the embroidery contains an 
appliqué piece.

24 Click Next Piece . Your appliqué piece is selected again.
25 Click Select Fabric . The Appliqué Selection dialog box opens again, 

with your selected fabric previewed.
Use the Appliqué Selection dialog box to change the fabric for existing 
appliqué. Audition new fabrics and visaulize the effect using the Apply 
button. 

26 Click Cancel to close the dialog box.
27 Click Design Player , then click Start  to play the design from the beginning. The appliqué is 

placed after the first line of running stitch, and before the second line.
You can also view the structure of the embroidery using the sliders on the Control Strip.

28 In the Quick Access toolbar, click Save As . 
29 Save the embroidery in your My Designs folder as Appliqué Bouquet with Fabric.vp4.

In .vp4 format the appliqué information is saved.
30 Close mySewnet™ Stitch Editor, then open it again.
31 Open the file you just saved. You can see the appliqué piece that you created.

Appliqué Hole
Use the Appliqué Hole  functions to draw or place points to define a line of any shape 
to create a hole within the selected appliqué area. Select the desired Appliqué Piece so its 
points are displayed, then draw the hole. 

Freehand Appliqué Hole
Use Freehand Appliqué Hole  to draw a line of any shape to create a hole within the 
selected appliqué area. 

Select the desired Appliqué Piece so its points are displayed, then draw a line to form the 
hole. Release the mouse button to complete the line. Any appliqué fabric is removed from 
the hole. Right-click to deselect.

Hold down Shift to place a corner point when creating or editing a line. Click Delete to remove the last-
placed point.

Shortcuts
■ Create, Appliqué Tab: 
■ Keys: Alt, A, AH, FT

Draw a Hole in an Appliqué Area
1 Click the Border tab, and click Add Appliqué.
2 Select the fabric of your choice, then use Border Shape  and 

draw an external border . See “Border Shape” on page 87.
3 Click the Appliqué tab.
4 In Appliqué Hole , select Freehand Appliqué Hole .

If Appliqué Hole is not available, click Next Piece to select the 
appliqué piece, then click Appliqué Hole.

5 Draw a circle in the middle of your appliqué area. The hole is 
created.

6 The Right-click to deselect Freehand Appliqué Hole.
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Point Appliqué Hole
Use Point Appliqué Hole  to place points to define a line of any shape to create a hole 
within the selected appliqué area. 

Select the desired Appliqué Piece so its points are displayed, then place points to draw a 
hole. Right-click, and any appliqué fabric is removed from the hole.

Hold down Shift to place a corner point when creating or editing a line. Click Delete to remove the last-
placed point.

Shortcuts
■ Create, Appliqué Tab: 
■ Keys: Alt, A, AH, FP

Express Appliqué
Use Express Appliqué  to automatically find appliqué stitches within the visible stitches 
of some existing embroideries, and apply an appliqué fabric to them.

Multiple appliqué areas can be detected in the same subdesign. Use the selection tools and Control Strip to 
hide areas where you don’t want appliqué added.
In the Appliqué window, select an appliqué embroidery with no fabric, click Express 
Appliqué , then add a fabric in the Appliqué Selection dialog box. Optionally, adjust the 
overlap margin.

Express Appliqué detects the pattern of Stop and Color Change Commands used with appliqué placement 
stitches, and inserts appliqué fabric in that area. If an appliqué area is not detected automatically, use 
Freehand Appliqué Outline or Point Appliqué Outline to define it.

Shortcuts
■ Create, Appliqué Tab: 
■ Keys: Alt, A, Q

Add Appliqué to a Sun Embroidery
1 Click Change Hoop . From the Universal Hoop Group, set the Hoop Size to 200mm x 200mm - 

Universal Square Hoop 3. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 Browse to the folder 

Documents\mySewnet\Samples\ 
Embroidery\Stitch and load the embroidery 
'Sunshine Applique Large with Lettering'. The 
design contains three subdesigns.
Click Yes when told that the design will be fixed 
as stitches. The lettering is the part of the design 
that will be fixed as stitches.

5 In the Home tab, click to select the first 
subdesign in the Design Select area (the sun 
embroidery).
This is the part of the design with an appliqué 
area.

6 Click the Appliqué tab.
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7 Click Express Appliqué . The Appliqué 
Selection dialog box opens so you can choose a 
fabric for your appliqué.
Express Appliqué detects the pattern of Stop and 
Color Change Commands used by appliqué 
placement stitches and inserts appliqué fabric in 
that area.

8 In Appliqué Type, click Fabric.
9 Click Load Previously Saved Fabric  to load 

a fabric in the Picture Viewer.
10 Browse to the folder General\Lattice.
11 Click the fabric Lattice 1 - 18, then click OK. The 

Picture Viewer will close and the fabric will be 
shown in the Appliqué Selection dialog box.
If desired, adjust the Appliqué Piece Margin.

12 Click OK to close the Appliqué Selection dialog box. The fabric is shown under the sun’s face, as if you 
had stitched it down as an appliqué.
You may have to delete some additional appliqué pieces.

13 In the Quick Access toolbar, click Life View .
14 Move the Zoom Bar slider to the right so that you can see the 

embroidery clearly.
Note that the threads for the sun’s face and lettering are white.

15 Click Solar Reactive . The white threads turn yellow and 
orange.

16 In the Quick Access toolbar, click Save As  and save the 
embroidery with the appliqué and background as ’Sunshine 
Applique Large with Lettering and Applique’.
The sun and lettering will be stored separately within this multipart 
embroidery, making further adjustment easier.

Select Piece
Use Select Piece  to select an Appliqué Piece to alter its shape and preview or adjust its 
fabric. 

Click Select Piece , and then click the desired Appliqué Piece.

Shortcuts
■ Select, Appliqué Tab: 
■ Keys: Alt, A, SP

Next Piece
Use Next Piece  to select the next Appliqué Piece in the stitchout order. 

Next Piece will select an appliqué piece even if no appliqué piece is currently selected.

Shortcuts
■ Select, Appliqué Tab: 
■ Keys: Alt, A, N

Previous Piece
Use Previous Piece  to select the previous Appliqué Piece in the stitchout order.



mySewnet™ Stitch Editor   Borders and Appliqué              115

Previous Piece will select an appliqué piece even if no appliqué piece is currently selected.

Shortcuts
■ Select, Appliqué Tab: 
■ Keys: Alt, A, P

Select Appliqué Pieces
1 Open mySewnet™ Embroidery, and click the SuperDesign tab.
2 Select the Appliqué Category.
3 In the Children 1 SuperDesign set, select the 5th design, Blocks.

Use Style 1, with a satin line border.
4 Click Apply to place the ABC blocks in the work area. 

The embroidery has green handles, indicating that it is a SuperDesign.
5 In the Home tab, click Copy . The design is placed in the Clipboard block.
6 Open mySewnet™ Stitch Editor.
7 In the Home tab, click Paste , then click Yes to continue. The blocks appear in the work area.
8 Click the Appliqué tab.

Note that the Select Piece icon  is available. This indicates that there is 
at least one apppliqué piece in the embroidery.

9 Click Select Piece , then click the A block. The points outlining the 
appliqué appear.

10 Click and drag one of the points to change the shape of the appliqué.
Note that you can change the shape of the appliqué area, but this does 
not affect the satin border.

11 Click Undo  to return to the original shape.
You can also use the Fabric Handle  to change the position and 
rotation of the fabric.

12 Click Next Piece . The letter C block is now selected.
13 Click Previous Piece  twice. First the A and then the B are selected.
14 Click Delete Piece . The appliqué fabric for the B block is removed, leaving the border lines for the 

block.

Insert Points
Use Insert Points  to add new points into the currently selected Appliqué Piece. 

Select the desired appliqué piece, then click Insert Points . The pointer changes to the 
plus pointer . Click to add a point to the outline of the selected area. Right-click to finish 
adding points.

Hold down Shift to place a straight line or corner point. Click Undo  to remove the new point.

Shortcuts
■ Edit, Appliqué Tab: 
■ Keys: Alt, A, I

Delete Points
Use Delete Points  to delete points from the currently selected Appliqué Piece. 

Select the desired appliqué piece, then click Delete Points . The pointer changes to the 
minus pointer . Click to remove a point from the outline of the selected area. Right-click 
to finish deleting points.
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Click Undo  to replace a deleted point.

Shortcuts
■ Edit, Appliqué Tab: 
■ Keys: Alt, A, DP

Delete Piece
Use Delete Piece  to delete the currently selected Appliqué Piece with its outline. 

Select the desired appliqué piece, then click Delete Piece . The appliqué piece is 
removed from the design.

Shortcuts
■ Edit, Appliqué Tab: 
■ Keys: Alt, A, DE

Select Fabric
Use Select Fabric  to audition a fabric for the selected appliqué piece in the Appliqué 
Selection dialog box. 

Select the desired appliqué piece, then click Select Fabric  and the Appliqué Selection 
dialog box appears. See “Appliqué Selection” on page 95.

Shortcuts
■ Edit, Appliqué Tab: 
■ Keys: Alt, A, SF

Export Appliqué
Use Export Appliqué Pieces  in the File menu to save or print appliqué outlines ready 
for cutting. 

There are five export methods: save as SVG, DXF of FCM files for use in fabric cutters, save 
as VP4 or VP3 stitch files for use with INSPIRA™ Cutwork Needles, print as an outline 
template to cut around, print directly onto printable fabric or an iron-on transfer (this 
prints the image of the appliqué piece), or save as SVG files with the fabric image placed as 
the fill for each shape (for use with fully customized layouts).

See “Export Appliqué Pieces” on page 24 for more information.
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Border and Appliqué Techniques
There are many ways the Border/Appliqué functions can be used creatively.

Decorative Shapes
Use the Overlay option to simply add border or appliqué shapes as decorative additions to 
an embroidery. With the Overlay option, shapes can be added to the embroidery in any 
position. Hence, several small border or appliqué shapes can be added to the sides, such 
as the small hearts in the picture below.

Alternatively, add overlays within the embroidery to surround elements of the design.

Appliqué Patch within Bordered Embroidery
First create an External Border around the embroidery. Then create either an Internal 
Border with appliqué or an Overlay Border with appliqué. 

If an Overlay Border with appliqué had been used in the example above, the Curly Lace 
embroidery would also have stitched over the appliqué fabric in the center, giving a 
different effect. With other border shapes, it will also be effective to place the appliqué 
shape towards a corner or edge of the External Border.

Multiple Appliqué Patches
Create as many appliqué areas as desired. When stitching out, the appliqué fabric inserts 
are placed in the reverse order to the order the appliqué areas were created.

If you wish to have overlapping appliqué areas, it is recommended to select the second appliqué method in 
Appliqué Options, as this will show the changes to the shapes of overlapped areas when you stitch out the 
embroidery. It is also recommended to play through the embroidery, with Stitch Player, the slider bars, or 
the Design Player so that you can anticipate the order in which the appliqué areas will be created.
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Drawing Border Shapes as the Design
Start a New embroidery. Draw the first border shape as 
desired, then Create External Border. A new embroidery 
is created that only consists of the border. Add further 
border shapes as desired, generally using the Overlay 
Border option. Use the Select functions with Copy and 
Paste to make identical copies of the same shape. Use 
External and Internal border where you wish to cut 
through previously created border shapes.

A new embroidery is created each time a new border is created, so 
you can return to any stage of the creative process to try different 
ideas.

Double Border
Create the same border shape twice, one around the other, 
to make a double border. This is effective as an alternative 
type of frame, and works best with simple border shapes. 
Create the inner border first. This effect looks best if the 
border width and the gap between the double borders are 
approximately the same.

Border Donut
For this effect, create a small Internal Border and a large 
External Border. Hence, a small hole is cut from the middle of the overall embroidery 
shape, like the hole in a donut. This is particularly effective with lightly stitched fill effects 
created using Object editing features, or in mySewnet™ Digitizing.
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Double Layer Appliqué
Use this to create double layers of appliqué fabric 
using a smaller inner appliqué shape over a large 
outer appliqué shape. Draw the inner appliqué 
shape first. This can be created with any of the 
appliqué options to give different effects. Then 
create the outer appliqué shape, usually as External 
Border with appliqué. When stitching out, the larger 
piece of appliqué fabric is stitched down first and 
trimmed, and then the inner piece is placed over it.

Stamps on a Thick Border
This is ideal for adding text and simple stamps, 
while also framing an embroidery. Use a wide 
External Border, that is 8 to 10mm wide. Then use 
the text stamping (here Segoe Script, Regular 144) 
found on the Emboss tab to create writing on the 
border. Use other stamps and Freehand/ Point 
Emboss Line for additional decoration.



120          mySewnet™ Stitch Editor   Colors 

7Colors

Quick Colors
Use the Quick Colors palette to select the nearest matching 
color in the current range to the color that you pick. Use one of 
the theme palettes: Standard, Spring, Summer, Fall, Winter, or 
create your own palette.

Quick Colors are used for thread colors, Felting Needle colors, 
and appliqué fabric colors.

Quick Color Themes
Use Quick Color Themes for quick selection of colors using a related set of colors. Create 
your own Quick Color Themes, which are available for selecting thread colors in the Color 
Selection dialog box in most mySewnet™ Embroidery Software modules. Also use Quick 
Color Themes to set fabric colors in the Appliqué Selection dialog box.

Select a Quick Color
1 Open a dialog box with the Quick Colors area, such as the Color 

Selection box.
2 Click the drop-down menu to the right of the Quick Colors to choose a 

Quick Color Theme.
In this menu you can also select Edit Themes to create a new theme, or 
edit a Custom theme.

3 Click the desired Quick Color. The nearest shade that is available from 
the current range will be selected. 
This is also a quick way to jump to threads or fabrics of that color (for example, click light yellow in the 
Standard Theme to jump to light yellow shades).

Select a Theme

Delete a custom ThemeCreate a new custom Theme

Give your Theme a name

Choose a color block to edit
Edit the selected color
Apply your changes

Color sample box

Copy a color to the sample box
Paste the sample box color

Replace all colors with the
sample box color
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Add a Quick Color Theme
You can add or customize your own Quick Colors themes in the Color Selection or the 
Appliqué Selection dialog box in most mySewnet™ Embroidery Software modules.

1 Open a dialog box with the Quick Colors area, such as the Color Selection box.
2 Click the drop-down menu to the right of the Quick Colors and select Edit Themes... The Edit Quick 

Color Themes dialog box opens.
Note that if one of the system Themes is selected, the editing options will be unavailable (grayed out).

3 Select a Theme from the drop-down menu at the top.
Your new Theme will be based on the colors in this theme.

4 Click the Add New button. A new theme ’Untitled’ appears.
5 Give your new theme a name, then click Apply. 

You can now select your new theme from the drop-down list at 
the top.

6 Select a color in the palette.
7 Click the Edit Color button. The Colors dialog box appears. See 

“Colors Dialog Box” on page 123.
8 Choose a new color from the Standard or Custom tab, then click 

OK. Your chosen color will replace the original color.
9 To copy a color, select a color in the palette, then click Copy 

Color. Your selected color will appear in the Color Box.
10 To paste the color in the Color Box, select a color in the palette, 

then click Paste Color. The color in the palette will be replaced.
11 To replace all colors in the palette, click Paste To All.
12 Click Apply to save the changes to your new Quick Color 

Theme.
13 Click Close to finish editing your new Theme.

To make further edits to your theme, select Edit Themes in the Quick Colors Theme menu.

Edit Quick Color Themes

Theme
Select a Theme from the drop-down list. 

Any new Theme will be based on the colors in this theme.

Add New
Click Add New to create a new theme.

Delete Theme
Click Delete Theme to remove a custom Theme.

You cannot delete system Themes.

Name
Enter the desired theme name.

Theme Colors
Click a color in the grid and a box will appear around the selected 
color.
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Edit Color
Click Edit Color to change the currently selected color in the Colors Dialog Box. 
Alternatively, double-click a color to change it in the Colors Dialog Box.

Apply
Click Apply to save the changes you have made.

Copy Color
Click Copy Color to place the color in the color sample box, to the right of the button.

Use the color sample box to copy a color from one theme to another.

Paste Color
Click Paste Color to replace the color in the currently selected grid position with the color 
in the sample box.

Paste To All
Click Paste To All to place the color in the sample box in all the grid positions. This is useful 
when starting a new Theme if you wish to vary the Theme around a single initial color.

Close
Click Close to finish editing the new theme. The new theme is added to the end of the 
Theme list.

You will be asked if you want to save any changes you have made, if you have not clicked Apply.

Change a Quick Color Theme
Select an existing Quick Color Theme you wish to change from the Theme drop-down list, 
then click Edit Theme.

The predefined Quick Color Themes may not be edited. However, you may use any predefined theme as the 
basis for a new theme.
The options are the same as when you Add a Quick Color Theme. See “Edit Quick Color 
Themes” on page 121.

Delete a Quick Color Theme
1 In the Edit Quick Color Themes dialog box, use the Theme drop-down list to select the Theme you 

wish to remove. 
2 Click Delete Theme. A message will appear to remind you that this action may not be reversed. 
3 Click Yes and the theme will be deleted.

The predefined Quick Color Themes may not be deleted.
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Colors Dialog Box
The Colors dialog box is used to choose or change 
a color for a thread or fabric, or modify any color in 
a Quick Colors Custom theme.

When the Colors dialog box appears, it shows the 
Standard color selection. If desired, click one of 
the Standard colors. A highlight shows the 
selected color. The New/Current box shows the 
difference between the newly chosen color and 
the color currently used.

Click the Custom tab to be able to select any of 
the 16 million RGB colors.

Click in the blended color palette to choose a 
basic color, then use the slider at the side to 
choose the desired brightness level. The HSL and 
RGB values are updated as you change the color 
and the color is previewed in the New/Current 
box.

You can also directly enter Hue, Sat(uration), 
Lum(inance) (HSL) and/or Red, Green, Blue (RGB) 
values. Alternatively, use the up/down buttons on 
each of the HSL and RGB value boxes to make fine 
adjustments to the color.

Color Models

Hue, Saturation, Luminance (HSL) Color Model
Hue is the color (red, yellow, green, or blue) for the selected color, expressed as a value 
between 0 and 239. Saturation (Sat) is the strength or purity of color in a specified hue. 
This is related to the amount of gray in it and is measured from 0 (completely gray) up to a 
maximum of 240 (no gray). The higher the saturation, the purer or more vivid the color. 
Luminosity (Lum) is the intensity of lightness or darkness in a color, specified by a value 
between 0 (black) and 240 (white). If Saturation is 0, the Luminosity setting specifies a 
shade of gray.

Red, Green, Blue (RGB) Color Model
The RGB model, one of the Additive Color models, is used on computer monitors. It has 
three primary colors — red, green, and blue — that it creates by emitting light. These 
three colors are combined in various proportions to produce all the colors displayed on 
your screen. They are referred to as additive because they combine to produce white. 
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Primary colors are measured as a value from 0-255. The colors produced by combining the 
three primaries are a result of the amount of each of those shades present. For example, 
pure red has a red value of 255, a green value of 0, and a blue value of 0. Yellow has a red 
value of 255, a green value of 255, and a blue value of 0. If Red, Green and Blue are set to 
zero, the color is black; if all three are 255, they produce white.
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8Morphing and Cutwork

Point Morphing
The point morphing effects change the positions of stitches around the point where you 
click. You do not need to click directly on stitches in order to affect them. 

The effect is strongest at the point clicked and gets weaker with distance. Only visible stitches are affected.

Magnet
Use Magnet  to pull stitches in towards the point where you click.

Click Magnet, then click the required points on the embroidery to morph stitches around 
those points. Right-click to deselect.

Shortcuts
■ Morphing, Modify Tab: 
■ Keys: Alt, M, MA

Polarize
Use Polarize  to push stitches away from the point where you click. This does not 
reverse the effects of a previously applied Magnet.

Click Polarize, then click the required points on the embroidery to morph stitches around 
those points. Right-click to deselect.

Shortcuts
■ Morphing, Modify Tab: 
■ Keys: Alt, M, P

Twirl
Use Twirl  to move stitches around the point where you click, like a swirling spiral. Twirl 
moves the stitches clockwise around the click point, or hold Shift and click for a counter-
clockwise Twirl.

Click Twirl, then click or shift-click the required points on the embroidery to morph 
stitches around those points. Right-click to deselect.

Shortcuts
■ Morphing, Modify Tab: 
■ Keys: Alt, M, TW

Wave
Use Wave  to move stitches in a wave pattern around the point where you click. The 
effect of Wave is usually clearest on straight lines of stitch points.

Click Wave, then click the required points on the embroidery to morph stitches around 
those points. Right-click to deselect.
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Shortcuts
■ Morphing, Modify Tab: 
■ Keys: Alt, M, W

Twirl the Border of a Heart Embroidery
1 Click File, New  to open a new window.
2 Click Change Hoop . From the Universal Hoop Group, set the Hoop Size to 240mm x 150mm - 

Universal Large Hoop 2. Set the Orientation to Rotated. Click OK.
3 In the Quick Access toolbar, click Insert .
4 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Lace Heart' embroidery.

Alternatively, you could use the embroidery you created in “Cut a Heart Border Shape from Lace” on 
page 87.

5 In the color worksheet on the Design Panel, click the check box for the first color to hide the thread 
color for the lace. This ensures the lace will not be affected by the Twirl function.

6 Click the Modify tab.
7 In the Morphing area, click the Twirl  icon.
8 Starting from the central top point of the heart, move the mouse pointer along the inside of the 

border, about two grid squares up and to the right.
See the pictures below for more details.

9 Hold down the Shift key on the keyboard. Click once and the border next to the pointer will be 
twirled into a scallop-like shape. Release the Shift key on the keyboard.

10 Move the pointer horizontally across, so that it is just inside the border on the left, opposite the twirl 
that you placed on the right. 

11 Click once and the border will be twirled into a scallop-like shape on the left side. However, the 
scallop is created in the opposite direction.

When you click, the stitches are twirled clockwise. When you hold down Shift and click, the stitches are 
twirled counter-clockwise. Twirl is the only morphing function that is affected by holding down the Shift 
key.

12 Hold down the Shift key. On the right side of the inside of the heart, move the pointer about two grid 
squares up and around the inside of the border from the first scallop and click again. 

13 Keep the Shift key held down, and continue to click around the inside of the right half of the heart 
border.
It is not important to twirl as frequently as in the example, as this is for practice with using the Twirl 
function. However, try to space the twirls evenly.
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14 Click to place the last twirl a few grid squares 
from the point at the bottom of the heart, then 
release the Shift key.
If you wish to undo a Twirl you have just made, 
click Undo  and try again.

15 On the left side of the heart, move the pointer 
about two grid squares around the inside of the 
border from the first scallop and click. Continue 
to click around the inside of the left half of the 
heart border. 

16 Click to place the last twirl a few grid squares 
from the point at the bottom of the heart.

17 Right-click to deselect the function.
18 Click Draw All Stitches .

Global Morphing
Use Global Morphing  to move all the visible stitches to change the shape and size of 
the embroidery. Choose any of the following global effects:

Depending on the Morphing effect selected, move one or two slider bars, or type in a 
number, to adjust the intensity or height and frequency for the effect. The Before and 
After boxes show the original stitches and a preview of the effect.

Pinch
Pinch the stitches 
together in the center, 
while pulling the outer 
stitches away from 
each other

Ripple
Apply a wave pattern 
radiating from the 
center, like dropping 
a stone into a pond.

Skew Horizontal
Slant the stitches 
horizontally to the 
left or right.

Skew Vertical
Slant the stitches 
vertically up or down.

Spherize
Stretch the stitches 
around an imaginary 
sphere.

Twirl
Twist the stitches 
around the center, 
creating a swirling 
effect like a whirlpool

Wave Horizontal
Move the stitches to 
follow a horizontal 
wave pattern.

Wave Vertical
Move the stitches to 
follow a vertical wave 
pattern
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All visible stitches are morphed by the chosen effect. Global Morphing may not be used 
when a block of stitches is selected.

Global Morphing effects are generally more pleasing when applied to an embroidery that is mainly or 
completely symmetrical.
The last effect used and the last settings for each effect are remembered for the current 
mySewnet™ Stitch Editor session.

This function works on the entire visible area. Hide colors and use Draw Range to isolate an area of the 
embroidery if you do not wish to affect the whole embroidery.

Shortcuts
■ Morphing, Modify Tab: 
■ Keys: Alt, M, G

Zoom Controls
Use the Zoom Controls to zoom in and out, zoom to fit and show the 
Before and After views at Real Size. The preview changes in real time when 
you adjust the settings.

Zoom In
Use Zoom In  to enlarge the view of an area of the Before and After 
views.

Click Zoom In  and move the pointer over the Before or After view. The mouse pointer 
changes to the zoom in pointer . Then either click a point on the view you want to 
zoom in towards, or click and drag a rectangle around the area you want to zoom in to and 
release the mouse button to zoom.

When zoomed in, use the scroll bars to move around the Before and After views.

Select a morphing effect

Zoom in and out

Adjust the settings 
for the effect

View the changes
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Zoom Out
Use Zoom Out  to zoom out of the Before and After views, to show more of the 
embroidery in each view.

Click Zoom Out  and move the pointer over the Before or After view. The mouse pointer 
changes to the zoom out pointer . Then click a point on the Before or After view you 
want to zoom out from.

Zoom To Fit
Click Zoom To Fit  to view all of the stitches in the Before and After views.

Real Size
Click Real Size  to show the Before and After views at the Real Size selected in 
mySewnet™ Configure.
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Pinch
Pinch the stitches together in the center, while pulling the outer stitches away from each 
other.

Intensity
Adjust the Intensity from 0 to 100. The higher the number, the more the stitches are 
Pinched.

Morph a Flower with Pinch
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Yellow Twist' 

embroidery.
4 Click the Modify tab.
5 Click Global Morphing  and the Global Morphing Effects dialog box will appear.
6 At the top left of the screen, click the drop-down arrow to the right of the currently selected effect 

and select Pinch.
7 Click and drag the Intensity slider bar to 40. The Before and After boxes show the original stitches and 

a preview of the effect.
Alternatively, click in the Intensity box and enter a number. You can set Intensity between 0 and 100. 

8 Click OK and the visible stitches will be pinched.
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Ripple
Apply a wave pattern radiating from the center of the visible stitches, like dropping a 
stone in a pond.

Height
Adjust the Height from -100 to +100. The higher the number, the larger the size of the 
ripples. Negative values reverse the peaks and troughs of the waves.

Frequency
Adjust the Frequency from 1 to 100. This changes the number of ripples radiating from the 
center.

Morph a Flower with Ripple
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Yellow Twist' 

embroidery.
4 Click the Modify tab.
5 Click Global Morphing  and the Global Morphing Effects dialog box will appear.
6 At the top left of the screen, click the drop-down arrow to the right of the currently selected effect 

and select Ripple.
7 Click and drag the Height slider bar to 25. The After preview will be updated as you move the slider 

bar. Alternatively, enter the number in the Height box.
You can set the Height between -100 and +100.

8 Click and drag the Frequency slider bar to 75. The After preview will be updated as you move the 
slider bar.
You can set the Frequency between 1 and 100.

9 Click OK and the flower will be morphed.
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Skew Horizontal
Slant the stitches horizontally to the left or right.

Intensity
Adjust the Intensity from -100 to +100. The higher the number, the greater the slant. 
Negative values slant the stitches to the left and positive values slant the stitches to the 
right.

Morph a Flower with Skew Horizontal
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Yellow Twist' 

embroidery.
4 Click the Modify tab.
5 Click Global Morphing  and the Global Morphing Effects dialog box will appear.
6 At the top left of the screen, click the drop-down arrow to the right of the currently selected effect 

and select Skew Horizontal.
7 Click and drag the Intensity slider bar to 15. The After preview will be updated as you move the slider 

bar. Alternatively, enter the number in the Intensity box.
You can set the Intensity between -100 and +100.

8 Click OK and the flower will be morphed.
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Skew Vertical
Slant the stitches vertically up or down.

Intensity
Adjust the Intensity from -100 to +100. The higher the number, the greater the slant. 
Negative values slant the stitches down and positive values slant the stitches up.

Morph a Flower with Skew Vertical
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Yellow Twist' 

embroidery.
4 Click the Modify tab.
5 Click Global Morphing  and the Global Morphing Effects dialog box will appear.
6 At the top left of the screen, click the drop-down arrow to the right of the currently selected effect 

and select Skew Vertical.
7 Click and drag the Intensity slider bar to -15. The After preview will be updated as you move the slider 

bar. Alternatively, enter the number in the Intensity box.
You can set the Intensity between -100 and +100.

8 Click OK and the flower will be morphed.
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Spherize
Stretch the stitches around an imaginary sphere.

Intensity
Adjust the Intensity from 0 to 100. The higher the number, the more rounded the stitches 
become.

Morph a Flower with Spherize
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Yellow Twist' 

embroidery.
4 Click the Modify tab.
5 Click Global Morphing  and the Global Morphing Effects dialog box will appear.
6 At the top left of the screen, click the drop-down arrow to the right of the currently selected effect 

and select Spherize.
7 Click and drag the Intensity slider bar to 35. The After preview will be updated as you move the slider 

bar. Alternatively, enter the number in the Intensity box.
You can set the Intensity between 0 and 100.

8 Click OK and the flower will be rounded.
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Twirl
Twist the stitches around the center of the visible stitches, creating a swirling effect like a 
whirlpool.

Intensity
Adjust the Intensity from -100 to +100. The higher the number, the more extreme the 
swirling effect. Negative values twirl the stitches counter-clockwise, while positive values 
twirl the stitches clockwise.

Morph a Flower with Twirl
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Yellow Twist' 

embroidery.
4 Click the Modify tab.
5 Click Global Morphing  and the Global Morphing Effects dialog box will appear.
6 At the top left of the screen, click the drop-down arrow to the right of the currently selected effect 

and select Twirl.
7 Click and drag the Intensity slider bar to -25. The After preview will be updated as you move the slider 

bar. Alternatively, enter the number in the Intensity box.
You can set the Intensity between -100 and +100.

8 Click OK and the flower will be twirled.
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Wave Horizontal
Move the stitches to follow a horizontal wave pattern.

Height
Adjust the Height from -100 to +100. The higher the number, the larger the size of the 
waves. Negative values reverse the peaks and troughs of the waves.

Frequency
Adjust the Frequency from 1 to 100. This changes the number of waves across the stitches.

Morph a Flower with Wave Horizontal
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Yellow Twist' 

embroidery.
4 Click the Modify tab.
5 Click Global Morphing  and the Global Morphing Effects dialog box will appear.
6 At the top left of the screen, click the drop-down arrow to the right of the currently selected effect 

and select Wave Horizontal.
7 Click and drag the Height slider bar to 50. The After preview will be updated as you move the slider 

bar. Alternatively, enter the number in the Height box.
You can set the Height between -100 and +100.

8 Click and drag the Frequency slider bar to 65. The After preview will be updated as you move the 
slider bar.
You can set the Frequency between 1 and 100.

9 Click OK and the flower will be morphed.
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Wave Vertical
Move the stitches to follow a vertical wave pattern.

Height
Adjust the Height from -100 to +100. The higher the number, the larger the size of the 
waves. Negative values reverse the peaks and troughs of the waves.

Frequency
Adjust the Frequency from 1 to 100. This changes the number of waves across the stitches.

Morph a Flower with Wave Vertical
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Yellow Twist' 

embroidery.
4 Click the Modify tab.
5 Click Global Morphing  and the Global Morphing Effects dialog box will appear.
6 At the top left of the screen, click the drop-down arrow to the right of the currently selected effect 

and select Wave Vertical.
7 Click and drag the Height slider bar to -80. The After preview will be updated as you move the slider 

bar. Alternatively, enter the number in the Height box.
You can set the Height between -100 and +100.

8 Click and drag the Frequency slider bar to 30. The After preview will be updated as you move the 
slider bar.
You can set the Frequency between 1 and 100.

9 Click OK and the flower will be morphed.
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Add Cutwork Needle Lines
Use the Cutwork  features to draw a cutwork needle line within your design, optimized 
for the INSPIRA™ Cutwork Needle Kit. There are two cutwork options:

■ Freehand Cutwork Line 
■ Point Cutwork Line 

Use cutwork needle lines for reverse appliqué embroideries and free-standing lace, or 
simply to cut out a shape or design.

About Cutwork Needle Lines
The stitch points for cutwork needle lines are very close together (0.3mm). 

Where two cutwork needles are used, the two lines are represented by the colors red and 
yellow. Where four needles are used, the four lines are red, yellow, green and blue. The 
gaps in these lines represent the secure points.

Surrounding the cutwork lines are the more widely spaced points for the stabilizing line. 
(As the points for the cutwork lines are placed on top of each other, you cannot see the 
separate lines.)

Use the Move and Merge functions for Color Blocks when changing the order of designs with multiple 
areas of cutwork and stabilizing lines, as ColorSort may occasionally merge stabilizing lines in these 
circumstances.

Freehand Cutwork Line
Use Freehand Cutwork Line  to draw a line to be cut using cutwork needles. Create two 
or four needle lines automatically, with secure points and stabilizing lines according to the 
settings in Cutwork options.

Draw a line, then release the mouse button to finish the line. The line is closed 
automatically to form a shape. Move the nodes to adjust the line. Click Delete to remove 
the last-placed point. Right-click to place the line on the work area.

If the desired line is not achieved when created initially, either redo the line or select and move the nodes as 
desired.
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Shortcuts
■ Cutwork, Modify Tab: 
■ Keys: Alt, M, CL, FT

Create a Freehand Cutwork Line
1 In the Quick Access toolbar, click Insert  and open a design.
2 Open the Modify tab.
3 In the Cutwork Line  menu, click Freehand Cutwork Line . The pointer changes to the draw 

pointer .
4 Draw a line on the work area, then release the mouse button. 

When you release the mouse button the line is drawn as a closed line (a loop) with nodes.
5 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 

pointer . Adjust the node as desired.
Use Shift+click to change a round node to a square node, to make the line straight.
Click Delete to remove the last–placed point.

6 Right-click to deselect Freehand Cutwork Line. The cutwork line is placed on the work area.
The points for the cutwork needle and stabilizing lines are inserted automatically, along the line that you 
drew.

Point Cutwork Line
Use Point Cutwork Line  to place points to define a line to be cut using cutwork 
needles. Create two or four needle lines automatically, with secure points and stabilizing 
lines according to the selected Cutwork options.

Click to insert points for the line, then adjust the nodes as desired, or place more points. 
Click Delete to remove the last-placed point. Right-click to place the line on the work area.

If the desired line is not achieved when created initially, either redo the line or select and move the group 
area of stitch points you wish to change.

Shortcuts
■ Cutwork, Modify Tab: 
■ Keys: Alt, M, CL, FP

Create a Point Cutwork Line
1 In the Quick Access toolbar, click Insert  and open a design.
2 Open the Modify tab.
3 In the Cutwork Line  menu, click Point Cutwork Line . The pointer changes to the Point 

pointer .
4 Click to place a series of points for the line.

As you click the third point on the line, the line becomes closed (it becomes a loop). As you place more 
points the line adjusts itself.
The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.

5 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 
pointer . Adjust the node as desired.
When the Move Node pointer is active you can adjust existing nodes.
Use Shift+click to change a node to a square node for a straight line.

If you click while the Point pointer  is active, another point will be added to the line.
Click Delete to remove the last–placed point.

6 Right-click to deselect Point Cutwork Line. The cutwork line is placed on the work area.
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The points for the cutwork needle and stabilizing lines are inserted automatically, along the line that you 
placed.

Cutwork Options
The cutwork needle features allow you to draw a cutting line within a design, optimized 
for the INSPIRA™ Cutwork Needles. Use two or four cutwork needles, add secure points for 
fabric stability, and add a stabilizing line.

Method
Choose between:

■ 2 Cutwork Needles
■ 4 Cutwork Needles

Choose between 2 Cutwork Needles and 4 Cutwork Needles. 

By default 2 needles is selected.

With 2 needles, a bladed needle set at one angle is used to cut around the shape, and then the second 
needle travels around the shape cutting at a different angle.
With 4 needles a more precise cutting method is used, where each needle is used for the section of the 
shape that closely matches its angle. This method is recommended for more delicate fabrics.

Cutwork Line

Include Secure Points
Select Include Secure Points to create gaps in the cutwork needle line. By default Include 
Secure Points is selected.

This allows the cut fabric to remain attached for stability while all the cutwork needle lines are created. 
Afterwards it can be easily trimmed with scissors.

Distance Between Secure Points
Set the Distance Between Secure Points from 10mm to 100mm in steps of 1mm. The initial 
setting is 30mm.
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Stabilizing Line
Insert a stabilizing line of stitching before and/or after the cutwork line. This may be 
helpful for reverse appliqué or free-standing lace, but is not required if you are simply 
cutting out a shape.

Before Cutwork Line
By default Before Cutwork Line is selected.

After Cutwork Line
By default After Cutwork Line is selected.

Stitch Length
Set the Stitch Length from 1.0 to 6.0mm in 0.1mm steps. The default setting is 2mm.

Distance from Cutwork Line
Set the distance of the stabilizing line from the cutwork line from 0.1 to 10.0mm in 0.1mm 
steps. The default setting is 1.0mm.

Cutwork Racket
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click  Change Hoop . 
3 In the Universal Hoop Group, set the Hoop Size to 100mm x 100mm - 

Universal Standard Hoop 1. Click OK.
4 In the Quick Access toolbar, click Insert .
5 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch, 

open the embroidery Racket.vp4.
6 Look at the Color Select area of the Control Panel. There are two 

thread colors in the worksheet.
7 In the Control Strip, click Start , and then click Play  to use the 

Stitch Player to play through the embroidery as if it was being 
stitched. The handle and shaft of the racket are stitched out before the strings and head.
This will enable a cutwork line to be placed before the strings and head.
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8 Click Draw All Stitches .
9 Slowly move the slider for the End to the left. 

As you move the slider, some of the stitches 
forming the head of the racket and the 
strings are hidden.
The Draw Range enables you to insert stitches 
(or in this case a cutwork line) into a design. 
However, to work accurately you need to be 
able to see where the stitches after the cutwork 
line will be placed.

10 Click Ghost Mode . 
The stitches that were hidden are now white.

11 Move the End slider to the left to where the 
stitches move into the strings for the racket, 
approximately stitch number 504.
If needed, click the arrows on the number boxes 
below the slider bar to show or hide stitches one 
at a time.
This is where the cutwork line will be inserted.
Stitch numbers are given as guides only. It is 
more important to ensure that the correct 
stitches are hidden or left showing than to follow 
the exact stitch numbers.

12 Click the Modify tab.
13 In the Cutwork area, click the Options button. 

The Cutwork dialog box appears.
14 In Method, ensure that 2 Cutwork Needles is selected.

With 2 needles, a bladed needle set at one angle is used to cut around the shape, and then the second 
needle travels around the shape cutting at a different angle.
4 Cutwork Needles is a little more precise, and is recommended for delicate fabrics, but takes longer to 
complete the cutwork process. In this design the cutwork line will be covered by a satin border, therefore it 
is not necessary to use four needles.

15 In Cutwork Line ensure that Include Secure 
Points is selected (checked), and that Distance 
Between Secure Points is set to 30mm.
Secure Points prevent the fabric from lifting up 
while it is being cut. The secure points are trimmed 
away, and the fabric removed, after the cutwork 
line has been completed, and before washable 
stabilizer (or reverse appliqué fabric) is placed.

16 In Stabilizing Line ensure that both Before 
Cutwork Line and After Cutwork Line are 
selected (checked).

17 Ensure that Stitch Length is set to 1.5mm, and set 
Distance from Cutwork Line to 1.0mm.
The line cut through the fabric may have a sharper 
edge if a stabilizing line of stitching is placed before 
the cutwork line. This can prevent the fabric from 
shifting when the cutting needle moves in and out. 
A stabilizing line placed after the cutwork line may also add security. Stabilizing lines may not always be 
suitable when embroidering on delicate fabrics, or if you are simply cutting out a shape.
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18 Click OK to close the Cutwork dialog box.
19 Click the View tab, then click 2D View with Stitch Points . 

The individual stitches are now visible.
20 Click Zoom to Rectangle . The pointer changes to the 

zoom pointer .
21 Click and drag to draw a rectangle around the racket head, 

then release the mouse button to zoom in.
22 Click the Modify tab.
23 In the Cutwork Line  menu, click Point Cutwork Line . 

The pointer changes to the Point pointer .

24 Click to place points around the inside edge of the racket 
head, a short distance from the edge of the satin stitch.
As you click the third point on the line, the line becomes closed (it 
becomes a loop). As you place more points the line adjusts itself.
The line may ’swing’ while you place points. Continue, and you can 
adjust it afterwards if required.

25 Place points until you are near to your starting point, then 
right-click to finish.

The points for the cutwork needle lines and the stabilizing lines 
are inserted automatically.
The stitch points for the cutwork lines are very close together 
(0.3mm).
The gaps in this line represent the secure points.
Surrounding this cutwork lines are the more widely spaced points 
for the two stabilizing lines. (As the points for the two cutwork 
lines and the two stabilizing lines are placed on top of each other, 
you cannot see the separate lines.)

26 Look at the Control Panel. There are now five thread colors in the color worksheet.
The gray for the racket shaft and head is now in two parts, with the bright red and yellow for the Inspira 
Cutwork needles in between.

27 Ensure that Ghost Mode  is still 
selected.

28 Move the End (right) slider on the 
Draw Range to the beginning of the 
racket head stitching, approximately 
stitch number 504.
This will enable you to distinguish 
between the thread colors more 
clearly.

29 Hover the mouse pointer over the 
first gray thread in the Color 
Worksheet. The thread in the 
embroidery is highlighted, and a 
tooltip displays the name of the thread (Robison-Anton Rayon 40, 2585 Banner Gray).
As well as the gray stitching in the racket shaft, a ring of stitching around the head of the racket is 
highlighted. This is the first stabilizing line.

30 Hover the mouse pointer over the colors below, in turn.
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The bright red is the cutwork line for Inspira Cutwork Needle 1, and the bright yellow is for Inspira Cutwork 
Needle 2. The satin of the racket head uses Banner Gray.

31 Click Save As  and the Save As dialog box will appear.
32 In the Save As Type box, ensure .vp4 is selected. Browse to the 

folder Documents\mySewnet\MyDesigns. In the File Name 
box, change the name to 'RacketCutwork', then click Save.
The preferred file format for saving embroideries is .vp4, as this 
will preserve background and appliqué information, thread 
color information and notes.
When inserting washable stabilizer (or appliqué fabric), insert it 
after needle color 2 - red, and before the second stabilizing line. 
The stitch line will then hold the stabilizer or fabric in place.
When the racket embroidery has been stitched out, wash the 
fabric to remove the washable stabilizer that the racket strings 
were stitched on.

View the Stitching Order in Detail
33 Click Draw All Stitches .
34 Click Ghost Mode  so it is no 

longer selected.
35 Move the slider on the Zoom 

Bar to zoom out until you can 
see the top of the green for the 
racket handle.

36 Move the End (right) slider on 
the Draw Range to the 
beginning of the racket shaft 
stitching, approximately stitch 
number 374.

37 Slowly move the End slider on 
the Draw Range to the right. 
The shaft of the racket is drawn.

38 Move the slider further to the 
right. A circle is drawn. This is 
the stabilizing line stitched 
before the cutwork line is 
placed.

39 Move the slider again to the 
right. The first circular line is 
completed, and a second 
heavier circular line is placed 
within the first. This is the line 
for the first cutwork needle (the 
red in the color worksheet).
The closely spaced (0.3mm) 
needle points are shown as a 
heavy line. The secure points 
(gaps) are shown as a thin red 
line.
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40 Move the slider further still to the 
right. A second cutwork line (the 
yellow in the color worksheet) is 
placed directly on top of the first.
The best way to detect the added 
line is that the lines in the gaps for 
the secure points change from red 
to yellow.
You could also see the changes by 
deselecting (unchecking) the check 
box next to the red in the color 
worksheet after drawing the yellow 
(first) cutwork line. The red cut line 
will disappear.

41 Move the slider to the right to the 
end of the yellow color in the 
Control Strip.

42 Drag the Start (left) slider to the 
right to the last of the yellow 
cutwork line stitches, so that it 
touches the other slider.

43 Now move the End (right) slider 
to the right again to draw the 
second stabilizing line.

44 Drag the Start (left) slider back to 
the start point to view all of the 
stitching and the cutwork lines.

45 Move the End (right) slider to the 
right. The mesh for the racket 
strings is displayed.
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46 Finally, move the slider the rest of 
the way, and the satin for the 
racket head is placed over the 
stabilizing and cutwork lines.

Use a Cutwork Line for Dragonfly Wings
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch, open the Perky Dragonfly 

embroidery to load it.
4 On the Home tab, use Box Select  to select the dragonfly, then click Resize . The handles on the 

selection box become blue.
5 Click Modify Block  and in the dialog box change the Height and Width to 125%, then click Apply 

and Close. See “Resize a Dragonfly Embroidery” on page 73 for full instructions, if desired.
6 Left-click outside the select box to deselect the stitches.
7 In the Stitch Player section of the Control Strip, click Start . The Draw from End handle moves to 

the far left, and none of the embroidery can be seen.
The Draw Range enables you to insert the cutwork line into this design, but to work accurately you must be 
able to see where the stitches after the cutwork line will be placed.

8 Click Ghost Mode . A pale version of the embroidery can now be seen.
9 Click Play  to play through the embroidery as if it was being stitched. The wings of the dragonfly 

are stitched out before the body.
10 Click Stop  when the body is all or partially shown. 

The stabilizing stitch line and the cutwork line can be placed before the rest of the embroidery.
11 In the Control Strip, click Start  again.

This enables you to insert the cutwork stitches at the beginning of the embroidery.
12 Click the Modify tab.
13 In the Cutwork area, click the Options button. The Cutwork dialog box appears.
14 In Method, ensure that 2 Cutwork Needles is selected.

With 2 needles, a bladed needle set at one angle is used to cut around the shape, and then the second 
needle travels around the shape cutting at a different angle.

15 In Cutwork Line ensure that Include Secure Points is selected 
(checked), and that Distance Between Secure Points is set to 
30mm.
Secure Points prevent the fabric from lifting up while it is being cut.

16 In Stabilizing Line, ensure that Before Cutwork Line is selected.
17 Deselect (uncheck) After Cutwork Line.

In this design there will be several cutwork areas, and the color 
blocks for the cutwork lines will be merged. Frequent needle 
changing would be necessary if there was a stabilizing line after 
each cutwork line.

18 Ensure that Stitch Length is set to 2mm, and set Distance from 
Cutwork Line to 1.0mm.
The line cut through the fabric may have a sharper edge if a stabilizing line of stitching is placed before the 
cutwork line. This can prevent the fabric from shifting when the cutting needle moves in and out. 



mySewnet™ Stitch Editor   Morphing and Cutwork              147

19 Click OK to close the Cutwork dialog box.
20 Click Zoom To Rectangle . Click and drag to draw a rectangle around the top left wing, then 

release the mouse button to zoom in.
21 In the Cutwork Line  menu, click Point Cutwork Line . The pointer changes to the Point 

pointer .
22 Starting at the base of the ’hole’ in the top 

left wing, click to place a series of points 
just inside the edge of the satin stitch line.
As you click the third point on the line, the line 
becomes closed (it becomes a loop). As you 
place more points the line adjusts itself.
The line may ’swing’ while you place points. 
Continue, and you can adjust it afterwards if 
required.

23 Click points to complete the line around 
the edge of the hole.

24 Move the pointer over one of the nodes on 
the line. The pointer changes to the Move 
Node pointer . Adjust the node as 
desired.
When the Move Node pointer is active you can adjust existing nodes.

If you click while the Point pointer  is active, another point will be added to the line.
25 Right-click to place the cutwork line and deselect Point Cutwork Line. The cutwork line is placed on 

the work area.
The points for the cutwork needle and stabilizing lines are inserted automatically.
Surrounding the cutwork lines are the more widely spaced points for the stabilizing line. (As the points for 
the two cutwork lines are placed on top of each other, you cannot see the separate lines.)

26 In the Design Panel, click the Overview tab.
27 Click and drag in the overview window to position the lower left wing in the center of the screen.
28 Click Point Cutwork Line , and starting at the base of the lower left wing, place points around the 

inner edge of the wing, finishing back where you started.
29 Adjust the points as desired, then right-click to place the cutwork line and deselect.

30 Click and drag in the overview window to view the top wing on the right.
31 Using Point Cutwork Line  and starting at the base of each wing, place points to set cutwork areas 

for first the upper, and then the lower wing on the right.
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32 Click Zoom To Fit .

Note that new stitches (bright red and yellow) for the cutwork line, and for the stabilizing line (green) are 
visible on the colored slider bar in the Control Strip. The handle to the right moved as these stitches were 
inserted.
The bright red is the cutwork line for Inspira Cutwork Needle1, and the bright yellow is for Inspira Cutwork 
Needle 2. The green used for the stabilizing line is the green used in the wings. It is now in several places.

33 Click the View tab.
34 Click 2D View with Stitch Points  to go to 2D view, so you can see the individual stitches more 

clearly.
35 Use the slider on the Zoom Bar to zoom in a little.
36 Click Draw All Stitches .
37 Click Draw Next Color Block  once. The stabilizing line for the top left wing is drawn.

The green for the stabilizing line is the only selected color in the color worksheet.
38 Click Draw Next Color Block  again.

The closely spaced (0.3mm) needle points are shown as a heavy line. The secure points (gaps) are shown as 
a thin red line.

39 Click Draw Next Color Block  a third time.
A second cutwork line (the yellow in the color worksheet) has been placed directly on top of the first. The 
lines in the gaps for the secure points are now yellow, not red. This may be easier to see if Ghost Mode is 
temporarily turned off.

40 Click Draw Next Color Block  a few more times. The same 
structure is used for the cutwork and stabilizing lines in the other 
wings.

41 Click Zoom To Fit , and then click Draw All Stitches .
42 Click 3D View  to return to a realistic view of the embroidery.
43 In the color worksheet, scroll down the list of color changes. There 

are now 18, but many of them are the same colors repeated.
Change the color order yourself when optimizing the order of designs 
with multiple areas of cutwork and stabilizing lines. ColorSort may 
occasionally merge stabilizing lines in these circumstances.

44 Click the green color block in position 4.
45 Click Move Color Up  twice. What was green block number 4 is 

now below green block number 1.
Alternatively, right-click the color block and select Move Color Up from 
the context menu.

46 Move the green color blocks at numbers 7 and 10 in turn to just 
below the green block that is now number 2.
This places the stabilizing lines for the four wings together at the top 
of the embroidery.
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47 Click the red color block in position 7.
48 Click Move Color Up  once. The red block that was number 7 is now below red block number 5.
49 Move the red blocks numbers 9 and 11 in turn to just below block number 6 (the block you just 

moved).
50 Click the green color block in position 4.
51 Click Merge into Previous Color  3 times. There is now one green block at the top.

Alternatively, right-click the color block and select Merge into Next Color or Merge into Previous Color, as 
appropriate.
Do not move the green color block that is now in position 10. This is for the outlines of the wings and is 
stitched after the cutwork is placed.

52 Click the red color block in position 5.
53 Click Merge into Previous Color  3 times. There is now one red block.
54 Click the yellow color block in position 6 and merge the four yellow color blocks. There are now 9 

colors in the color worksheet.
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9Modifying an Embroidery

Select, Move and Merge Designs
Use the Design Select area on the Home tab to view the different sections or subdesigns 
of a multipart design. The selected section is displayed in the work area. You can change 
the order of the subdesigns, and select designs to merge together.

Automatic Ghost Mode is used to show the position of the other parts of the design in the work area.
To see all subdesigns, click the arrow at the bottom right of the Design Select area.
Use Merge Design if you are confident you will not wish to move the subdesigns 
separately, and if there are few or no overlapping stitches.

Decoration subdesigns cannot be merged with others. Alignment subdesigns cannot be moved from the 
beginning of the design or merged with others unless they are changed to standard stitches using the 
Alignment  function.
To remove overlapping stitches when combining designs (unless any of the designs contain appliqué), use 
Export with the Combine and Remove Overlap option checked. See “Export” on page 19.

Move and Merge Designs
1 In the Quick Access toolbar, click Change Hoop , and ensure that the hoop is set to 240mm x 

150mm - Universal Large Hoop 2, and that Rotated is selected in Orientation. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch, insert the following embroideries 

in this order: 'Floral Beehive’, ’Three Bees’ and ’Three Dragonflies’.
The embroideries are loaded into the center of the work area.
The embroideries will be shown in the Design Select area in the order that you loaded them. This is also the 
stitching order.

5 In the Design Select area, click the beehive. 
The dragonflies and bees are shown in automatic ghost mode.

6 Click Select All Visible . The beehive is surrounded by a selection box.
7 Drag the beehive embroidery to the bottom of the hoop.
8 In the Design Select area, click Next Design . The three bees are selected. 

Click a design in the Design Select area to select it, or use Previous Design  and Next Design , or the 
Tab key, to browse through the sections of a multipart design.

9 Click Select All Visible . The bees are surrounded by a selection box.
10 Drag the bees down and to the left of the hoop, so that the antennae of the bee on the right overlap 

the red and yellow flower by the hive.
11 Select the dragonflies, as above, and drag them to the right so that the yellow bubbles underneath 

the dragonfly on the left overlap the wings of the bee to the right of the beehive.
12 Click Life View . This shows the whole project as it will be stitched out.

Click to select a design

View previous design
View next design

Merge design with the

Move design up or
down the stitch order

one above
View all subdesigns
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The hive was loaded first, so it is stitched out before the bees and dragonflies. This works well for the 
overlapping antennae on the left, but on the right it would be better if the bee by the hive was placed over 
the yellow bubbles.

13 Click Cancel to close Life View.
14 In the Design Select area, click the dragonflies.
15 Click the Move Backwards icon  to the right of the Design Select area twice to move the 

dragonflies to the top of the stitching order.

The dragonflies are now above the hive in the Design Select area, and will be stitched out first.

Use Move Forwards  to move a design down the stitching order. Alternatively, right-click the design in 
the Design Select area, and choose Move Forwards or Move Backwards from the context menu.

16 In the Design Select area, click the bees to make them the active subdesign, then click Combine with 
Previous . The bee and hive designs are merged, and are both now fully visible in the work area.
Alternatively, you could right-click the beehive in the Design Select area and choose Combine with 
Previous from the context menu.

Previous Design
Use Previous Design  to select the previous design in the stitchout order.

Shortcuts
■ Design Select, Home Tab: 
■ Keys: Shift + Tab; Alt, H. PD

Next Design
Use Next Design  to select the next design in the stitchout order.

Shortcuts
■ Design Select, Home Tab: 
■ Keys: Tab; Alt, H, N

Move Forwards
Use Move Forwards  to move a design down the stitchout order.

Shortcuts
■ Design Select, Home Tab: 
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■ Keys: Alt, H, MF

Move Backwards
Use Move Backwards  to move a design up the stitchout order.

Shortcuts
■ Design Select, Home Tab: 
■ Keys: Alt, H, MO

Combine with Previous
Use Combine with Previous  to merge the design with the previous design in the 
stitchout order.

Shortcuts
■ Design Select, Home Tab: 
■ Keys: Alt, H, CW

Compensate Stitches
Use Compensate Stitches  to make a stitch block appear 'bolder' by increasing the 
relative size of the stitches by a factor of 1 to 15. Stitch lengths are increased at the edges 
of areas by the compensation factor. Only visible stitches are affected. 

Compensation allows for the effects of stitches' tendency to pull in, which varies 
according to fabric weight and type. A common use is to 'thicken up' lettering in an 
embroidery when it is being embroidered on knitwear, as lettering tends to have thinner 
columns relative to the rest of the embroidery.

Shortcuts
■ Modify Design, Modify Tab: 
■ Keys: Alt, M, CS

Using Compensate Stitches
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Racket' embroidery.
4 Click the Modify tab.
5 In the Modify Design area, click Compensate Stitches . The Compensate Stitches dialog opens.
6 If the dialog covers the racket embroidery, move it to one side.

7 Enter 15 in the Compensate Stitches dialog box.
8 Click OK. Compensation thickens the handle and the edge of the racket head.

Compensate Stitches works on the entire visible area. Hide colors and use Draw Range to isolate an area of 
the embroidery if you do not wish to affect the whole embroidery.
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9 Close without saving.

Break Up Stitches
Use Break Up Stitches  to add extra stitch points to the embroidery so that no stitches 
are longer than the specified maximum length. This is useful to reduce the length of 
stitches if they are causing any difficulties during embroidery, however it does increase 
the number of stitches in the embroidery. Only visible stitches are affected.

It is recommended to use Break Up Stitches if some very long stitches are left when the Remove Needle 
Points in Fill function is used before stamping. If these long stitches are not broken up, they may be too 
loose when the embroidery is stitched out.
Set the maximum length of visible stitches in the current embroidery to between 2mm 
and 12mm. The initial setting is 8mm. Change the Length in steps of 0.1mm.

Use the Extreme setting to break up stitches that are hidden in 3D but visible in 2D. The 
Extreme setting is off by default and reset when the module is restarted again.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.

Shortcuts
■ Modify Design, Modify Tab: 
■ Keys: Alt, M, BU

Using Break Up Stitches
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Girl with Rose' 

embroidery.
4 In the Control Strip, click Draw Next Color Block  once so that the background color behind the 

girl’s head is shown.
5 Click the Emboss tab.
6 Click Remove Needle Points in Fill . The stitches making the flat fill pattern are removed.
7 In Stamps in the Category drop-down menu, select Games, then select stamp 11, a heart.
8 Click Single Stamp , then click on the background area to place stamps in a few locations where a 

full stamp can be fitted.
9 Click the Modify tab.
10 Click Break Up Stitches .
11 Enter the desired Length in the Break Up Stitches dialog box.

8mm is a good length to maintain the patterns that have been 
stamped, but removing long, loose stitches.

12 Click OK to break up the stitches. Extra stitch points are 
inserted on the areas with stitches longer than your selected 
length.
This function works on the visible stitches. Hide colors and use Draw Range to isolate an area of the 
embroidery if you do not wish to affect the whole embroidery.
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Design Separator
Use Design Separator  to break an embroidery into two parts. Click Design Separator 
and the pointer changes to the add point pointer . Place a line to enclose the area of 
the embroidery you wish to split. Two new embroideries are automatically created, one for 
each part of the split. The new embroideries are shown as separate subdesigns in the 
Design Select area of the Home tab.

Design Separator can be used to cut out a section of an embroidery you wish to keep, or to 
cut away a section of an embroidery you wish to discard. This may be preferable to making 
a selection and then using Cut, as Design Separator creates a clean split with traveling 
stitches where it is necessary to move along the split line. Design Separator may also be 
used to split an embroidery into two subdesigns for stitching out.

To automatically split an embroidery for stitching out multiple hoopings in a particular hoop, it is 
recommended to use the Split Project Wizard in mySewnet™ Embroidery.
If you want to keep the split sections then you must save them.

Shortcuts
■ Modify Design, Modify Tab: 
■ Keys: Alt, M, DS

Separating for Cutting Out
Use these steps when separating an embroidery to cut out or cut away a section.

1 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Lion' embroidery.
2 Click Draw All Stitches . 

This is recommended as Split Design cuts through all stitches whether or not they are visible. 

Alternatively, ensure Ghost Mode  is selected.
3 If desired, in the View tab, select 2D View with Stitch Points , so you can see any movement 

stitches.

You can also use Grid Off  to aid in seeing movement stitches.
4 If desired, Zoom In  to the area around which you will place the cut line.

Once you have started to place the cut line, you can use mouse wheel zoom (hold Ctrl and move the mouse 
wheel) if you wish to change the zoom level.

5 On the Modify tab, click the Design Separator icon . The pointer changes to the place point 
pointer .

6 Click the desired start point for your cut line. If possible, choose a start point in clear space as this will 
make it easier to see where you started.

The original embroidery A separated section
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7 Click to place more points. This is the line along which the embroidery will be cut.
As you click the third point on the line, the line becomes closed (it becomes a loop). As you place more 
points the line adjusts itself.
The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.

8 Use Shift+click to place square nodes for straight lines.
Click Delete to remove the last–placed point.
When you cross stitching in the embroidery, try to avoid following outlining stitches as this may 
fragment the outline.

9 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 
pointer . Adjust the node as desired.
When the Move Node pointer is active you can adjust existing nodes.

If you click while the Point pointer  is active, another point will be added to the line.
10 Click points until you are at or near the start point again.

Notice that the dark thread color has been hidden and shown in Ghost Mode. This makes it easier to see 
where to place the cut line.

11 Right-click to cut the embroidery.
When the split has been calculated, the design has been cut in two, with 
the head of the lion as the active embroidery. 

12 Click the Home tab. In the Design Select area you can see the two parts of 
the embroidery as separate subdesigns.

13 If desired, select one of the sections and Delete  it.
14 Use Save As  to save the split sections under a new name.

Separating for Stitching Out
Use these steps when splitting an embroidery for stitching out in sections.
In the example the embroidery Documents\mySewnet\Samples\Stitch Editor\Stitch\Large Flower is used.

1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Large Flower' embroidery.
4 Click Hoop  to select a hoop size large enough for the embroidery, or use Enter Size to set a 

temporary custom hoop size. Click OK after selecting your hoop.
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If a message appears asking if you wish to change the hoop size for all open embroideries, click No.
5 Click Draw All Stitches .

This is recommended as Split Design cuts through all stitches whether or not they are visible.
6 If desired, in the View tab, select 2D View with Stitch Points , so you can see any movement 

stitches. You can also use Grid Off  to aid in seeing movement stitches.
It is particularly useful to see movement stitches when splitting for stitching out in sections, as this may 
help avoid creating unnecessary short stitches.

7 If desired, Zoom In  to the end of the hoop where you will place the cut line.
Once you have started to place the cut line, you can use mouse wheel zoom (hold Ctrl and move the mouse 
wheel) if you wish to change the zoom level.

8 On the Modify tab, click the Design Separator icon .
9 Click to place the first point outside the hoop. Click on one side of the section of the embroidery 

where you wish to cut across.
This ensures that you cut as few movement stitches as possible.

10 Click points to place a cut line across the embroidery to the opposite side of the hoop. When you 
cross stitching in the embroidery, try to follow the angle of the stitches. Also, avoid following 
outlining stitches as this may fragment the outline.

11 Click two or three points around the outside of the hoop to go around one end of the hoop in long 
steps and return to the start point.

12 Adjust the nodes with the Move Node  pointer as desired.
13 Right-click to close the area. 
14 Click the Home tab to view the two subdesigns in the Design Select area.
15 Click Select All Visible . The top half of the embroidery is selected.
16 Click Copy . The copied section appears in the Clipboard block.
17 In the Paste drop-down menu, select Paste Into New Window .
18 Click the first tab at the bottom of the work area.
19 In the Home tab, select the bottom half in the Design Select area.
20 Click Select All Visible . The bottom half of the embroidery is selected.
21 Click Copy . The copied section appears in the Clipboard block.
22 In the Paste drop-down menu, select Paste Into New Window .

There are now three tabs at the bottom of the work area.
23 Click Change Hoop  to change the hoop size to the hoop you will use to stitch out the sections.
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24 Click OK after selecting your hoop. A message appears asking if you wish to change the hoop size for 
all open embroideries. Click Yes.

25 Click Center in Hoop . The split section is in the center of the new hoop.
26 Click the tab for the other section at the bottom of the work area.
27 Click Center in Hoop . The other split section is now also in the center of the hoop.
28 Use Save As  to save the two subdesigns with their own names, for example Large Flower Top and 

Large Flower Bottom.
29 Print  a worksheet for each subdesign at 100%, to use as a template when stitching out the second 

area.

Density Advisor
Use the Density Advisor  (Modify tab) to view the density of the embroidery and, if 
desired, reduce the density where stitch points are tightly packed together. 

View an embroidery with Density Advisor to determine if a particular embroidery may be 
troublesome when it is stitched out. Extensive areas of Very Dense or Super Dense 
stitching may cause difficulties such as thread and needle breakage. Isolated spots of 
dense stitching are unlikely to need adjustment.

The embroidery is shown in 3D on the left, and a density preview on the right shows the 
density of stitch points in the embroidery.

Click OK to reduce the density as desired. Click Cancel to close the Density Advisor without 
making changes, after viewing the density map.

Only visible stitches are affected. It is not available if a block is selected.

If the Density Advisor does not give you the desired results, use Undo to reverse the effect of Density 
Advisor.

Using the Density Advisor
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .

View the density information

Original embroidery

Density map of the 
embroidery

Select a density level to view

Reduce the density level

Zoom in and out

Adjust embroidery visibility
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3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Hermit Crab Shell Dense' 
embroidery.

4 Click the Modify tab.
5 Click Density Advisor . The dialog box appears.
6 In the Show Density area, use the checkboxes to view where the dense areas of stitching are.
7 Use the Reduce Denser Areas drop-down list to reduce the density of dense areas of stitching.
8 Close the dialog box to view your changes.

If you are not satisfied with the result, click Undo  and try again. 

Shortcuts
■ Modify Design, Modify Tab: 
■ Keys: Alt, M, DA

Density Statistics
This shows the density of the stitches, per square millimeter. Average is the overall density 
of the stitches, Minimum is the lowest density and Maximum is the highest density.

This is not affected by the Show Measurements setting in mySewnet™ Configure.

Show Density
Check and uncheck the desired options to show where the density is Light (up to 10 stitch 
points per mm²), Dense (up to 17 stitch points per mm²), Very Dense (up to 25 stitch points 
per mm²) or Super Dense (over 25 stitch points per mm²).

Zoom Controls
Use the Zoom Controls to zoom in and out, zoom to fit and zoom to Real Size.

Zoom In
Use Zoom In  to enlarge the view of an area of the 3D and density views.

Click Zoom In  and move the pointer over the 3D or density view. The mouse pointer 
changes to the zoom in pointer . Then either click a point on the view you want to 
zoom in towards, or click and drag a rectangle around the area you want to zoom in to and 
release the mouse button to zoom.

When zoomed in, use the scroll bars to move around the 3D and density views.

Zoom Out
Use Zoom Out to zoom out of the 3D and density views, to show more of the embroidery 
in each view.

Click Zoom Out  and move the pointer over the 3D or density view. The mouse pointer 
changes to the zoom out pointer . Then click a point on the 3D or density view you 
want to zoom out from.

Zoom To Fit
Click Zoom To Fit  to view all of the stitches in the Before and After views.
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Real Size
Click Real Size  to show the Before and After views at the Real Size selected in 
mySewnet™ Configure.

Reduce Denser Areas To
This is a drop-down list with options for Light, Dense and Very Dense. This determines the 
level of density reduction to apply when you click OK.

The density is reduced to the maximum allowed for the option you choose. For instance, if 
you choose Dense, then Very Dense and Super Dense areas will be reduced to 17 stitch 
points per mm².

Stitch Optimizer
Click Stitch Optimizer  to improve the stitchout of the embroidery, both in speed and 
quality. One of the effects of the Stitch Optimizer is to remove unnecessary short stitches. 
The Stitch Optimizer only affects visible stitches. A confirmation message appears that 
shows the number of stitches removed from the embroidery.

Feel free to try using the Stitch Optimizer on most embroideries, especially after changes have been made 
to an embroidery, before saving the final result. However, the Stitch Optimizer only optimizes an 
embroidery once, rather than making progressive changes to the embroidery. 
Use Optimizer Preferences  to change the settings used by Stitch Optimizer. This is 
recommended only if you feel that stitches have been removed that affect the look of the 
embroidery. Changes to Optimizer Preferences are very rarely needed.

By default, Stitch Optimizer is also used automatically after using Resize. 
Cutwork Needle lines in the Inspira Cutwork Needle "thread range" and Felting Needle Colors in the Inspira 
Felting Needle "thread range" are unaffected by Optimize Stitch Length.

Use Stitch Optimizer before using Export , or as part of the Export process. See “Export” on page 19. 

Shortcuts
■ Modify Design, Modify Tab: 
■ Keys: Alt, M, S

Trim Commands
In the Trim Commands  menu, use Automatically Add Trim Commands  to add Trim 
Commands before most movement stitches in the visible stitch area, and use Remove All 
Trim Commands  to automatically remove all Trim Commands in the design.

To add individual Trim Commands to an embroidery, use Insert Trim Command , and to remove 

individual Trim Commands, use Delete Commands .

 Automatically Add Trim Commands
Use Automatically Add Trim Commands  to add Trim Commands before most 
movement stitches in the visible stitch area.
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To add individual trim commands to an embroidery, use Insert Trim Command . See “Insert Trim 
Command” on page 78.
To add trims automatically to an embroidery with no trims when it is opened, set "Add trims automatically 
when opening a file" in the Opening Files section of Preferences. See “General” on page 284.

Shortcuts
■ Modify Design, Modify Tab: 
■ Keys: Alt, M, TC, A

Remove All Trim Commands
Use Remove All Trim Commands  to remove all Trim Commands in the design.

To delete individual trim commands in an embroidery, use Delete Commands . See “Delete 
Commands” on page 79.
To add trims automatically to an embroidery with no trims when it is opened, set "Add trims automatically 
when opening a file" in the Opening Files section of Preferences. See “General” on page 284.

Shortcuts
■ Modify Design, Modify Tab: 
■ Keys: Alt, M, TC, R

Basting Line
Use a Basting Line  to secure your fabric before beginning embroidery. Basting Line for 
Visible Stitches  places a line around visible stitches, and Basting Line for All Designs  
places a line around all designs on the screen.
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Basting Line for Visible Stitches
Use Basting Line for Visible Stitches  to insert a rectangular basting line automatically 
around the visible stitches. This will secure the fabric and stabilizer before beginning 
embroidery. 

Set the margin and stitch length in the Basting Line section of Preferences .

The basting line is automatically created immediately before the visible stitches using a medium gray 
color.

Shortcuts
■ Modify Design, Modify Tab: 
■ Keys: Alt, M, BL, BL

Add a Basting Line to Sweet Rose Border
1 In the File menu, Click Configure to open mySewnet™ Configure , then click the Appearance tab.
2 To change the Background, click the drop-down arrow and then click 

More Colors on the drop-down panel. The Colors dialog box appears, 
with the Standard tab selected.

3 In the hexagonal matrix, click the medium pink hexagon sixth from 
the right (just to the right of the central white hexagon). The color 
sample on the right will show the old and new colors.

4 Click OK. The new color is shown on the Color button. 
This background color is similar to the fabric to be used for the 
embroidery.

5 Click Apply and the new color will be seen on the Clipboard in 
mySewnet™ Stitch Editor. Click OK to close mySewnet™ Configure.

6 In mySewnet™ Stitch Editor , click File, New  to open a new 
window.

7 In the Quick Access toolbar, click Insert .
8 Browse to the folder Documents\mySewnet\Samples\Stitch Editor\Stitch, then select the embroidery 

'Sweet Rose Border'.
The embroidery is loaded into the work area.
Alternatively, you could use the embroidery you created in “Add a Satin Border to the Sweet Rose 
Embroidery” on page 91.

9 Hover the pointer over the colors in the worksheet.
All of the colors are Sulky, except the 13th color which is Robison-Anton. Use Color Tone to change the 
thread range.
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10 In the Home tab, click Color Tone . The Color Tone dialog box appears.
11 In the Thread Range drop-down list, select Robison-Anton Rayon 40. The thread shades change a 

little.
12 Click OK to close the Color Tone dialog box.

The embroidery background would match the fabric background better if it used a paler shade.
13 Double-click the first color in the color worksheet (Robison-Anton Rayon 40 2203 Gold). The Color 

Selection dialog box appears.
14 Browse for thread number 2374 (Emily Pink) in the list and select it, or type 2374 in the Find Thread 

box.
15 Click OK to close the Color Selection dialog.
16 Click File, Preferences .
17 In Basting Line, ensure that Stitch Length is set to 4mm, and that Margin is set to 5mm.

18 Click the Modify tab.
19 Under Basting Line, click Basting Line for Visible Stitches . A basting line is placed around the 

embroidery.
This will secure the fabric and stabilizer before beginning the embroidery.
Note that the basting line is created using a gray color to contrast with the background fabric.

After placing the basting line around this embroidery, use the Appearance tab of mySewnet™ Configure to 
set the Background Color back to the default blue (RGB 211, 233, 255) in the Colors dialog box Custom tab. 
See the instructions at the beginning of this section.

Basting Line for All Designs
Use Basting Line for All Designs  to insert a rectangular basting line automatically 
around all designs on the screen. This will secure the fabric and stabilizer before beginning 
embroidery, and is useful for an embroidery project with multiple sections. 

Set the margin and stitch length in Preferences.

The basting line is automatically created as the first subdesign, using a medium gray color.
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Shortcuts
■ Modify Design, Modify Tab: 

■ Keys: Alt, M, BL, BF
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Alignment Stitches
Use Alignment Stitches  to mark the first or last subdesign as an alignment stitch 
subdesign.

Use Alignment Stitches to align your embroidery with the background fabric, or with another embroidery.

Select the alignment stitch section on the work area using the select tools in the Home 
tab, then click Alignment Stitches  in the Modify tab to flag it as a set of alignment 
stitches.

To mark a set of alignment stitches as a normal subdesign, select the section in the Home tab, and then 

deselect Alignment Stitches  in the Modify tab.

Alignment Stitch Sections
Either the first or last subdesign in a design can be marked as Alignment Stitches. In the 
Home tab an Alignment Stitch subdesign is shown by the letter ‘A’ in the Design Select 
gallery, rather than the number used for standard subdesigns.

Most editing functions are not available for Alignment Stitch subdesigns. To edit the subdesign, change it 
to a normal subdesign, edit it, then change it back again after editing.

■ When a .vp4 design with alignment stitches is Opened , the alignment stitches are 
retained. 

■ When a .vp4 design with alignment stitches is Inserted  into a project, the alignment 
stitches are discarded.

To change the alignment stitches in a .vp3 format embroidery into an alignment stitch subdesign, use 
Design Separator  to create two different subdesigns; one for the embroidery, and one for the 
alignment stitches. Then in the Design Select area on the Home tab, move the alignment stitches to the 

front (or back) of the design. With the alignment stitches selected, click Alignment Stitches  in the 
Modify tab to change them into an ’A’ alignment stitch subdesign.

Shortcuts
■ Modify Tab: 

■ Keys: Alt, M, A
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Using Alignment Stitch Sections
1 Click Change Hoop . From the Universal Hoop Group, set the Hoop Size to 100mm x 100mm - 

Universal Square Hoop 1. Click OK.
2 Ensure that the Home tab is selected.
3 Click File, Open  to open an existing design in a new window.
4 In the folder *Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Small Cypress' 

embroidery.
The embroidery is opened with the second subdesign selected, the tree, as the first subdesign is alignment 
stitches.

5 In the Design Select area, click design ’A’ - the alignment stitches. Most of the editing functions 
become unavailable (grayed out).
You cannot edit the stitches in an alignment stitch subdesign.

6 Click the Modify tab. Alignment Stitches  is enabled, but all other functions are disabled.

7 Click Alignment Stitches . The editing functions are now available.
8 Click the Home tab. In the Design Select area the alignment stitch section is now subdesign 1, and the 

tree has been renumbered to 2.
9 Close the window without saving your changes.
10 Click File, New  to open a new window.
11 In the Quick Access toolbar, click Insert .
12 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Small Cypress' 

embroidery.
13 Look at the Design Select area. This time there is no Alignment Stitch subdesign.

When you Open  an existing embroidery the alignment stitches are retained, as they are part of a 
complete design. However, when you Insert  a design into an existing project, any alignment stitches 
are not needed, so they are not retained.

Convert the Alignment Stitches in a .VP3 Embroidery
To change the alignment stitches in a .vp3 or other format embroidery into an alignment 
stitch subdesign, do as follows:

1 Load the embroidery to be converted.
2 Click the Modify tab.
3 Use the Design Separator  to create two different subdesigns; one for the embroidery, and one for 

the alignment stitches.
4 Click the Home tab.
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5 In the Design Select area of the ribbon bar, move the alignment stitches to the front (or back) of the 
design.

6 Click the Modify tab.
7 With the alignment stitches selected, click Alignment Stitches  to change them into an ’A’ 

alignment stitch subdesign.
Return to the Home tab to check that the alignment stitches are now an Alignment Stitch subdesign.
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10Split and Save a Design
Use Split Design  to split a large design for stitching out in multiple hoopings, adjusting 
points for the best possible split.

Use the Split Project Wizard in mySewnet™ Embroidery to split a design automatically, and Design 
Separator to break an embroidery into two parts. See “Design Separator” on page 154.

Split Design
Use the Split Design window to move the points on the split line within the overlap zone, 
and to add and delete points on the line. Use the Split Options dialog to set the number of 
hoops, the width of the overlap zone, and the alignment stitches, compensation and 
connection. Use the Split Wizard  to save the split sections, and print an overview and 
worksheets.

When you first load an embroidery in Split Design the hoop, orientation and overlap are calculated 
automatically.

Overlap Zones
The pale bands across the work area are the overlap zones for the selected hoop. The size 
and directions of the overlap zones (horizontal and/or vertical) will depend on whether 
natural or rotated hoop orientation is selected.

If there is no overlap zone, then you have chosen an embroidery that does not need to be split for the 
selected hoop.

Split Options Change, Add and Delete points Split Wizard

Area Dimensions Zoom ToolsOverlap Zone Split Line
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Split Lines
There is one split line for each overlap zone. The split lines show where the embroidery 
will be split. 

Each split line has points along the line that can be used to adjust the split line. There are 
two types of points: the triangular end points and square mid-points. The end points can 
only be moved along the edges of the design area, and may not be deleted. The mid-
points are initially placed about every 20mm, and they can be added and deleted as 
needed. All points are limited to the overlap zone to which they belong.

The embroidery will not be split if any split lines cross over themselves, or if a pair of 
horizontal and vertical split lines cross each other more than once.

Adjacent horizontal or adjacent vertical split lines cannot cross each other.

Moving Points and Lines
To move a point, move the mouse pointer over the desired point. The pointer becomes a 
two-headed arrow  over a triangular end point, or a four-headed arrow  over a 
square mid-point. Click and drag the point to the desired position. The lines leading to the 
point will move as you move the point.

Points can only be moved within the overlap zone to which they belong. The end points 
can only be moved along the edge of the design area.

For finer adjustments to split lines, zoom in to the desired area.

Insert Point
Use Insert Point  to add a new point into a split line. 

Click the Insert Point icon and the Insert pointer  appears. Then click the position on 
the split line where you want to add the point. Click to add any other points to split lines as 
desired. Click Move Point  to finish adding points.

Delete Point
Use Delete Point  to delete a point from a split line. 

Click the Delete Point icon and the Delete pointer  appears. Then click the point on the 
split line that you want to delete. Click any other points that you also want to delete. Click 
Move Point  to finish deleting points. 

You may not delete the end points of a split line.

Move Point
Use Move Point  to adjust a point on the line, and to cancel Insert Point and Delete 
Point.

Click the Move Point icon and the move pointer   appears. Then drag the point on the 
split line that you want to move.
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Splitter Options
Use the Splitter Options to set the hoop size and orientation, the overlap and the number 
of hoopings used. In the Split tab set the alignment stitch type, the compensation and 
connection.

Hoop Options
Use the Hoop Options to select the desired hoop size, the number of hoops, and the 
overlap between hoop areas, what type of alignment stitch to use and the level of 
compensation.

Hoop Size
The currently selected hoop, and its size and orientation, are shown here.

Generally, you should choose the largest hoop size for your machine. This will reduce the 
number of split sections. This then reduces the number of split lines to be adjusted, the 
number of times you will need to hoop your fabric, and the number of color changes. The 
minimum recommended hoop size is 100mm x 100mm.

Change Hoop
Click Change Hoop to choose the size of the hoop you wish to use for splitting the 
embroidery. Select any available hoop in the Hoop Selection dialog box. See “Hoop 
Selection” on page 10. If you choose a multipart hoop, the Overlap setting is not available.

Overlap
Set the desired overlap between each hoop area. The minimum overlap is 1mm. The 
maximum overlap is half the shortest side of the chosen hoop. This means that hoops may 

Select a hoop

Set the overlap between hoopings

Set the number of hoopings
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not overlap more than 50%. This is so that adjacent horizontal split lines or adjacent 
vertical split lines may not cross each other.

It is recommended to make the overlap as large as is practical so that you have maximum 
flexibility for adjusting the split lines. However, increasing the overlap may add 
unnecessary extra hoop sections, so a balanced choice is needed.

Number of Hoop Sections
Set the number of hooping to use, across and down.

Split Options
Use the Split Options to select what type of alignment stitch to use and the level of 
compensation.

Alignment Stitch Style
Select the type of alignment stitch that you wish to use to help with lining up the split 
sections of the embroidery.

None
When None is selected, no alignment stitches are added to the split sections.

Select None if you wish to use a hoop template to align the split sections, or you have 
fabric that you do not wish to mark with the alignment stitches. This is also appropriate 
when you can split an embroidery without cutting through any design elements.

Corner
When Corner is selected, movement stitches are added at the beginning and small L-
shaped corners of three long loose stitches are added at the end of each split section. The 
alignment stitches go to the corners, halfway across the overlap between the hoop areas.



mySewnet™ Stitch Editor   Split and Save a Design              171

Use the movement stitches at the beginning to align to previously stitched sections. The 
alignment points for subsequent sections are the corners of each L.

Corner is useful for lightly stitched embroideries, and where there are only a few splits 
within design elements.

Baste
When Baste is selected, movement stitches are added at the beginning and a box of long 
single stitches is added at the end of each split section. The alignment stitches go to the 
corners, half way across the overlap between the hoop areas.

Use the movement stitches at the beginning to align to previously stitched sections. The 
alignment points for subsequent sections are the corners of the box of basting stitches.

Baste is useful for a heavily stitched embroidery that may be difficult to line up owing to 
pull on the fabric.

Compensation
Compensation adds overlapping stitches along the edges where the embroidery is split. 
This is used to compensate for pull on the fabric. If you can split an embroidery without 
cutting through any of the design elements, set Compensation to None. Use Low when 
splitting through a lightly stitched embroidery. Use High when the embroidery is dense, 
when the split lines make long splits through stitch areas or when stitching onto materials 
such as knitted or stretchy fabric.

Connection
Choose the travel method to connect separate areas of the same color along the edges of 
the split sections. The initial setting is Trim.

Trim
Use movement stitches to travel along the edges of the split sections. This option is the 
most suitable choice when an embroidery project can be split without cutting through 
large stitch areas.

Running Stitch
Use Running Stitch when the split lines cross large stitch areas.

Split Embroidery
Use Split Embroidery  to split the embroidery according to the split lines you have 
defined. Once the split is processed, the sections of the embroidery are shown in the Save 
Embroidery wizard page. If you are happy with the result, export the split sections of the 
embroidery with a common name. The name is suffixed with a number for each 
embroidery section.
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Save Embroidery

Use the Save Embroidery page to preview the split sections, and to export the split 
embroidery sections automatically.

An animation plays while the design is split.

Exporting Split Embroideries
When you export a split embroidery, you provide a single embroidery file name which is 
used for all sections of the split embroidery and the sections are distinguished by a suffix.

For standard hoops, each section is suffixed by a number. The top left section starts at 01, 
then the numbering works across and down. You can stitch out the sections in the order 
you think is most suitable for each split design.

Zoom
Use the Zoom functions to change the view of the embroidery.

Use Zoom In  to magnify the view. Move the pointer over the embroidery and the 
pointer changes to the zoom in pointer . Then either click a point you want to zoom in 
towards, or click and drag a rectangle around the area you want to zoom in to and release 
the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the embroidery and the 
pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the embroidery to the preview area.

Click Real Size  to view the embroidery at a magnification as close as possible to the 
Real Size setting you chose in mySewnet™ Configure.

Information
The information on the left shows the zoom level compared to Real Size, the stitch 
count , dimensions (height  and width ) and number of color changes  in the 
current section.

Information for this 

Zoom in and out

Browse the split sections

Export the embroidery 

split section

sections
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View
The number of the section, and the total number of sections, is shown to the left of the 
preview.

Click the navigation icons to browse through the split sections.

Use Previous  and Next  to step through the split sections one at a time.

Use First  to jump to the first split section.

Use Last  to jump to the last split section.

Export All Sections
Click the Export All Sections  button to export all the split embroidery project sections, 
as shown in the Save Embroidery preview pane, as a .vp4 file or in an alternative 
embroidery format. 

The Split Project Wizard displays the Export dialog so you can select the embroidery 
format, then the Save or Save As dialog box so you can name your design. For more 
information on using Export, see “Export” on page 19.

Export in any of the following embroidery file formats: Brother/Baby Lock/Bernina PEC 
(.pec), Brother/Baby Lock/Bernina PES (.pes version 2 - 11), Compucon/Singer PSW (.xxx), 
Husqvarna Viking / Pfaff (.vp4, .vp3 and .vip), Husqvarna (.hus, .shv), Janome (.jef and .sew), 
Melco (.exp), Pfaff (.pcs), Tajima (.dst) and Toyota (.10*).

Note: The preferred file format for saving embroideries is .vp4, as this will preserve thread color information 
and notes.

File Name
When you save a split embroidery, you provide a single name which is used for all parts of 
the split embroidery. The split parts are distinguished by a two digit suffix that is 
automatically added to the file name.

Suffixes for Multi-Hoop Splits
For a multi-hoop split, the split parts are suffixed with two digit numbers. The numbers 
start at 01 for the top left hoop, then increase across and down, for example Three Flowers 
Exported_01 to Three Flowers Exported_03. The numbers are used only to distinguish the 
individual sections. You can stitch out the sections in any order, as required.

Next
Go to the Print Options page.
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Print Options

Use the Print Options page to print information on stitching and aligning your project.

Back
Return to the Save Embroidery page.

Finish
Accept the final embroidery project layout and close the Split Wizard.

Worksheets
Print a worksheet for each embroidery section.

The worksheets illustrate the embroidery section, and list the threads to be used, and the 
quantity of each thread.

Page Setup

Select the information to be printed with the embroidery, such as the Dimensions, Color 
Information and Technical Information. In addition, the scale may be altered and a grid 
turned on or off. Set the Units of Measurement for the Dimensions and Technical 
Information to millimeters or inches, as desired.

Print a plan of the split 

Print a worksheet for each

Information used in worksheet

Full-size template for each 
section

section

sections
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Print Setup
Use Print Setup to select the destination printer and its connection. See “Print Setup” on 
page 281.

Print
The Print dialog box appears, where you may specify number of copies, the destination 
printer, and other printer setup options. See “Print Setup” on page 281.

Overview
Print a plan of the splitting of the embroidery, with the name of each section, and the 
number of stitches in each.

Print
The Print dialog box appears, where you may specify number of copies, the destination 
printer, and other printer setup options. See “Print Setup” on page 281.

Complete 2D Template
Print a full size 2D template of the split embroidery sections, with an outline around each 
section to indicate how to join them together.

See “Using the 2D Template” on page 179.

Print
The Print dialog box appears, where you may specify number of copies, the destination 
printer, and other printer setup options. See “Print Setup” on page 281.

Preparing an Embroidery Composition
You can use Split Design to split a large overall design that you have put together as a 
composition in mySewnet™ Embroidery. It is recommended not to ColorSort before 
saving such a design. This will reduce the number of movement stitches that cross split 
sections that would otherwise not use that color. Instead, ColorSort the split embroidery 
sections when exporting them.

When preparing your composition, also consider how you wish traveling stitches to follow 
the edges created by the split lines. The Connection setting in the Split Options tab 
provides a choice of Trim or Running Stitch. Use the Trim option when it is possible to 
route split lines through gaps, with only a few or no cuts across stitch areas. Use the 
Running Stitch option when the split lines will cross large stitch areas.

Hoop and Overlap Selection
For each embroidery, it is possible to vary the size of the overlap in combination with the 
number and orientation of the hoop areas. This may be desirable, for example, to split an 
embroidery without crossing any stitch areas. These choices must be balanced so that you 
have the fewest number of hoop areas with the largest possible overlap.

Keeping the number of hoop areas to a minimum saves the number of times you have to 
re-hoop, and also saves on changing colors. However, larger overlap areas are often 
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helpful in minimizing the need to split design elements. A margin for adjustments on the 
embroidery machine is also desirable. To alter the overlap, simply use the Load Design 
Wizard again.

In the Hoop Options tab, an orientation and overlap is automatically selected for your chosen hoop. You 
can change this to obtain the desired hoop overlap and an optimal number of hoopings. Try changing the 
overlap, orientation and number of hoopings in Hoop Options.
Also remember that you can change the overall position of the embroidery on the work 
area. Click OK in the Split Design dialog, use Select All  to select the whole embroidery 
in the mySewnet™ Stitch Editor work area, then click and drag it or use the nudge feature 
so that the embroidery is positioned over the overlap zones as desired.

In this example, the embroidery 'Flower Corner Large' from 
Documents\mySewnet\Samples\Stitch Editor\Stitch has been selected in the Split Design 
dialog on a 100mm x 100mm hoop with a 20mm overlap.

It can be seen that it currently occupies all four hoop areas. Also, the overlap zones pass 
through some of the heavier stitch areas.

By moving the whole embroidery, it now fits within only three of the hoop areas, and the 
top right area can be ignored when stitching out.
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Also, the split lines can be adjusted to split through lighter areas of stitching.

As well as moving an embroidery, you can rotate it so that fewer hoop areas are required 
to stitch it out.

In this example, the embroidery 'Star Trails' from Documents\mySewnet\Samples\Stitch 
Editor\Stitch has been selected in the Split Design dialog on a 100mm x 100mm hoop 
with a 20mm overlap.

This embroidery could simply be moved so that it only needs three hoop areas for 
stitching out.

However, by also rotating the embroidery, it will fit in two hoop areas. The overlap has also 
been reduced to 15mm to increase the margin for adjustment on the machine.
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Adjusting Split Lines
There is one split line for each overlap zone. The split lines show where the embroidery 
will be split. 

Each split line has points along the line that can be used to adjust the split line. There are 
two types of points: the triangular end points and square mid-points. The end points can 
only be moved along the edges of the design area, and may not be deleted. The mid-
points are initially placed about every 20mm, and they can be added and deleted as 
needed. All points are confined to the overlap zone to which they belong. As well as 
moving individual points as desired, the whole line can be moved across the overlap zone.

The embroidery will not be split if any split lines cross over themselves, or if any horizontal 
and vertical split lines cross each other more than once.

Adjacent horizontal or adjacent vertical split lines cannot cross each other.

Choosing Routes for Split Lines
Wherever possible, route the split lines through gaps in the embroidery, to minimize the 
cutting up of stitch areas.

When splitting through a stitch area, try to take the shortest route through the area if 
there is an obvious way to do this. 

The split through an area of stitching can be concealed by positioning the split line next to 
natural edges within the design. When crossing an open area of fill or satin, split in line 
with stitching.

When following a line of running stitch or satin border, if possible, place the split line to 
one side of the line or border so that it is not split into multiple segments. Check this by 
clicking OK to go back to the main screen, and in the View tab select 2D View with Stitch 
Points  to see the stitch points, and check the exact position of the split line. When you 
must cross the line, place the split line fully across it so that it is split cleanly.

If it is possible to route split lines through gaps, with only a few or no cuts across stitch areas, use the Trim 
option for Connection in Split Options. Use the Running Stitch option for Connection when the split lines 
cross large stitch areas.
The final size of each split section must also be assessed. Try to avoid having any sections 
that use the full width or height of a hoop if you have split through any stitch areas. This 
would mean that you have to be very precise when hooping up such a section. If you must 
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have a section that uses the full height or width of a hoop, then this section should be 
stitched first.

Use the zoom functions to zoom in and out to help with precise adjustment of the split 
lines. Click OK to go back to the main screen, and switch between 2D and 3D view to check 
that split lines are placed correctly. Add and remove points on the split lines as needed 
with Insert Point  and Delete Point .

Stitch Out and Align Split Embroidery Sections
Deciding the Stitchout Order
Generally, the split sections should be stitched out from the center. However, if the 
embroidery only uses a few hoop areas, stitch out the section with the heaviest stitching 
first, as this will be the section which pulls the fabric the most.

As with all projects, it is best to try some test stitchouts before stitching the final version. It 
is particularly important to make test stitchouts of some adjacent sections if you think 
they may be difficult to align. For example, it may be difficult to align sections if the split 
line across a fully stitched area is very irregular, or when one of the sections has very heavy 
stitching.

It is not possible to send split sections from within mySewnet™ Stitch Editor. Use a module such as 
mySewnet™ Embroidery, or the mySewnet™ Embroidery menu in Windows® Explorer.

General Alignment Considerations
Some designs will require less precise alignment than others. If you have split an 
embroidery so that the split lines go between all the stitch areas, it is unlikely that you will 
need to have perfect alignment between sections. The main consideration would be to 
ensure the fabric is straight each time it is re-hooped.

However, when any stitch areas are split, alignment is crucial to achieving a good 
stitchout. Using alignment stitches and compensation of Low or High in Split Options will 
help to align sections and eliminate gaps between them.

The alignment stitches are created in a medium gray color.
There are also various alignment aids including:

■ The printed full size 2D template
■ Worksheets for each section, optionally printed on transparency paper
■ The hoop template supplied with some machine hoops
■ Light sensitive pens that can be used to mark fabric, and other temporary fabric marks
■ Fabric stiffening aids and stabilizers that combat pull and make alignment easier
■ The needle and embroidery positioning controls on your embroidery machine

Using the 2D Template
This is the most useful alignment aid. The 2D template shows the whole embroidery at the 
size it will be stitched out. Each hoop area is marked by corners and a large + in the center. 
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The hoop area corners show the extreme points of the stitchable area within the hoop. If 
you have a hoop template supplied with your hoop, this corresponds to the stitchable 
area shown on the hoop template, usually marked as a grid.

The template starts in the top left corner and works across and down to the bottom right 
corner. When cutting out and joining the pages together, you may find it easier to leave 
the first page uncut, then cut the dashed edge of the next page before aligning it to the 
first page and taping it in place. Continue like this until all the pages are joined together.

You can also use the template as a guide to the size of your piece of fabric. The template shows the overall 
stitchable area that will be hooped, but you will need to allow extra fabric around the edges for physically 
hooping up the fabric.
Use the template to mark hoop centers on the fabric. Use a pin to punch a hole through 
the template at each hoop center. Pin the template to the fabric and mark the fabric 
through each hole. If the point that is marked will be stitched over and hidden, use a 
pencil or a pen to mark the center point. If the point will be on open fabric, use a light-
reactive fading pen.

Using Other Alignment Aids

Fabric Choice, Stiffeners and Stabilizers
In general, stiffer fabrics will resist pull and distortion better. 

Fabric stiffening aids and stabilizers will combat pull and make alignment easier. In 
particular, iron-on backing helps to resist fabric distortion. You may wish to apply this to 
the fabric before marking the hoop centers or making any other alignment marks.

Hoop Templates and Printed Worksheets
When hooping up each section, align the center marked on the fabric against the hoop 
template to guide the position of the fabric in the hoop. If you do not have a hoop 
template, use the printed worksheet at 100% scale for the section. You could also print the 
worksheet on transparency paper.

Center Lines
You may also wish to mark lines between the hoop center points so you can line up the 
fabric to the center marks on the frame of the hoop. This is especially helpful if you do not 
have a hoop template. Use a light-reactive fading pen to mark temporary lines just before 
you hoop the fabric. An alternative is to iron creases into the fabric as lines between the 
center points.

Stitching Out the First Section
First, ensure the fabric is straight in the hoop, according to the marked positions of the 
hoop centers. After selecting the embroidery on the machine, use the machine controls to 
position the needle over the center point marked on the fabric.

If you are unable to line up the needle correctly, this means that you have not hooped up your fabric with 
sufficient accuracy. You will need to move the fabric in the hoop and try again.
If you did not generate alignment stitches, simply start stitching out.
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If you have alignment stitches in your split embroidery sections, each section starts with a 
sequence of movement stitches. These movement stitches jump to the corner of a 
rectangle within the stitchable area of the hoop, that is half way across the overlap 
between the hoop areas. For the first section, skip past these movement stitches by 
advancing through the stitches in your design until it starts stitching out.

Aligning a Section to Previous Sections
First, ensure the fabric is straight in the hoop, according to the marked positions of the 
hoop centers. After selecting the embroidery on the machine, use the machine controls to 
position the needle over the center point marked on the fabric.

Aligning With No Alignment Stitches
Use the 2D template or full size worksheet to confirm that the embroidery will connect 
correctly to previous sections. This is easier to do if you have printed the template or 
worksheet on transparency paper. If you created test stitchouts, this will help you judge 
the positioning according to the effect of the fabric properties. Alternatively, you may use 
special positioning features on some machines.

Aligning With Corner or Baste Alignment Stitches
The previous sections will have placed alignment stitches that mark the corner positions, 
either as a small set of corner stitches or lines of basting stitch that meet at the corner. Use 
the machine controls to step through the sequence of movement stitches that should 
match up to the corners.

Adjust the machine so that the needle is over the appropriate corner for each movement 
stitch position. If there are no split stitch areas around the edges of the section that need 
joining to previous sections, your alignment should now be accurate enough to start 
stitching.

As the number of sections that must be stitched out increases, the type of fabric and embroidery become 
even more relevant for obtaining a good stitchout. Accurately hooped fabric and the alignment aids will 
help, but test stitchouts are also important.
If the section must join to stitch areas in previous sections, use the 2D template or full size 
worksheet to confirm that the embroidery will connect correctly. This is easier to do if you 
have printed the template or worksheet on transparency paper. If the alignment is too far 
out, it may be necessary to hoop up your fabric again.

Before starting to stitch, check the alignment stitches of the previous sections, and trim 
any that may be overlapped by the section you are about to stitch out. New alignment 
stitches will be added at the end of this section, to replace any that you trim.
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Splitting Examples
Split and Export a Chaffinch Embroidery

1 In mySewnet™ Stitch Editor Quick Access toolbar, click Insert  and load the embroidery 
Documents\mySewnet\Samples\Stitch Editor\Stitch\Chaffinches.

2 In the Modify tab, click Split Design  to open the Split Design window. The chaffinch embroidery is 
displayed with a suggested split line.
See “Split Design” on page 167.

3 Click the Options button to open the Splitter Options dialog.
See “Splitter Options” on page 169.

4 In the Hoop Options tab, click Change Hoop.
5 If needed, in the Hoop Selection dialog box select 240mm x 150mm - Universal Large Hoop 2, and set 

Orientation to Rotated. Click OK.
6 Set the Overlap to 20mm.
7 Click the Split tab.
8 Ensure that Alignment Stitch Style is set to Corner, compensation is set to Low, and Connection is set 

to Trim.
Use the Trim option for Connection unless the split lines need to go through solid or heavy areas of 
stitching. 

9 Click OK to close the Splitter 
Options dialog. The split line 
is acceptable in its default 
position, so there is no need 
to adjust anything for this 
embroidery.

10 Click the Split Embroidery 
icon . The Save Embroidery 
dialog box appears.

11 The top half of the split design 
is shown in the Preview area. 
Click Next  and the lower 
section of the embroidery will 
be shown.
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12 Click Real Size  to see the embroidery section at the size it will be stitched. You can use the scroll 
bars to see the alignment stitches at each corner of the embroidery.
The alignment stitches are pale gray in color.

13 Click Zoom To Fit  to show the whole embroidery section again.
14 Click the Export button. The Export dialog box appears.
15 In the File Format box, ensure .vp4 is selected, and click OK. The Save As dialog box will appear.
16 In the Save In box, browse to the folder Documents\mySewnet\My Designs. In the File Name box, 

leave the name as 'ChaffinchesExported’, then click Export. The split embroidery is exported as two 
separate files called 'ChaffinchesExported_01' and 'ChaffinchesExported_02'.
If your machine only supports short file names, choose a shorter name. You can stitch out the sections in 
the order you think is most suitable for each split design.

17 Click Next. The Print Options 
page will appear.
If you have not saved the files a 
warning message will be 
displayed.

18 In the Overview area, click 
Print . 

19 To print, in the Print dialog box 
click OK. An overview of how 
the embroidery has been split 
will be printed.
The Overview shows how the 
embroidery has been split, how 
each split section has been 
named, and the number of 
stitches involved. Use this to 
determine the order which you 
think is best for stitching out the split sections.

20 In the Complete 2D Template area click Print, and then OK. (If necessary, use 
Properties to change printing to single side.) A full-size 2D template of the 
split embroidery sections is printed, with an outline around each section to 
indicate how to join them together.
Cut out the 2D template and attach the sections as a guide for positioning fabric 
within the hoop.

21 In the Worksheets area, click Page Setup.
22 In the Page Setup dialog box, set Design Scale to 50%, and click OK.
23 Click Print and then OK to print the worksheets.

The worksheets give the dimensions of the section, the number of stitches, 
information on the thread colors used and the Notes and Settings for the 
embroidery.

24 Click Finish to close the Split Project Wizard.
25 Click OK to close the Split Design window.
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Split a Butterfly Garden Embroidery
1 In mySewnet™ Stitch Editor Quick Access toolbar, click Insert  and load the embroidery 

Documents\mySewnet\Samples\Stitch Editor\Stitch\Butterfly Garden.
2 In the Modify tab, click Split Design  to open the Split Design window. The butterfly embroidery is 

displayed with a suggested split line.
See “Split Design” on page 167.

3 Click the Options button to open the Splitter Options dialog.
See “Splitter Options” on page 169.

4 In the Hoop Options tab, click Change Hoop.
5 In the Hoop Selection dialog box select 240mm x 150mm - Universal Large Hoop 2, and set 

Orientation to Natural. Click OK.
6 Set the Overlap to 60mm.
7 Set Across to 3. This is the number of hoops to be used.
8 Click the Split tab.
9 Ensure that Alignment Stitch Style is set to Baste, compensation is set to None, and Connection is set 

to Trim.
Use the Trim option for Connection unless the split lines need to go through solid or heavy areas of 
stitching. 

10 Click OK to close the Splitter Options dialog.
Notice that the largest brown butterfly covers the full width of the overlap zone on the right. This means 
that the butterfly is not completely in either of the hoops that overlap here. One solution is to move the 
butterfly so it is not split.

11 In the Split Design window, click OK.
You can see the split lines and overlap zone, and the outline of the splitting hoops.

12 In the main mySewnet™ Stitch Editor window, click the Home tab.
13 Click Zoom To Rectangle . The pointer will change to the zoom in pointer .
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14 Click and drag to draw a rectangle around the large brown butterfly, 
then release the mouse button to zoom in.

15 Click the Freehand Select icon . The pointer will change to the 
freehand select pointer .

16 Click and drag to draw a line that goes around the large brown 
butterfly, without including any of the butterflies nearby.

17 Release the mouse button when you have drawn the line nearly 
back to the starting point. The stitches making up the butterfly will 
be selected, as indicated by the selection box around the butterfly.
The selection box may be a little larger than the butterfly. This is 
because you may have selected some movement stitches that are not 
shown in 3D view.

18 Click and drag inside the selection box to move the butterfly to the 
left by one grid square. The butterfly is now completely inside the 
center hoop position. If desired, use the arrow keys to nudge the 
butterfly into position.

19 Right-click to deselect the butterfly and the Freehand Select 
function.

20 Click Zoom To Fit  and you will see how much the layout has 
changed. The embroidery will look better if the butterfly is left in its 
original position. This means it must be split.

21 Click Undo . The move you made to the butterfly will be undone 
and it will return to its original position.

22 In the Modify tab, click Split Design  to open the Split Design 
window.

23 Click Zoom To Rectangle . The pointer will change to the zoom in 
pointer .

24 Click and drag to draw a rectangle over the large brown butterfly, 
then release the mouse button to zoom in. It will be easier to adjust 
the split line through the butterfly when you are zoomed in.

25 Move the mouse pointer over the upper point on the split line that is 
on the top wing of the butterfly. The mouse pointer will change to a 
four-pointed arrow . 

26 Click and drag and you will move the point. 

Notice that the split line between the wing and the body could be improved. Extra points can be added and 
adjusted to do this.

Click and drag the point a to the 
left so that the split line above the 
point is clear of the wing.

Click and drag the 
second point over the 
wing so that it is 
between the wing and 
the antenna, clear of 
any of the stitch points.

There is a point that is level with 
the bottom of the body of the 
butterfly. Click and drag this point 
to the right so that it is in the 
middle of the space between the 
body and the lower right wing.
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27 Click the Insert Point icon  and the Insert pointer 
appears .

28 Click to add four new points along the line that crosses 
between the wing and the body, then click Move Point  to 
deselect the function.
If you accidentally add an extra point, use the Delete Point 
icon  to remove it.

29 Click and drag these four points so that the split line follows 
around the outside of the body of the butterfly.

30 Click Zoom To Fit .

31 On the right-hand split line, there are two points that go 
through the wings of the small brown butterfly. Click and drag both points to 
the left, so that the split line clears the wings of the small butterfly.

32 There are three points in the blue flower. Click and drag each of these to the 
right so that the split line goes around the blue flower. Ensure that the split 
line does not go through the leaves of the yellow flower.

33 Move the mouse pointer over the second to top point on the split line on the 
left.

34 Move it clear of the butterfly’s wing.
35 Click and drag each of the points on the split line that goes through the 

butterflies or the blue flower, and move them so that the split line goes 
around the butterflies and flowers.
Notice that the split line goes to the left of the blue butterfly that is on the overlap 
zone. 
Ideally, it would be better if this butterfly was in the left-hand hoop area instead, 
as this would reduce the number of thread changes that were needed when 
stitching out, however as the right tip of the wing is in the next hoop, this cannot 
be done by moving the split lines.

Alternatively, in the main screen you could click Select All  to select all of the split sections of the 
embroidery, then click and drag the complete embroidery to the left, so that both of the two blue 
butterflies are within the left hoop section. Then reset your split lines.
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36 In the main screen, use Design Player  to preview the stitching of the split sections of the 
embroidery with alignment stitches and export options included.

37 In the Modify tab, click Split Design  to open the Split Design window again.
38 Click the Split Embroidery icon . The Split Project Wizard - Save Embroidery dialog box will appear. 

The first section of the split design is shown in the Preview area. Notice the baste alignment stitches 
that form a rectangle on the section.

The full rectangle of the baste alignment stitches (which are a medium gray) may not be visible at Zoom To 
Fit. To see the alignment stitches clearly, zoom in with Zoom In or Real Size and use the scroll bars to move 
around the preview.

39 Click Next  twice to see the other split sections.
40 Click Export All Sections  to save the project as numbered sections. The Export dialog box will 

appear.
41 In File Format, ensure that .vp3 is selected, then click OK. The Save As dialog box will appear.
42 In the Save In box, browse to the folder Documents\mySewnet\My Designs.
43 Click "New Folder", and name the new folder Butterfly Garden. Then browse to the new folder.
44 In the File Name box, enter the name ’ButterflyGardenExported’, then click Export.

The files will be saved as the files ButterflyGarden_Exported_01 to ButterflyGarden_Exported_03. Creating 
a new folder makes it easier to find all the sections.
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When stitching out this split embroidery, stitch section 'Butterfly GardenExported_03' before 'Butterfly 
GardenExported_02'. Section 'Butterfly GardenExported_03' contains the right wing of the butterfly that 
was split, and it will look better if the part with the body of the butterfly is stitched after the wing. This 
should also successfully conceal the split.

45 Click Next. The Print Options 
page will appear.
If you have not saved the files a 
warning message will be 
displayed.

46 In the Overview area, click 
Print . 

47 To print, in the Print dialog box 
click OK. An overview of how 
the embroidery has been split 
will be printed.
The Overview shows how the 
embroidery has been split, how 
each split section has been 
named, and the number of 
stitches involved. Use this to 
determine the order which you 
think is best for stitching out the split sections.

48 In the Complete 2D Template area click Print, and then OK. (If necessary, use Properties to change 
printing to single side.) A full-size 2D template of the split embroidery sections is printed, with an 
outline around each section to indicate how to join them together.
Cut out the 2D template and attach the sections as a guide for positioning fabric within the hoop.

49 In the Worksheets area, click Page Setup.
50 In the Page Setup dialog box, set Design Scale to 50%, and click OK.
51 Click Print and then OK to print the worksheets.

The worksheets give the dimensions of the section, the number of stitches, information on the thread 
colors used and the Notes and Settings for the embroidery.

52 Click Finish to close the Split Project Wizard, then click OK to close the Split Design dialog box.
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11Embossing
Use the Emboss features to add beautiful patterns to your embroideries.

Effect
Use Effect to change the prominence of embossed or stamp effects. Select from Standard 
or Super.

The Super effect creates a heavier impression as more needle points are removed surrounding the stamp or 
embossed line.

Standard
When needle points are added, they are not placed close to existing needle points.

Shortcuts
■ Effect, Emboss Tab
■ Keys: Alt, E, ST

Super
When needle points are added, if an existing needle point is found close by, it is removed 
before adding the new needle point. This creates a heavier impression in the stitched area.

Shortcuts
■ Effect, Emboss Tab
■ Keys: Alt, E, SU

Needle Points
Use the Emboss Line  functions (Freehand Emboss Line  and 
Point Emboss Line ) to emboss lines on areas of stitching. Use 
Remove Needle Points in Fill   to remove stitch points before 
embossing.

Freehand Emboss Line
Use Freehand Emboss Line  to draw a line to emboss on an area of 
stitching. To move the points in the line after drawing, place the 
pointer over a node. The Move Node pointer  appears. Move the node as desired.

Select the strength of the emboss or stamp

Emboss a line on a stitch area
Remove the needle points in a fill

Select a stamp category Choose a stamp

Load an image as a stamp

Create a stamp from text

Set the stamp size & angle

Mirror the selected stamp

Select a Single, Line or Stamp Fill

Emboss Tab
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To change a round (curved line) point to a square (straight line) point, hold down the Shift 
key and click the point while moving it.

Each line you place, as ended by a right-click, is treated separately by Undo.

Shortcuts
■ Needle Points, Emboss Tab:
■ Keys: Alt, E, E, FT

Draw an Embossed Line on a Petal
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Pink' embroidery.
4 Click the Emboss tab.
5 Zoom in on one of the petals.
6 In the Emboss Line  drop-down menu, click Freehand Emboss Line . The pointer changes to 

the draw pointer .
7 Draw a curved line along the length of the petal. The first point appears automatically as a small 

square.
8 Release the mouse pointer to complete the line.

The emboss line will appear with the first point as a square and later points as circles, 
except for a yellow square final point.

9 Place the pointer over a node. The Move Node pointer  appears.
10 Click and drag to move the node, and adjust the line.
11 Use Shift+click to change a round node to a square node while moving it.

Round nodes form a curved line, and square nodes form an angular line.
Click Delete to remove the last–placed point.

12 Right-click to emboss the line on the petal.
13 Repeat to place as many embossed lines as desired.

Once an embossed line has been placed it can be removed with Undo, but it cannot be further edited.

Point Emboss Line
Use Point Emboss Line  to place points to emboss a line on an area of stitching.

Each line you place, as ended by a right-click, is treated separately by Undo.

Shortcuts
■ Needle Points, Emboss Tab:
■ Keys: Alt, E, E, FP

Place Points to Emboss a Line on a Petal
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Flower Pink' embroidery.
4 Click the Emboss tab.
5 Zoom in on one of the petals.
6 In the Emboss Line  drop-down menu, click the Point Emboss Line  icon. The pointer changes 

to the Point pointer .
7 Click to place your first point. The point appears automatically as a small hollow square.
8 Click to place a second point.

The second and subsequent points are round.
9 Continue placing points along the desired path. 
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10 Curved lines are created automatically. For corners and straight sections, hold down the Shift key. 
Click Delete to remove the last–placed point.

11 To move one of the nodes, move the pointer over the node. The pointer changes to the Move Node 
pointer .

12 Adjust the position of the node as desired.
13 Right-click to end the line and deselect the function. The emboss line will appear on the selected 

petal.
14 Repeat to place as many embossed lines as desired.

Remove Needle Points In Fill
Use Remove Needle Points In Fill  to remove most of the needle points within an area 
of stitches, leaving the area blank so that the stamp you apply will show clearly. Only 
visible stitches are affected.

If underlay stitches are not hidden, they will also have their stitch points removed. If desired, use the Draw 
Range slider bars to hide underlay stitches so they are not affected.
Use this function to prepare areas with existing patterns for stamps or embossed lines.

Not all stitch points are removed. If you find it necessary to have all stitch points removed from inside an 

area then use Delete . Select a block within the bounds of an area using one of the Select functions. 
Ensure you do not select any part of the edge of the area or the shape of the area will be lost or distorted. 
For instance, if you have a rectangle then use Box Select to make a block that is just inside the stitches 
along the edges of your rectangle. Delete the stitch points with Delete and you will be left with the shape of 
the area with stitches going across it, but no stitch points inside the area.

Shortcuts
■ Needle Points, Emboss Tab: 
■ Keys: Alt, E, RN

Remove the Stitch Points from an Embroidery Background
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Girl with Rose' 

embroidery.
4 In the Control Strip, click Draw Next Color Block  once so that the background color behind the 

girl’s head is shown.
5 Click Ghost Mode . The stitches that were hidden are now shown in pale colors.
6 Move the Draw To End handle at the right of the slider bar to 

approximately stitch number 3114. This hides the background 
areas between the girl’s head and hair, and below her portrait.
To adjust stitch by stitch, use the arrows in the stitch number boxes.

1. Original pattern in 2D 2. Needle points removed in 2D
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7 Click the Emboss tab.
8 Click Remove Needle Points in Fill . The stitches making the flat 

fill pattern will be removed.
It is recommended to use Remove Needle Points in Fill before 
stamping an area of stitches. This is so that the new pattern or series 
of stamps is clearly visible, rather than adding to an existing fill 
pattern.

Stamps
Stamps are used to place extra stitch points on existing threads to make a predefined 
symbol or pattern. Stamps can be placed individually, in lines or used to fill all visible 
stitches with the selected pattern. The Stamp functions are found on the Emboss tab.

Select a Stamp
There are 7 named categories of stamps.

Select a set of stamps by name from the drop-down list to the left of the 
Stamp samples.

Use the arrows at the right of the Stamp 
box to scroll through the stamps within a 
set, or click the drop-down arrow to view 
the stamps gallery. When you see the 
desired stamp, click it. It will be 
highlighted with a different shade of blue 
and it will be shown in the sample box at 
the current Size and Angle.
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Load Stamp File
Use Load Stamp File  to load an .ecq or .4qb file to use as a stamp. Load Stamp File 
opens the Open dialog box that shows thumbnails of .ecq and .4qb files.

Load an ecq or 4qb file as a stamp by clicking the corresponding thumbnail.

To see details about a file, position the arrow pointer over the desired thumbnail. A label 
showing the file information will appear.

Shortcuts

■ Stamps, Emboss Tab: 
■ Keys: Alt, E, L

Load a Picture to Stamp an Area
1 In mySewnet™ Draw & Paint load or design a drawing in the Draw tab, and then save it as an .ecq file.

You cannot use pictures from the Paint tab as a stamp.
2 In mySewnet™ Stitch Editor open the Emboss tab.
3 On the Emboss tab, click Load Stamp File  and the Open dialog box appears.
4 Browse to the desired folder.
5 Scroll down to see further designs, if available.
6 Click on a picture to highlight the .ecq or .4qb design
7 Click Open to load the design, and close the viewer.
8 Use your picture as a stamp.
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Create a Text Stamp
With Create a Text Stamp  you can use the TrueType® or OpenType® fonts on your 
computer to create a stamp with your selection of letters. 

Only the outlines will be used to create needle points.
Choose from Regular, Bold, Italic or Bold Italic styles, and adjust the font size in points.

Enter the desired text and click OK. The text then appears in the preview in the Emboss 
tab. Adjust the Size and Angle as desired.

Create multi-line text by pressing ENTER while typing in the Text box.

Shortcuts
■ Stamps, Emboss Tab: 
■ Keys: Alt, E, C

Add a Name Below the Sweet Rose Embroidery
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Girl with Rose 

Background' embroidery.
Alternatively, you could use the embroidery you created in “Stamp the Background of the Sweet Rose 
Embroidery” on page 201.

4 In the Control Strip, click Draw Next Color Block . The complete background is shown.
It is not necessary to isolate the visible stitches with the draw range handles, as no needle points will be 
removed.

5 Leaving the flat fill background unchanged, set Effect to Super.
The Super effect creates a heavier impression as more needle points are removed surrounding the stamp.

6 Click Create a Text Stamp . The Create Text dialog box will appear.
7 In the left drop-down list, select Georgia as the font.
8 In the style (center) drop-down list, select Bold.
9 In the furthest right (font size) drop-down list, ensure that 144 is selected.

This affects the shape of the letters, but not their size in the stamp, as the stamp’s height can be changed 
before it is used.
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10 Click inside the text box. The pointer changes to an I-
bar .

11 In the text box, enter the words:
SWEET ROSE

12 Click OK. The stamp preview box now contains your 
text.

13 Click Single Stamp , then move the pointer over 
the work area. The pointer is now the text "SWEET 
ROSE".

14 The lettering is slightly too large to fit in the space at 
the bottom of the picture. Set the Size to 6mm.

15 Move the stamp so that the letter ’T’ is over the center grid line. 
16 Click to place the stamp.
17 Right-click to deselect your text stamp. 
18 In the Control Strip, click Draw All Stitches .

To add stamp buttons to the jacket, see “Make Diamond Stamp Buttons for the Sweet Rose Embroidery” on 
page 198.

Stamp Size
Set the stamp Size from 2 to 50mm in 1mm steps. The default setting is 10mm.

To see how big a stamp will be, select Single Stamp and move the mouse pointer over your embroidery.

Stamp Angle
Rotate the stamps to any angle from 0 to 359 degrees. One 
reason for changing the angle is to get the best result from a 
stamp, so that any straight lines in the stamp are at a 
different angle to threads in the embroidery. When you have 
parallel or nearly parallel lines between the stamp and the 
threads then fewer stitch points will be placed and the stamp 
will be less noticeable.

The stamp sample to the right of the Size and Angle boxes 
shows how the stamp will look. Use Single Stamp to see how 
the stamp will be used on the embroidery and as a check against parallel lines between 
the stamp and threads.

Vertical Flip
Use Vertical Flip  to mirror the selected stamp from top to bottom. 

0 degrees

45 degrees

Stamp
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Shortcuts
■ Stamps, Emboss Tab: 
■ Keys: Alt, E, V

Horizontal Flip
Use Horizontal Flip  to mirror the selected stamp from left to right.

Shortcuts
■ Stamps, Emboss Tab: 
■ Keys: Alt, E, H

Applying Stamps
The following methods are available to place stamps onto your embroidery. 

Single Stamp
Use Single Stamp  to place individual stamps.

Stamp Line
Use the Stamp Line  functions to create a line of stamps. 

Freehand Stamp Line
Use Freehand Stamp Line  to draw a line of stamps in any direction.

Point Stamp Line
Use Point Stamp Line  to place points for lines of stamps in any direction.

Stamp Fill
Use Stamp Fill  to fill all visible stitches with the currently selected stamp.
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Single Stamp
Use Single Stamp  to place the currently selected Stamp one at time with each click of 
the mouse. The mouse pointer will become the shape of the selected stamp when the 
mouse is over the work area. Use this to see how big the stamp will be on the embroidery. 
Click to place the stamp.

Select different stamps and change the stamp size or angle without deselecting Single 
Stamp. Right-click to deselect Single Stamp. Only visible stitches are affected.

Shortcuts
■ Stamps, Emboss Tab: 
■ Keys: Alt, E, SS

Add a Single Stamp to a Thick Border
1 Isolate the stitches you want to stamp by hiding colors 

and/or using Draw Range.
2 If required, click the Remove Needle Points In Fill 

icon  to remove any existing pattern.
3 In the Stamps area, select the desired stamp.
4 Select the size for the stamp using the Size box.

In the example on the right, a star in the Climate stamp 
category was used.

5 Enter the Angle to which you want to rotate the stamp.
6 Click the Single Stamp icon . When you move the 

mouse pointer into the work area it will show the shape, 
size and angle of the stamp as it will be used.

7 Click on a stitched area to place the stamp. Stitch points will be inserted each time you click. If you 
click in a blank area or on hidden stitches then there will be no effect. If desired, select different 
stamps and change the size or angle while Single Stamp is active.

8 When you have placed all the required stamps, right-click to deselect Single Stamp.
If you use Undo after placing Single Stamps then each Undo will undo one stamp at a time.



198          mySewnet™ Stitch Editor   Embossing 

Freehand Stamp Line
Use Freehand Stamp Line  to place lines of the currently selected stamp across an 
embroidery in any direction. Click and drag to draw the line, then release the mouse 
button to preview the line of stamps. Adjust the nodes on the line as desired to change 
the direction of the line. Right-click to place the line of stamps. Only visible stitches are 
affected.

Select Freehand Stamp Line again to place another stamp line.

Shortcuts
■ Stamps, Emboss Tab: 
■ Keys: Alt, E, SL, FT

Draw a Line of Stamps Across an Embroidery
1 Isolate the stitches you want to stamp by hiding colors and/or using Draw Range.
2 If required, click the Remove Needle Points In Fill icon  to remove any existing pattern.
3 Select the desired stamp.
4 Select the size for the stamp using the Size box.
5 Enter the Angle to which you want to rotate the stamp.
6 In the Stamp Line drop-down list, click the Freehand Stamp Line icon .
7 Click and drag across a visible area of stitches. As you drag the mouse, a line at the selected size and 

angle will be shown.
8 Release the mouse button to view the stamp line.
9 To adjust the nodes on the line, move the pointer over a node. The pointer changes to the move node 

pointer . Drag the node as desired.
Use Shift+click to replace a round node with a square node to make an angular line.
Click Delete to remove the last–placed point.

10 If desired, select different stamps and change the size or angle while Freehand Stamp Line is active.
11 Right-click when the line of stamps is placed as desired. Stitch points will be inserted according to 

how you have placed the line of stamps.
12 To place other lines, reselect Freehand Stamp Line.

If you are not satisfied with a particular line of stamps, use Undo to undo one line of stamps at a time.

Point Stamp Line
Use Point Stamp Line  to place lines of the currently selected stamp across an 
embroidery in any direction. Click and drag to preview the stamp outlines, then release 
the mouse button to place the line of stamps.

Select different stamps and change the stamp size or angle without deselecting Stamp 
Line. Right-click to deselect Stamp Line. Only visible stitches are affected.

Shortcuts
■ Stamps, Emboss Tab: 
■ Keys: Alt, E, SL, FP

Make Diamond Stamp Buttons for the Sweet Rose Embroidery
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .



mySewnet™ Stitch Editor   Embossing              199

3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Girl with Rose and Name' 
embroidery.
Alternatively, you could use the embroidery you created in “Add a Name Below the Sweet Rose Embroidery” 
on page 194.

4 In the Emboss tab, select the Games stamp Category, then click the diamond stamp (number 9).
5 Set the stamp size to 4mm.
6 Set the Angle to 30 degrees.

The preview changes to show the new angle.
7 In the Stamp Line drop-down list, click Point Stamp Line .
8 Click and drag the slider on the Zoom Bar at the bottom of the 

Design Panel to zoom in on the picture of the girl.
Alternatively, click the plus icon to increase magnification 10% each 
time.

9 Click to place points for a line of buttons down the front of the girl’s 
jacket.

10 Right-click to finish the line of buttons.
11 Click Zoom To Fit .

.
If you are not satisfied with the line of stamps, use Undo to undo one line of stamps at a time. Right-click to 
deselect the Stamp Line function before using Undo.

You can select Point Stamp Line  again to place other lines. If desired, select different stamps and 
change the size or angle while Stamp Line is active.
To add a border to the embroidery, see “Add a Satin Border to the Sweet Rose Embroidery” on page 91.
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Stamp Fill
Use Stamp Fill  to fill all visible stitches with the currently selected stamp. It is 
recommended to use Remove Needle Points In Fill from the visible stitches before using 
Stamp Fill.

To use Stamp Fill, isolate the stitches you want to stamp by hiding colors and/or using 
Draw Range, then use Remove Needle Points In Fill  to remove any existing pattern. 
Select your desired stamp and its Size and Angle, then click Stamp Fill . An animation 
will play while the fill is calculated. When the process is complete, the visible stitches will 
be shown with the new pattern stamped in.

If you are not satisfied with the result, use Undo to undo the fill, then reselect Stamp Fill.

Shortcuts
■ Stamps, Emboss Tab: 
■ Keys: Alt, E, SF

1. Original pattern in 2D with Stitch 
Points

2. Needle points removed in 2D

3. Rose used for Stamp Fill in 2D 4. Roses in 3D
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Stamp the Background of the Sweet Rose Embroidery
1 Change the background color to pink. See “Add a Basting Line to Sweet Rose Border” on page 161.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 Browse to the folder Documents\mySewnet\Samples\Stitch Editor\Stitch. 
5 Load the 'Girl with Rose' embroidery.
6 In the Control Strip, click Draw Next Color Block  once so that the background color behind the 

girl’s head is shown.
7 Click Ghost Mode . The stitches that were hidden are now shown in pale colors.
8 Move the Draw To End handle at the right of the slider bar to approximately stitch number 3114. This 

hides the background areas between the girl’s head and hair, and below her portrait.
Stitch numbers are given as guides only. It is more important to ensure that the correct stitches are hidden 
or left showing than to follow the exact stitch numbers. 
To adjust stitch by stitch, use the arrows in the stitch number boxes.
Click in the space on the slider bar on either side of the handle to move it 
in that direction and change the stitch number by 50 at a time. You can 
also click and hold to change the number more rapidly, but the handle 
will stop when it reaches the arrow pointer.

9 Click the Emboss tab. 
10 Click Remove Needle Points in Fill . The stitches making the flat fill 

pattern will be removed.
It is recommended to use Remove Needle Points in Fill before stamping an 
area of stitches. This is so that the new pattern or series of stamps is clearly 
visible, rather than adding to an existing fill pattern.

11 Set Effect to Standard.
12 In the stamps area, select Plants in the Category drop-down menu.
13 Click the rose stamp (number 3) and it will be shown in the preview box 

for the stamps.
14 Click Single Stamp , then move the pointer over the work area. The 

pointer is now a rose.
You can change the stamp and stamp options while Single Stamp is selected. You can also do this when 

using Freehand Stamp Line  and Point Stamp Line .

15 Place the rose pointer over the area between the girl’s shoulders and hair. 
At the default size (10mm) the stamp is a little large to be used in this area; a smaller size would look 
better.

16 Set Size to 8mm and move the pointer back over the work area. The pointer is now smaller.
The pointer uses the size and angle that you choose in the Stamps area of the ribbon bar. 

17 Click Stamp Fill . The new stitch points are calculated, then the 
new fill pattern will be shown, giving a sculpted rose background 
behind the girl’s head and shoulders.

18 Click Draw All Stitches .
19 Click Draw Next Color Block . Only the background color is 

shown.
20 Move the Draw From Start slider at the left of the slider bar to 

approximately stitch number 7231, so that only the background 
showing between the girl’s hair and body is visible. The end 
number should be about 7586.



202          mySewnet™ Stitch Editor   Embossing 

If this isolates a different part of the design, check that Effect is set to Standard, and stamp size is set to 
8mm.

21 Click Remove Needle Points in Fill .
22 Ensure that Standard is selected.
23 Click Stamp Fill . The animation plays while the background area is decorated.

The end number has now changed to approximately 7922. The start and end numbers change as needle 
points are added and removed.
The movement stitch between these two small background areas is concealed by the girl’s jacket. It is 
recommended to hide any visible movement stitches before stamping, to ensure that they are not turned 
into normal stitches. In 2D view, movement stitches appear as dashed lines of stitches.

24 Click Draw All Stitches .
To add a name to the embroidery, see “Add a Name Below the Sweet Rose Embroidery” on page 194.
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12Editing Objects
You may want to edit areas and lines as objects, changing their properties; for example a 
fill type, density or pattern. Select the Object tab, click inside the desired area to select the 
object, then change the outline of the object, or right-click to access and change its 
properties.

If an object is difficult to select, use the Control Strip features. Alternatively, use Show Only Object  to 
hide other objects, then select it.

Select Objects
In the Object window in mySewnet™ Stitch Editor, designs are made up of a sequence of 
lines and areas (e.g. stitch lines, fills and columns). Each area, line or column is defined by a 
number of points.

Select an Object to Edit
In the Object window move the pointer over the embroidery and you will see the points 
and outlines of the different areas. Click  inside a line or an area to select the object. 
The Edit Properties section of the Object tab will show what object type it is.

To select multiple areas, hold down the Ctrl key when selecting. It is often helpful to use Draw Previous 
Color Block  or Draw Next Color Block  to isolate areas for object editing.

After locating the desired object, click and drag its points to change the shape of the 
object. You can insert extra points  or delete unwanted points  in the selected 
object.

Alternatively, click the Properties button or right-click the object to access a dialog box to alter properties 
such as Fill Pattern or Stitch Length.

Select an object and stitch type

Edit the object’s properties

Make the stitching lighter or denser
Change the object’s stitch type

Remove stitches underneath the object

Align the origin handles for multiple selected fill areas

Show only the selected object

Add or remove points in an object outline

Add or remove a wave line 
from a MultiWave Fill area

Object Tab
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Change Object Settings
Change the Settings for an Object

1 Open an embroidery.
2 Click the Object tab. The pointer changes to the Object Select  pointer.
3 Move the pointer until the desired area is highlighted, then click to select the object. 

You can use Ctrl + click to select more than one object at a time.
The object type is displayed in the Edit Properties and Convert sections of the Object tab.

4 Right-click the object. A context menu is displayed.
 If you have selected more than one object type, you can choose the desired type in the context menu.

5 Select the stitch type properties from Edit... at the top of the context menu. The properties dialog box 
for that stitch type is displayed.

6 In the properties dialog box make the desired changes, and click OK to save the changes.

Convert an Object and Change its Settings
1 Open an embroidery.
2 Click the Object tab. The pointer changes to the Object Select  pointer.

To make it easier to select the desired object, use the color worksheet and slider bars to hide other objects.
3 Move the pointer until the desired area is highlighted, then click on the desired object.

To change the properties of the selected object, right-click on the work area and select the object type from 
the context menu. The properties dialog box for the object type will appear.

4 To convert the selected object, choose the desired object type from the Convert  drop-down 
menu. 
Alternatively, right-click the object and select a new stitch type from the context menu. 
The properties dialog for the converted object will appear. Make any desired changes.

5 To further change the properties for a converted object, click Properties while that object is still 
selected, or right-click and select the stitch type. The properties dialog box for the object type will 
appear.

6 Change the settings in the properties dialog box then click OK to apply the new settings. Click Cancel 
if you decide not to save the new settings.
The settings are remembered in that session. After closing and reopening the program, lightly stitched fill 
types such as Contour Fill and MultiWave fill will be detected as running or double stitch lines, not as fills. 

Edit Properties
The stitch type for the currently selected object is shown in the 
Edit Properties area.

If more than one object is selected, further stitch types can be seen in the stitch 
type drop-down list.

Properties
To change the properties for the selected stitch type, click the Properties  button, or 
select Properties from the right-click context menu. The Properties dialog box for the 
stitch type will appear.

Shortcut
■ Keys: Alt, O, P
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Lighter Density
Use Lighter Density  to make the stitches in the currently selected object(s) more open. 
When clicked, the density value is increased by 1.

Shortcuts
■ Object Tab, Edit Properties: 
■ Keys: Alt, O, L

Heavier Density
Use Heavier Density  to make the stitches in the currently selected object(s) more 
closed. When clicked, the density value decreases by 1.

Shortcuts
■ Object Tab, Edit Properties: 
■ Keys: Alt, O, H

Convert
Use the Convert function to change the currently selected 
object to another stitch type.

Select the object that you want to convert, then click 
Convert  and select a new stitch type from the drop-down 
menu. The stitch type properties dialog box will appear. 

 If more than one object is selected, there may be more than one stitch 
type to convert from.
Select the desired properties and click OK to change the 
stitch type. See “Change Bumblebee Wings to Contour Fill” on 
page 252.

Alternatively, right-click and select the stitch type to convert to from the context menu.



206          mySewnet™ Stitch Editor   Editing Objects 

Stitch and Area Types
Stitch types in the following two groups may be changed to any other stitch type in either 
of these groups:

Lines

Areas

When converting to a Satin Area, any holes in the fill area will be lost.

Columns
Objects in this group may be changed to any other stitch type in the group:

Any Column can be changed into a Satin Area, but it cannot be changed back.

Running Stitch Double Stitch Double Zigzag 

Triple Stitch Satin Line Motif Line 

Pattern Fill Motif Fill Shape Fill 

Radial Fill Spiral Fill QuiltStipple Fill 

Contour Fill Crosshatch Fill Curved Crosshatch Fill 

MultiWave Fill Echo Fill Satin Area 

Satin Column Feathered Satin 

Richelieu Bars Tapered Motifs 
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Area Types
Pattern Fill  areas 
contain small stitches 
with repeating 
patterns, which can be 
selected from the 
system fill patterns.

Contour Fill  areas 
use contour stitch 
lines. Vary the gap 
between stitch lines 
and the length of the 
stitches, use running, 
double or triple stitch.

Shape Fill  areas use 
one of 120 different 
shapes. Vary the stitch 
density, use running 
stitch or motif lines for 
the fill.

Radial Fill  areas use a 
pattern of radiating lines 
from an origin point that 
can be moved. Vary the 
stitch density.

Spiral Fill  areas use 
a spiral pattern from an 
origin point that can 
be moved. Use 
constant or gradient 
density.

QuiltStipple Fill  
areas use stipple stitch 
in curved or straight 
lines. Vary the gap 
between stitch lines, 
use running or triple 
stitch.

Motif Fill  areas 
contain repeated small 
stitches using one of the 
Universal or machine 
motif patterns. The 
motifs can be at any 
angle and at different 
sizes, and can be varied 
on alternating lines.

Crosshatch Fill  areas 
use diamond, square and 
parallel crosshatch 
patterns, or select the 
angles. Set the gap, style, 
line angle, stitch type and 
stitch length.
Crosshatch fill is often 
used for lace designs.

MultiWave Fill  
areas use a wave 
pattern defined by a 
line, or lines, drawn on 
the fill area. Vary the 
density, or use a motif 
for the stitch lines.

Echo Fill  areas use 
echo lines within or 
around a shape. Use 
rounded, square and 
diagonal corners, and 
set the gap between 
the echo lines.

Curved Crosshatch 

Fill  areas use a mesh 
of curving lines. Vary the 
curve and the gap 
between the lines, and 
use running, double, 
triple or motif lines.
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Satin Areas
Satin Areas  contain zigzag stitches that fill the area from one end 
to the other at the same density. The stitch angle changes with the 
shape of the area, and can be adjusted as desired. Choose automatic 
edge walk and/or zigzag underlay.

Convert Satin Areas into any type of fill area.

Columns
Columns may be converted into Satin Areas, but Satin Areas cannot be converted into any type of column.

Satin Column
Use Satin Column  to create a straight or curved column of parallel 
stitches. The column may be of any length.

The recommended maximum length for satin stitches is around 8-10mm, otherwise 
the stitches may be loose and not lie flat. To create satin wider than this, either 
overlap satin columns, or use a satin area.

Feathered Satin
For lifelike realistic feathers or fur, use Feathered Satin , where 
the start and end points of the stitches are random rather than all 
parallel. Feathered satin may also be created with only one side 
feathered – the side where the first (A) or second (B) point was 
placed.

Richelieu Bars
Use Richelieu bars  to create a column of short sections of satin 
perpendicular to the direction of the column. Choose the number of 
bars, and the width of the satin.

Richelieu bars are typically used for cutwork designs.

Feathered Both Sides Feathered Side A Feathered Side B
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Tapered Motifs
Use Tapered motifs  to create a line of motifs that vary in size 
according to the width of the column.

Tapered motifs are often used in lace designs.

Line Types

Running, Double and Triple Stitches
Set Running Stitch  from 0.3-12mm in 0.1mm steps. Set Double , Double Zigzag  
and Triple  stitch to any length from 1mm to 12mm.

Running may also be set to cutwork needles.
Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag 
pattern to create a mesh.

Motif Line
Motif lines  are lines of the chosen Universal or machine motif 
patterns.

Satin Line
Create Satin lines  where a line or border of satin stitches of 
constant width is desired. The line will be created along the center 
of the chosen line.

Single Stitch
Single stitches are embroidered at whatever length they are 
created. Alternatively, if you select to Break Up into Smaller 
Stitches they will be broken up into stitches of Running 
Stitch at any length from 1mm to 12mm.

Single stitches cannot be converted to any other line type.

Running Double Triple
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Edit Lines and Areas
The shape of a line or area can be changed in the Object window by moving the points 
that define its outline.

Move the pointer until the desired area is highlighted 
then click to select it on the work area. When the desired 
line or area is selected, its points can be moved. The 
points are shown as small circles or squares.

Square points are used for straight sections and corners. Round 
points are used for curves.
Objects such as fill areas, running stitch and satin lines, 
can have any number of points, and points may be 
inserted and deleted, allowing greater control over their 
shapes. The start and end points for fill and satin areas 
can be changed, typically to reduce the need for trimming. Satin areas have angle lines 
that are used to control the satin angle.

Fill areas have as many points as needed to 
define their outlines, and also have moveable 
start, end and origin markers

Satin areas have moveable start and end markers 
and adjustable stitch angle lines

Start
Marker

Origin
Marker

End
Marker

Start
Marker

End Marker

Stitch Angle
Lines
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Move Points
The points that define the currently selected stitch object (satin 
column, fill area, running stitch, etc.) are shown as small squares 
and circles.

The object type is shown in the Edit Properties area of the Object 
tab. The points used to start and end fill and satin areas are shown 
by the start  and end  markers. Some types of fill areas also 
have an origin, marked by an orange circle , or for Pattern Fill 
an orange circle with a handle . Satin areas also have stitch 
angle lines with hexagonal ends.

Move the pointer until the desired area is highlighted, then click it on the work 
area. When selecting an object, click near one of the points that define it.
Once the points are shown, click and drag the squares or circles to move them. The first 
point is shared with the previous object, and last point is shared with the next object, so 
moving these will also change the shape of those objects.

When a different point is selected for the start or end of a fill or satin area, a movement 
stitch (trim) may be added to prevent the previous or next object changing shape.

Moving the points that define a satin area may also affect the stitch angle lines, but moving the stitch 
angle lines does not affect the shape of a satin area.

Make Lines Straight or Curved
The outlines defining most types of lines and areas can have both curved and straight 
sections:

To have any curves, lines must be defined by at least four points. The first point of a fill or 
satin area is always a 'corner' (square) point. The first and last pair of points for a column 
are always square.

To change a curve (round) point to a square point, hold down the Shift key and click the 
point without moving it. When adjacent points are corners, the line between them will be 
straight. This is useful if, for instance, a point was not added as a corner at the desired 
place on a fill area or stitch line.

To change a corner point to a curve (round) point, simply click the point without moving 
it. There must be at least two round points next to each other to make the lines curved, so 
if there is one round point between two square points then the lines to the round point 
will be straight.

Point is a curve Point is a corner after Shift + click
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If a line does not have enough points to make the desired section curved, use Insert Points  to add an 
extra point to use for the curve.

Move the Start and End Points for Areas
The start and end points for fill and satin areas are shown by circular markers. The start 
marker  is on the inside of the object, and the end marker  is on the outside of the 
object.

Click and drag the desired marker. Move the marker to the point that you wish to use as 
the new start or end point of the area. Drop at the desired point and the position of the 
marker will change.

The marker snaps to the nearest point on the edge of the object. If an area does not have a point in the 

desired position, use Insert Points  to add an extra point.

Move the Origin for Areas
Some types of fill areas have an origin, marked by a orange circle . This is used to move 
the center point for Radial fill, Spiral fill and Shape fill types, or the start point for the 
pattern in a Pattern Fill. For Pattern Fill, the origin marker also has an adjustment handle to 
set the angle of the pattern .

This means you can control how the pattern is repeated in a pattern fill area.
For Radial fill, Spiral fill and Shape fill areas, the origin can be moved. This sets the start 
point for the fill, such as the point from which stitches radiate on a Radial fill.

Use Align Origin Handles  to align the origin for multiple fill areas.

Change the Stitch Angle for Satin Areas
Satin areas have stitch angle lines that show and adjust the angle of the stitches across the 
area. The stitch angle lines have pink handles at each end that are used to adjust each line 
individually.

Click and drag the desired pink handle. Drop at the desired point and the position of the 
angle line will change. If the line does not move, this is because the new end point is not 
usable. This will happen if, for example, you attempt to force two angle lines to cross each 
other within the area.

Delete Angle Lines
To delete angle lines, click Delete Points  then click the hexagon at either end of the 
line to be deleted. Right-click when you have finished deleting angle lines and/or points.

A satin area must have at least one angle line. Therefore, the last angle line may not be deleted.
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Nodes
Insert Points
Use Insert Points  to add a new point to the currently selected line.

Points may be inserted into all line and area types. They may also be inserted into MultiWave lines.
Click the Insert Points icon , then click the position on the selected object where you 
want to add the point.

A pair of points is inserted when Insert Points is used on a column.

Shortcuts
■ Object Tab, Nodes: 
■ Keys: Alt, O, I

Change the Shape of the Bumblebee’s Wing
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Bumblebee 2' embroidery.
4 Click the Object tab. The pointer changes to the Object Select pointer.

All of the icons are unavailable (grayed out) as no area of stitches is selected.
5 Move the pointer until the upper wing is highlighted, then click to select it.
6 Zoom in  so you can see the points with space between them.
7 Click the Insert Points icon . The pointer changes to the add points pointer .

The Insert Points icon is only available for objects that can have points inserted.
8 Click an empty place along the line defining the outline of the wing. A new round point is inserted, 

and the wing changes slightly.
9 Click to place a point well outside the area of the wing. The fill area changes to include the new point.
10 Click to place any further desired points.
11 Right-click to deselect Insert Points. The Object Select pointer reappears.
12 Click and drag to move any of the points in the wing to further alter its shape.
13 If desired, click the Insert Points icon  again and repeat.
14 Close without saving.

Delete Points
Use Delete Points  to delete points from the currently selected line. 

Points may be deleted from all line and area types. Points may also be deleted from MultiWave lines.
Click the Delete Points icon , then click the points on the selected object that you want 
to delete. Stitch angle lines can be removed from satin areas by clicking the hexagonal 
control point at either end of the line. Right-click to finish.

You may not delete all the points for an object. A fill or satin area must have at least three points. Satin 
border, motif lines and running, double and triple stitch lines must have at least two points. A satin area 
must also have at least one angle line.

Shortcuts
■ Object Tab, Nodes: 
■ Keys: Alt, O, DP
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Remove Points from the Wing Outline
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Bumblebee 2' embroidery.
4 Click the Object tab. The pointer changes to the Object Select pointer.
5 Move the pointer until the upper wing is highlighted, then click to select it.
6 Zoom in  so you can see the points with space between them.
7 Click the Delete Points icon . The pointer changes to the delete points pointer .

The Delete Points icon is only available for objects that can have points deleted.
8 Click the points you wish to delete. They are removed and the wing changes shape accordingly.

You cannot remove the Start and End points for an object.
To remove an angle line for a satin area, click the triangular control point at either end of the line.

9 Right-click to deselect the function.
10 Click and drag to move any of the points in the object to alter its shape.
11 If desired, click the Delete Points icon  again and repeat.
12 Close without saving.

MultiWave Lines
Freehand MultiWave Line
Use the MultiWave Line  function Freehand MultiWave Line  to draw a line that 
shapes the wave patterns in a MultiWave Fill.

Use a long line to position the stitch lines in an embroidery, or use a short line to add texture to the 
stitching. The lines do not have to be within the fill area, however they should not cross each other. Vary the 
density or use a motif to change the effect.

Shortcuts
■ Object Tab; MultiWave Lines:
■ Keys: Alt, O, ML, FT

Draw a MultiWave Line on a MultiWave Fill Area
1 With a MultiWave Fill area selected, in the MultiWave Line  menu click the Freehand MultiWave 

Line  icon.

MultiWave Fill areas, using two MultiWave Lines to 
shape the flow of the fill within the wings.

See “Change Bumblebee Wings to MultiWave Fill with a 
MultiWave Line” on page 239.

MultiWave Fill, using a short MultiWave 
Line to add texture to an embroidery
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2 Draw a line over or near the selected area. The MultiWave line will appear on the fill, with the first and 
last points as a squares. The other points will be circles if the line is curved, and square if the line is 
straight. The wave patterns in the fill will follow this line.

You can move points after the line has been created. To add or remove points, use Insert Point  or Delete 

Point .
3 Repeat to place as many MultiWave lines as desired.

Use Delete MultiWave Line  to remove a MultiWave line. See “Delete MultiWave Line” on page 215.

Point MultiWave Line
Use the MultiWave Line  function Point MultiWave Line  to place points to form a line 
that shapes the wave patterns in a MultiWave Fill.

Shortcuts
■ Object Tab; MultiWave Lines:
■ Keys: Alt, O, ML, FP

Place Points for a MultiWave Line on a MultiWave Fill
1 With a MultiWave Fill area selected, in the MultiWave Line  menu click the Point MultiWave Line  

icon.
2 Click to place your first point. 

The point appears automatically as a small hollow yellow square.
3 Click to place a second point.

The new point is a yellow circle, the first point is now white.
Yellow is used for the most recently placed point.

4 Continue placing points along the desired path. 
Curved lines are created automatically. For corners and straight sections, hold down the Shift key. 

5 Right-click to end the line. The MultiWave line will appear on the fill, and the wave patterns in the fill 
will follow this line.

You can move points after the line has been created. To add or remove points, use Insert Point  or Delete 

Point .
6 Repeat to place as many MultiWave lines as desired.

Use Delete MultiWave Line  to remove a MultiWave line. See “Delete MultiWave Line” on page 215.

Delete MultiWave Line
Use Delete MultiWave Line  to delete one or more MultiWave lines from the currently 
selected MultiWave Fill area. Click the square (node point) at either end of the line to be 
deleted. Right-click when you have finished deleting MultiWave lines.

Shortcuts
■ Object Tab; MultiWave Lines: 
■ Keys: Alt, O, DM

Remove a MultiWave Line
1 With a MultiWave Fill area selected containing one or more MultiWave lines, click the Delete 

MultiWave Line icon . 
2 Click a node point (square or circle) on the line you wish to delete. The MultiWave line will be deleted.
3 Right-click to deselect the function.
4 If desired, click the Delete MultiWave Line icon  again and repeat.
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Modify Object
Remove Underlying Stitches
Use Remove Underlying Stitches  to remove all visible stitches within the area of the 
selected object, excluding stitches in the object itself, and those stitched out after it. 

Use Remove Underlying Stitches to remove the packing stitches under a fill before 
converting it to a lightly stitched fill such as MultiWave Fill. 

See “Change Bumblebee Wings to MultiWave Fill with a MultiWave Line” on page 239.
Remove Underlying Stitches can be used to remove existing underlying stitches before adding new 
underlay.

Shortcuts
■ Object Tab; Modify Object:
■ Keys: Alt, O, R

Align Origin Handles
Use Align Origin Handles  to align the patterns or focal points of multiple fill areas. It 
places the orange origin  handles of the fill areas in the same position as the handle of 
the object that is last in the stitching order.

Align Origin Handles is useful when aligning fill patterns for Pattern Fill or focal points for Shape, Radial 
and Spiral Fill.

Shortcuts
■ Object Tab; Modify Object:
■ Keys: Alt, O, A

Align the Stitching in Bumblebee Wings
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Bumblebee 2' embroidery.
4 Click the Object tab. The pointer changes to the Object Select pointer.
5 Move the pointer until the upper wing is highlighted, then click to select it.
6 In the Modify Object area, click Remove Underlying Stitches .
7 Then click the lower wing to select it and click Remove Underlying 

Stitches . The end stitch number in the Control Strip is now 
lower.
Remove Underlying Stitches removes any underlay stitches, or other 
stitches, under a fill area. This will enable you to see the stitch lines in 
the Spiral Fill you are about to create clearly.

8 Select the upper wing, then use Ctrl + click to select the lower 
wing.

9 In the Convert drop-down list, select "Pattern Fill to Spiral Fill". The 
Spiral Fill properties dialog box appears.

10 In the Options tab, set Density to 15 and click OK. The 
bumblebee’s wings now use spiral fill.

11 Click Align Origin Handles to align the origin handles for the selected areas.
12 Move the orange origin handle  above the lower wing. The spiral pattern for both areas follows 

the origin point.
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Display
Show Only Object
Use Show Only Object  to move the handles on the slider bar so that only the selected 
object can be seen.

Select a Racket Handle
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Racket' embroidery.
4 Click the Object tab. The pointer changes to the Object Select pointer.
5 Look at the Control Strip. All of the colors in the embroidery can be seen, and the stitch count is over 

1500.
6 Move the pointer over the racket handle until its points appear, then click to select it. The points 

defining the handle appear.
7 Click Show Only Object . Only the handle of the racket can now be seen.

Only the stitches in the handle are selected.
8 Click Ghost Mode . You can now see the rest of the stitches in pale colors.

Using Ghost Mode enables you to work with part of the embroidery, without affecting other parts.

Shortcuts
■ Object Tab; Display:
■ Keys: Alt, O, S
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13Stitch Types and Properties

Stitch Type
You can change the properties for many line and fill types using the Object tab.

Select a line or area and click Properties. The properties dialog box for that stitch type will 
appear. Alternatively, convert it to another line or fill type, then change its properties.

Fills
You can use Convert to change between the Fill stitch types:

■ Pattern Fill
■ Motif Fill
■ Crosshatch Fill
■ Curved Crosshatch Fill
■ MultiWave Fill
■ Shape Fill
■ Radial Fill
■ Spiral Fill
■ QuiltStipple Fill
■ Contour Fill
■ Echo Fill

You can also convert to Satin Area.

Pattern Fill
A pattern fill area is an area of stitching where the threads all lie parallel to each other, and 
that has stitch points inserted to create different types of patterns. The density and color 
can also be changed with single gradient density and multigradient density.

Add new patterns using Manage My Fills in mySewnet™ Digitizing.

The patterns may be simple textures or decorative shapes. A satin-effect pattern (pattern 
number 36 in Standard 3) is also available.

Constant density creates a uniform fill at the chosen density. Gradient density creates a fill with varying 
density or color.

Pattern Fill Area with Pattern 107 from 
Diamonds
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Use the Pattern Fill properties dialog box to change the pattern, density and stitch angle 
used for fill areas.

Pattern Fill — Pattern
Use the Pattern area to select the desired 
pattern category and number.

Select the desired pattern number. There are 
several ways to select patterns:

• Click the drop-down arrow below the pattern 
sample and scroll down to choose a pattern 
Category, and a pattern. Click the desired 
pattern sample and the Pattern number is 
shown.

• Enter a favorite Pattern number directly in 
the Pattern box. As you type the number, the 
correct pattern sample is selected 
immediately.

• Use a My Fill pattern created with Manage 
My Fills in mySewnet™ Digitizing.

• View the patterns in the Pattern Gallery. See “Fill and Satin Patterns” on page 274.

Add a Pattern to a Bumblebee Stripe
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Bumblebee 2' embroidery.
4 Click the Object tab. The pointer changes to the Object Select  pointer.

All of the icons are unavailable (grayed out) as no area of stitches is selected.

Choose a Category
and Pattern

Search for a Pattern
by number

Set Standard density Use gradient density

Set the pattern Angle

Adjust the area’s size

Choose Underlay 
density

Settings for Single &
Multicolor gradient

Use a My Fills pattern
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5 Move the pointer until the lower part of the middle yellow stripe on the bumblebee is highlighted, 
then click to select it.

Notice the Pattern Fill icon  in the Edit Properties area. If other parts of stitching, such as lines, are 
selected, the icon for their stitch type will appear. Click again to select the desired area.

6 Hold down Ctrl and click to select the upper part of the yellow 
stripe. 
The points defining most of the striped areas appear, together with 
the colored fill pattern origin  marker, and start  and 
end  points.
The front and back stripes are too small to show a pattern, therefore 
do not select them.

7 In Edit Properties, click the Properties button. The Pattern Fill 
properties dialog box appears.
The Pattern Fill properties dialog enables you to set the properties 
for the pattern fill.

8 The fill pattern is currently set to Pattern 3. Click the drop-down 
arrow below the sample and in the Patterns gallery scroll down 
to 'Waves 1' in the list.

9 Click the pattern sample in row 1, column 2. The pattern 
number will change to 230.
Patterns may also be selected directly by entering the desired 
pattern number in the Pattern box.

10 Click OK to see the new pattern in the bumblebee stripe.
11 Click outside the bumblebee to see the pattern clearly.

Pattern Fill — Options
Use the Options area to see and change the settings for fill angle, underlay and 
compensation.

Angle
The angle of the fill pattern, as shown by the arrow. The thread is at a 
right angle to the fill pattern. Set the Angle from 0 to 359 degrees. 
The initial setting is 0.

Alternatively, adjust the angle of the fill pattern with the handle on the Origin 
marker .
The fill angle will also affect the orientation of the gradient.

Set the pattern Angle

Set Compensation

Choose Underlay density
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The example shows pattern number 56 with the fill angle set to 315, 270 and 180 degrees.

Underlay
Choose from None, Low, Medium or High density underlay. Underlay is a low density fill 
that is perpendicular to the stitches of the actual fill area. Underlay is useful for stabilizing 
large fill areas. Underlay is initially set to Low.

Underlay stitches are not generated for areas using gradient density, although the property can be 
selected in case you switch the area back to a standard density area.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set 
Compensation from 0 to 20. The higher the number, the bolder the area appears. The 
initial setting is 0.

Pattern Fill — Density
Use the Density area to see and change the density settings and the color Gradient of the 
fill.

The color on a fill area can change over a range, or have multiple color changes across the 
fill. This is ideal for gradual color changes such as sunsets, subtle shadow effects and so on.

Gradient is not initially selected.

Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting. 
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like 
linen or satin. 

Standard Density

Set the standard Density from 2 to 80. The lower the number, the 
closer together the stitches and the more stitches are produced.

The initial setting is 2.
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Single Color Gradient

Use Single Color Gradient to change the density across a fill 
with only one color. Set a value for the start and end density 
markers for the fill, and the density gradually changes between 
the two values. Add multiple markers for a more complex 
pattern.

The markers can each take a value of 2 to 80, which means you can reverse 
the gradient simply by swapping the start and end values.
The example shows a Gradient of 2 to 15, with a fill angle of 90°.

Use Density Gradient for loosely stitched areas so that the traveling stitches will go around the outside of 
the fill area. Set the start and end densities to the same number. If the Density Gradient option was not 
used the traveling stitches would cross the fill area and show through.
Use the adjustment marker above the gradient bar to change the gradient across the fill.

Reset
Reset your changes and use the initial settings.

Add Marker
Click Add Marker to add a value marker below the gradient bar, and an adjustment marker 
above the gradient bar. The initial value for the marker will be between the existing 
markers. Edit the density value, and move the value and adjustment markers as desired.

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment marker

Highlighted value marker

Set the stitch density for 
the chosen value marker

Delete the selected
marker
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This means that you can have any combination of density values across the fill area. 
Remember, a higher value means the fill is less dense.

Density
Density is used to change the density of the stitching. Set Density from 2 to 80. The higher 
the number, the less dense the fill. The initial start marker setting is 2, and end marker 
setting is 8.

Remove
Click Remove to delete the highlighted marker.

Use Single Gradient Fill on a Landscape Embroidery
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 

'SunsetGarmentBagOriginal' embroidery.
4 Click the Object tab. The pointer changes to the Object Select  pointer.

All of the icons are unavailable (grayed out) as no area of stitches is selected.
5 Move the pointer until the sun is highlighted, and click to select it.

Notice the Pattern Fill icon  in the Edit Properties area. If other parts of stitching, such as lines, are 
selected, the icon for their stitch type will appear. Click again to select the desired area.

6 In Edit Properties, click the Properties button. The Pattern Fill properties dialog box appears.
7 Click (check) the Gradient checkbox. The Gradient box will become available.
8 Select Single Color Gradient.
9 In the Gradient area, ensure that the value marker on the left below the gradient bar is selected.
10 Click the value marker and change the value in the Density box to 2.
11 Click the value marker on the right below the gradient bar and 

change the value in the Density box to 40.
12 Click OK to view your changes.
13 With the sun still selected, click Properties again to open the 

Pattern Fill dialog box. 
14 Move the adjustment marker above the gradient bar to vary the 

change in density across the fill.
15 Click OK to view your changes as desired. Open the dialog box 

again to make further changes.
16 Click Add Marker to add another value marker and adjustment 

marker.
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17 Change the density of the fill as desired.

18 Click OK to close the properties dialog box.

Multicolor Gradient

Use Multicolor Gradient to change the color across a fill with 
only one density. Set colors for the start and end markers for the 
fill, and the color gradually changes between the two values.

Use the marker above the gradient bar to change the color 
gradient across the fill.

Reset
Reset your changes and use the initial settings.

Add Marker
Click Add Marker to add a color marker 
below the gradient bar, and an 
adjustment marker above the gradient 
bar. The initial color for the marker will 
be the same as the currently 
highlighted marker. Change the color 
and move the color and adjustment 
markers as desired.

This means that you can have any combination of colors across the fill area.

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment markers

Selected color marker

Choose a thread for the 
highlighted marker

Delete the selected
marker

Set the stitch density
for the whole fill



mySewnet™ Stitch Editor   Stitch Types and Properties              225

Thread Color
Use Thread Color  to change the color of the currently highlighted marker. The Color 
Selection box will be displayed.

See “Change an Existing Thread Color” on page 37.

Remove
Click Remove to delete the highlighted marker.

Use a Multicolor Gradient Fill
1 Open an embroidery.
2 Click the Object tab. The pointer changes to the Object Select  pointer.

All of the icons are unavailable (grayed out) as no area of stitches is selected.
3 Click to select the an area of pattern fill in the embroidery.

Notice the Pattern Fill icon  in the Edit Properties area. If other parts of stitching, such as lines, are 
selected, the icon for their stitch type will appear. Click again to select the desired area.

4 In Edit Properties, click the Properties button. The Pattern Fill properties dialog box appears.
5 Click the Gradient option. The Gradient box will become available.
6 Select Multicolor Gradient.
7 Click a color marker (the marker below the gradient bar) and click the button to the right of the 

Thread Color to open the Color Selection dialog box. See “Change an Existing Thread Color” on 
page 37.

8 Change the color to the required color and 
click OK.

9 Move the adjustment marker above the 
gradient bar to vary the change in color 
across the fill.

10 Click Add Marker to add another color 
marker and adjustment marker.

11 Change the color of the fill as desired.
12 Click OK to close the properties dialog box.
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Motif Fill
Motif fill areas contain repeated small stitches placed using one of the Universal or 
machine motif patterns. Motif patterns typically have spaces between the stitches. The 
motifs can be at any angle and at different sizes, and different motifs can be used on 
alternating lines.

Motif Fill — Motif 1
The Motif Fill properties dialog box has tabs for setting all the properties on a motif fill 
area.

The Motif 1 tab is always shown first when the Motif Fill properties dialog box appears.

Use Motif 1 to select the first motif and its size.

Motif
Use Motif to select the first motif and its size.

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

The bumblebee wings use a Motif Fill Area 
with motif 44 from Candlewicking 1

Select a motif Group, Category and pattern

Select the motif size

Preserve motif Height / Width ratio

Flip the motif vertically or horizontally
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Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Reverse
Use this option to reverse the direction of the motif along the lines of the motif fill. Some 
motifs are symmetrical and will have no apparent change when they are reversed.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Motif Fill — Motif 2

Use Motif 2 to select a second optional motif and its size.

Use Motif 2
Select this option to use a second motif in the motif fill. The second motif will be placed on 
alternating lines with the first motif.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.
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Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Reverse
Use this option to reverse the direction of the motif along the lines of the motif fill. Some 
motifs are symmetrical and will have no apparent change when they are reversed.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Motif Fill — Spacing

Center Motifs 1 and 2
When this option is selected the narrower of the two motifs has extra stitches added at 
either side to make it the same width as the wider motif. This is so that the motifs can be 
centered, or so the horizontal offset between them will remain constant.

Gap
The Horizontal gap adds or removes space between motifs along the line. The Vertical gap 
adds or removes space between lines of motifs.

Set the Horizontal and Vertical gap from -50% to +100%.

Space the motifs regularly

Set the distance between
motifs and lines of motifs

Set the relative position of
motifs and lines of motifs
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Offset
The Horizontal offset moves the motifs along each line, relative to the previous line. The 
Vertical offset adjusts the position of every other line of motifs, so that it is nearer to one 
line than the next or previous line.

Set the Horizontal and Vertical offset from -50% to 50%.

The offset is limited to 50% each way because, for instance, a 75% offset would be the same as a -25% 
offset.

Motif Fill — Options
Use the Options tab to see and change the settings for fill angle, stitch type and length.

Angle
The angle of the motif fill pattern, as shown by the arrow. Set the Angle from 0 to 359 
degrees.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum stitch Length 
from 1 to 12mm in steps of 0.1mm.

Adjust the motif angle

Select a line type

Set the stitch length
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Crosshatch Fill
Crosshatch fills are used in quilting, and to create free-standing lace.

Crosshatch Fill Properties
The Crosshatch Fill properties dialog box enables you to set the gap, style, line angle, 
stitch type and stitch length for the crosshatched lines of stitching in the fill. The preview 
changes according to the options chosen.

Spacing
Set the Gap to the preferred distance between lines of stitching.

Set the Gap from 1mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Style
Choose from Diamond, Square, Parallel and Enter Angles. Diamond is selected by default, 
and creates a symmetrical crosshatch pattern (balanced horizontally). Choose Enter 
Angles to create an asymmetrical crosshatch pattern, if desired.

Diamond
Enter an Angle for the Diamond fill. The Angle is initially set to 45 degrees.

The bumblebee wings are in Crosshatch 
Fill, using Enter Angles style and Angles of 
60 and 150 degrees.

Select a style for the Crosshatch fill
Set the angle for one or both crosshatch lines

Adjust the gap between the stitch lines

Select a stitch type for the 

Set the stitch length for fill lines

Set the width for zigzag lines

Preview your settings

crosshatch lines
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Square
There are no additional options for the Square fill which creates a crosshatch pattern of 
lines set at 90 degrees.

Parallel
Enter an Angle for the Parallel fill. The Angle is initially set to 90 degrees.

The Pattern Fills 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create 
a weave effect. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm to combine 
with Pattern 258, and so on.

Enter Angles
Enter an angle for each of the two line directions in the crosshatch. Angle1 is initially set to 
the same angle as the Diamond style previously used, and Angle2 is initially set to this 
angle plus 90 degrees.

Stitch Type
Select a stitch type for the crosshatch fill. Choose from:

■ Running Stitch
■ Double Stitch
■ Double Zigzag
■ Triple Stitch

Stitch Length
Set the Stitch Length from 1 to 12mm in steps of 0.1mm. The initial setting is 2.0mm.

Zigzag Width
Set the Zigzag width for Double Zigzag stitch from 0.1 to 6mm in steps of 0.1mm. The 
initial setting is 0.6mm.

Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag 
pattern to create a mesh. After embroidering on water soluble stabilizer, the mesh of stitches provides 
strength when the stabilizer is washed away.
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Curved Crosshatch Fill
Curved Crosshatch fills use curving lines in the crosshatch, which can be used to create a 
feeling of depth. They are used in quilting, and to create free-standing lace.

Curved Crosshatch Fill Properties
The Curved Crosshatch Fill properties dialog box enables you to set the curve, gap, style, 
line angle, stitch type and stitch length for the curved crosshatched lines of stitching in 
the fill. 

You can also change the curves in the crosshatch lines using the handles in the work area.

Spacing
Set the Gap to the preferred distance between lines of stitching.

Set the Gap from 1mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Style
Choose from Diamond, Square, Parallel and Enter Angles. Diamond is selected by default, 
and creates a symmetrical crosshatch pattern (balanced horizontally). Choose Enter 
Angles to create an asymmetrical crosshatch pattern, if desired.

The bumblebee wings are in Curved 
Crosshatch Fill, using Square style and a 
Gap of 4.0mm.

Adjust the gap between the stitch lines

Select a stitch type for the 

Set the stitch length for fill lines

curved crosshatch lines

Set the angle for one or both 
curved crosshatch lines

Select a style for the 
Curved Crosshatch fill

Set the curve for the curved crosshatch lines

Use a Motif with the fill
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Diamond
Enter an Angle for the Diamond fill. The Angle is initially set to 45 degrees.

Square
There are no additional options for the Square fill which creates a crosshatch pattern of 
lines set at 90 degrees.

Parallel
Enter an Angle for the Parallel fill. The Angle is initially set to 90 degrees.

The Pattern Fills 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create 
a weave effect. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm to combine 
with Pattern 258, and so on.

Enter Angles
Enter an angle for each of the two line directions in the crosshatch. Angle1 is initially set to 
the same angle as the Diamond style previously used, and Angle2 is initially set to this 
angle plus 90 degrees.

Stitch Type
Select a stitch type for the curved crosshatch fill. Choose from:

■ Running Stitch
■ Double Stitch
■ Triple Stitch
■ Motif Line

Stitch Length
Set the Stitch Length from 1 to 12mm in steps of 0.1mm. The initial setting is 2.0mm.

Curved Crosshatch
Use Lines 1 and 2 to change the curve on the crosshatch lines.

You can also change the curves in the crosshatch lines using the handles in the work area.

Lines 1
Change the position of the origin for one of the sets of curved lines.

Set percentage Curve In and Curve Out  from -100 to 100. The initial setting for Curve In % 
and for Curve Out % is 50.

Lines 2
Change the position of the origin for the other set of curved lines.

Set percentage Curve In and Curve Out  from -100 to 100. The initial setting for Curve In % 
and for Curve Out % is 50.
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Curved Crosshatch Fill — Motif
The selected Motif is only used by the Curved Crosshatch Fill if the Motif Line option is 
selected on the Options tab.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line. 

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.

Set the gap between the motifs 
Adjust the position of the motifs 

Select a stitch type for the

Set the stitch length

Set the motif size and 

Select a motif Group, Category 
and pattern

Height / Width ratio

motif lines
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Reverse
Use this option to reverse the direction of the motif along the line. Some motifs are 
symmetrical and will have no apparent change when they are reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum stitch Length 
from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended value for 
each motif.

Change Bumblebee Wings to Curved Crosshatch Fill
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Bumblebee 2' embroidery.
4 Click the Object tab. The pointer changes to the Object Select pointer.

All of the icons are unavailable (grayed out) as no area of stitches is selected.
5 Click the upper wing to select it.

Note the end stitch number in the Control Strip.
6 In the Modify Object area, Click Remove Underlying Stitches .

The number of stitches is reduced, as shown by a lower end stitch number in the Control Strip.
7 Click the lower wing to select it, then click Remove Underlying Stitches . The number of stitches 

drops again.
Remove Underlying Stitches removes any underlay stitches, or other stitches, under a fill area. The wings 
are Pattern Fill, which uses an underlay. With Curved Crosshatch Fill the fabric should be visible 
underneath the lines of stitching.
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8 Use Ctrl + click to select both wings.
9 In the Convert drop-down menu select "Pattern Fill to Curved 

Crosshatch Fill". The Curved Crosshatch Fill properties dialog box 
appears.

10 In the Curved Crosshatch area, note the settings for Lines 1 and 
Lines 2.

11 In Spacing, set the Gap to 4.0mm.
12 Click OK to close the dialog box.
13 With the wings still selected, move the pink handles for the wings. 

This changes the curve on the lines in the fills.
14 Ensure that both wings are still selected, then right-click and select Edit Curved Crosshatch Fill in the 

context menu.
15 Look at the settings in the Curved Crosshatch area. They have changed.

You can change the curve on the crosshatch lines with the handles, or with the Lines 1 and Lines 2 settings.
16 In Stitch Type, select Motif Line.
17 Click the Motif tab.
18 Set the Motif Group to Universal and the Category to Hand 

Stitches 1.
19 Set the Pattern to 6.
20 With Proportional selected (checked), set Height to 1.8mm.
21 Click OK to close the dialog box. The lines on the wings now use the 

motif.
22 Click outside the bumblebee to deselect the wings.
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MultiWave Fill
MultiWave fill areas use a wave pattern defined by a line, or lines, drawn on the fill area by 
the designer. Vary the density, or use a motif for the stitch lines.

MultiWave Fill — Options

Density
Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced.

Use Motifs
Click Use Motifs if you would prefer to use motifs instead of a plain 
line to follow the line angle selected for the fill. Click the Motif tab 
to choose a motif.

The bumblebee wings are in MultiWave 
Fill, using a density of 20

Set the stitch line density for the fill

Use a motif line

Select a motif



238          mySewnet™ Stitch Editor   Stitch Types and Properties 

MultiWave Fill — Motif
The selected Motif is only used by the MultiWave Fill if the Use Motifs option is selected on 
the Options tab.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line. 

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.

Set the gap between the motifs in the line

Adjust the position of the motifs in the line

Select a stitch type for the motif lines
Set the stitch length for the motif lines

Set the motif size and Height / Width ratio

Select a motif Group, Category and pattern
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Reverse
Use this option to reverse the direction of the motif along the line. Some motifs are 
symmetrical and will have no apparent change when they are reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum stitch Length 
from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended value for 
each motif.

Change Bumblebee Wings to MultiWave Fill with a MultiWave Line
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Bumblebee 2' embroidery.
4 Click the Object tab. The pointer changes to the Object Select pointer.

All of the icons are unavailable (grayed out) as no area of stitches is selected.
5 Click the upper wing to select it.

Note the end stitch number in the Control Strip.
6 In the Modify Object area, Click Remove Underlying Stitches .

The number of stitches is reduced, as shown by a lower end stitch number in the Control Strip.
7 Click the lower wing to select it, then click Remove Underlying Stitches . The number of stitches 

drops again.
Remove Underlying Stitches removes any underlay stitches, or other stitches, under a fill area. The wings 
are Pattern Fill, which uses an underlay. With MultiWave Fill the fabric should be visible underneath the 
lines of stitching.

8 Use Ctrl + click to select both wings.
9 In the Convert drop-down list click "Pattern Fill to MultiWave Fill". The MultiWave Fill properties dialog 

box appears.
10 Click OK to close the dialog box.
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11 With the wings still selected, in the MultiWave Line drop-
down menu, click Point MultiWave Line .

12 Starting on the work area to the left of the upper wing, click 
a series of points to draw a curved line that runs below the 
top of the wing, but follows its line.

13 Right-click to finish the line on the work area to the right of 
the wing. The node points on the line will be displayed.
The stitch lines within the wing will change to follow the direction of the line that you drew.

14 Ensure that the wings are still selected, and select Point MultiWave Line  again.
15 Starting above and to the right of the lower wing, click a series of points to draw a line that intersects 

the wing, then curves down and back.
16 Right-click to finish the line. The node points on the line will be displayed.

17 Adjust the nodes on the two MultiWave lines as desired.
18 Click outside the bumblebee to deselect the wings.
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Echo Fill

Echo Fill places echo lines within or around a shape. Choose from rounded, square and 
diagonal corners, and set the gap between the echo lines and the number of lines, and 
select the stitch type and length.

Echo Fill Properties
The Echo Fill properties dialog enables you to place echo lines within or around a shape. 
Set the style, gap, stitch type and stitch length.

The bumblebee wings are in Echo Fill 
using 5 echo lines, a spacing of 2mm, 
rounded corners, and are embroidered in 
running stitch.

Rounded corners Square corners Diagonal corners

Choose rounded, square or
diagonal corners for the fill

Select a stitch type for the lines

Select a stitch length for the lines

Set the Gap between the echo lines

Place echo lines inside and/or
around a shape
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Style
Choose from 1, 2 or 3. For a square shape:

• 1  creates rounded corners

• 2  creates square corners

• 3  creates diagonal corners

Rounded corners (1) is initially selected.

Stitch type
Select a line type for the echo lines in the fill. Choose from:

• Running Stitch
• Double Stitch
• Triple Stitch

Spacing
Set the Spacing to the preferred distance between lines of stitching.

Set the Spacing from 2mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Stitch Length
Set the stitch length for the echo lines from 1 to 12mm in 0.1mm steps. The initial setting 
is 2mm.

Create Echo Fill Wings for a Bumblebee
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Bumblebee 2' embroidery.
4 Click the Object tab. The pointer changes to the Object Select pointer.

All of the icons are unavailable (grayed out) as no area of stitches is selected.
5 Click the upper wing to select it.

Note the end stitch number in the Control Strip.
6 In the Modify Object area, Click Remove Underlying Stitches .

The number of stitches is reduced, as shown by a lower end stitch number in the Control Strip.
7 Click the lower wing to select it, then click Remove 

Underlying Stitches . The number of stitches drops 
again.
Remove Underlying Stitches removes any underlay stitches, 
or other stitches, under a fill area.

8 Use Ctrl + click to select both wings.
9 In the Convert drop-down list click "Pattern Fill to Echo 

Fill". The Echo Fill properties dialog box appears.
10 In Echo Area, select External and Internal Lines.
11 Ensure that Echo Lines is set to 5.
12 Set Spacing to 2mm.
13 Click OK to close the dialog. 
14 Click outside the bumblebee to deselect the wings.
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Shape Fill
Shape fill areas use one of 120 different shapes. Vary the stitch density and use motif lines 
for the fill.

The Shape Fill properties dialog box has tabs for setting all the properties on a shape fill 
area.

Shape Fill — Options

Density
Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced.

Shapes
Click the drop-down arrow and select the desired shape from the 
list.

Use Motifs
Click Use Motifs if you would prefer to use motifs instead of a plain line to follow the shape 
selected for the fill. Click the Motif tab to choose a motif.

The bumblebee wings are in Shape Fill 
using Shape 18 and Density 8

Select a shape for the fill 

Set the stitch density for the fill

Use motif lines in the fill

Select a motif for the fill
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Shape Fill — Motif
The selected Motif is only used by the Shape Fill if the Use Motifs option is selected on the 
Options tab.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line. 

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.

Set the gap between the motifs in the line
Adjust the position of the motifs in the line

Select a stitch type for the motif lines
Set the stitch length for the motif lines

Select a motif Group, Category and pattern

Set the motif size and Height / Width ratio
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Reverse
Use this option to reverse the direction of the motif along the line. This is useful, for 
instance, if you have placed a QuickStitch™ Motif Line and wish to reverse the motif 
direction. Some motifs are symmetrical and will have no apparent change when they are 
reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum stitch Length 
from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended value for 
each motif.
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Radial Fill
Radial fill areas use a pattern of radiating lines from an origin 
point. The stitch density can be varied.

Radial Fill — Options

Density
Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced.

The initial setting is 20.

Set the density from 2 to 40
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Spiral Fill
Spiral fill areas use a spiral pattern from an origin point. Use constant or gradient density.

Spiral Fill — Options

Density
The density on a spiral fill area can change over a range, or have multiple density changes 
from the origin to the edge of the fill. Choose from two density options: Standard and 
Gradient.

Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting. 
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like 
linen or satin. 

Standard Density

Set the standard Density from 2 to 80. The lower the number, the 
closer together the stitches and the more stitches are produced.

The initial setting is 2.

Gradient Density

The bumblebee wings are in Spiral Fill 
using Gradient Density

Set the density from 2 to 80
Select Gradient fill

Return to the
original settings
Add a marker
Adjustment marker

Highlighted value marker

Set the stitch density for 
the chosen value marker

Delete the selected
marker
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Use Gradient Density to change the density across the Spiral Fill. Set a value for the start 
and end density markers for the fill, and the density gradually changes between the two 
values. The start value is used at the origin of the spiral fill, and the end value is used at the 
edge.

The markers can each take a value of 2 to 80, which means you can reverse the gradient simply by 
swapping the start and end values.
The example shows a Gradient of 2 to 15, with a fill angle of 90°.

Use the marker above the gradient bar to change the gradient across the fill.

Add Marker
Click Add Marker to add a marker. The 
initial value for the marker will be 
between the existing markers. Edit the 
value and move the marker as desired.

This means that you can have any 
combination of density values across the fill 
area. Remember, a higher value means the fill 
is less dense. The marker furthest to the left 
affects the spiral fill at the origin, then from 
left to right to the edge of the spiral fill.

Remove
Click Remove to delete the highlighted marker.

Use Spiral Fill with a Gradient
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 

'SunsetGarmentBagOriginal' embroidery.
4 Click the Object tab. The pointer changes to the Object Select  pointer.

All of the icons are unavailable (grayed out) as no area of stitches is selected.
5 Click to select the sun.
6 In the Convert drop-down list select "Pattern Fill to Spiral Fill". The Spiral Fill properties dialog box 

appears.
Alternatively, right-click and a context menu appears. Select "Convert from Pattern Fill to Spiral Fill...".

7 Click to select the Gradient checkbox. The Gradient area will become available.
8 In the Gradient area, ensure that the value marker on the left below the gradient bar is selected.
9 Click the value marker and change the value in the Density box to 2.
10 Click the value marker below the gradient bar on the right and change the value in the Density box to 

8.



mySewnet™ Stitch Editor   Stitch Types and Properties              249

You can move the adjustment marker above the gradient bar to vary the change in density across the fill, 
and click Add Marker to add another value marker and adjustment marker.

11 Click OK to view your changes.
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QuiltStipple Fill
QuiltStipple fill areas use stipple stitch in a curved or straight lines. Vary the gap between 
stitch lines and use running or triple stitch.

QuiltStipple Fill — Options

Style
Choose between curved or straight.

The bumblebee wings are in QuiltStipple 
Fill using a curved style

Curved Straight

Select curved or straight stipple lines

Set the spacing between the stipple lines

Select a stitch type for the stipple lines

Set the stitch length for the stipple lines
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Spacing
Set the Gap to the preferred distance between lines of stitching. This also, where possible, 
is the border inside the area, between the edge of the area and the fill pattern.

Set the Gap from 1 to 20mm in steps of 0.1mm. It is initially set to 5.0mm.

Stitch
Select Running or Triple stitch for stitching out the fill. Set the Length of stitches from 1 to 
12mm in steps of 0.1mm. Length is initially set to 2mm.



252          mySewnet™ Stitch Editor   Stitch Types and Properties 

Contour Fill
Contour fill areas use contour stitch lines. Vary the gap between stitch lines and the length 
of the stitches, and use running, double or triple stitch.

Contour Fill — Options

Spacing
Set the Gap to the preferred distance between lines of stitching. This also is the border 
inside the area, between the edge of the area and the fill pattern.

Set the Gap from 0.2 to 5mm in steps of 0.1mm. It is initially set to 2.0mm.

Stitch
Select Running, Double or Triple stitch for stitching out the fill. Set the Length of stitches 
from 1 to 12mm in steps of 0.1mm. Length is initially set to 2mm.

Change Bumblebee Wings to Contour Fill
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch load the 'Bumblebee 2' embroidery.
4 Click the Object tab. The pointer changes to the Object Select pointer.

All of the icons are unavailable (grayed out) as no area of stitches is selected.
5 Click the upper wing to select it. The points defining the wing appear.

The bumblebee wings are in Contour Fill, 
using Double Stitch and a 1.4mm gap

Set the space between the lines in the fill

Select a stitch type for the contour lines

Set a stitch length for the contour lines
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Note the end stitch number in the Control Strip.
6 In the Modify Object area, Click Remove Underlying 

Stitches .
The number of stitches is reduced, as shown by a lower end 
stitch number in the Control Strip.

7 Click the lower wing to select it, then click Remove 
Underlying Stitches . The number of stitches drops 
again.
Remove Underlying Stitches removes any underlay stitches, 
or other stitches, under a fill area. The wings are Pattern Fill, 
which uses an underlay. With Contour Fill the fabric should 
be visible underneath the lines of stitching.
You can use Draw Previous Color Block  or Draw Next 
Color Block  to isolate areas for object editing, or right-
click the color block in the worksheet, and select Show only 
this Color.

8 Use Ctrl + click to select both wings.
9 In the Convert drop-down list, select "Pattern Fill to Contour Fill". 

The Contour Fill properties dialog box appears.
Alternatively, right-click and a context menu appears. Select "Convert 
from Pattern Fill to Contour Fill...".

10 On the Options tab, set Gap to 1.4mm.
11 Click OK. The bumblebee’s wings now use contour fill.
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Satin Area
Satin areas contain zigzag stitches that fill the area from one 
end to the other at the same density. The stitch angle changes 
with the shape of the area, and can be adjusted as desired. 
Choose automatic edge walk and/or zigzag underlay.

Satin Area — Options
Use the Satin Area Options to set pattern, underlay, 
compensation and density for satin areas.

Pattern
Choose from more than 250 patterns for satin (for areas wider than around 8-10mm). Click 
a pattern sample or enter the Pattern number to select a pattern. Set the Pattern number 
to 0 for standard satin with no pattern, or click No Pattern . The initial setting is 0.

You can add new patterns using Manage My Fills in mySewnet™ Digitizing.
View the patterns in the pattern gallery. See “Fill and Satin Patterns” on page 274.

Underlay
Set the Underlay option that will be used for the satin area. Zigzag creates zigzag lines of 
running stitch as underlay. Use zigzag underlay for wide areas of satin. Edge walk places 
lines of running stitch just inside the edges of the satin areas. Use edge walk when the 
satin areas have both wide and narrow sections. For very wide areas of satin, select both 
underlay types.

Zigzag is initially selected.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set 
Compensation from 0 to 30. The higher the number, the bolder the area appears.

Set the stitch density for the satin

Select an underlay type for the satin

Adjust the area’s size
Choose a Category and pattern

Search for a pattern by number

Click to use no pattern
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Density
Set Density from 2 to 80. The lower the number, the closer 
together the stitches and the more stitches are produced.

The initial setting is 4.
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Columns
You can use Convert to change between the Column stitch types:

■ Satin Column
■ Feathered Satin
■ Richelieu Bars
■ Tapered Motifs

You can also convert to Satin Area, but you cannot convert back to a satin column.

Satin Column
Satin Column forms a column of straight or curving satin.

Satin lines, and satins created using earlier methods such as Straight Satin and 
Curved Satin, are treated as Satin Column.

Satin Column Options
Use the Satin Column Options to set underlay, compensation and 
density.

Pattern
Choose from more than 250 patterns for satin (for areas wider than around 8-10mm). Click 
a pattern sample or enter the Pattern number to select a pattern. Set the Pattern number 
to 0 for standard satin with no pattern, or click No Pattern . The initial setting is 0.

You can add new patterns using Manage My Fills in mySewnet™ Digitizing.
View the patterns in the pattern gallery. See “Fill and Satin Patterns” on page 274.

Patterns should only be used for columns wider than about 8-10 mm.

Set the Standard density

Select an underlay type for the satin

Adjust the area’s size
Choose a Category and pattern

Search for a pattern by number

Use gradient density

Settings for Single & Multicolor gradient
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Underlay
Set the Underlay option that will be used for the satin column. Zigzag creates zigzag lines 
of running stitch as underlay. Use zigzag underlay for wide areas of satin. Edge walk places 
lines of running stitch just inside the edges of the satin column. Use edge walk when the 
satin columns have both wide and narrow sections. For very wide satin columns, select 
both underlay types.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set 
Compensation from 0 to 30. The higher the number, the bolder the area appears. The 
initial setting is 0.

Standard Density
Set Density from 2 to 80. The lower the number, the closer 
together the stitches and the more stitches are produced. 

The initial setting is 4.

Gradient
Use the Gradient settings to see and change the density settings 
and the color Gradient of the satin.

The color on a satin column can change over a range, or have multiple color changes 
across the area. This is ideal for gradual color changes such as subtle shadow effects. 
Gradient is not initially selected.

Single Color Gradient

Use Single Color Gradient to change the density across a satin column with only one color. 
Set a value for the start and end density markers for the fill, and the density gradually 
changes between the two values. Add multiple markers for a more complex pattern.

The markers can each take a value of 2 to 80, which means you can reverse the gradient simply by 
swapping the start and end values.
Use the adjustment marker above the gradient bar to change the gradient across the area.

Use Reset to cancel your changes and use the initial settings.

Click Add Marker to add a value marker below the gradient bar, and an adjustment marker 
above the gradient bar. The initial value for the marker will be between the existing 
markers. Edit the density value, and move the value and adjustment markers as desired. 

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment marker

Highlighted value marker

Set the stitch density for 
the chosen value marker

Delete the selected
marker
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This means that you can have any combination of density values across the area. A higher 
value means the fill is less dense.

Density is used to change the density of the stitching. Set Density from 2 to 80. The higher 
the number, the less dense the satin. The initial start marker setting is 4, and end marker 
setting is 4.

Click Remove to delete the highlighted marker.

Multicolor Gradient

Use Multicolor Gradient to change the color across a satin column with only one density. 
Set colors for the start and end markers for the area, and the color gradually changes 
between the two values.

Use the marker above the gradient bar to change the color gradient across the area.

Use Reset to cancel your changes and use the initial settings.

Click Add Marker to add a color marker below the gradient bar, and an adjustment marker 
above the gradient bar. The initial color for the marker will be the same as the currently 
highlighted marker. Change the color and move the color and adjustment markers as 
desired. This means that you can have any combination of colors across the area.

Use Thread Color  to change the color of the currently highlighted marker. The Color 
Selection box will be displayed.

See “Change an Existing Thread Color” on page 37.
Click Remove to delete the highlighted marker.

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment markers

Selected color marker

Choose a thread for the 
highlighted marker

Delete the selected
marker

Set the stitch density
for the whole fill
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Feathered Satin
Feathered Satin forms a column of satin that is feathered on one or 
both sides. A Feathered Satin column uses zigzag stitches where 
the start and end points of the stitches are random rather than all 
parallel.

Choose whether one or both sides of the column will be 
feathered, and set the stitch length and density. 

Feathered Satin Options
Use the Feathered Satin Options to set density, Feather Type, and Stitch Length.

Density
Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced. The 
initial setting is 15.

Feather Type
Select which side of the column to feather. The available options 
are Both, Side A or Side B, according to the side where the first (A) or second (B) point was 
placed.

Feather Both Sides Feather One Side

Set the density for the feathered satin

Select which side of the column to feather

Set the length of the feathering stitches
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Stitch Length
Set the Length of feathering stitches from 2 to 30mm in steps of 1mm. The initial setting is 
30mm.

Feather Both Sides
Create a satin column with both edges feathered.

The start and end points of the stitches are random rather 
than all parallel. The final width of the section is 2-2.5 
times larger than it is for standard satin, as shown.

The maximum stitch lengths of the feathered satin may 
be from 2 to 30mm and the satin density may be from 2 
to 40.

Feather One Side
Create curved satin with one edge feathered.

If desired, the feathered side may be altered in the properties dialog box.

One edge is feathered, so the start and end points of the 
stitches on the feathered are random rather than all 
parallel. The final width of the section is 1.5 to 1.75 times 
larger than it would be for standard satin, as shown.

The maximum stitch lengths of the feathered satin may be from 2 to 30mm and the satin 
density may be from 2 to 40.
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Richelieu Bars
Richelieu Bars forms bars in the work area. Richelieu bars are often 
used in lace designs.

Richelieu Bars Options
Use Richelieu Bars Options to set the width and density of the 
satin bars, the gap between the bars, and the number of bars.

Satin
Set the Width of the satin bars from 1mm to 6mm in steps of 0.1mm. The initial setting is 
2mm.

Set the Density of the satin bars from 2 to 15. The initial Density is 4.

Method
Select a method for setting the number of bars.

Select Minimum Gap Size to set the distance between the bars from 1mm to 50mm in 
steps of 1mm. The initial setting is 6mm.

Select Number of Bars to set the number of bars from 1 to 50. The initial number is 6.

Turn off Include Additional First and Last Bar if the edges of the Richelieu bars area are to 
be covered in satin. This option is initially selected.

Underlay
Choose from Edge walk, Center link with zigzag return, and Web double with zigzag 
return. All three options are initially selected.

■ Edge walk places lines of running stitch just inside the edges of the satin bars. 

Set the width for the bars

Set the stitch density for the bars

Set the minimum distance 

Set the number of bars
Use a bar at both ends of the column

Set underlay for the Richelieu bars

between the bars
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■ Center link with zigzag return places a central line of running stitch, with a zigzag return 
line. 

■ Web double with zigzag return places a crosshatch pattern of stitching with a zigzag 
return line.

Vary the combination of underlay, depending on the type of design. It is recommended to use all three 
types for free-standing lace.
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Tapered Motifs
Tapered Motifs form columns of motifs that vary in size according 
to the width of the column. Tapered motifs are often used in lace 
designs.

Tapered Motifs Options
Use the Tapered Motifs Options to set the motif type, stitch type, 
and placement method.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Stitches
Select Running or Triple stitch for stitching out the motifs. Set the Length of stitches from 
1 to 20mm in steps of 0.1mm. Length is initially set to the recommended value for each 
motif.

Set a stitch type for the motifs

Set the stitch length for the motifs

Adjust the position in the column

Set the gap between the motifs
Number of motifs in the column

Select a motif and its orientation

Retain proportions within column
Set the motif width



264          mySewnet™ Stitch Editor   Stitch Types and Properties 

Method

Minimum Gap Size
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Number of Motifs
Set the number of Motifs from 2 to 50. The initial number is 6.

Fit To Line
Select this option to make the shape of the motifs follow the curves of the line. 

Proportional
Use this option to keep the relative height and width of the motif in proportion when the 
column width is changed. This option is selected by default.

Width
The Width is initially set according to the chosen motif. The maximum and minimum 
values for Width are individual to each motif.

Create Textured Antennae for a Dragonfly Embroidery
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\mySewnet\Samples\Stitch Editor\Stitch, 

open the Perky Dragonfly embroidery to load it.
4 Click the Object tab.
5 Use Ctrl + click to select both of the antennae.

The main stitch type in the antennae is Satin Column.

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.
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6 In the Convert drop-down list, select "Satin Column 
to Tapered Motifs". The Tapered Motifs properties 
dialog box appears.
If any stitch type other than Satin Column is listed as 
the stitch type to convert from, deselect and select 
again.

7 Set the Motif Group to Universal and the Category to 
Hand Stitches 1.

8 Set the Pattern to 4, a blanket stitch.
9 Leave the other settings unchanged, and click OK to 

close the dialog box.
10 Click outside the dragonfly to view the changed 

antennae.
Some of the underlay lines may still be present. 
However, this is not a problem as it adds a texturing 
effect.
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Line Types
The following line types are available:

■ Running Stitch
■ Double Stitch
■ Double Zigzag
■ Triple Stitch
■ Satin Line
■ Motif Line

Running Stitch
Running stitch is a row of small stitches going forward. Running Stitch is 
also the preferred option for traveling stitches between sections of an 
embroidery.

Lines of running stitch are used for light markout or as 
underlay.

Running Stitch Properties

Cutwork settings are dimmed (grayed out) as this stitch property is not available in mySewnet™ Stitch 
Editor.

Length
Set the Length of Running stitch from 0.3 to 12mm in steps of 0.1mm.

The initial setting is 2mm.

Set the stitch length

Create a cutwork line

Select 2 or 4 cutwork needles

Create stability gaps in the cutwork line
Set the distance between the gaps
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Double Stitch
Double stitch is a row of small stitches going forward, followed by a row of 
small stitches going backward, so it ends at the same point where it 
began.

Double stitch is used for markout and for branching outlines that need to return to their 
starting points.

Double Stitch Properties

Length
Set the Length of Double stitch from 1 to 12mm in steps of 0.1mm.

The initial setting is 2mm.

Set the stitch length from 1mm to 12mm
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Double Zigzag
Double Zigzag stitch is a row of small stitches going forward, 
followed by a zigzag row of small stitches going backward, so it 
ends at the same point where it began.

Double Zigzag is a special stitch type, recommended for lace. A running 
stitch line is retraced in a zigzag pattern to create a mesh if sections are 
placed together. Alternatively, use this stitch type for crosshatch fill.

Double Zigzag Properties

Length
Set the Length of Double Zigzag stitch from 1 to 12mm in steps of 0.1mm.

The initial setting is 2mm.

Zigzag Width
Set the Width of the Zigzag part of the stitch from 0.2 to 6mm in steps of 0.1mm.

The initial setting is 0.6mm.

Include a Linking Stitch
Use a linking stitch between sections of Double Zigzag stitch.

Set the stitch length
Set the width of the zigzag line

Use a linking stitch between sections of
Double Zigzag
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Triple Stitch
Triple stitch is a row of small three-part stitches, each composed of one 
stitch going forward, one going backward then one going forward. The 
stitch length can be changed from 1mm to 12mm for individual lines in 
the properties dialog box.

Use triple stitch for heavy markout or as heavy joining lines 
between sections of a character or SuperDesign.

Triple Stitch Properties

Length
Set the Length of Triple stitch from 1 to 12mm in steps of 0.1mm.

The initial setting is 2mm.

Set the stitch length
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Satin Line
Satin Line is a line of constant-width satin stitch. It can be used alone, 
or as a border to a fill. The width of the line can be set from 1 to 
12mm.

Satin Line Properties
Set width and density for satin line.

Width
Set Width for satin border from 1 to 12mm. The initial setting is 4mm.

Density
Set Density from 2 to 15. The lower the number, the closer together the stitches and the 
more stitches are produced. The initial setting is 4.

Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting. 
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like 
linen or satin. 

Underlay
Use this option to place edge walk underlay inside each edge of the satin border. Underlay 
will not be generated if the Border Width is set below 2mm.

Tapered Ends
The Start Point and End Point settings can be used to taper the ends of your satin lines.

Use these options to create mitered or pointed ends for your satin lines.

Set the stitch density for the line

Set the satin line width

Use edge walk underlay inside each 
edge of the line

Taper the ends of the satin line
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Start Point
Use these options to change the type of line beginning for the satin line. Select a taper 
type, then set the angle of the taper.

■ No Taper 

■ Left Taper 

■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.

End Point
Use these options to change the type of line end for the satin line. Select a taper type, then 
set the angle of the taper.

■ No Taper 

■ Left Taper 

■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.
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Motif Line
Motif line is used for decorative stitches and details.

Motif Line Properties
The Motif Line properties dialog box appears when you 
select a motif line.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap

The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Set the gap between the motifs in the line

Adjust the position of the motifs in the line

Select a stitch type for the motif line

Set the stitch length for the motif line

Select a motif Group, Category and pattern

Set the motif size and Height / Width ratio

Taper the end of the satin line
Taper the beginning of the satin line
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Fit To Line
Select this option to make the shape of the motifs follow the curves of the line. 

Reverse
Use this option to reverse the direction of the motif along the line. Some motifs are 
symmetrical and will have no apparent change when they are reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motifs. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum Length of 
stitches from 1 to 20mm in steps of 0.1mm. Length is initially set to the recommended 
value for each motif.

Tapered Ends
The Start Point and End Point settings can be used to taper the ends of your motif lines.

For Motif Lines, the Central Point option starts at the first stitch point in the first motif in 
the line. The precise position of the point will vary, depending on the motif used.

Use these options to create mitered or pointed ends for your motif lines.

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.
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Start Point
Use these options to change the type of line beginning for the Motif Line. Select a taper 
type, then set the angle of the taper.

■ No Taper 

■ Left Taper 

■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.

End Point
Use these options to change the type of line end for the Motif Line. Select a taper type, 
then set the angle of the taper.

■ No Taper 

■ Left Taper 

■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.

Fill and Satin Patterns
Set the Fill Pattern number for fill areas, satin areas and columns. When a pattern fill area is 
first created, for example by converting from another stitch type, the initial setting is 
Pattern 3. Standard satin uses Pattern 0, which is not available for Pattern Fill areas.

Patterns in categories other than Standard are recommended for use in relatively large fill areas, as they 
have repeating patterns which work well when 'tiled' together. Pattern 36 produces a 'satin effect' fill stitch.
The first four patterns in the Gradient & Lace category (253-256) are recommended for multicolor gradient.
Patterns 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create a 
weave effect for lace designs. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm 
to combine with Pattern 258, and so on.
For a complete reference to all the fill patterns that can be used, see the Fill Patterns Sample Guide. This is 
provided as a PDF for viewing and printing.

Animals 1 — Patterns 37 to 48

Arrows — Patterns 49 to 60
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Circles 1 — Patterns 61 to 72

Circles 2 — Patterns 73 to 84

Climate — Patterns 85 to 96

Diamonds — Patterns 97 to 108

Gradient & Lace — 
Patterns 253 to 264

Hearts — Patterns 109 to 120

Leisure 1 — Patterns 121 to 132
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Mosaic 1 — Patterns 133 to 144

Mosaic 2 — Patterns 265 to 276

People — Patterns 145 to 156

Plants & Flowers 1 — 
Patterns 157 to 168

Polygons — Patterns 169 to 180

Rope & Chains — 
Patterns 181 to 192

Squares 1 — Patterns 193 to 204
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Squares 2 — Patterns 205 to 216

Standard 1 — Patterns 1 to 12

Standard 2 — Patterns 13 to 24

Standard 3 — Patterns 25 to 36

Transport — Patterns 217 to 228

Waves 1 — Patterns 229 to 240

Waves 2 — Patterns 241 to 252
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14Printing
Use the Print page to select your print settings, and to preview and print a worksheet for 
your embroidery. The printed pages match the Export settings for the embroidery. 

To open the print page in mySewnet™ Stitch Editor, click File, Print .

To open the print dialog in Explorer in Windows®, right-click an embroidery, or a group of selected 
embroideries, and select Print in the Context menu.

Print Page
Select the printer and page layout in print setup, and choose a scale, hoop, units of 
measurement, and details to be printed. Then click Print to print the embroidery 
worksheet and/or overview.

Shortcuts
■ Quick Access Toolbar: 

Print
Click Print to open the Print page and print the project. See “Print” on page 282.

Worksheet
Select the format of the worksheet. Select a Design Scale, whether to use a grid, and 
whether to filp the design. Choose the information to show for the embroidery in the 
worksheet (Dimension, Color Information, Notes and Settings and Technical Information).

Design Scale
Select 25%, 50%, 75%, 100% or ’to fit’ scaling when printing your embroidery. This is how 
large the embroidery will print compared to the real size of a stitched out embroidery. Use 
a reduced Design Scale if you want to ensure that the worksheet fits on one page. Look at 
the print preview pane to see how many pages will be printed.

Select information & grid

Select measurement units

Print the worksheets

Worksheet settings

Preview the printout
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Grid
This determines whether or not a grid will be printed with the embroidery. If you turn this 
off you will still get a rectangle representing the hoop.

Flip design for felting or reverse embroidery
Flip the embroidery for being stitched in reverse, or for felting effects. 

Print All Designs
Select this to print all of the designs in the embroidery, or uncheck to print only the 
selected subdesign.

Print Information
This determines what additional information is printed. All items are selected initially.

Dimensions
The size of the embroidery and the stitch count.

Hoop
The hoop used for the embroidery.

Color Information
The sequence of thread colors used and, if available, the thread specification (range and 
thread number). Stop Commands and their text (where present) are also shown.

Decoration Information
Information on the decorations used, and their size, color and number.

Notes and Settings
Any notes or settings that are included with the embroidery.

Export Options
The Export options used for the embroidery, as set in the Export dialog box.

Technical Information
The distance of each edge of the embroidery from the center of the embroidery.

Units of Measurement
Select between Millimeters and Inches.

Print Setup
Click Print Setup to select a printer in the Print Setup dialog. Choose the units of 
measurement (inches or millimeters) and print quality. Select and enter details for a table 
of contents.

Preview Pane
The preview pane displays the embroidery as it would appear when printed. Other 
information, such as the Dimension, Color Information, Notes, Settings and Technical 
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Information, is shown depending on the choices made in the Worksheets section of the 
Print dialog box.

The print preview toolbar offers you options to zoom in and out of the page, and to show 
multiple pages  or individual pages . If there are multiple pages, step through them 
with Next Page  and Previous Page .

If you are trying to preview an embroidery that does not lie entirely inside its hoop then the preview will not 
be shown and a message will appear instead of the Print Preview. Solve this by changing the hoop size or 
adjusting the embroidery so that it fits the hoop.

Print Preview Toolbar
The print preview toolbar offers you the following options:

Next Page
Preview the next page  to be printed. If this is grayed out when you are on Page 1 then 
there are no more pages and the print fits on one page.

Previous Page
Preview the previous page  to be printed.

Multiple Pages
Select  how many printed pages to preview at a time.

Individual Page
Preview only one  page at a time.

Zoom In
Take a closer look at the page to be printed.

Zoom Out
Take a larger look at the page to be printed.
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Print Setup
This is displayed when you click the Print Setup button in the Page Setup dialog box.

Use Print Setup to select the destination printer and its connection.

Printer
Select the printer you want to use.

Paper Size
Select the size of paper that the embroidery is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.

Orientation
Choose Portrait or Landscape. Generally, you should not need Landscape for the standard 
hoop sizes as the embroidery is rotated automatically by the print process when you print 
an embroidery that uses a Rotated hoop.

Properties
Displays a dialog box that provides additional printing choices, specific to the type of 
printer you have selected.
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Print
Print the active embroidery on the mySewnet™ Stitch Editor screen. Other information, 
such as the Dimensions, Color Information, Notes and Technical Information is printed 
depending on the choices made in Page Setup. The scale may also be altered and a grid 
turned on or off in Page Setup. If possible, the hoop will be printed with the same 
orientation as on the screen. If a horizontal hoop is too wide to fit on the paper at the 
Design Scale chosen in Page Setup then the hoop will be rotated 90 degrees when it is 
printed.

The Print dialog box appears, where you may specify number of copies, the destination 
printer, and other printer setup options.

If you are trying to print an embroidery that does not lie entirely inside its hoop then a message will appear 
instead of the Print dialog box. Solve this by changing the hoop size or adjusting the embroidery so that it 
fits the hoop.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + P; Alt, F, P

Printer
Select the printer you want to use.

Properties
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Print to File
When this option is checked, you will be prompted for a file name after you click OK. The 
print job will then be saved with the file name you specify and can be sent to the printer at 
a later time.

This is an advanced Windows® printing option.
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Print Range
Select the range of pages you wish to print.

Copies
Select the number of Copies you wish to print. If you choose to print more than one copy, 
you can choose to Collate the copies.
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15Preferences
Use Preferences  to add trims automatically, and set Basting Line, Optimizer and Resize 
options. When these are changed, the new settings will be remembered when 
mySewnet™ Stitch Editor is closed and reopened. The sections in the Preferences area are:

Shortcut
■ File Menu: 

• General
• Optimizer
• Resize

General
Adjust preferences for opening files, and set Basting Line stitch length and margin.

Opening Files

Warning when opening files...
Select this option to warn when opening files that contain SuperDesigns, Fonts, or other 
information that would be fixed as stitches. To keep the original file, make a copy, and then 
open the copy instead.

Add trims automatically
If trims are needed for an embroidery design, automatically add the trims when the 
embroidery file is opened.

Basting Line
Set the stitch length and margin width for a basting line to secure the fabric and stabilizer 
before beginning embroidery.
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Stitch Length
Set the stitch length between 2.0mm and 8.0mm in steps of 0.1mm. The initial setting is 
4.0mm.

Margin
Set the margin between 0mm and 20mm in steps of 1mm. The initial setting is 5mm.

Optimizer
Change the settings used by the Stitch Optimizer. This is recommended only if you feel 
that stitches have been removed that affect the look of the embroidery. Changes to 
Optimizer Preferences are very rarely needed.

Sensitivity
Choose the maximum level of sensitivity for Stitch removal with the Stitch Optimizer. 
Fewer stitches are removed when sensitivity is Low.

The initial value is Low.

Stitch Length
Choose the minimum stitch length that will be treated as significant by the Stitch 
Optimizer. Hence, any stitches longer than the selected length will be considered 
significant and will remain unaffected by the Stitch Optimizer. Any stitches that are shorter 
than this value will be checked for optimization.

The initial value is 0.8mm.

The choices for Minimum Significant Stitch Length are always shown in millimeters.
Cutwork Needle lines in the Inspira Cutwork Needle "thread range" and Felting Needle Colors in the Inspira 
Felting Needle "thread range" are unaffected by Optimize Stitch Length.

Resize
These settings are only used when Resize is switched on. They do not affect the Scale 
function.

Density

Change from Standard Calculation (%)
Use this to force the density to vary from the original density. It can be useful to set this to 
a negative value when making an embroidery much smaller than the original.

Uncheck the option to use the standard calculation without having to change the value 
back to 0%.

Set the density change from -10% to +50%. The initial value is 0%.
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Fill Areas

Pattern Sensitivity
Increasing this value improves the recognition of patterns that are hard to identify. When a 
fill area contains an unrecognized pattern, a flat fill pattern is used. Note that patterned 
satin (column fill) is treated as a patterned fill area by the Resize function.

Uncheck the option to turn off pattern recognition. This will force replacement of all 
patterns on fill areas with a flat fill pattern.

Set the sensitivity from 1 to 5. The initial value is 5.

Maximum Stitch Length
This limits the length of stitches in fill areas in the resized selection. This is mainly used 
when making a selection larger.

Uncheck the option to avoid limiting the length of stitches when resizing.

Set the length from 1.0mm to 15.0mm in steps of 0.1mm. The initial value is 5.0mm.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.

Maximum Satin Stitch Length before Conversion to Fill
When resizing satin, the average length of stitches is compared to this setting. If the 
stitches would be larger than this value after resizing, the satin block is converted to a fill 
area. Note that an area of satin can be made up of several blocks, each of which could be 
treated differently when the area is resized.

Uncheck the option to prevent converting satin areas to fill.

Set the length from 1.0mm to 15.0mm in steps of 0.1mm. The initial value is 15.0mm.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.

Single Stitch

Single Stitch Length
Use this to set the stitch length for running stitch and single stitches. The stitch curve is 
recalculated, which can improve the appearance of outlines. When enlarging designs, this 
prevents long untidy stitches. When making designs smaller, this helps curves and shapes 
stay accurate, although small details may be partially lost to prevent stitches from 
becoming too small and dense.

Uncheck the option to resize single stitches without any recalculation of the stitch path.

Set the length from 1.0mm to 15.0mm in steps of 0.1mm. The initial value is 2.0mm.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.
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Stitch Optimizer

Run Stitch Optimizer after Resize
Use this to automatically optimize the embroidery after it has been Resized. This will 
improve the quality of the resized embroidery when it is stitched out. It is recommended 
to use this option, and it is initially selected.
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16Troubleshooting

Error Messages
Loading Embroideries

"Cannot open embroidery."
This message appears if the desired embroidery is not where the module expects it to be, 
for example if an embroidery was loaded from a USB memory stick, then closed and the 
memory stick removed. The message would appear if you tried to load the embroidery 
from the Recent Files list on the File menu.

"Unrecognized file format."
This message appears if the embroidery you are attempting to load is corrupt. For 
example, it might have the extension .vp4, yet not be a proper Husqvarna Viking / Pfaff 
embroidery.

"Embroidery is corrupt."
The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

"Embroidery XY coordinates incorrect."
The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

"Unrecognized file extension."
This message appears if you attempt to load a file with an extension that does not belong 
to any embroidery file types. For example, it would appear if you tried to Drag and Drop a 
.doc file onto the screen.

"Embroidery not created using licensed software."
This message may appear if you attempt to load an embroidery created in third-party 
software. Such embroideries may cause unpredictable results.

"This design contains design information that would be fixed as 
embroidery stitches; for example, Lettering or SuperDesigns. Do you wish 
to continue?"
This message may appear if you open a .vp4 file containing lettering or SuperDesigns in 
mySewnet™ Stitch Editor, as they will be fixed as stitches. Save the embroidery under a 
new name if you want to keep a copy of the original.

If desired, you can turn this message off in Preferences.
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Choosing Thread Colors

"The color xx has been found in your database, but the thread color is not 
exactly the same."
This message appears if the Thread Range and Color Number of the selected color are 
identical to those in your thread database, but some aspect of the color is different. It 
could be a different material or weight, or have additional colors as a variegated thread. 
This could happen if the design you are attempting to edit was supplied by someone with 
a different version of the color, for instance if they have edited it in MyThreads, or if they 
have a later version of the thread database. If you click OK, the color will be replaced with 
the near match. You can alter it to any other color if desired. If you click Cancel, the color 
will not be changed. To import the new color from an embroidery if it is a MyThreads color, 
use mySewnet™ Thread Cache. To check for the latest updates for the mySewnet™ 
Embroidery Software, use Check For Updates in mySewnet™ Configure.

"Could not find xx in your database. Matching to closest thread in yy."
This message appears if the Thread Range of the selected color is not found in your thread 
database. This could happen if the design you are attempting to edit was supplied by 
someone with a later version of the thread database. If you click OK, the color will be 
replaced with the nearest match in the Import Thread Range you have set in mySewnet™ 
Configure. You can alter it to any other color if desired. If you click Cancel, the color will not 
be changed. To import the new color from an embroidery if it is a MyThreads color, use 
mySewnet™ Thread Cache.

"Error: Please select a valid thread."
This message appears if you attempt to click OK in the Color Selection dialog box when 
MyThreads is selected as the thread range and MyThreads is empty.

To prevent this message appearing again, use mySewnet™ Thread Cache to add at least 
one thread to MyThreads.

Modifying Embroideries

"Error. Not enough cut points to separate the embroidery."
This message appears when you place only two points to define your cut line when using 
Design Separator. You must place at least three points to define the area that will be 
separated.

"Cannot add tie. This stitch will not be stitched and cannot have a tie 
placed on it."
This message appears if you try to insert a tie for a stitch that begins with a color or trim 
command. As it will not be stitched, a tie should not be added to it.
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Exporting Files

"Embroidery is too large or will not fit in the hoop."
This message appears if an embroidery you are trying to Export is outside the selected 
hoop or larger than will fit in it. For example, with the 100mm x 100mm hoop selected, an 
embroidery smaller than 100mm x 100mm might be placed partially outside the work 
area when you click Export. This message would then appear. Move the embroidery 
completely within the four blue corners of the work area and try again.

"Embroidery too large for export format."
Certain formats are limited to the number of stitches they can save or the size of hoop 
used on their specific embroidery machine, for example .sew. If you attempt to save a file 
in this format that is bigger than the largest available hoop size or has more stitches than 
are allowed, this message would appear. 

"Unrecognized file extension."
This message appears if you type an incorrect extension that does not belong to any 
embroidery types in the File Name box when trying to save a file.

"Cannot save file."
This message appears if, for instance, you have loaded an embroidery from a CD-ROM and 
then attempt to save the embroidery back to the CD. A CD-ROM is read only, therefore you 
will not be able to save the embroidery.

"You can’t save here. Please choose another location."
This message appears if, for instance, you have loaded an embroidery from a CD-ROM and 
then attempt to save the embroidery back to the CD. A CD-ROM is read only, therefore you 
will not be able to save the embroidery.

"Embroidery has too many stitches for file format."
There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff 
(.pcs) file format. This message appears if the embroidery you attempt to save to this 
format exceeds this limit.

"No stitch data to save."
This message appears on attempting to save when there is no embroidery on the current 
window.

Printing Embroideries

"No embroideries available to print. Only embroideries that are inside the 
hoop can be printed."
This message appears if the embroidery on screen is partially outside the selected hoop. 
Move the embroidery completely within the four blue corners of the work area and try 
again.
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Miscellaneous

"Not enough memory available to perform function."
This message will appear if system resources are low. Close other programs and try again. 
If this does not work, try restarting your computer.



292          mySewnet™ Stitch Editor   Troubleshooting 

Other Topics
Screen Appearance

"It seems to take a long time to redraw embroideries when I choose 
different functions or switch to a new embroidery."
The refresh rate of the screen is limited by the power of your computer's processor and 
RAM as well as the video card and its memory. Try using 2D view as this requires less 
power than 3D view.

"Some of the icons in the Ribbon Bar or Toolbar are 'grayed out'."
Certain icons (for example Copy and other Home tab icons) are only highlighted once an 
embroidery is shown on the screen.

"I have changed grid color and spacing and now I wish to return to the 
original settings."
Use mySewnet™ Configure to change the grid color. Follow the instructions in mySewnet™ 
Configure and select Blue Gray (RGB values 102, 102, 153) from the standard color drop-
down on the Grid Color button.

Use the View tab to change the grid spacing. Set the Grid Size to 5.

"I have changed the screen background color and now I wish to return to 
the original light blue."
Use mySewnet™ Configure to change the background color. Follow the instructions in 
mySewnet™ Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

Loading Embroideries

"I can't drag and drop embroideries from the Open dialog box."
To drag and drop embroideries onto the Work Area, in Windows®  10 & 11, click File 
Explorer on the Status Bar. Then follow the instructions under Drag and Drop. See “Load 
Embroideries with Drag and Drop” on page 15.

Importing Pictures

"The From Scanner or Camera option is not available, even though my 
scanner/camera is plugged in."
The From Scanner or Camera option may not be available, even though you have installed 
and connected a scanner/camera, if it does not support Windows Image Acquisition 
(WIA). If your scanner/camera supports a different image acquisition system, e.g. TWAIN, 
create a .PNG or .JPG file of the image in My Pictures, and load it from there.
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Embroidery appearance and selection of stitches

"The embroidery I want to work with appears too small on the screen."
Make sure the mySewnet™ Stitch Editor window is maximized by clicking the Maximize 
icon on the title bar, then maximize the window of the desired embroidery by clicking the 
Maximize icon on its title bar. Click Zoom To Fit to expand the embroidery so it fills the 
window or use Zoom To Rectangle together with the Overview Window to move around 
the embroidery.

"When I hover the mouse pointer over a color in the color worksheet, part 
of the embroidery changes to an unusual color."
This is called "Highlight Selected Color". It allows you to see where each color is used in an 
embroidery. For example, if you have several color blocks using the same thread color and 
you wish to change the color of a specific section, hover over each color in the worksheet 
in turn until the section you require is highlighted.

"The selection outline partly or completely disappears when I move a 
selected block."
This can happen two reasons:

■ The block has at least one perfectly vertical or horizontal edge
■ The block is composed of very wide satin columns

Blocks with perfectly vertical or horizontal edges
The selection box around the selected block is drawn using a method to provide 
maximum contrast with the background. The outline that shows the shape of the block is 
drawn using the same method. When the two lines are in the same place, they cancel each 
other out. If the block of stitches is a rectangle or a square, the outline may disappear 
completely when you move the block. Notice that the scaling, mirror and rotate handles 
are always visible, so you can use these as cues for positioning blocks where the edges are 
not visible.

Wide satin columns
Satin columns that are made of very long stitches may be interpreted as a series of 
movement stitches when the outline is detected. Movement stitches are ignored by the 
outline detection, so wide satin columns may have no outline, or other stitches 
overlapping the column may be outlined instead.

Positioning blocks with missing outlines
Click and drag the block approximately into position. Use the arrow keys on the keyboard 
to nudge the block into its final position without needing to see the outline.

"I find it hard to select the part of the embroidery I wish to edit."
Many functions of mySewnet™ Stitch Editor can be used to help see sections of 
embroideries more easily. They include the Zoom Commands and the Overview Window, 
as well as the Draw Next Color Block and Draw Previous Color Block, Draw Range and 
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Ghost Mode. The Stitch Player and Coordinates can also be used to help run through 
embroideries to find the required stitch or command. The different methods of selection 
(Box Select, Color Block Select, Freehand Select, Point Select and Select All Visible) are also 
useful for different situations.

"I selected part of an embroidery, then tried to Compensate the block. 
The compensation has been applied to the whole embroidery, not just 
the area selected."
Compensation works on the visible part of an embroidery. Hide stitches with Draw Range, 
Draw Next Color Block or turn colors off by right-clicking in the color worksheet to isolate 
a specific area before using this function.

"I selected part of an embroidery, then tried to Break Up Stitches. Stitches 
have been broken up in the whole embroidery, not just the area selected."
Break Up Stitches works on the visible part of an embroidery. Hide stitches with Draw 
Range, Draw Next Color Block or turn colors off to isolate a specific area before using this 
function.

"I cannot select the desired color using the Color Block Select function, 
because one color is on top of the other."
Use Draw Next Color and Draw Previous Color or turn colors off in the Color Worksheet to 
isolate the desired color area, then click Color Block Select to select those stitches.

Creating Border/Appliqué

"The points on my border shape are blunt."
This may happen with some border shapes that have sharp points if they are not drawn 
proportionally, or if you create very sharp points with Freehand or Point Border. This may 
also happen when border shapes are used at very small sizes.

For best results when drawing preset shapes with sharp points, it is recommended to hold 
down Ctrl so that the shape is perfectly in proportion.

When using Freehand or Point Border, if you need to have an acute angle, try placing an 
extra point or two around the turn, instead of using a single point. Also, try to join the 
polygonal border back to itself on a straight side. If the border starts and finishes at a 
corner, that corner will not be mitered because the ends of the border will be flat at that 
point.

"When using Border Embroidery only the Create Overlay Border option is 
available."
This may happen with some embroideries containing holes or appliqué areas. Where 
multiple lines are found, there cannot be a single external or internal border, so only the 
Create Overlay Border option is available for use.
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Creating Cutwork

"Some of the stabilizing lines on my cutwork are placed in the wrong 
sequence."
If you use ColorSort on multiple areas of cutwork with stabilizing lines, in some 
circumstances the stabilizing lines may be merged. Move the color blocks in the Color 
Select area of the Design panel to change the order of designs with multiple cutwork 
areas.

Using Design Player

"Why is the stitch order of my appliqué embroidery different in Design 
Player than in Stitch Player?"
Design Player uses the Export settings in mySewnet™ Configure when displaying the 
stitching out of an embroidery. Stitch Player uses the stitch order as seen in the Color 
Select area of the Design Panel. When an appliqué piece is created in the Border tab, the 
appliqué placement stitches are placed before the embroidery, and the border is placed 
after the embroidery. If the embroidery is ColorSorted, the placement stitches and border 
may become part of the same block. If ColorSort is selected in the Optimize for Sewing 
settings in the Export tab of mySewnet™ Configure, Design Player will then show the 
appliqué stitches as a single block.

Cancelling unwanted actions

"I used Box Select around an area, but selected some stitches I didn't 
want. Undo is grayed out so I can't click it."
To cancel a stitch block selection made using Box Select, Color Block Select, Freehand 
Select, Point Select or Select All Visible, click anywhere in the currently active embroidery, 
but outside the box showing the selected stitches. The stitches will no longer be selected.

"I have started to Emboss an embroidery using the Stamp Fill and realize I 
have not isolated the part of the embroidery I wish to pattern."
Click Undo once the stamping process is complete, then isolate the desired stitches and 
use Stamp Fill again. If necessary, click Undo once more to Undo the use of Remove 
Needle Points in Fill.

"I have a very large embroidery in the clipboard block. How do I remove 
it?"
Click the clipboard block to clear the current contents.
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17Quick Reference Guide

Ribbon Tabs
File Tab/Menu

New Create a new embroidery.
Ctrl + N

Open Open an existing embroidery in a new window.
Ctrl + O

Recent Open recently used embroideries.

Insert Insert an existing embroidery into your current project.
Ctrl + I; Alt, 1

Save Save the embroidery as a multipart embroidery in .vp4 format.
Ctrl + S; Alt, 2

Save As Save the embroidery as a multipart embroidery in .vp4 format under a 
new name.
Ctrl + Shift + S; Alt, 3

Export Save the embroidery in the current window as a flattened .vp4 file, or 
in an alternative embroidery format, optimized for stitching.
Ctrl + E; Alt, 4

Export Appliqué 
Pieces

Save or print appliqué outlines ready for cutting by a fabric cutter or 
INSPIRA™ Cutwork Needles.
Ctrl + Shift + E

Send Send the selected embroidery to the mySewnet™ Cloud, or to the 
connected machine or computer.
Ctrl + K

Print Set printing options, preview and print the selected embroidery(ies) 
and background.

Preferences Set options for opening files, Basting Line, and for Optimizer and 
Resize.

Configure Open mySewnet™ Configure.

Exit Close the module and prompt to save new and changed embroideries.
Alt + F4
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Home Tab

Clipboard
Copy Make a copy of the embroidery or the selected block of stitches and 

place it on the clipboard.
Ctrl + C; Alt, H, CO, CO

Copy All
Copy all designs in the embroidery, and place them on the clipboard.
Ctrl + Shift + C; Alt, H, CO, CA

Paste Paste the clipboard block.
Ctrl + V; Alt, H, PA, PA

Paste as Design
Paste the embroidery in the Clipboard into the current window as a 
new design.
Ctrl + Shift + V; Alt, H, PA, PD

Paste into New Window
Paste the embroidery in the Clipboard into a new window.
Ctrl + Shift + N; Alt, H, PA, PI

Cut Delete the selected embroidery or block of stitches from the screen 
and place it on the clipboard.
Ctrl + X; Alt, H, CU

Duplicate Make a copy of the selected embroidery, which is automatically pasted 
on the work area.
Ctrl + D; Alt, H, DU

Delete Delete the currently selected embroidery, block or stitch without 
moving it to the clipboard.
Delete; Alt, H, DE

Select
Box Select Select a number of embroideries by opening a square or rectangular 

box around them.
Alt, H, B

Freehand Select Select a number of embroideries within an area of any shape.
Alt, H, FS

Point Select Select a block of embroideries within an area of any shape, defined by 
a series of points.
Alt, H, FP

Select Stitches Select and edit single stitches.
Alt, H, SS

Color Block 
Select

Select a stitch color by clicking the color in the embroidery. All visible 
stitches of the clicked color are selected.
Alt, H, CB

Select All Visible Select all visible stitches. Use in combination with hidden colors and 
Draw Range.
Ctrl + A; Alt, H, SA, SA
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Select None
Deselect all of the embroideries in the work area, including any 
outside the hoop.
Ctrl + Shift + A; Alt, H, SA, SN

Replace 
Selection

Replace the currently selected stitches with the new selection.
Alt, H, RS

Add To 
Selection

Add the new selection to the currently selected stitches.
Alt, H, A

Remove From 
Selection

Remove the new selection from the currently selected stitches.
Alt, H, RF

Resize Switch between resize and scale modes.
Alt, H, Re 

Tools
Reverse Order Reverse the stitch order of a selected block.

Alt, H, RO

ColorSort Reduce the embroidery to the minimum number of color blocks.
Alt, H, CL

Color Tone Convert all the threads in an embroidery to those of another 
manufacturer. Also adjust brightness and contrast, selecting new 
threads automatically.
Alt, H, CT

Rotate 45 Rotate the selected area of stitches by 45 degrees.
Alt, H, R4

Modify Block Show and change the size, rotation and skew of the currently selected 
block.
Alt, H, MB

Center in Hoop Center the embroidery in the hoop and, if necessary, add a movement 
stitch so that the start point of the embroidery is in the center.
Alt, H, CI

Design Select
Previous Design Select the previous design in the stitchout order.

Shift + Tab; Alt, H, PD

Next Design Select the next design in the stitchout order.
Tab; Alt, H, N

Move Forwards Bring the selected embroidery one step closer to the front.
Alt, H, MF

Move 
Backwards

Bring the selected embroidery one step closer to the back.
Alt, H, MO

Combine with 
Previous

Merge the design with the previous design in the stitchout order.
Alt, H, CW

Hoop
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Change Hoop Choose the hoop size you wish to use in mySewnet™ Stitch Editor.
Ctrl + H; Alt, 6; Alt, H, H; Alt, V, H

Life View Show how an embroidery exported from the project will look in 3D 
with real-world perspective. Create a picture or video of your design.
Ctrl + L; Alt, H, L; Alt, 9

Design Player Play through the stitches in the embroidery as if they were being 
stitched from an exported embroidery. Create a picture or video of 
your design.
Ctrl + J; Alt, H, J; Alt, 0
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Modify Tab

Modify Design
Compensate 
Stitches

Make the visible area of stitches in the currently active embroidery 
'bolder'.
Alt, M, CS

Break Up 
Stitches

Add extra stitch points to the embroidery so that no stitches are 
longer than the specified maximum length.
Alt, M, BU

Density Advisor View the density of the embroidery and, if desired, reduce the 
density.
Alt, M, DA

Stitch Optimizer Improve the stitchout of the embroidery, both in speed and quality. 
One of the effects is to remove unnecessary short stitches.
Alt, M, SO

Trim Commands

Automatically Add Trim Commands
Add Trim Commands before most movement stitches in the visible 
stitch area.
Alt, M, TC, A

Remove All Trim Commands
Remove all Trim Commands in the visible stitches of the design.
Alt, M, TC, R

Monochrome Change all visible stitches to one color.
Alt, M, MO

Basting Line

Basting Line for Visible Stitches
Insert a rectangular basting line automatically around the visible 
stitches to secure fabric and stabilizer before beginning 
embroidery.
Alt, M, BL, BL

Basting Line for All Designs
Insert a rectangular basting line automatically around all designs to 
secure fabric and stabilizer before beginning embroidery
Alt, M, BL, BF

Design 
Separator

Break an embroidery into two subdesigns along a line that you 
place around a section of the embroidery.
Alt, M, DS

Split Design Split a large design for stitching out in multiple hoopings, adjusting 
points for the best possible split.
Alt, M, SD

Alignment 
Stitches

Set the selected subdesign as Alignment or Normal stitches.
Alt, M, A

Modify Stitch
Insert Color 
Command

Add a new color change at the point where you click.
Alt, M, IC
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Insert Trim 
Command

Add a Trim Command, which instructs some embroidery machines 
to cut the thread, at the point where you click.
Alt, M, IT

Delete 
Commands

Delete an unwanted Color Change, Stop or Trim command.
Alt, M, DC

Insert Stop 
Command

Add a Stop command, which instructs the embroidery machine to 
stop, at the point where you click.
Alt, M, IS

Edit Stop 
Command

Add or change the message for any existing Stop Command.
Alt, M, E

Insert Stitches Add new stitches to an embroidery.
Alt, M, IN

Insert Tie On Add a tie stitch at the beginning of the stitch area to be secured.
Alt, M, IO

Insert Tie Off Add a tie stitch at the end of the stitch area to be secured.
Alt, M, IE

Morphing
Magnet Pull stitches in towards the point where you click.

Alt, M, MA

Polarize Push stitches away from the point where you click.
Alt, M, P

Twirl Move stitches around the point where you click.
Alt, M, TW

Wave Move stitches in a wave pattern around the point where you click.
Alt, M, W

Global 
Morphing

Move all visible stitches using one of eight morphing effects.
Alt, M, G

Cutwork
Cutwork Line

Freehand Cutwork Line
Use Freehand Cutwork Line to draw a line to be cut using cutwork 
needles.
Alt, M, CL, FT

Point Cutwork Line
Use Point Cutwork Line to place points to define a line to be cut 
using cutwork needles.
Alt, M, CL, FP

Options
Adjust the settings for your cutwork line.
Alt, M, O
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Border Tab

Draw Border Line
Border Line

Freehand Border Line
Draw a line of any shape to create a border.
Alt, B, BL, FT

Point Border Line
Place points to define a line of any shape to create a border.
Alt, B, BL, FP

Border Shape Draw the border shape selected in the list of preset shapes.
Alt, B, BS

Border Shapes Select the desired preset border shape. To draw a shape that is not 
in the list, use a Freehand Border.

Border 
Embroidery

Create a border automatically around the selected embroidery or 
stitches.
Alt, B, BE

Margin Set the distance between the embroidery and the automatic 
border.

Stitch Type Select a stitch type for the border line.

Satin Line Create a line of satin stitches of constant width.

Motif Line Create a line of motif stitches.

Running Stitch Create a line of running stitches (small consecutive stitches).

Triple Stitch Create a line of triple stitch (small three-part stitches, each 
composed of one stitch going forward, one going backward then 
one going forward).

Options Open the options dialog for the line.
Alt, B, OP

Appliqué
Add Appliqué Add appliqué stitches and fabric to your border.

Alt, B, A

Select Fabric Audition a new fabric for your border appliqué.
Alt, B, SF

Options Open the Appliqué Selection dialog box.
Alt, B, OT

Create Border
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Create External 
Border

Keep only the stitches inside the shape that has been drawn and 
add a border around the stitches.
Alt, B, CE

Create Internal 
Border

Keep only the stitches outside the shape that has been drawn and 
add a border inside the stitches.
Alt, B, CI

Create Overlay 
Border

Add a border on top of the embroidery.
Alt, B, CO
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Appliqué Tab

Appliqué Piece
Appliqué Outline

Freehand Appliqué Outline
Draw to define a line of any shape to create an appliqué outline.
Alt, A, AO, FT

Point Appliqué Outline
Place points to define a line of any shape to create an appliqué 
outline.
Alt, A, AO, FP

Appliqué Hole

Freehand Appliqué Hole
Draw to define a line of any shape to create a hole within the 
selected appliqué outline.
Alt, A, AH, FT

Point Appliqué Hole
Place points to define a line of any shape to create a hole within the 
selected appliqué outline.
Alt, A, AH, FP

Express Appliqué Automatically find appliqué stitches within the visible stitches in an 
existing embroidery, and apply an appliqué fabric to them.
Alt, A, Q

Select Piece Select an Appliqué Piece to alter its shape and preview or adjust its 
fabric.
Alt, A, SP

Next Piece Select the next Appliqué Piece in the stitchout order.
Alt, A, N

Previous Piece Select the previous Appliqué Piece in the stitchout order.
Alt, A, P

Insert Points Add new points into the currently selected Appliqué Piece.
Alt, A, I

Delete Points Delete points from the currently selected Appliqué Piece.
Alt, A, DP

Delete Piece Delete the currently selected Appliqué Piece with its outline.
Alt, A, DE

Select Fabric Audition a new fabric for the currently selected Appliqué Piece.
Alt, A, SF
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Emboss Tab
The Emboss tab is used to add stitch points along lines and stamp the embroidery with 
new stitch point patterns.

Effect
Standard Create a light stamped effect.

Alt, E, ST

Super Create a heavy stamped effect.
Alt, E, SU

Needle Points
Emboss Line

Freehand Emboss Line
Draw a line to emboss on an area of stitching.
Alt, E, E, FT

Point Emboss Line
Place points to emboss a line on an area of stitching.
Alt, E, E, FP

Remove Needle 
Points In Fill

Remove most of the needle points within an area of stitches, 
leaving the area blank so that the stamp you apply will show clearly. 
Use in preparation for stamps or placing lines of stitches.
Alt, E, R

Stamps
Category Select a set of stamps by name from the drop-down list.

Stamps Use the scroll bar to the right of the Stamps  to view them.

Load Stamp File Load an ECQ or 4QB file to use as a stamp.
Alt, E, L

Create a Text 
Stamp

Use the TrueType® or OpenType® fonts on your computer to create 
a stamp with your selection of letters.
Alt, E, C

Size Set the stamp Size from 2 to 50mm in 1mm steps.
Alt, E, SI

Rotation Rotate the stamp to any angle from 0 to 359 degrees. Enter a value 
directly or use the small up/down arrows at the side of the box. The 
sample box shows the change.
Alt, E, RA

Stamp Sample Shows the selected stamp. The stamp sample rotates if the Rotation 
is changed.

Vertical Flip Use Vertical Flip to mirror the selected stamp from top to bottom.
Alt, E, V

Horizontal Flip Use Horizontal Flip to mirror the selected stamp from side to side.
Alt, E, H

Single Stamp Place individual stamps where you click.
Alt, E, SS
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Object Tab

Stamp Line

Freehand Stamp Line
Draw lines of stamps in any direction.
Alt, E, SL, FT

Point Stamp Line
Place points for lines of stamps in any direction.
Alt, E, SL, FP

Stamp Fill Fill all visible stitches with the currently selected stamp.
Alt, E, SF

Edit Properties
Stitch Type Shows the stitch type(s) for the currently selected object(s).

Alt, O, T...

Properties Change the properties of the currently selected object(s).
Alt, O, P

Lighter Density Make the stitches more open in the currently selected object(s).
Alt, O, L

Heavier Density Make the stitches more closed in the currently selected object(s).
Alt, O, H

Convert Change the stitch type for the currently selected object(s). Choose 
the type to convert from the drop-down list.
Alt, O, CO...

Modify Object
Remove 
Underlying 
Stitches

Remove all visible stitches within the area of the selected object, 
except those in the object itself, and those stitched after it.
Alt, O, R

Align Origin 
Handles

Aligns the Origin Handles of multiple fill areas to the same location. 
Use to align patterns or focal points.
Alt, O, A

Show Only 
Object

Move the sliders to show only the selected object.
Alt, O, S

Nodes
Insert Points Add a new point into the current fill area or line.

Alt, O, I

Delete Points Delete one or more points from the current fill area or line.
Alt, O, DP

MultiWave Lines
MultiWave Line
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Freehand MultiWave Line
Draw one or more MultiWave lines within the selected MultiWave 
Fill object.
Alt, O, ML, FT

Point MultiWave Line
Place points to define one or more MultiWave lines within the 
selected MultiWave Fill object.
Alt, O, ML, FP

Delete 
MultiWave Line

Delete one or more MultiWave lines from the currently selected 
MultiWave Fill object.
Alt, O, DM
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View Tab

Grid Show or hide the background grid.

Grid On Show the grid.
Alt, V, GO

Grid Numbered 
Half

Show the grid, with grid line numbers along the top and left sides.
Alt, V, GN

Grid Numbered 
Full

Show the grid with grid line numbers on all sides.
Alt, V, GF

Grid Off Hide the grid.
Alt, V, GR

Grid Size Set the distance between the lines in the Grid.
Alt, V, GS

Get Length Measure the distance between any two points on an embroidery.
Alt, V, L

View Mode
3D View View embroideries and background in standard 3D mode.

Ctrl + T; Alt, V, 3

2D View with 
Stitch Points

See the individual stitches in your embroideries as lines with no 
shading, and with stitch points.
Alt, V, 2V

2D View 
without Stitch 
Points

See the individual stitches in your embroideries as lines with no 
shading or stitch points.
Alt, V, 2W

Commands Show or hide the command markers for Color Change, Stop, Appliqué 
and Trim.
Alt, V, CO

Coordinates Show coordinates of the first and last visible stitches.
Alt, V, CR

Hoop
Change Hoop Choose the hoop size you wish to use in mySewnet™ Stitch Editor.

Ctrl + H; Alt, 6; Alt, V, H

Design Panel
Show Design 
Panel

Show the Design Panel.
Alt, V, D

Window
Cascade Arrange multiple windows in the work area in an overlapped fashion. 

Alt, V, CA

Tile Windows Arrange the embroidery windows in the work area so they can all be 
seen.
Alt, V, T

Switch 
Windows

Move to another window.
Alt, V, SW
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Help Tab

Help Topics List help topics.
F1; Alt, P, H

About mySewnet™ 
Stitch Editor

Display module information, version number and copyright.
Alt, P, A
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Toolbars
Quick Access Toolbar

Selection Toolbar

Insert Insert an existing embroidery into your current project.
Ctrl + I; Alt, 1

Save Save a multipart embroidery under the same name.
Ctrl + S; Alt, 2

Save As Save a multipart embroidery under a new name.
Ctrl + Shift + S; Alt, 3

Export Save the embroidery in the current window as a flattened .vp4 file, or in an 
alternative embroidery format.
Ctrl + E; Alt, 4

Print Print the selected embroidery(ies) and background. To set page options, 
use File, Print.
Ctrl + P; Alt, 5

Change Hoop Choose the hoop size you wish to use in mySewnet™ Stitch Editor.
Ctrl + H; Alt, 6; Alt, V, H

Undo Undo the last action.
Ctrl + Z; Alt, 7

Redo Redo the previously undone action.
Ctrl + Y; Alt, 8

Life View Show how an embroidery exported from the project will look in 3D with 
real-world perspective. 
Ctrl + L; Alt, 9; Alt, H, L

Design Player Play through the stitches in the embroidery as if they were being stitched 
from an exported embroidery.
Ctrl + J; Alt, 0; Alt, H, J

Box Select Select a number of embroideries by opening a square or rectangular box 
around them.

Freehand Select Select a number of embroideries within an area of any shape.

Point Select Select a block of embroideries within an area of any shape, defined by a 
series of points.

Select Stitches Select and edit single stitches.

Color Block Select Select a stitch color by clicking the color in the embroidery. All visible 
stitches of the clicked color are selected.

Select All Visible Select all visible stitches. Use in combination with hidden colors and Draw 
Range.
Ctrl + A

Select None Deselect all of the embroideries in the work area, including any outside the 
hoop.
Ctrl + Shift + A
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Design Panel
Design Information
Stitch Count : The Stitch Count of the embroidery.

Height : The Height of the embroidery.

Width : The Width of the embroidery.

Colors : The number of colors in the embroidery.

Color Select
A worksheet panel showing the color blocks in the embroidery. It is used to change the 
thread color and add thread or needle effects, show which color blocks are visible and turn 
the display of color blocks on and off, move color blocks up  and down  the design, 
and merge  color blocks. 

The Draw Range may hide threads in a visible color block.

Notes
Enter up to 2000 characters in the Notes for information and keywords about the 
embroidery.

Settings
Enter up to 2000 characters in the Settings for information on the techniques used for the 
embroidery.

Edit
Edit the Notes or Settings.

Clipboard Block
The Clipboard Block shows the current block that can be pasted into your embroideries.

Overview Window
The overview window gives a small overview of the whole work area for the current 
embroidery.
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Control Strip
Draw Range
The left slider bar and stitch number box set the Draw From Start stitch number. The right 
slider bar and stitch number box set the Draw To End stitch number. Move the appropriate 
slider bar to change the start or end stitch number, or enter a stitch number directly in the 
box. Stitches are not displayed when the color block containing the stitches is hidden.

Stitch Player

Display

Pause for Commands When Pause for Commands is enabled, the Stitch Player will pause at 
every Color Change, Stop or Trim command and display any messages.

Start Jump to the first stitch in the embroidery and stop.

Fast Rewind Play in reverse at triple speed.

Medium Rewind Play in reverse at double speed.

Rewind Play in reverse.

Stop Stop play.

Play Play at normal speed.

Medium Play Play at double speed.

Fast Play Play at triple speed.

End Jump to the last stitch in the embroidery and stop.

Draw Previous Color 
Block

Step through the color blocks in reverse order.

Draw Next Color 
Block

Step through the color blocks one at a time.

Invert Visible Color 
Blocks

Switch the visibility of the color blocks so that those that were visible 
become hidden, and those that were hidden are displayed.

Previous Stop Step through the Stop commands one at a time.

Next Stop Step through the Stop commands in reverse order.

Draw All Stitches Display all stitches in the currently active embroidery.

Ghost Mode Display pale 'ghost' stitches where there are hidden stitches in the 
currently active embroidery.
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Status Bar
Use the Zoom Commands on the Status Bar to navigate around embroideries.

Zoom To Rectangle Increase magnification of an area of the embroidery.
Ctrl + 0

Zoom To Fit Fit the work area to the screen.
Ctrl + 9

100%
Display at 100% magnification.
Ctrl + 1

200%
Display at 200% magnification.
Ctrl + 2

400%
Display at 400% magnification.
Ctrl + 3

800%
Display at 800% magnification.
Ctrl + 4

75%
Display at 75% magnification.
Ctrl + 5

50%
Display at 50% magnification.
Ctrl + 6

25%
Display at 25% magnification.
Ctrl + 7

Zoom Out Decrease magnification.
Ctrl + -

Zoom In Increase magnification.
Ctrl + =
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Index
Symbols
.4qb ....................................................................... 193
.ecq File ................................................................ 193
.vp3

Add Appliqué .......................................... 110
Alignment Stitches................................ 165

.vp4............................................................................. 9

Numerics
2 Cutwork Needles ...................... 140, 142, 146
2D Template ....................................................... 179
2D View with Stitch Points ..........................6, 32
2D View without Stitch Points ........................32
3D View ...................................................................32
4 Cutwork Needles ................................ 140, 142
45 Degree Block Rotate.....................................71

A
Abbreviation .........................................................38
About......................................................................... 3
Acquire Picture.................................................. 105
Acrobat Reader® .................................................... 2
Add

Quick Color Theme................................ 121
Add Cutwork Needle Lines ........................... 138
Add Stitches ..........................................................79
Add To Selection..................................................69
Adding Trims...................................................... 284
Adjust

Split Lines.................................................. 178
Advisor

Density....................................................... 157
Aids for Alignment........................................... 180
Align

Split Embroidery Sections .................. 179
To Previous Sections ............................. 181
With Baste Alignment Stitches.......... 181
With Corner Alignment Stitches....... 181
With No Alignment Stitches............... 181

Align Origin Handles....................................... 216
Alignment

General Considerations ....................... 179
Other Aids................................................. 180
Subdesign................................................. 164

Alignment Stitch Style.................................... 170
Alignment Stitches ................................ 164, 181

Align With None ..................................... 181
Angle

Background Picture..................... 101, 106
Block Rotation............................................72
Fill ................................................................ 220
Fill Pattern................................................. 220
For Satin Areas ........................................ 212
Motif Fill..................................................... 229
Stamp......................................................... 195

Angle Line
Delete......................................................... 212
Last.............................................................. 212

Angle Lines............................................... 211, 212
Animals 1 — Patterns 37 to 48.................... 274
Animated Demo ..................................................54

Appliqué....................................................... 85, 120
Add ..............................................................110
Create............................................................ 92
Double Layer ............................................119
Method.......................................................107
Multiple Patches......................................117
Overlapping..............................................117
Patch in Bordered Embroidery ..........117
Placement..................................................107
Techniques................................................117

Appliqué Embroidery
Change Fabric ..........................................109

Appliqué Hole ....................................................112
Appliqué Outline...............................................110
Appliqué Piece...................................................109
Appliqué Piece Margin............................ 97, 108
Appliqué Pieces

Export ........................................................... 24
Appliqué Selection............................................. 95
Apply Stamps .....................................................196
Area

Deselect ........................................66, 67, 68
Fill .................................................................286
Get Length .................................................. 60
Stitch ................................................................5
Traveling Stitches Around Outside...222
Types ...........................................................207
Work .................................................................5

Areas
Fill .................................................................207
Motif Fill .....................................................207
Move Origin ..............................................212
Move Start and End Points ..................212
Satin.............................................................208
Stitch Type.................................................206

Arrows — Patterns 49 to 60 ..........................274
Automatic Basting Line.........................161, 162
Automatic Border ............................................... 89
Automatically Add Trim Commands..........159

B
Background

Name...........................................................103
Size...............................................................102
Wizard................................................. 98–103

Background Grid ............................................ 6, 33
Bar

Menu ................................................................4
Status ...............................................................7
Title ...................................................................4
Zoom............................................................. 58

Bars
Richelieu ....................................................261

Baste ......................................................................171
Baste Alignment Stitches ...............................181
Basting Line...............................................162, 284

Automatic..................................................161
Color ..................................................161, 162

Basting Line for All Designs...........................162
Block

Clipboard......................................7, 81, 311



mySewnet™ Stitch Editor   Index              315

Deselect........................................................66
Draw Next....................................................46
Draw Previous ............................................46
Flip..................................................................73
Horizontally Flip ........................................73
Modify...........................................................72
Move..............................................................70
Paste ..............................................................65
Resize and Scale ........................................70
Rotate............................................................71
Rotate 45 Degrees ....................................71
Rotation Angle...........................................72
Select.............................................................64
Select by Color ...........................................66
Skew ..............................................................72
Vertically Flip ..............................................73

Block Select Functions ......................................66
Block Selection and Draw Range ..................48
Blocks

Hide Stitch Color .......................................36
Modify...........................................................75
Move and Merge Color ...........................40
Show Stitch Color .....................................36

Blue ....................................................................... 123
Blue Handles .........................................................73
Blue Handles for Resize............................. 65, 70
Border

Create............................................................90
Donut ......................................................... 118
Double ....................................................... 118
Draw Shape.................................................87
Draw Shapes as Design........................ 118
Embroidery .................................................89
Freehand......................................................85
Options...................................................... 107
Point ..............................................................86
With Stamps............................................. 119

Border and Appliqué ...............................85, 120
Techniques ............................................... 117

Border Embroidery .............................................89
Border Options.....................................................88
Border Properties

Satin............................................................ 270
Border Shape ........................................................88
Border Stitch Type...............................................90
Bordered Embroidery & Appliqué Patch . 117
Borders

Satin............................................................ 209
Boundary of Hoop ..............................................65
Box Select...............................................................66
Break Up Stitches ............................................. 153
Brightness

Color Tone....................................................43

C
Calculation (%) .................................................. 285
Camera................................................................. 105
Cascade...................................................................63
Category

Curved Crosshatch Fill.......................... 234
Motif Fill........................................... 226, 228
Motif Line.................................................. 272
MultiWave Fill .......................................... 238
Shape Fill................................................... 244
Tapered Motifs ........................................ 263

Center

In Hoop......................................................... 74
Of Rotation...........................................70, 71

Center in Hoop..................................................... 74
Center Lines ........................................................180
Center link with Zigzag Return ....................262
Center Motifs 1 and 2 ......................................228
Central Point .............................................271, 274
Change

Color .............................................................. 36
Hoop............................................................169
Hoop Size..................................................... 11
Object Settings........................................204
Order Of Color Blocks.............................. 40
Stitch Angle for Satin Areas ................212
Thread Color ............................................... 37

Change from Standard Calculation (%) ....285
Change the Alignment Stitches in a .VP3 

Embroidery ......................................................165
Choose

Fabric...........................................................180
New Thread Color ...................................123
Object to Edit ...........................................211
Picture.........................................................104
Routes for Split Lines.............................178

Choose Picture
Background Wizard.................................. 98

Circles 1 — Patterns 61 to 72........................275
Circles 2 — Patterns 73 to 84........................275
Climate — Patterns 85 to 96 .........................275
Clipboard Block ....................................7, 81, 311
Close ........................................................................ 18

Embroideries .............................................. 18
mySewent Stitch Editor .............................3

Color
Basting Line ....................................161, 162
Choose New Thread...............................123
Display ........................................................312
Edit ...............................................................122
Information...............................................279
Models ........................................................123
Paste ............................................................122
Popup Description ................................... 36
Select...........................................................311
Thread.........................................................123
Tone............................................................... 42

Color Block
Draw Next.................................................... 46
Draw Previous ............................................ 46
Select............................................................. 66

Color Block Selection and Draw Range....... 48
Color Blocks

Hide ............................................................... 36
Move and Merge....................................... 40
Show.............................................................. 36

Color Change........................................................ 36
Thread........................................................... 37

Color Command
Insert ............................................................. 75

Color Select ..............................................................7
Color Tone

Brightness.................................................... 43
Contrast........................................................ 43
Gamma......................................................... 43

Color Worksheet .................................................. 36
Colors ....................................................................311

Dialog Box .................................................123
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Merge............................................................41
Move..............................................................41
Thread...........................................................36
View Selected.............................................36

ColorSort ................................................................42
Columns .......................................... 208, 218, 256
Combine with Previous.................................. 152
Command Markers ............................................... 9
Commands ............................................................75

Delete............................................................79
Pause For......................................................50
View ....................................................... 33, 79

Compensate Stitches...................................... 152
Compensation................................................... 171

Fill ................................................................ 221
Satin Area.................................................. 254

Composition in mySewnet Embroidery... 175
Connection

Split Project.............................................. 171
Contour Fill ............................................... 207, 252

Options...................................................... 252
Contrast

Color Tone....................................................43
Control Strip...........................................6, 45, 312
Conversion to Fill.............................................. 286
Convert

Object Type.................................... 205, 206
Coordinates................................................... 60, 62
Copies

Print Number........................................... 283
Copy.........................................................................81

Color ........................................................... 122
Copy All...................................................................82
Corner................................................................... 170

Alignment Stitches................................ 181
Create

Appliqué ......................................................92
Border ...........................................................90

Create a Text Stamp......................................... 194
Crop

Picture for Fabric .................................... 100
Crop Box .............................................................. 106
Crop Picture

Load Picture Wizard .............................. 106
Crosshatch

Curved ....................................................... 232
Crosshatch Fill ................................................... 230

Properties ................................................. 230
Cursor

Coordinates.................................................62
Curved

QuiltStipple Fill ....................................... 250
Curved Crosshatch Fill .................................... 232

Properties ................................................. 232
Curved Lines ...................................................... 211
Custom Color..................................................... 123
Cut ............................................................................81
Cutting Out......................................................... 154
Cutwork

Options...................................................... 140
Cutwork Line...................................................... 140

Freehand................................................... 138
Point ........................................................... 139

Cutwork Needle.........................................40, 138
Cutwork Needle Line ...............................23, 138
Cutwork Needles.............................................. 140

Cutwork Racket..................................................141

D
Decide Stitchout Order...................................179
Decoration Information..................................279
Decoration Subdesigns .......................................6
Decorations..............................................................6
Decorative Shapes............................................117
Delete...................................................................... 83

Angle Lines ...............................................212
Commands.................................................. 79
MultiWave Line........................................215
Point ..................................................168, 213
Points ............................................................ 83
Quick Color Theme.................................122
Single Stitches ........................................... 83
Stitch Points..............................................191

Delete Piece ........................................................116
Delete Points ......................................................115
Demo....................................................................... 54
Dense Areas ........................................................159
Density..................................................................285

Advisor........................................................157
Fill Properties............................................221
Gradient .................................222, 247, 257
Heavier .......................................................205
Lighter ........................................................205
MultiWave Fill...........................................237
Normal..............................................221, 247
Radial Fill....................................................246
Satin Area ..................................................255
Satin Border ..............................................270
Shape Fill....................................................243
Show............................................................158
Standard ..........................................221, 247
Statistics .....................................................158

Description
Thread........................................................... 44

Description of Thread Color ............................ 36
Deselect

Block.............................................................. 66
Wrong Area..................................66, 67, 68

Design
Draw Border Shapes ..............................118
Edit ...............................................................203
Information.................................... 6, 53, 58
Panel............................................................311
Scale ............................................................278
Separator ...................................................154
Split..............................................................171

Design Information ..........................................311
Design Panel .................................................... 6, 35

Show.............................................................. 35
Design Player........................................................ 50

Video Speed................................................ 56
Design Select................................................... 4, 31
Design Separator

Alignment Stitches.......................164, 165
Design Wizard ....................................................176
Desktop Shortcuts.................................................3
Diagonal Corners

Echo Fill ......................................................242
Diamond

Crosshatch Fill ..........................................230
Curved Crosshatch Fill ..........................233

Diamonds — Patterns 97 to 108 .................275
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Digital Camera................................................... 105
Dimensions

Page Setup ............................................... 279
Direct USB Connection .....................................27
Direct USB Settings ............................................29
Display........................................................ 217, 312
Distance

Between Secure Points ........................ 140
Double Border................................................... 118
Double Layer Appliqué .................................. 119
Double Stitch..................................................... 267

Appliqué ................................................... 107
Length........................................................ 108
Properties ................................................. 267

Double Stitch - Stop - Satin .......................... 108
Double with Zigzag Return .......................... 268
Double Zigzag................................................... 268
Drag and Drop Load...........................................15
Dragonfly ................................... 14, 73, 146, 264
Draw

All Stitches...................................................47
Border Shape..............................................87
Border Shapes as the Design............. 118
Next Color Block........................................46
Previous Color Block ................................46

Draw From Start...................................................48
Draw Range.................................................49, 312
Draw Range (Slider Bars) ..................................48
Draw Range and Color Blocks ........................47
Draw To End ..........................................................48
Dual Thread................................................... 38, 39
Duplicate................................................................82

E
Echo Fill................................................................ 241

Properties ................................................. 241
Echo Lines........................................................... 241
ECQ File

Stamp......................................................... 193
Edge Walk

Richelieu Bars .......................................... 261
Edit

Choose Object ........................................ 211
Color ........................................................... 122
Design........................................................ 203
Lines and Areas....................................... 210
Quick Color Theme................................ 122
Select Object ........................................... 203
Single Stitches............................................79
Stitches .........................................................79

Edit Properties................................................... 204
Edit Stop Command...........................................78
Editing Objects ................................................. 203
Effect........................................................... 189, 305
Effects ......................................................................38
Emboss

Freehand................................................... 189
Point ........................................................... 190

Embossing .......................................................... 189
Embroideries

Close ..............................................................18
Load with Drag and Drop ......................15
Managing.....................................................12
Open..............................................................12
Open Recently Used ................................15
Save................................................................17

Splitting and Saving ..............................167
Switch Between Open .....................12, 16
Viewing......................................................... 31

Embroidery
Automatic Border ..................................... 89
File Formats....................................................9
File Names.................................................172
Modify.........................................................150
Navigate....................................................... 56
New..............................................................118
On Heavy Knit Fabric .........221, 247, 270
On Linen.................................221, 247, 270
On Satin..................................221, 247, 270
On Thick Fabric ....................221, 247, 270
Prepare Composition ............................175
Stitch Out and Align Split Sections ..179
With Appliqué Patch..............................117

End Marker ................................................211, 212
End Point....................................................271, 274
End Point for Area.............................................212
Enter Angles

Crosshatch Fill ..........................................231
Curved Crosshatch Fill ..........................233

Enter Size ............................................................... 11
Error Messages...................................................288
Exit.......................................................................3, 29

Save On ........................................................ 17
Explorer .................................................................. 15
Export...................................................................... 19
Export Appliqué ................................................116
Export Appliqué Pieces..................................... 24
Export Options...................................................279
Express Appliqué ..............................................113

F
Fabric

Embroidery on Heavy Knit221, 247, 270
Embroidery on Thick .........221, 247, 270
Handle ........................................................109
Rotate and Crop Picture .......................100
Select................................................... 94, 116

Fabric Choice ......................................................180
Fabric Pull ............................................................152
Feather

Both Sides..................................................260
One Side.....................................................260

Feather Type .......................................................259
Feathered Satin........................................208, 259

Options.......................................................259
Felting Needle...................................................... 40
File

Embroidery Name ..................................172
File Formats of Embroideries .............................9
File Menu .............................................................296
File Name ............................................................... 13
Files

Of Type ......................................................... 13
Picture..............................................................9
Sample.............................................................2

Fill
Angle...........................................................220
Areas............................................................286
Contour ......................................................207
Crosshatch.................................................230
Curved Crosshatch .................................232
Echo.............................................................241
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Motif ........................................................... 226
MultiWave....................................... 207, 237
Pattern ....................................................... 218
QuiltStipple.................................... 207, 250
Radial.......................................................... 207
Remove Needle Points In.................... 191
Satin Effect ............................................... 274
Spiral........................................................... 207
Stamp............................................... 196, 200

Fill Area
Traveling Stitches Around Outside.. 222

Fill Areas .............................................................. 207
Fill Options

Contour ..................................................... 252
QuiltStipple.............................................. 250
Radial.......................................................... 246
Shape ......................................................... 243
Spiral........................................................... 247

Fill Pattern........................................................... 274
Fill Patterns

Sample Guide.......................................... 274
Fill Properties

Density....................................................... 221
Options...................................................... 220
Pattern ....................................................... 219

Find Thread............................................................38
Finding Information ............................................. 2
First Section

Split Embroidery .................................... 173
Stitchout.................................................... 180

Fit Motif To Line
Curved Crosshatch Fill.......................... 234
MultiWave Fill .......................................... 239
Shape Fill................................................... 244

Fit To Line
Motif Line.................................................. 273
Tapered Motifs ........................................ 264

Flip
Horizontal ................................................. 196
Vertical ....................................................... 195

Flip Block ................................................................73
Horizontally.................................................73
Vertically.......................................................73

Flip design for felting or reverse embroidery279
Foam

Puffy....................................................... 38, 39
Font

Text Stamp................................................ 194
Formats of Embroidery Files ............................. 9
Free Rotation ........................................................71
Freehand

Emboss ...................................................... 189
MultiWave Line ....................................... 214

Freehand Appliqué Hole ............................... 112
Freehand Appliqué Outline.......................... 110
Freehand Border..................................................85
Freehand Cutwork Line.................................. 138
Freehand Emboss Line ................................... 189
Freehand MultiWave Line ............................. 214
Freehand Select ...................................................67
Freehand Stamp Line...................................... 198
Frequency

Ripple ......................................................... 131
Wave ................................................. 136, 137

G
Gamma

Color Tone ................................................... 43
Gap

Minimum ...........234, 238, 244, 264, 272
Motif Fill .....................................................228

General Alignment Considerations............179
General Preferences .........................................284
Get Length............................................................. 60
Getting Started .......................................................1
Ghost Mode .......................................................... 33
Global Morphing...............................................127
Glow in the Dark.................................................. 53
Gradient

Multicolor ........................................224, 258
Gradient — Patterns 253 to 264..................275
Gradient Density .....................................222, 257

Spiral Fill .....................................................247
Green.....................................................................123
Grid

Background ........................................... 6, 33
Numbered Full ........................................... 34
Numbered Half .......................................... 34
Off................................................................... 34
On................................................................... 34
Page Setup ................................................279
Size................................................................. 35

Group
Curved Crosshatch Fill ..........................234
Motif Fill ...........................................226, 227
Motif Line...................................................272
MultiWave Fill...........................................238
Shape Fill....................................................244
Tapered Motifs .........................................263

Guide
Reference........................................................2

Guides
Sample.............................................................2
View and Print PDF......................................2

H
Handle

Fabric...........................................................109
Handles

For Resize..............................................65, 70
For Scale................................................65, 70
Round ........................................................... 65

Hearts — Patterns 109 to 120 ......................275
Heavier Density .................................................205
Heavy Knit Fabric ..........................221, 247, 270
Height ...................................................................311

Ripple..........................................................131
Wave..................................................136, 137

Height and Width
Curved Crosshatch Fill ..........................235
Motif Fill ...........................................227, 228
Motif Line...................................................273
MultiWave Fill...........................................239
Shape Fill....................................................245

Help
Tab................................................................309

Help Online ..............................................................2
Hidden Stitches

Display .......................................................... 33
Hide

Stitch Color Blocks.................................... 36
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Underlay Stitches................................... 191
Highlight Thread .................................................44
Hole

Appliqué ................................................... 112
Home

Tab............................................................... 297
Hoop ..................................................................... 279

Boundary .....................................................65
Center In.......................................................74
Center in.......................................................74
Change ...................................................... 169
Change Size ................................................11
Group ............................................................11
Optimal Number .................................... 176
Options...................................................... 169
Orientation............................................... 176
Preferences............................................... 176
Selection ......................................................10
Size .......................................................58, 169
Splitting........................................................21
Templates and Printed Worksheets. 180

Hoop and Overlap Selection........................ 175
Hoop Group ..........................................................10
Hoop Options

Split Design.............................................. 169
Hoop Size ...............................................................10
Horizontal

Skew ........................................................... 132
Wave ........................................................... 136

Horizontal Flip ................................................... 196
Horizontally Flip Block.......................................73
How To

Change Object Settings ...................... 204
HSL ........................................................................ 123
Hue Saturation Luminance (HSL)

Color Model ............................................. 123

I
Inches .................................................... 35, 60, 286

Show Measurements...............................34
Include Secure Points ..................................... 140
Included in My Hoops .......................................10
Information

Color ........................................................... 279
Design.............................................. 6, 53, 58
Finding............................................................ 2
Print ............................................................ 279
Readme and Technical .............................. 2
Save Embroidery Project..................... 172
Technical ................................................... 279

Insert
Color Command........................................75
Point ........................................................... 213
Stitches .........................................................80
Stop Command .........................................77
Tie Stitch.......................................................80
Trim Command..........................................78

Insert Color Command......................................76
Insert Point ......................................................... 168
Insert Points ............................................. 115, 189
Insert Tie Off..........................................................80
Insert Tie On..........................................................80
Intensity

Pinch........................................................... 130
Skew Horizontal ..................................... 132
Skew Vertical ........................................... 133

Spherize .....................................................134
Twirl .............................................................135

Invert Visible Color Blocks................................ 47

J
Jump Stitch

Split Project...............................................171

K
Kern

Curved Crosshatch Fill ..........................235
Motif Line...................................................273
MultiWave Fill...........................................239
Shape Fill....................................................245

Keywords
Notes ............................................................. 59

Knitwear
Embroidery on.........................................152

L
Lace — Patterns 253 to 264 ..........................275
Last

Angle Line .................................................212
Split Embroidery Section .....................173

Left Taper ...................................................271, 274
Leisure 1 — Patterns 121 to 132..................275
Length

Before Conversion to Fill ......................286
Coordinates ................................................ 61
Double Stitch ...........................................108
Maximum Stitch......................................286
Of Area.......................................................... 60
Running Stitch .........................................108
Single Stitch..............................................286
Stitch ...........................................................285

Life View ................................................................. 52
Lighter Density ..................................................205
Limit

Offset...........................................................229
Line

Basting........................................................284
Fit Motif To.............................234, 239, 244
Fit To ..................................................264, 273
MultiWave .................................................214
Satin.............................................................270
Stabilizing..................................................141
Stamp................................................196, 198
Wave............................................................214

Line Types ............................................................209
Linen..................................................221, 247, 270
Lines.......................................................................206

Adjust..........................................................178
Center .........................................................180
Choose Routes for Split ........................178
Echo.............................................................241
Motif ............................................................209
Move............................................................168
Split..............................................................168
Stitch Angle ....................................211, 212
Straight or Curved ..................................211

Load Design Wizard .........................................176
Load Embroideries with Drag and Drop..... 15
Load Stamp File .................................................193
Look In .................................................................... 13
Luminance...........................................................123
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M
Magnet................................................................. 125
Make Lines Straight or Curved .................... 211
Manage Threads ..................................................38
Managing Embroideries ...................................12
Margin

Appliqué Piece...........................................97
Border Embroidery...................................90

Marker
End .................................................... 211, 212
Origin ......................................................... 211
Snap............................................................ 212
Start .................................................. 211, 212

Markers
Command...................................................... 9

Match Placement Line.................................... 108
Maximum

Satin Stitch Length before Conversion to 
Fill ............................................................. 286

Stitch Length ........................................... 286
Maximum Recommended Satin Stitch Length

208
Measure Pointer...................................................60
Measurement Units......................................... 279
Menu

Bar .................................................................... 4
File ............................................................... 296
Window ........................................................12

Menus................................................................... 296
Merge Colors.........................................................41
Merge into Next Color.......................................42
Merge into Previous Color ...............................41
Method

Richelieu Bars .......................................... 261
Method for Appliqué ...................................... 107
Millimeters.............................................................60
Minimum Gap

Curved Crosshatch Fill.......................... 234
Motif Line.................................................. 272
MultiWave Fill .......................................... 238
Shape Fill................................................... 244
Tapered Motifs ........................................ 264

Minimum Significant Stitch Length .............23
Mirror

Curved Crosshatch Fill.......................... 235
Motif Fill........................................... 227, 228
Motif Line.................................................. 273
MultiWave Fill .......................................... 239
Settings.........................................................74
Shape Fill................................................... 245

Mitered End.............................................. 270, 273
Modify Block ....................................... 72, 73, 146
Modify Object.......................................... 216, 306
Modify Stitch.........................................................75
Modifying

Blocks and Stitches...................................75
Embroidery .............................................. 150

Monochrome........................................................45
Morphing

Global......................................................... 127
Point ........................................................... 125
Stitches ...................................................... 125

Mosaic — Patterns 133 to 144..................... 276
Mosaic — Patterns 265 to 276..................... 276
Motif

Curved Crosshatch Fill.......................... 234

Fit To Line...............................234, 239, 244
Motif Line...................................................272
MultiWave Fill...........................................238
Shape Fill....................................................244
Tapered.......................................................263
Tapered Motifs .........................................263

Motif 1.........................................................226, 227
Motif 2...................................................................227
Motif Fill................................................................226

Areas............................................................207
Properties ..................................................226

Motif Fill Properties
Options.......................................................229
Patterns ......................................................226

Motif Line...................................................209, 272
Properties ..................................................272

Motifs
Center 1 and 2..........................................228
Use .....................................................237, 243

Mouse
Zoom with Wheel .........................154, 156

Move
Block.............................................................. 70
Center of Rotation .................................... 71
Colors ............................................................ 41
Origin for Areas .......................................212
Points ..........................................................211
Points and Lines ......................................168
Start and End Points for Areas ...........212

Move Backwards ...............................................152
Move Color Down............................................... 41
Move Color Up ..................................................... 41
Move Forwards ..................................................151
Move Node Pointer ..........................................147
Move Point ..........................................................168
Movement Stitches ..........................................156
Multicolor Gradient................................224, 258
Multipart Hoops

Splitting........................................................ 21
Multiple Appliqué Patches ............................117
MultiWave Fill ...........................................207, 237

Options.......................................................237
MultiWave Line

Delete..........................................................215
Freehand....................................................214
Point ............................................................215

MultiWave Lines ................................................214
Freehand..........................................214, 306
Point ..................................................214, 306

My Hoops............................................................... 10
mySewent Configure......................................... 60
mySewnet Configure......................................... 34
mySewnet Embroidery ...................................154

Composition.............................................175
mySewnet™........................................................... 25
mySewnet™ Cloud Sync Tool.......................... 29
mySewnet™ Connect......................................... 26
mySewnet™ Options.......................................... 29
mySewnet™ Thread Cache .............................. 38
MyThreadRanges ................................................ 38
MyThreads ............................................................. 36

N
Name

Background ..............................................103
Embroidery File .......................................172
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File ..................................................................13
Thumbnail ...................................................15

Navigate Embroidery.........................................56
Needle

Insertions ....................................................... 6
Remove Points In Fill............................. 191

Needle Point ...................................................... 189
Needle Points..................................................... 305
New ..........................................................................12

Embroidery .............................................. 118
New Thread Color ............................................ 123
Next

Split Section............................................. 173
Next Color Block ..................................................46
Next Design........................................................ 151
Next Page

Print Preview............................................ 280
Next Piece ........................................................... 114
Next Stop ...............................................................47
No Alignment Stitches ................................... 181
No Overlap Zone .............................................. 167
No Taper .................................................... 271, 274
Nodes ......................................................... 213, 306
None ..................................................................... 170
Normal Density ....................................... 221, 247
Notes..............................................................58, 311

Dialog Box ...................................................59
Page Setup ............................................... 279

Nudge......................................................................70
Number of Hoopings...................................... 176
Numbered Full

Grid ................................................................34
Numbered Half

Grid ................................................................34

O
Object

Choose to Edit......................................... 211
Convert ...................................................... 205
How To Change Settings ..................... 204
Modify.............................................. 216, 306
Select to Edit............................................ 203
Show Only ................................................ 217

Object Types
Convert ...................................................... 206

Objects
Select.......................................................... 203

Off
Grid ................................................................34

Offset
Limit............................................................ 229
Motif Fill..................................................... 229

On
Grid ................................................................34

One Page / Two Page
Print Preview............................................ 280

Online Help ............................................................. 2
On-screen Pointers ............................................... 7
Open ........................................................................13

Recently Used Embroideries.................15
Open Embroideries ............................................12

Switch Between................................. 12, 16
OpenType............................................................ 194
Optimal Number of Hoopings..................... 176
Optimize Stitch Length.....................................23
Optimizer

After Resize ...............................................287
Preferences ...............................................285
Stitch ......................................... 71, 159, 287

Optimizer Preferences.....................................159
Options

Border .........................................................107
Contour Fill................................................252
Cutwork......................................................140
Feathered Satin .......................................259
Fill Properties............................................220
Hoop............................................................169
Motif Fill Properties................................229
MultiWave Fill...........................................237
Print .............................................................174
QuiltStipple Fill ........................................250
Radial Fill....................................................246
Shape Fill....................................................243
Spiral Fill .....................................................247
Tapered Motifs .........................................263

Order Of Color Blocks ........................................ 40
Organizing Windows ......................................... 63
Orientation............................................................ 11

Hoop............................................................176
Override .....................................................176
Print Setup ................................................281

Origin
Marker.........................................................211
Move............................................................212

Origin Handles
Align ............................................................216

Other Alignment Aids .....................................180
Other Topics........................................................292
Outline

Appliqué ....................................................110
Outline Around Selection ................................ 70
Outlines

Edit ...............................................................210
Overlap .......................................................169, 176

No Zone......................................................167
Selection ....................................................175

Overlap Zones....................................................167
Overlapping Appliqué ....................................117
Override Orientation .......................................176
Overview Window ...............................7, 31, 311

P
Packing Stitches

Remove ......................................................216
Page Setup

Project Wizard Printing .........................174
Pale Bands ...........................................................167
Paper

Size...............................................................281
Source.........................................................281

Parallel
Crosshatch Fill ..........................................231
Curved Crosshatch Fill ..........................233

Parts of the Software Window...........................4
Paste .................................................................81, 82

Block.............................................................. 65
Paste Color...........................................................122
Paste Picture ............................................... 99, 105
Paste To All...........................................................122
Pattern

Curved Crosshatch Fill ..........................234
Fill .................................................................274
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Fill Properties........................................... 219
Motif Fill........................................... 227, 228
Motif Line.................................................. 272
MultiWave Fill .......................................... 238
Satin Area.................................................. 254
Shape Fill................................................... 244
Tapered Motifs ........................................ 263

Pattern 36 Satin Effect Fill ............................. 274
Pattern Fill ................................................. 207, 218
Pattern Sensitivity ............................................ 286
Patterns

1 to 12 (Standard 1)............................... 277
109 to 120 (Hearts) ................................ 275
121 to 132 (Leisure 1) ........................... 275
13 to 24 (Standard 2) ............................ 277
133 to 144 (Mosaic) ............................... 276
145 to 156 (People) ............................... 276
157 to 168 (Plants & Flowers 1) ......... 276
169 to 180 (Polygons)........................... 276
181 to 192 (Rope & Chains) ................ 276
193 to 204 (Squares 1).......................... 276
205 to 216 (Squares 2).......................... 277
217 to 228 (Transport) ......................... 277
229 to 240 (Waves 1) ............................ 277
241 to 252 (Waves 2) ............................ 277
25 to 36 (Standard 3) ............................ 277
253 to 264 (Gradient)............................ 275
253 to 264 (Lace).................................... 275
265 to 276 (Mosaic) ............................... 276
37 to 48 (Animals 1) .............................. 274
49 to 60 (Arrows) .................................... 274
61 to 72 (Circles 1) ................................. 275
73 to 84 (Circles 2) ................................. 275
85 to 96 (Climate)................................... 275
97 to 108 (Diamonds)........................... 275
Motif Fill Properties ............................... 226

Pause for Commands.........................................50
PDF

Fill Patterns............................................... 274
PDF Guides .............................................................. 2
People — Patterns 145 to 156..................... 276
Percentage Zoom................................................57
Perky Dragonfly ....................... 14, 73, 146, 264
Perspective Correction......................... 101, 106
Photochromic Threads ......................................53
Picture

Acquire ...................................................... 105
Background Wizard ..................................98
Choose....................................................... 104
Crop ............................................................ 106
Files .................................................................. 9
Paste ....................................................99, 105
Scan ............................................................ 105
Share..............................................................54
View ............................................................ 104
View for Background ...............................99

Picture Viewer.................................................... 104
Pictures

Formats...................................................... 105
Piece

Delete......................................................... 116
Pinch ..................................................................... 130
Placement

Appliqué ................................................... 107
Placement Line

Match ......................................................... 108

Plants & Flowers 1 — Patterns 157 to 168276
Play Demo ............................................................. 54
Play My Demo ...................................................... 54
Player Controls ..................................................... 50
Point

Delete........................................ 83, 168, 213
Emboss .......................................................190
Insert .................................................168, 213
Secure .........................................................140

Point Appliqué Hole.........................................113
Point Appliqué Outline ...................................110
Point Border .......................................................... 86
Point Cutwork Line.................................139, 143
Point Emboss Line ............................................190
Point Morphing .................................................125
Point MultiWave Line.......................................215
Point Select ........................................................... 68
Point Stamp Line...............................................198
Pointer

Measure........................................................ 60
Pointers......................................................................7
Points

Insert ...........................................................189
Move..................................................168, 211
Move Start and End ...............................212
Remove In Fill ...........................................191
Stitch ........................................................ 6, 32

Polarize .................................................................125
Polygons — Patterns 169 to 180 .................276
Popup Description of Thread Color.............. 36
Popup Thread Description............................... 44
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Print .............................................................282
Toolbar........................................................282

Previous
Split Section..............................................173

Previous Color Block .......................................... 46
Previous Design.................................................151
Previous Piece ....................................................114
Previous Section Alignment .........................181
Previous Stop........................................................ 47
Print........................................................................278

Information...............................................279
Options.......................................................174
Preview.......................................................282
Preview Toolbar.............................280, 282
Range ..........................................................283
Setup...........................................................281
To File ..........................................................282

Print All Designs ................................................279
Print Preview

Toolbar........................................................280
Print Sheet ............................................................. 96
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Motif Line.................................................. 273
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On Exit...........................................................17
Project........................................................ 172
Project Sections...................................... 173

Save As ....................................................................17
Saving Embroideries ....................................... 167
Scale

Design........................................................ 278
White Handles.................................... 65, 70

Scale Block and Resize Block...........................70
Scan

Picture for Background...........................99
Scan Picture........................................................ 105
Scanner ................................................................ 105
Second Color ........................................................39
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